
 

- 1 - 

 

Getting
into the Details
Getting
into the Details



 

- 2 - 

 

Documentation by Ernst Nathorst-Böös, Ludvig Carlson, Anders Nordmark, Roger Wiklander
Additional assistance: Cecilia Lilja
Quality Control: Cristina Bachmann, Sabine Pfeifer, Claudia Schomburg

The information in this document is subject to change without notice and does not represent a commit-
ment on the part of Steinberg Media Technologies AG. The software described by this document is subject
to a License Agreement and may not be copied to other media except as specifically allowed in the License
Agreement. No part of this publication may be copied, reproduced or otherwise transmitted or recorded,
for any purpose, without prior written permission by Steinberg Media Technologies AG.

All product and company names are ™ or © trademarks of their respective owners. 

© Steinberg Media Technologies AG, 2000. 
All rights reserved.



 

- 3 - 

 

Table of Contents



 

- 4 - 

 

10 Setting up an Advanced Audio 

 

System

 

11 Introduction
11 General Precautions
12 A few words on Word Clock and 

Sample Rates
14 What Devices can be used? – 

Example Hook-ups
20 About the Busing System
20 Selecting Inputs for Mono, Stereo 

and Multi Recordings
22 Routing Channels and Effects to 

Audio Outputs
23 Application Examples

 

25 Recording in High Resolution and 

 

Using TrueTape™

 

26 About this Chapter
26 Selecting Recording Resolution
27 The Available Recording Resolutions

 

29 How Cubase VST handles audio 

 

and MIDI

 

30 Why you should read this Chapter
30 Audio Channels vs Tracks
33 Audio Files
34 Audio Segments and Events - 

Non-Destructive Editing
36 MIDI Inputs
36 MIDI Outputs
37 How Cubase VST records MIDI 

Channel data
38 Rechannelizing – The MIDI Channel 

setting for the Track
38 Rechannelizing also works on Thru-

put!
39 Turning off Rechannelization – MIDI 

Channel “Any”

 

40 Using Auto Crossfade

 

41 Background
41 How does Auto Crossfade work?
42 Activating and making settings

 

43 Stereo, Multi Channel and Multi 

 

Track Recording

 

44 Stereo audio recording
46 Multi Channel Recording - 

Channel “Any”
49 Multi Track Recording

 

55 The Arrangement - More on what 

 

you can do with Parts and Tracks

 

56 Creating Parts
58 Overlapping MIDI Parts
59 Merging Parts
60 About Cut, Copy & Paste
61 Part Operations using the Toolbox
72 Renaming Parts
73 Ghost Parts
74 Using the “Repeat” function
75 Trim Events to Part
75 Cut At Locators
76 Insert At Locators
77 Split At Locators
77 Copy Locator Range
78 Explode By Channel
80 Merge Tracks
82 Merge Audio Segments
83 Merge Overlapping Parts
83 Optimize Arrangement

 

84 Instruments

 

85 About Instruments
85 Setting up
89 Selecting Instruments
89 Redirecting Instruments
91 Working with Patch Names

 

95 More about Play Parameters and 

 

the Inspector

 

96 What are Play Parameters?
97 The Parameters
100 Using the Multi Out feature
104 Using the Randomize feature
106 Using the Dynamic feature



 

- 5 - 

 

113 Program Changes and MIDI 

 

Volume

 

114 Why you should read this Chapter
114 About Program Change
115 Entering Program Change as a Play 

Parameter
118 Recording or Entering Program 

Change in the Editors
119 Which should I choose?
120 About Bank Select
121 About MIDI Volume
121 Entering Volume as a Play Parameter
122 Entering Volume in an Editor
123 Entering Volume in the MIDI 

Track Mixer
123 About Chase

 

124 Programming and Recording 

 

Mutes and Solo

 

125 Pre-programming Mutes
125 Recording Mutes and Solo
127 About editing recorded Mutes

 

128 Folder Tracks

 

129 About Folder Tracks
129 Using Folders

 

134 Groups

 

135 About Groups
136 How to use Groups - The basic steps
136 Building Groups
139 Using Groups

 

146 More about Quantizing and 

 

Grooves

 

147 About this chapter
147 Using Groove Control
153 Importing, Exporting and Managing 

Grooves
155 Using the Groove Tool
155 Additional Quantizing Types

 

156 The MIDI Editors - General 

 

Information

 

157 About this Chapter
157 Similarities and differences between 

Editors
158 Opening an Editor
161 Closing an Editor
162 Editing music during playback
164 How Events are displayed in the 

Editors
167 Moving around and the Goto pop-up 

menu
168 Monitoring Events in the Editors
168 Selecting and the To pop-up menu
170 The Do pop-up menu
173 The Info Line
175 Quantize and Snap Values
177 Creating Note Events
179 Editing Notes
184 Deleting Events
185 Creating and Editing Continuous 

Data

 

189 Step Recording

 

190 Introduction
190 Preparations
191 Entering notes and chords
194 Using the Insert button
195 Playing back
195 When you are finished

 

196 Key Edit

 

197 About this “Chapter”

 

198 Drum Edit and Drum Tracks

 

199 About this Chapter
199 About Drum Tracks and Drum Parts
200 About Drum Maps
203 Loading and Selecting Drum Maps
205 Editing and Creating Drum Maps
208 Saving your Drum Map
208 Removing Drum Maps
209 Editing Drum Parts in the Drum 

Editor
212 Editing MIDI Parts in Drum Edit
213 Converting between MIDI and Drum 

Parts



 

- 6 - 

 

214 List Edit

 

215 The Columns in the List
221 Creating Events
222 Editing in the List
225 Editing in the Event Display
226 Editing in the “Value 2” Display
227 Hiding Events
228 Using Mask
229 About Quantizing and Functions
230 Printing the List

 

231 Score Edit

 

232 About this Chapter
233 Overview
234 Getting the Score displayed correctly
238 Editing several Tracks
239 Manipulating Notes
242 Adding Text
243 Moving and Duplicating Text
243 Deleting Text Symbols
243 Title, Comment and Copyright
244 Printing

 

245 The Controller Editor

 

246 What can I do with the Controller 
Editor?

247 Opening the Controller Editor
248 Selecting which Event Types should 

be displayed
254 Customizing the Display
255 Creating and Editing Continuous data
262 Various Functions on the Do menu
262 Closing the Editor

 

263 Logical Edit

 

264 Why Should I Use Logical Edit?
264 Opening Logical Edit
265 Working with Presets
267 Managing and Creating Presets
269 Selecting Easy or Expert Mode
270 Initializing the Settings
270 How Logical Edit Operates
271 About Setting Values
272 Setting up Filters
276 Applying a Filter
277 Setting Up for Processing
281 Processing Functions
282 Expert Mode

 

284 Filtering and Mapping MIDI Data

 

285 Introduction
285 Recording Filters
287 Thru Filters
288 Mapping Controller Messages
289 The MIDI Input Transformer

 

292 The MIDI Track Mixer

 

293 About this chapter
293 The MIDI Track Mixer layout
294 The Controls
299 Automating the MIDI Track Mixer
306 Customizing the MIDI Track Mixer
309 What is GM/GS/XG?

 

310 The Audio Pool

 

311 Introduction
311 Overview of the Window
312 Displaying Segments
313 The Headings and Columns
315 Customizing the View
317 Finding Out how a Segment is used 

in the Song
318 File Operations
321 Handling “Missing Files”
322 Creating Wave Images and Keeping 

them up to date
323 Segment Operations
326 Deleting Unused Portions of Audio 

Files (Erase Unused)
328 Importing Audio Files into the Audio 

Pool
330 Exporting Files and Segments
330 Dragging Segments into Other 

Windows
332 Banish Silence
333 Preparing File Archives and “Masters”
335 Saving and Loading the Audio Pool

 

336 The Audio Editor

 

337 Introduction
337 Opening the Audio editor
337 About Events, Lanes and Segments
342 About Zero Crossings
344 Customizing the View
348 Recording in the Audio editor
349 Importing and Dragging Audio into 

the Editor



 

- 7 - 

351 Auditioning and Scrubbing
352 Editing on the Info Line
353 Changing Start and End Insets
357 Working with Q-Points
359 Moving Audio Events
360 Duplicating and Repeating Events
363 Using Cut, Copy and Paste
364 Muting Events
365 Splitting Events
366 Deleting Events
367 Adding and Editing Match Points
370 Quantizing Audio Events
373 Match Quantizing Audio
375 Fitting Audio Events to the Loop
377 Working with Grouped Events
379 Banish Silence
381 Creating Crossfades, Fade Ins and 

Fade Outs
385 Using Cycled Recording for 

assembling a “perfect” take
387 Changing the Volume and Panning 

of an Event
389 Making an Event Play another 

Segment
389 Exporting Events into Files

 

390 Audio Functions

 

391 Introduction
392 Applying the Processing
393 The Functions

 

400 The Wave editor

 

401 What is the Wave Editor?
401 Precautions
402 Opening Wave Editor Windows
403 Adjusting the View
406 Playing Back
407 Selecting
408 Working with Segments
409 Turning the Selection into a File
410 Cutting and Pasting Audio
410 Applying Processing Functions
411 Using an External Wave Editor

 

412 Mixing Audio and using Effects

 

413 Introduction
413 About Routing and Signal Paths
419 Volume
420 Panning

421 EQ
424 VST Dynamics
431 Effects
446 Using Dither
449 Copying settings between Channels
450 Saving Mixer Settings
452 Loading Mixer Settings
453 Group Channels
458 ReWire Channels
458 VST Instrument Channels
459 VST Mixer Views
462 Changing the Meter Characteristics
462 Reset Switch
463 Volume and Pan Automation – 

Dynamic Events or VST Channel Mixer
464 Automating the VST Channel Mixer

 

471 Remote Controlling VST Objects

 

472 About this Chapter
472 Setting Up
473 Writing Automation using Remote 

Controls

 

474 VST Instruments

 

475 Introduction
475 About the included VST Instruments
476 Activating and Using Instruments in 

Cubase VST
479 Automating a VST Instrument

 

480 ReWire

 

481 Introduction
482 Launching and Quitting
483 Activating ReWire Channels
484 Using the Transport and Tempo 

Controls
485 How the ReWire Channels are 

handled in Cubase VST
485 Considerations and Limitations

 

486 The Input/Output Bus System

 

487 Introduction
487 What you can do with the Bus system
488 Activating Inputs
489 Recording from an Input
490 Activating and routing Output Buses
492 Routing Audio Channels to Buses
493 Sends and Effects



 

- 8 - 

 

496 Importing and Exporting Audio

 

497 Importing audio files into the 
Arrangement

499 Mixing down to an audio file
503 Including your MIDI music in the 

mixdown

 

504 Working with ReCycle files

 

505 About ReCycle
505 Using ReCycle files in VST
506 About Tempo Changes and the last 

Segment(s)
507 If you get clicks during playback
509 Editing Tips and Tricks

 

510 Making the Most of the Event/

 

Segment Relationship

 

511 What is an Event really?
511 What is a Segment really?
511 Copying Audio Events

 

514 Optimizing Audio Performance

 

515 Introduction
515 Audio System Settings
521 Multi processing
522 Methods of Optimizing Performance
524 Maintaining the Hard Disk

 

525 The Master Track

 

526 What is the Master Track?
527 Opening the Graphic Editor
528 The Window Sections
529 About the Tempo Display
529 About Time Signature Events
530 About Rulers and Positions 
531 Switching between Meter and Time 

based Display
532 Moving around and setting Song 

Position
532 About Hitpoints
533 About the Toolbox
533 Activate Master!
534 Recording Tempo Changes
536 Selecting
538 Editing on the Info Line
539 Redrawing the Tempo Curve
540 Drawing new Events
541 Moving Events Using the Mouse

541 Duplicating Events
541 Adding a Tempo Change at the Song 

Position
541 Cut, Copy and Paste
542 Deleting Events
542 Repeating Events
542 Creating Accelerandi and Ritardandi
543 Reducing the number of Tempo 

Events
543 Smoothing Tempo Event values
544 Numerical processing of Tempo 

Events
546 The Master Track List Editor
548 Moving Master Track data between 

Arrangements

 

549 Hitpoints

 

550 About this Chapter
550 What can I do with Hitpoints?
550 What are Hitpoints?
552 Setting Out Hitpoints
554 Editing Hitpoints
556 Hitpoints in the MIDI Editors
557 Playing back Hitpoints via MIDI
558 Linking Hitpoints
561 Working with Tempo Matching
565 Working with Straighten Up
569 Tempo Mapping “freely recorded” 

Music using Time Locked Tracks

 

572 Matching Audio and Tempo

 

573 Introduction
573 Opening the Audio/Tempo Match 

Editor
574 Adding and Editing Match Points in 

the Editor
577 Making the Playback Tempo follow 

the Audio
581 Making the Audio Follow the Tempo
585 Creating a Groove template
586 Using Snip at M-points

 

588 Time Locked Tracks

 

589 What are Time Locked Tracks?
589 Time Locking a Track
589 Changing the Tempo
590 Turning Time Lock On and Off
590 Editing Time Locked Tracks
590 Creating Multiple Tempi
590 Things To Note



 

- 9 - 

 

591 Synchronization

 

592 Introduction
592 The two types of Sync Signals
592 Cubase VST – Master Or Slave?
593 Synchronization and audio playback 

- Introduction
593 If your Audio Hardware supports the 

ASIO Positioning Protocol
596 If your Audio Hardware doesn’t 

support the ASIO Positioning 
Protocol

599 The Synchronization Dialog Box
600 Internal Sync - No External 

Synchronization used
601 Synchronizing Cubase VST to MIDI 

Time Code (MTC) or Time Code via 
ASIO Positioning Protocol

603 Synchronizing Cubase VST to MIDI 
Machine Control (MMC)

604 About Frame Rates
605 Synchronizing Cubase VST to 

another MIDI Device via MIDI Clock
607 Synchronizing other Equipment to 

Cubase VST
608 Transmitting Synchronization 

Signals while Cubase VST is 
synchronized to an External Source

609 Song Start
609 Time Display Offset
610 Bar Display
610 MROS Resolution
611 Write Timecode
612 Sync Options

 

613 Quicktime Movie capabilities

 

614 Basic Movie Playback
614 Movie features
615 Opening a movie in the MovieTracks 

window
616 The Controls in the MovieTracks 

windows
617 Extracting Audio Data from Movies 

(Export Audio)
618 Adding Audio to Movies (Import 

Audio)
619 Saving a Movie
620 Editing the audio for a movie - 

An example

 

621 Customizing Cubase VST

 

622 Why Customize?
622 Creating a Custom Startup Song

 

627 Keyboard Commands, MIDI 

 

Remote Control and the Toolbar

 

628 Defining and Using Key Commands
632 The Toolbar
636 MIDI Remote Control
638 The Default Key Commands

 

643 Track Views and Window Sets

 

644 Track Views
646 About Window Sets
647 Creating a Window Set
648 Recalling a Window Set
649 Renaming and Removing Window 

Sets
650 Application Examples
650 File Handling of Window Sets

 

651 Index



 

- 10 - 

 

1

 

Setting up an Advanced Audio System



 

- 11 - 

 

Introduction

 

This chapter is devoted to users who have (or plan to get) additional audio hard-
ware, especially “advanced” hardware that goes beyond the “basic sound card” 
with analog stereo inputs and outputs only. Advanced audio hardware may have 
various additional features, such as multiple inputs and outputs, digital audio con-
nectors, synchronization facilities, etc. Furthermore they may support higher reso-
lutions and sample rates. This chapter describes considerations and possibilities 
with such systems.

 

General Precautions

 

• For all installation procedures, please refer to the instructions that came with the hard-
ware. If in doubt, please contact your dealer - do not guess about anything.

• Some combinations of computer components may interfere with each other. Make 
sure to check the hardware documentation and the manufacturer’s web site for known 
compatibility issues.

• Make sure you get the latest drivers for your audio hardware.

 

If there is a specific ASIO driver for the audio hardware, you should use this.
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A few words on Word Clock and Sample Rates

 

As described in the chapter “Synchronization” and below, there are several issues 
involved in getting a digital audio system to synchronize properly:

 

Word Clock

 

A digital audio device is always “clocked” by some signal running at the same fre-
quency as the sample rate (most often 44.1 or 48kHz). This clock is often provided 
by a built-in, extremely accurate, crystal circuitry.

When you make digital audio connections between two devices, the clock signals 
must be synchronized, or you will get glitches in the audio. This is done by routing 
a sync signal from the 

 

master

 

 (the device “transmitting” the clock signal) to the 

 

slave

 

 (the device receiving the clock signal). The slave device then replaces its inter-
nal clock with the one provided by the master. In this way the two devices are in 
perfect sync.

In the most basic connection, like when transferring digital audio between two 
DAT type recorders, the synchronization signal is part of the audio signal itself. In 
this setup, the recording device is 

 

automatically

 

 “locked” to the clock of the incom-
ing audio.

In more advanced setups, the synchronization signal – often referred to as “word 
clock” – can be carried either as part of some audio signal (in a number of formats – 
S/PDIF, AES/EBU or ADAT for example) or in a separate cable (again in a number of 
different formats).

When setting up a digital audio system, it is extremely important that all the de-
vices are synchronized to the same clock source. That is, there can only be one mas-
ter, but an infinite number of slaves.

 

❐

 

Failing to provide proper synchronization for digital audio will most likely lead in 

 

glitches or distortion in your audio recordings.

 

Please consult the dealer providing the equipment for exact instructions on how to 
set things up.

 

Sample Rates

 

The sample rate is the speed with which you are capturing the digital audio. CDs 
use a sample rate of 44.1kHz and DAT recorders most often use 48kHz. Some sys-
tems use a sample rate of 96 kHz. Most audio hardware can be switched between 
several sample rates.

To be able to digitally transfer audio between components in your system, all re-
cordings must be done at the same sample rate, the sample rate that Cubase VST is 
set to. If you intend to include recordings made at other rates, you must first use 
some separate application to “sample rate convert” them to the rate used in your 
Cubase VST system.
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Transport Synchronization

 

The audio synchronization described above may not be the only type of sync re-
quired. If you are using Cubase VST in conjunction with some other type of re-
corder, (digital multitrack tape machine, analog tape recorder or other hard disk 
based recorder) you will probably need to set up 

 

time code synchronization

 

 so that 
the actual 

 

transports

 

 are synchronized. That is, you need to make all components 
that have playback facilities agree on time positions. This is done in a similar fash-
ion, but by providing a time code signal (rather than a word clock signal) that can 
be read by all devices. See the chapter “Synchronization” for details.

 

Both

 

 audio and time code synchronization is sometimes required in a digital audio 
system (for syncing to video for example). Although they are related, neither is a re-
placement for the other. Furthermore, it is very important that 

 

the same

 

 master 
source is used for both type of sync. That is, one and the same unit in the system 
should be the master source for all time code and word clock signals in the system. 
This master can be a digital tape recorder, a special synchronization device or some 
other device with similar capabilities.

 

ASIO Positioning Protocol

 

The ASIO Positioning Protocol (a part of the ASIO 2.0 feature specification) is a tech-
nology that ensures that audio in Cubase VST is in sample accurate sync with exter-
nal devices. By combining word clock sync and time code (transport) sync, ASIO 
Positioning Protocol facilitates sample accurate positioning and synchronization, 
as described on page 593. If your audio hardware and its ASIO driver support ASIO 
Positioning Protocol, we recommend that you use this.

 

MIDI Machine Control and Tape Tracks

 

If you are using Cubase VST together with some other type of recorder, you might 
be able to use MMC (MIDI Machine Control) to control its transport from the Trans-
port panel in Cubase VST. Combine this with Tape Tracks, and you can record, 
punch in and play back all tracks in the system, all from the Cubase Arrange win-
dow! It is also possible to combine MMC with ASIO Positioning Protocol. 

MIDI Machine Control and Tape Tracks are described in a separate document.
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What Devices can be used? – Example Hook-ups

 

Completely Analog System - Multiple Inputs and Outputs

 

In this system, the multiple analog inputs and outputs on the audio hardware are 
connected to an analog mixer.

 

Possibilities

 

• The multiple outputs allow you to separate the channels in Cubase VST for further process-
ing in an external mixer. See the chapter “The Input/Output Bus System” for details on how 
to map channels to outputs. 

• Having multiple inputs allows you to record several separate Audio Tracks at once (using 
Multi Track Recording - see page 49), which is useful if you want to record several players at 
the same time, etc.

 

Considerations

 

• As always when using an external mixer, it is necessary to use some kind of bus or send sys-
tem for feeding signals to the inputs on the audio hardware, thus allowing you to select 
which signals should be recorded. Simply connecting the main outputs of the mixer to the 
audio hardware is usually not a good idea, since this would cause everything you hear to be 
re-recorded (and possibly cause feedback).

• Some audio hardware models have special routing options, allowing you to send incoming 
audio directly back to any output. Most likely, you would want to turn these off to avoid 
feedback.

• No special type of synchronization is required in this system. The sync issues are exactly the 
same as for a built-in audio system. See the chapter “Optimizing Audio Performance”.

Computer w.
Audio Card

Analog Mixer

Digital 2-channel audio (S/PDIF, AES/EBU)

Digital Multi Channel Audio (e.g. ADAT Optical)

Word Clock

Analog Audio
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Analog System with Digital In and Out

 

This figure shows the same system as in the previous example, but with one addi-
tion – digital stereo inputs and outputs. However, the issues listed below also apply 
to an audio card with stereo analog in/out and stereo digital in/out, or a card with 
stereo digital in/out only.

 

Possibilities

 

• The digital output allows you to transfer the stereo output from Cubase VST digitally onto a 
DAT recorder, for example. Recording digitally this way ensures that no audio quality is lost 
in the mastering stage.

• In the same way, location recordings made on a DAT recorder (or similar) can be transferred 
digitally into Cubase VST with no audio quality loss.

• Another advantage is that you are not restricted to the audio hardware’s built-in analog to 
digital converters - if you have access to external, professional analog to digital converters, 
these may provide even higher audio quality.

 

Considerations

 

• When making connections for digital audio, make sure you are using the correct type of ca-
bling. Although they often use the same types of connectors, cables for digital and analog 
audio are not identical. Please ask your dealer for the correct type of cables.

• When 

 

recording

 

 digitally, it is very important that the digital input of the audio hardware is 
synchronized to the device producing the S/PDIF signal. This is done in Cubase VST in the 
Audio System Setup dialog (which you can find in the Audio Setup submenu on the Options 
menu), by adjusting the Audio Clock Source setting.

• When 

 

playing back

 

 digitally, it is equally important that the device at the other end of the ca-
ble (the DAT in our example) is set to synchronize its digital audio input to the computer au-
dio hardware.

Computer w.
Audio Card

Analog Mixer

Digital 2-channel audio (S/PDIF, AES/EBU)

Digital Multi Channel Audio (e.g. ADAT Optical)

Word Clock

Analog Audio

DAT
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Computer and Multitrack Digital Recorder (MDR)

 

In this system, audio hardware with ADAT Optical connectors is connected to an 
MDR, that is, some kind of digital stand-alone recording device (not necessarily an 
ADAT type tape recorder). No other equipment uses digital audio connections.

Audio 

 

input

 

 is not included in the diagram above, but would probably happen via 
the computer audio hardware.

In this system, the most straightforward way to set things up is probably this:

 

• Monitoring of the MDR is done via analog outputs, connected to the analog mixer.
• Monitoring of the audio hardware is also done via analog outputs, connected to the same 

mixer.
• A digital two way connection is established via the ADAT Optical connectors on the MDR and 

on the audio hardware. This allows you to transfer data in either direction. The ADAT Optical 
connection also carries the Word Clock signal.

 

Possibilities

 

• This setup allows you to transfer MDR tracks into Cubase VST for editing and processing. 
Submixes created in Cubase VST can be transferred back to the MDR. If your audio hardware 
supports ASIO Positioning Protocol, sample accurate transfer is possible (see page 593).

• If the device supports it, you can also use MMC and Tape Tracks in Cubase VST to control the 
MDR completely from the Cubase VST arrange window. See the separate “Tape Tracks” doc-
ument.

Computer w.
Audio Card

Analog Mixer

Digital 2-channel audio (S/PDIF, AES/EBU)

Digital Multi Channel Audio (e.g. ADAT Optical)

Word Clock

Analog Audio
MDR (e.g. ADAT)
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Considerations

 

Only one unit in the system can be the sync master (see the chapter “Synchroniza-
tion” for more information on sync). There are several options. Which to choose de-
pends on the exact nature of the equipment you are using:

 

• You can let the MDR be the master. This is the most common choice. This requires that the 
MDR can provide a clocking signal in a format the audio hardware can read. The Audio Clock 
Source setting in the Audio System Setup dialog must then also be adjusted accordingly. It 
also assumes that the MDR can generate MIDI Time code messages, either directly or via ad-
ditional hardware (a special synchronization device).

• You can let Cubase VST be the sync master. This assumes you can route word clock from the 
audio hardware in the computer to the MDR. It also assumes the MDR can sync its transport 
to MIDI Time Code (MTC) messages transmitted from Cubase VST, via the MIDI interface in 
the computer.

• If you want to use Cubase VST to control the transport of the MDR, MMC is always transmit-
ted from the computer to the MDR, regardless of which unit is the sync master. Again, see 
the Tape Tracks document for details.

• If your audio hardware and its ASIO driver support ASIO Positioning Protocol, we recom-
mend that you use this, for sample accurate positioning and synchronization (see page 593).

 

An additional consideration is the choice of sample rates. The audio hardware in the 
computer must be set to record and play back at the same sample rate as the MDR, 
or you probably won’t be able to transfer audio recordings between the two.

Finally, just note that it is possible to create audio feedback loops if you feed audio 
through both the audio hardware and the MDR. Be careful when activating moni-
toring on the two devices at the same time.



 

- 18 - 

 

Computer and Digital Mixer

 

In this system, an audio mixer with digital inputs and outputs is used together with 
some audio hardware with digital connectors.

All monitoring is done via the mixer which also has analog inputs to record various 
sources, such as microphones. 

Note that the digital mixer may be a part of the audio hardware itself! One example 
of this is the Yamaha DSP Factory, for which Cubase VST has special support fea-
tures (see the separate DSP Factory document for details).

 

Possibilities

 

• All the mixers facilities can be used for setting up the sound when recording. The audio is 
then transferred digitally to the computer without any loss of quality.

• The mixer’s internal effects and equalization can be used as a complement to those in VST, 
either when bouncing (see page 499) or during mixdown.

 

Considerations

 

• As with the MDR/Cubase VST setup described above, there must be synchronization be-
tween the mixer and the audio hardware in the computer. This can either be done as part of 
the audio signal or separately.

• In this setup, it would be reasonable to have the mixer slave to the computer audio hard-
ware, instead of vice versa. No time code sync is required, since the mixer doesn’t have a 
“transport”.

• The note about coherent sample rates throughout the system applies here as well, of course.

Computer w.
Audio Card

Digital 2-channel audio (S/PDIF, AES/EBU)

Digital Multi Channel Audio (e.g. ADAT Optical)

Word Clock

Analog Audio
Digital Mixer
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Computer, Digital Mixer, MDR and effects with Digital Inputs

 

This setup is just an expansion on the two above. Any number of MDRs and digital 
mixers and effect units can be connected to a Cubase VST system. There is even 
computer audio hardware with more than one digital multitrack connector, allow-
ing you to expand the number of audio channel “buses” in the system.

 

Possibilities

 

The possibilities in such a system are endless. When recording you can route audio 
from the mixer to the MDRs or to Cubase. You can route signals to audio effects and 
bounce tracks via Cubase VST and the MDRs. During mixdown all the recorders can 
play back and the mixer in Cubase VST can be combined with the external mixer for 
increased processing possibilities.

 

Considerations

 

Since this system can be practically anything, it is impossible to say exactly how to 
“wire” things.

Again, the word clock synchronization needs to be planned carefully. Only one de-
vice can be the master and all the others must slave to it. You should also consider 
using ASIO Positioning Protocol, if your audio hardware and ASIO driver support it.
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About the Busing System

 

Cubase VST’s busing system is described in detail in the chapter “The Input/Output 
Bus System”. It is the key to all the examples outlined below. It allows you to mix 
channels into stereo pairs and bus these pairs to output connectors on your audio 
hardware.

 

Selecting Inputs for Mono, Stereo and Multi Recordings

 

The basic methods of recording a single or stereo input are described in the Get-
ting Started book. Below follow some notes pertinent to users of audio hardware 
with multiple inputs.

 

Activating Inputs

 

Before you can record from an input, you need to be sure it is activated. 

 

1. Select VST Inputs from the Panels menu.

 

The VST Inputs window appears.

 

2. Activate the inputs you need, by clicking the green buttons in the middle column.

 

Deactivate inputs that you don’t use, since they may consume processing power.

 

3. If you like, you can label the inputs in the right column, to reflect what is connected to 
them.

 

The labels will appear on the input pop-up menus in the VST Channel Mixer and Inspector.
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Mapping Inputs to Channels

 

The next step is to set up the Tracks for recording as described in the Getting Started 
book.

 

1. Make sure the Track is selected.

2. In the Inspector, hold down [Command] and click on the Input button.

 

A pop-up menu appears.

 

3. Select the desired input from the list.

 

If the Track is set to stereo, the pop-up menu will list input pairs.

 

Multi Track- and Channel Recordings

 

Multi Channel and Multi Track recordings are described in the chapter “Stereo, Multi 
Channel and Multi Track Recording”. Here are the procedures related specifically to 
audio hardware with multiple inputs.

 

1. Activate the Inputs you want to use.

2. For a Multi Channel recording on one Track, set the Track to Any and set up the desired 
channels for recording. For a Multi Track recording, set up each Track.

 

See the chapter “Stereo, Multi Channel and Multi Track Recording” for details.

 

3. Open the VST Channel Mixer and locate the channels on which you plan to record.

4. Hold down [Command] and click on the Input button (at the top of the channel strip) 
for the first recording channel.

 

A pop-up menu appears.

 

5. Select an input for that channel.

6. Repeat with the other channels.



 

- 22 - 

 

Routing Channels and Effects to Audio Outputs

 

Routing a channel to a certain output is a two stage process. First you route channels 
to buses, and then you route buses to outputs. For logic reasons we will describe 
these two steps in reverse order!

 

Activating and naming buses

 

This is described in detail on page 490. Here are the basic steps:

 

1. Select VST Master Mixer from the Panels menu.
A window with as many stereo buses as your audio hardware has stereo outputs appears. 
You can also view the Master strip (but not the separate Output Buses, if any) in the VST 
Channel Mixers, by activating the Master On button.

2. For each bus, select a stereo output from the pop-up menu at the bottom.

3. Activate the stereo buses you want to use, by clicking the corresponding Active but-
tons.
The leftmost bus, Master, is always active. Do not activate outputs that you won’t use, as they 
may consume processing power.

4. If desired, rename the various buses, by clicking on the Bus name fields at the top of 
each section.
Generally, it is always recommended that you label the Buses to reflect what’s connected to 
them.

Routing channels to buses

Once the buses are active, you can route outputs from the respective windows:

• In the VST Channel Mixers you can route all kinds of channels to buses, using the 
menus at the bottom of the window.

• In the VST Channel Settings windows, you can route sends to buses (see page 493).

• In the VST Send effects window you route the return signals from the effects to buses 
(see page 493).
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Application Examples

Using Outputs as Effect Sends

As described above, you can route effect sends to physical outputs on your audio 
hardware. This allows you to route sends to external effects. This is described on 
page 493.

Bouncing

It seems that it’s a common law of recording that you never have enough audio 
tracks/channels. A system where Cubase VST is used in tandem with an MDR (see 
page 16) allows you to use Cubase VST’s mixing facilities to “bounce” recordings, 
that is mix down a multi track recording to stereo or mono.

1. Route the audio from the MDR to the inputs on your computer audio hardware.

2. Create a multi track recording of the outputs of the MDR, each on a separate audio 
Track in Cubase VST.
See the chapter “Stereo, Multi Channel and Multi Track Recording”. If you have a limited 
amount of audio channels available, you can temporarily mute some existing Tracks in Cu-
base VST, to make “room” for the recordings.

3. Create a stereo or mono mix of all the Tracks you want to bounce.
This might involve using eq, effects and automation.

4. Solo the Tracks you want to bounce.

5. Route the output of Cubase VST into the MDR and use it to record the stereo mix of the 
Tracks back on “tape” (or whatever media your MDR is using).

Using Cubase for Editing tape Tracks “Off-line”

It is common to have a field or on-location digital tape recording that involves multi-
ple takes of the same performance, distributed over several tracks, or lined up one af-
ter the other on the same track. Cubase VST is perfect for assembling such material to 
a single, “perfect” take.

1. Route the audio from the tape machine to the inputs on your computer audio hard-
ware.

2. Record all the various takes onto one or a few tracks in Cubase VST.

3. Also record a guide track, for example a rough mix, from the tape recorder, that you 
can use for reference during the assembly process.

4. Use Cubase VST’s extensive editing possibilities (such as the Toolbox facilities in the 
Audio Editor) to assemble the material into a single take, that plays well together with 
the guide track.

5. If required, route the output of Cubase VST into the MDR and record the “perfect” take 
back on tape.
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Mastering to Stereo

If you already have a portable MDR in your system, you can very well use it for mas-
tering final mixes. Just record the stereo output of the mix in Cubase VST onto two 
free tracks on whatever media your MDR is using.

Using the Busing System for Throughput

Cubase VST with some additional audio hardware can even be used for mastering 
purposes or for audio conversion. Here are a few examples:

• Use the busing system to route audio coming in via S/PDIF inputs to ADAT Optical out-
puts, for recording onto some other media.
Please note that you need to put the two input channels in Input Monitor mode, for the au-
dio to be routed through without recording.

• Route audio through some Cubase VST plug-in effects and dithering, and record the 
output onto other media.
This could be useful for example as part of a mastering process.

• Use the audio hardware for converting audio from e.g. ADAT format to S/PDIF, for 
routing though an external device. Then patch the audio back and reconvert back to 
the desired format (ADAT in this example).

❐ Please note that the throughput audio will be delayed by whatever latency (see page 
517) there is in your system!
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2
Recording in High Resolution and Using TrueTape™



- 26 - 

About this Chapter

This chapter describes some implications of recording “high resolution” audio, that 
is, audio files of a resolution higher than 16 bit. It also describes how to use the 
unique “TrueTape” recording mode (available in Cubase VST/32 only).

Selecting Recording Resolution

The resolution for recording can be set in two places:

• On the Record Mode pop-up menu above the Part Display in the Arrange Window.
• On the corresponding pop-up menu in the Audio System Setup dialog.

These two pop-up menus are “mirrors” - it doesn’t matter which one you use. 

Note:

• You can freely mix audio files of different resolution in the same Song.

• Regardless of the resolution of the audio files, Cubase VST processes audio internally 
in 32 bit float resolution to ensure pristine audio quality. 

• The recording resolution has nothing to do with the resolution of the final mix.
If you use the Export Audio Tracks function to mix down to a file, you can freely specify the 
desired resolution as described on page 499. If you are mixing down to an external recorder, 
the resolution depends on the audio hardware, the connection and the recorder.

• Audio hardware that supports high resolution may also support high sample rates, al-
lowing for very high audio quality.
You select a sample rate in the Audio System Setup dialog. Note that this setting is global for 
the Song - all files must be recorded with the same sample rate, otherwise some will play 
back with the wrong speed and pitch.
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The Available Recording Resolutions

All versions of Cubase VST allow you to select 16 or 24 Bit resolution. If you are us-
ing Cubase VST/32, there will be two additional modes on the pop-up menu: 32 Bit 
and TrueTape 32 Bit.

24 Bit Recording

24 Bit files have a greater dynamic range than 16 Bit files. Note:

• 24 Bit recording is only useful if your audio hardware supports a higher resolution than 
16 Bit.
Preferably, 24 Bit resolution should be supported, but it would also make sense to use 24 Bit 
recording if your audio hardware supported e.g. 20 Bit resolution. However, recording in 24 
Bit mode with a 16 Bit audio card would not add to the audio quality in any way.

• 24 bit files will be 1.5 times the size of 16 bit files.

32 Bit Recording (Cubase VST/32 only)

When “32 Bit” is selected, files are recorded in 32 Bit Float format. This is a very high 
resolution that involves floating point numbers, for extreme dynamic range. Note:

• 32 Bit Float recording is only useful if your audio hardware supports 24 Bit resolution 
or higher.

• 32 Bit files will be twice the size of 16 Bit files.
Not only will this result in files taking up more hard disk space, it will also increase disk trans-
fer demands (as larger amounts of data will have to be moved to and from the hard disk).

• However, for technical reasons a 32 Bit data stream can sometimes actually be easier 
to handle for the processor.
This means that under certain circumstances, 32 Bit files may actually put less demand on the 
processor than 24 Bit files. Note that this depends on many factors, like memory bus and 
cache speed, so this should not be read as an absolute truth.
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TrueTape 32 Bit Recording (Cubase VST/32 only)

TrueTape is a unique Steinberg technology that emulates the behavior of a profes-
sional analog tape recorder. While digital audio recording has a number of benefits, 
some may perceive digital sound to be somewhat “sterile” and “cold” compared to 
high quality analog recordings. The TrueTape feature remedies this problem by 
recreating the sound of analog tape saturation at the recording stage. 

Note:

• TrueTape produces 32 Bit float files.
The hard disk and processor speed considerations of the regular 32 Bit format apply here as 
well.

• Unlike the regular 32 Bit mode, you can make use of the TrueTape mode even if your 
audio hardware only supports 16 Bit resolution.
This is because the TrueTape feature converts the signal to 32 Bit Float format, and adds au-
dio information in the floating point domain. Note, however, that only Cubase VST/32 can 
play back TrueTape audio files.

The TrueTape Control Panel

Once you have selected the “TrueTape 32 Bit” format, you can make settings by se-
lecting “VST TrueTape” from the Panels menu. This brings up a control panel for the 
TrueTape process.

Use the Drive control to adjust the amount of tape saturation effect to your liking. If 
you are monitoring through Cubase VST, you will hear how the changes color the 
sound of the monitored signal. This allows you to try out the settings before actu-
ally recording.

• The pop-up menu below the TrueTape panel allows you to select one of four Drive pre-
sets, for quick changes.
These contain no “hidden parameters” - selecting the “24dB Super Saturation” preset is the 
same as moving the Drive control all the way to the right. Note that any adjustments you 
make to the Drive control are automatically applied to the selected preset. You can also re-
name a preset by double clicking and typing in a new name.

❐ Raising the Drive level will also raise the level in the audio file. When input level meter-
ing is selected in the VST Channel Mixer, you may find that the Clip indicators light up. 
However, unlike when recording in 16 bit format, this is nothing to worry about - it is 
virtually impossible to get digital distortion in a 32 Bit float file.
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3
How Cubase VST handles audio and MIDI
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Why you should read this Chapter

This chapter contains some details and background theory about how Cubase VST 
handles audio and MIDI, as well as some terminology used throughout this manual 
and in the program. Please take the time to read this, as it will aid you in using the 
program in the most effective way (when working with audio, you should also read 
the chapter “Optimizing Audio Performance” for best results).

Audio Channels vs Tracks

Many audio recording systems do not make a difference between audio channels 
and Tracks, which is the way a regular tape recorder works: one channel - one Track. 
Cubase VST however, has a much more flexible approach to handling audio, as we 
shall see. This is important to note, especially if you have previously been working 
with a system where Tracks and Channels are one and the same thing.

Tracks

An Arrangement can contain a practically unlimited number of Tracks. Each Track 
has a Channel (Chn) setting that determines which audio channel the Track records 
and plays back on, just like you select MIDI Channel for a MIDI Track. The possibili-
ties are:

• A single (mono) channel, for example “7”.
• A stereo pair, for example “3+4”.
• “Any”.

All these alternatives are described below.

Audio Channels

An audio channel plays back one mono audio recording at a time. The absolute 
maximum number of audio channels you can access is limited by your computer’s 
processor, the amount of free RAM and the speed of the hard disk. You decide how 
many audio channels you can use (up to this limit) by setting the “Number of Chan-
nels” parameter in the Audio System Setup dialog. The procedures and limitations 
are described in the chapter “Optimizing Audio Performance”.
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The number of audio channels puts a limit to how many audio recordings can be 
played back at the same time. For example, in a four channel system, you could 
play back:

• One stereo drum recording (two channels), plus
• One mono bass recording (one channel), plus
• One mono guitar recording (one channel)...

...all at the same time.

Mono/Stereo

A stereo recording occupies two consecutive channels. If you for example make a 
stereo recording on channels “3+4”, this single recording uses up both channels 3 
and 4. It’s your decision when to record in mono and when to record in stereo. 
Since the number of channels is limited, some care should be taken so that the ste-
reo facility is only used when actually needed.

More about stereo recording on page 44.

Channel “Any”

A Track can also be set to Channel “Any”. This allows you to access all available au-
dio channels from one Track. This feature is mainly useful for the more advanced 
systems where is it possible to record a large number of audio inputs (and hence 
channels) simultaneously.

Imagine a situation where you make a multi channel recording, for example a re-
cording of a drum kit via a large number of microphones. Using the “Any” feature 
then allows you to handle the whole recording as one entity (one Track) although it 
actually consists of recordings on many separate audio channels.

Four channels of audio
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Setting Two Tracks to the same Audio Channel

You can set things up so that two Tracks use the same audio channel. This is not a 
problem as long as there is no audio happening at the same time, on the two 
Tracks. For example like this:

Here, the Trumpet Track plays through the verses and the TenorSax Track plays in 
the chorus. Since the Parts don’t overlap, both Tracks can have access to the same 
audio channel during playback. 

However, if there is any overlap between the two – if, for example, the saxophone 
starts playing in the middle of the trumpet, the two Tracks will compete for the single 
audio channel, and only one of them can use it at the same moment. In this case, the 
“latest” recording will always “steal” the audio channel, as described in the illustra-
tion below.

This situation extends to stereo recordings. If one Track records in stereo, on for ex-
ample channels 3+4, both these channels are occupied when this Track plays back. 
You can’t overlap stereo recordings that use these channels.

The trumpet will play until the sax Part starts. Then the sax will be heard instead.

These sections will not be heard!
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Audio Files

When you record, your Macintosh computer or audio hardware digitizes the audio 
signal coming from the microphone (or other sources) and stores the digital data as 
a file on your hard disk.

One File per Recording

One file is always created for each single recording you make.

File Format

The audio files created when you record in Cubase VST are AIFF files. It is also possi-
ble to import and export audio files in the formats Sound Designer II and Wave 
(WAV).

Since practically all Macintosh audio processing programs read and write some or 
all of these file formats, this allows you to process your Cubase VST files in other 
programs, and import files that have been created elsewhere, into Cubase VST. See 
the chapter “Importing and Exporting Audio” for information about importing and 
exporting files.

Stereo files

This version of Cubase VST uses “Interleaved” stereo files, that is, both “stereo sides” 
are saved in the same file. 

About “split stereo” files

Earlier versions of Cubase and some other audio softwares use “Split” stereo files, 
where each “stereo side” is a separate file. In other words, “Split” stereo files always 
come in pairs, one file for the left side and one for the right side. You cannot import 
two files making up Split stereo files into Cubase VST “in one go”. You can, however, 
import Split stereo files one by one as normal mono files. You can also export split ste-
reo files with the Export Audio Track function (see page 499).

Audio Files are big

Audio files are relatively large, compared to Cubase VST Song files, MIDI files, or for 
example, word processor files. For each minute of recording at 44.1 kHz mono, you 
will use up 5 MBytes of hard disk storage per mono audio channel. This means that 
to record continuously on four channels for three minutes, you will need 60 Mbyte 
of free hard disk space (5MByte * 4 channels * 3 minutes = 60MByte).

Take good care of your Audio Files!

This can not be repeated too many times: Back up your files! Hard disk crashes are a 
well known fact in the world of computers, and the only way to insure yourself 
against any disasters is to maintain a meticulous back-up scheme. If you work pro-
fessionally, we suggest you invest in a removable disk based, DAT based or other 
back-up system and that you keep multiple copies of all files.
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Audio Segments and Events - Non-Destructive Editing

Cubase VST is a random access based, non-destructive audio recording system – 
and even if that sounds like gibberish, you should be happy about it, as you will 
soon find out.

Non-destructive editing

Let’s say you have recorded a couple of minutes of guitar. During the first verse, 
there happens to be a brilliant section that you would like to use again in all the 
other verses. As you may know, this is possible using the “Copy and Paste” tech-
niques employed in most computer programs.

However, reusing material over and over again, normally wastes computer mem-
ory and/or hard disk space. With Cubase VST it doesn’t!

If you “cut out” a section of audio, and paste it in, over and over again in the song, 
you are simply instructing the program to use the same portion of the audio file in 
many places, without actually copying the file. This is made possible via Cubase 
VST’s use of segments.

Segments

A segment is a specification for a section of an audio file. The segment contains in-
formation about where in the audio file to start playing and where to stop. It might 
be that the segment plays the entire file, or it could also be that it just plays a cou-
ple of seconds somewhere in the middle of the file.

You can create as many segments as you like from the same file, as the example 
below shows.

Audio file

Segments
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Audio Events

To actually play back a segment in your Song, you need to place an Audio Event in 
the Song. Each Audio Event plays a certain segment. 
Audio Events and segments are of course automatically created as you record, but 
you can also manually create events and segments when you are editing or assem-
bling recorded material.

In many cases, you will not “feel” any difference between handling Audio Events and 
segments, but there is one. For example, an Audio Event specifies where to start play-
ing some audio, but the segment specifies the duration of playback. Also, you might 
delete Audio Events and still have access to the segment it played, so that some other 
Audio Event can play back the same segment in another part of the song. When there 
is an important difference between these two, this manual will tell you.

A Part contains Audio Events...

...which play segments (portions of an audio file).
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MIDI Inputs

Cubase VST records from all active MIDI Inputs at the same time. In essence, this 
means you don’t have to care about selecting or activating MIDI Inputs. However, if 
you have multiple interfaces and want to deactivate an input for some reason, you 
can do this in the MIDI Setup System dialog on the Options menu.

MIDI Outputs

Each MIDI Track has a MIDI Output setting. This routes the data on the Track to a 
physical MIDI Output on one of your MIDI Interfaces.

Standard serial port Interfaces

Standard interfaces are identified in Cubase VST by the port you have them con-
nected to (Modem or Printer).

Multi-port Interfaces

If you have a multi-port interface, each of its MIDI Out connectors appears as a MIDI 
Output in the Output list. Setting a Track to a certain Output routes all the MIDI Data 
on that Track to that specific MIDI Out connector on the interface.

Interfaces connected via OMS

If you are using OMS, your MIDI interface(s) are identified by the names given to 
them in the OMS Setup application.

Direct Connections

Some MIDI equipment provide “direct connections” to the computer, using serial 
or USB cables instead of actual MIDI cables. From Cubase VST’s point of view, these 
behave exactly like regular MIDI interfaces, i.e. each “Direct Output” appears in the 
Output list, named according to the respective driver.

For details, see the documentation of the MIDI equipment in question.
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How Cubase VST records MIDI Channel data

Each MIDI Event that Cubase VST records has a MIDI Channel number.

If for example you set your MIDI keyboard to transmit on MIDI Channel 5, all the 
notes, Pitch Bend data, program change or whatever you transmit from it, will have 
the MIDI Channel number 5.

This keyboard transmits on MIDI Channel 5.

Some MIDI devices can transmit on more than one MIDI Channel. In this case the 
MIDI input data coming in to Cubase VST will contain mixed channel numbers.

This keyboard transmits on two MIDI Channels, – 2 and 6. It may for example transmit each 
channel from one side of a split point.

Cubase VST stores the MIDI Channel with the Event. If you look in List Edit for exam-
ple, you can see the MIDI Channel for each Event that has been recorded.

5
5

5

5
5

2

6

6

2

6

In List Edit you can see 
the MIDI Channel stored 
with each Event.
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Rechannelizing – The MIDI Channel setting for the Track

When you play back a recording, you want it to be routed to a certain sound in one 
of your synthesizers. Let’s say you have a synthesizer that plays a bass sound on 
MIDI Channel 3. To route a Track to that sound you set it to MIDI Channel 3.

Now the following happens: When you hit play Cubase VST plays back all the data 
on the Track, but when doing so it replaces the MIDI Channel number stored in the 
Events with that of the Track – in this example, MIDI Channel 3!

This replacement is done as part of the playback procedure, that is, it does not affect 
the recording permanently. If you check the data on the Track in List edit (as men-
tioned above) all the Events still have their MIDI channel intact.

This is what we refer to as rechannelizing – changing the MIDI Channel of the Events 
on playback.

Rechannelizing is very convenient because it lets you forget what MIDI Channel 
number your keyboard is set to transmit on. Instead, to route a Track to a certain 
sound, you simply set the MIDI Channel number in the Track list in Cubase VST. 
And, if you decide you want to route the Track to another synthesizer, later, the 
only thing you have to do is to change the MIDI Channel setting for the Track.

Rechannelizing also works on Thru-put!

The text above only described what happens on playback. But in fact, Rechannelizing 
happens on the data that passes Thru Cubase VST. 

If you click on a Track to activate it, its MIDI Channel setting is used for rechannelizing 
the data that passes through the program. This automatically routes your playing to 
the correct MIDI Channel when you are recording, or rehearsing for a recording you 
are about to make.

This Track is set to play back 
on MIDI Channel 3.

These Events, on different 
MIDI Channels...

3

3

3

3
3

...get their MIDI Channel changed to 
that of the Track, during playback.

If you make a 
Track active...

3

3

3

3
3

...its MIDI Channel value is used for 
rechannelizing the data that 
passes through Cubase VST.

2
6

6

2

6
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Turning off Rechannelization – MIDI Channel “Any”

There’s one situation where you might not want rechannelizing and that’s when 
you have a Track that contains Events on multiple MIDI Channels. You might for ex-
ample have:

• Recorded with a keyboard that can be “split” so that it transmits on two MIDI Channels.
• A guitar synthesizer where each string can transmit on a different MIDI Channel.
• Recorded the output of another MIDI sequencer onto a Track in Cubase VST.
• Imported a MIDI File of Type 0, which by definition contains only one Track, possibly with 

Events on several MIDI Channels.

In each of these situations you might want to have the Track transmit on all its MIDI 
Channels – the MIDI Channels actually stored with each Event, as described above. 
This would allow you to set up several sounds and play them all from one Track.

To do this, set the Track to MIDI Channel “Any” (the “lowest” value).

Summary

To summarize: When a Track is set to MIDI Channel “Any”, rechannelizing is turned 
off, and the Events will be transmitted on their original MIDI Channels instead.

These Events, on different 
MIDI Channels...

6

6

2

6
2

...will play back on their original MIDI 
Channels since the Track is set to “Any”.
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4
Using Auto Crossfade
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Background

Playing back consecutive audio segments (with no space in between) on the same 
audio channel can sometimes result in audible pops and clicks. The reason is that 
the signals in the two segments may have a different amplitude (level) at the inter-
section point, which in turn creates a transient (a sudden and dramatic change in 
signal level).

Two consecutive audio waveforms. The vertical line indicates the intersection point.

This may be especially noticeable when playing back imported ReCycle file (see 
page 505) or when playing back audio in Cycle mode (in which case the intersec-
tion happens when the playback position jumps from the end of the Cycle to the 
start).

To remedy this, you can activate the Auto Crossfade function for a channel.

How does Auto Crossfade work?

The Auto Crossfade function is independent for each audio channel. If the function is 
activated for an audio channel, Cubase VST will pre-calculate small linear crossfades 
at the intersection points between segments. During playback, the crossfades are in-
serted into the audio stream at the correct positions, for smooth transitions between 
segments.

❐ No crossfade is calculated if there is any gap whatsoever between two segments.

When are the Crossfades calculated?

The “pre-calculating” of the crossfades is done at the following occasions:

• When you activate the Auto Crossfade for a channel.
• When you move or edit Audio Events playing on a channel for which Auto Crossfade is acti-

vated.
• When you open a Song (or activate an Arrangement) in which Auto Crossfades are activated. 

If you open a Song with a lot of Auto Crossfaded segments, the calculation may take a few 
moments.
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About Crossfades and RAM

Whereas the “regular” Crossfade function in the Audio Editor (see page 382) creates 
new audio files, the crossfades created by the Auto Crossfade function are cached 
in RAM and never written to disk. 

• Unused crossfades in memory are removed if they are not used for 2 minutes.
This allows you to mute and unmute sections, etc, without the program having to re-calcu-
late crossfades each time.

• If you have turned off crossfades and want to make the used memory available immed-
itately, switch to another Arrangement and back.

• Since Auto Crossfades use RAM, you may want to increase the amount of memory as-
signed to Cubase VST in the Finder if you need to activate the function for several au-
dio channels. 
However, the processing (CPU) load is not affected by the function.

Activating and making settings

To activate Auto Crossfade for an audio channel, proceed as follows:

1. Open the Inspector for an Audio Track playing back on the channel in question.

❐ Note that the Auto Crossfade works on audio channels - not on Audio Tracks! This 
means that activating Auto Crossfade in the Inspector for one Track will automatically 
affect all other Tracks set to the same channel.
This also means that the Auto Crossfade works even if the consecutive segments are on 
different Audio Tracks.

2. Locate the “AutoXFade” parameter in the Inspector, and set this to “On”.
Auto Crossfade is now activated for the audio channel.

3. Start playback and check whether the audio plays back properly.

4. If you still get pops or clicks, try raising the “Samples” value in the Inspector.
This value determines the length of the calculated crossfades. Generally, higher values give 
smoother crossfades but also require more RAM. In most cases, the default “Samples” value 
should be sufficient.

• If you don’t specifically need Auto Crossfade for an audio channel, turn it off by setting 
the “AutoXFade” parameter to “Off”.
This makes more RAM available for other functions in the program (see the notes above).
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5
Stereo, Multi Channel and Multi Track Recording
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Stereo audio recording

Stereo recording only applies to audio Tracks and has no relevance for MIDI data.

Setting a Track to stereo

This is done in the Inspector, by clicking the “On” Stereo button so that it lights up.

The Stereo button in the Inspector.

Which Tracks can be set to stereo?

The stereo button indicates whether a track can be set to stereo or not. When stereo 
is not available, the button is dark and shows a lock symbol. A Track must meet the 
following criteria for the stereo option to be available:

• It must be set to an odd channel number.
A stereo recording always uses an odd channel for the left channel and an even for the right.

• It must not already contain any mono recordings.
If there are already mono Parts on the Track you cannot switch it to stereo and vice versa.

• No other audio Track that is already in use can be set to “the other” channel.
If channel 4, for example, is already used by some Track for a mono recording, a Track set to 
channel 3 cannot be switched to stereo.

What happens when I switch a Track to stereo?

• The Chn field in the Inspector and the Chn column in the Track List indicates the two 
channels used for stereo.

The Inspector for a stereo Track using channels 1 and 2.
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• The Channel pop-up (reached from the Inspector and the Chn column in the Track list) 
lists the two channels as a stereo pair.
From this point on they can only be used together, as a pair.

• Any Tracks set to the “other” audio channel in the resulting stereo pair, will automati-
cally be set to channel “Any”.
Let’s say you have a Track set to channel 3, and switch it to stereo. Then, any Tracks playing 
back on channel 4 will automatically be set to channel “Any”.

• In the VST Channel Mixer window, any two channels that are linked as a stereo pair dis-
play a stereo symbol, and the level meters are displayed adjacent to one another.

A stereo channel pair in the Mixer.

• Stereo recordings that you make take up two audio channel lanes in the audio editor, 
see page 339.

Recording in stereo

Making a stereo recording is actually no different from making a mono recording. 
Just make sure that the two audio outputs you want to record (probably the left 
and right sides of a stereo source) are connected to the correct inputs (see the Get-
ting Started book and page 488 for details about inputs), and that these inputs are 
selected for the two audio channels in the stereo pair.

In this example, all Tracks 
(in a 16 channel system) 
are set to stereo.
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The Mixer and Stereo Channel Pairs

As described above, a stereo channel pair is indicated in the VST Channel Mixer win-
dow by a “stereo symbol” and by the side by side positioning of the level meters. 
You will also note that there is only one button for Insert Effects and VST Dynamics 
in the mixer, meaning that you cannot make individual Insert or Dynamics settings 
for the two channels.

In addition to this, many controls for the channels are “ganged”, which means that 
when you change one of them, they are both affected.

For example, if you adjust the level of one channel in a stereo pair, the other chan-
nel is also adjusted, automatically. This makes it easy to set up the two channels in a 
stereo pair so that they sound identical.

The controls affected by this are:

• Level.
• All EQ settings.
• All Send settings.
• Mute and Solo.
• Monitoring on/off, Input Level switch and Meter Reset.

More about mixing in the chapter “Mixing Audio and using Effects”.

Overriding “ganging”

If you want to make VST Channel Mixer adjustments individually for a channel in a 
stereo pair, simply hold down [Option] when adjusting the control.

Multi Channel Recording - Channel “Any”

❐ Multi channel recording can be used on any system but is most useful to those with 
cards with more than two inputs.

Why record on an Any Track?

A single “Any” Track can contain recordings on multiple channels. In fact one Track 
can contain mono recordings on as many channels as the system supports.

Let’s say that you are recording a drum kit on four channels: a stereo mix of the entire 
kit, plus two separate channels for bass drum and snare (provided your audio hard-
ware can record four simultaneous inputs). If you use an “Any” Track for this record-
ing you will be able to record all four channels onto one Track and subsequently 
handle all four as one entity. This simplifies editing in the Arrange window and in the 
Audio editor.

• If the audio channels you are about to record are not directly related, but you still want 
to record them at the same time, you might instead prefer to record them on one Track 
each, using Multi Track Recording.
See page 49.
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Performing a Multi Channel Recording

1. Connect and set up the audio sources as desired.

2. Open the VST Channel Mixer and make sure that each audio channel is set to a sepa-
rate Input.
This is done by [Command]-clicking on the Input button at the top of each channel strip, and 
selecting an Input from the pop-up menu that appears.

3. Create an Audio Track to record on.

4. Open the Inspector for the Track and set it to channel “Any”.
A number of Record Info buttons appear. Exactly how many depends on the number of au-
dio channels in your audio recording system (see page 516).

• The Record Info buttons for even numbered channels of a stereo pair will not be 
shown.

A Track set to “Any” in a 16 channel system.

• There is also a group of Monitor buttons in the Inspector, as many as there are audio 
channels.
These work just like the Monitor button for a single channel Track, allowing you to manually 
turn monitoring on and off for each audio channel.

❐ If stereo inputs are used, a maximum of two audio channels - one odd, one even - can 
be monitored at once. If you for example are monitoring a channel with odd number, 
and click on another odd-numbered channel button, monitoring will be deactivated 
for the first channel.
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5. For the channels you plan to record on, click the corresponding Record Info button in 
the Inspector.
The Record Info buttons will change color to indicate their status, as described below.

6. Activate recording in any way you like, as described in the previous chapter.
All audio channels will now be recorded on the single Track.

When you later open the Audio Editor you will find that the recorded audio chan-
nels have been automatically Grouped. More on this on page 377.

About changing the Channel setting

As you noted above, it is the “Any” channel setting that is the clue to the Track be-
ing able to play back on more than one channel. If you later set the Track to a spe-
cific Channel number you will only hear one of the recorded files.

Record Info color coding

For Tracks with channel “Any”, a color scheme is used in the Inspector to make 
channel assignment more intuitive:

• An audio channel box is red if the channel is record enabled.

• An audio channel box has a blue border if the selected Track uses the channel and is 
ready for playback.

• An audio channel box has a yellow border if another Track uses the channel.
This helps you determine if this channel is available for recording.

❐ Please note that it may be perfectly OK to record on a channel that already is in use 
(displays a yellow or blue border). This depends on where in the Song the channel is in 
use.
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Multi Track Recording

What can I do with Multi Track Recording?

• Multi Track Recording allows you to record several players at the same time and have their 
performances appear on one Track each.

• If audio channels you are about to record are not directly related, but you still want to record 
them at the same time, you might prefer to record them on one Track each.

• If you have a keyboard or other MIDI Controller that can transmit on several MIDI Channels, 
Multi Track recording allows you to record different MIDI Channels onto different Tracks.

• Multi Track recording also allows you to “layer” several MIDI sounds, and record them on one 
Track each.

• When using Tape Tracks, Multi Track recording should be activated, so that you can set more 
than one Track on the tape recorder to record ready. This is described in the separate Tape 
Tracks document.

Activating Multi Recording

1. Pull down the Options menu and select “Multirecord”.

2. From the menu that appears, select “Active” so that it is ticked.
Multi Track Recording is now turned on, and a new Track column appears, labelled “R”. This is 
used in different ways for different Recording Modes, as described below.

3. Pull down the menu again and select one of the “modes” on the lower half, Merge, 
Channel Split, Input Split or Layer.
Which of these “modes” you should select depends on what type of recording you want to 
make. They are all described on the following pages.

Use this item to activate/deactivate 
Multi Recording.

This part of the menu allows you to 
select one of the modes.

When Multi Recording is active, a 
new Track column appears.
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Recording Audio

1. If you are only recording Audio, select Multi Record Merge mode.

2. Create as many Audio Tracks as desired and set them all to different channels.
The number of Tracks you can record on is limited by the number of inputs you have access 
to. If you only have two audio inputs, you can only record two different audio sources.

3. Make sure all Tracks are set to separate audio inputs.
This is done by holding down [Command] and clicking on the Input button in the Inspector, 
and selecting an Input from the pop-up menu that appears.

4. Click in the “R” column for each Track, to set them up for recording.

5. Enable recording for each Track by clicking the Record Enable button in the Inspector.

6. Activate recording in any way you like, as described in the previous chapter.
The audio channels will now be recorded on one Track each.

Recording MIDI

About Merge Mode

Using Merge mode is like recording with Multirecord turned off.There is no reason 
to use this mode for MIDI recording only. It is primarily used to record audio onto 
several Audio Tracks and with Tape Tracks (for setting multiple Tracks on the tape 
recorder to Record Ready Mode).

Here is how MIDI recording works in Merge mode:

• Recording only happens on one MIDI or Drum Track at a time, just as when Multi Track Re-
cording is turned off.

• Recording happens on the Track where you last activated recording in the “R” column (see il-
lustration on the previous page).
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Recording different MIDI Channels on different Tracks (Channel Split Mode)

This is the preferred mode if you either have several MIDI Instruments all connected 
to the same input, or if you have a MIDI Controller that can transmit on more than 
one MIDI Channel.

1. Set up your MIDI instrument(s) so that they transmit on different MIDI channels, pref-
erably on consecutive MIDI Channels, starting at 1 (1, 2, 3, etc.).

2. Activate Multi Recording in Channel Split mode (see above).

3. Set up the Tracks you plan to record on so that they transmit on the desired MIDI 
Channels and Outputs.
This does not have to be the same MIDI Channels as your instruments are set to transmit on. 
You can for example make a Track record information coming in via MIDI Channel 2, while it 
plays back on MIDI Channel 11.

4. Click in the “R” column for the first Track you want to record on. A pop-up appears 
from which you can select one of nine alternatives.

• The first option (Off) deactivates recording for this Track.
• Each of the other options makes this Track record all information coming in on the two indi-

cated MIDI Channels (1 and 9, 2 and 10, etc.).

5. Set up the other Tracks you wish to Record on.

6. Activate Recording as usual.

The Multi Rec pop-up when 
“Channel Split Mode” is selected.

The “R” column displays the first Channel of the two that the Track records on.



- 52 - 

Recording different players onto different Tracks (Input Split Mode)

This is the mode to use if you have several MIDI Instruments connected to one MIDI 
interface or MIDI input each. Note that there are some different restrictions de-
pending on whether you use OMS or not, as stated in the procedure description 
below.

1. Connect the instruments.
You can separate up to eight different MIDI instruments, connected to eight different, con-
tinuous MIDI Inputs on your multi-port interface.

2. Activate Multi Recording in Input Split mode (see the beginning of this chapter for de-
tails).

3. Set up the Tracks on which you plan to record, so that they transmit on the desired 
MIDI Channel and Output.

4. Click in the “R” column for the first Track you want to record on. 
A pop-up menu appears from which you can select one of nine options:

• The first option (Off) deactivates recording for this Track.
• Each of the other options makes this Track record all information coming in on the indicated 

MIDI Input on your multi-port interface.

5. Select inputs for the other Tracks (up to eight) on which you want to record.

6. Activate Recording as usual.

The Multi Rec pop-up when “Input 
Split Mode” is selected.

After selecting an Input, the “In” number is 
displayed in the “R” column.
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Using Multi Track Recording to layer sounds

In Layer Mode you record the same information onto several Tracks (up to four). If 
each of the Tracks you record on is set to transmit on a different MIDI Channel and 
Output you can play and record with up to four different sounds at the same time.

1. Set up the Tracks you plan to record on so that they transmit on the desired MIDI Chan-
nels and Outputs.

2. Activate Multi Recording in Layer mode (see the beginning of this chapter for de-
tails on how to do this).

3. Click in the “R” column for each of the Tracks you want to record on.
You can record on a maximum of four Tracks.

4. Activate Recording as usual.
The same information now gets recorded onto four different Tracks. While you record you 
will hear the sounds of all four of the instruments set to play back from those Tracks.

Recording MIDI and Audio at the Same Time

When Multi Record is activated you can record on MIDI and Audio Tracks at the 
same time. There’s only one special thing to note:

• You can only activate Multi Recording on up to three MIDI Tracks simultaneously.

Activating recording in Multi Record Mode

Recording in Multi Record mode is no different from Recording in regular mode.You 
can use punch in and out, Cycled Recording etc. There’s only one thing to note:

Cycle Modes and Multi Recording

As described in the Getting Started book, you can record in various Cycle Modes. 
You can also apply recording functions like Key Erase, Delete last version etc.

• During Multi Recording, these Modes and Functions only apply to the Active (selected) 
Track, not to all Tracks that you record on!

When four Tracks are activated 
in Layer mode...

...the same information gets recorded on 
all four Tracks...
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Options related to Multi Track Recording

With the Merge Tracks option on the Structure menu you can merge a Multi Track re-
cording into one Track set to channel “Any”. This can also be a handy way to assem-
ble several separate recordings (e.g. the different voices in a backing vocal 
arrangement) into one easily handled unit in the Arrange window. See page 80 for 
details.
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6
The Arrangement - More on what you can do with

Parts and Tracks
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Creating Parts

Parts are normally created in one of four ways:

• by recording (applies to Audio Parts, MIDI Parts and Drum Parts only, see the Getting Started 
book). 

• by direct creation of an empty Part.
• by duplication of existing Parts (see Getting Started).
• by activating Write Mode in the VST Channel or MIDI Track Mixer (see the chapters “Mixing 

Audio and Using Effect” and “MIDI Track Mixer”).

How Parts appear when you record

When you record on one Track the following rules apply:

• Recording from one point to another creates a Part that spans between these two 
points.

• Recording again between the same points or within the start and end points of the ex-
isting Part creates no new Part. 
The music is either added to (Overdub mode) or replaces (Replace mode) the existing.

• If “Prerecord” in the Metronome dialog box is active, recording during the Precount 
will extend the Part to the left. 
For obvious reasons Parts are not extended beyond the Left Locator position when you 
record in Cycle mode, or before Song Position 1.1.0.

• In other cases (like starting recording in an empty section of the Track, recording over 
Parts and recording out of existing Parts into empty areas of the Track), new Parts are 
only created where there wasn't any before. 
As described above, the Overdub/Replace setting determines whether music is being added 
to the existing, or replaces it.

An example might clarify this: 

You have an existing Part starting at 3.1.0 and ending at 4.1.0.

You start the new recording in Overdub mode at 
2.1.0 and end at 9.1.0.This creates a new Part starting at 

2.1.0 and ending at 3.1.0...

...and finally there is a new part created 
between 4.1.0 and 9.1.0.

...the old one between 3.1.0 and 4.1.0 is 
kept, but music gets added to it...
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Direct Creation of Empty Parts

There are three ways to create an empty Part:

• By double clicking in any empty (background) area between the Left and Right Loca-
tor, in the Arrange window.
The new Part winds up between the Locators, on the Track on which you clicked.

• By selecting Create Part from the Structure menu.
In this case, the new (empty) Part winds up on the active Track beginning at the Left Locator 
and ending at the Right Locator. 

• By drawing it with the Pencil tool.
In this case, the Track, position and length of the new (empty) Part depends on your drawing, 
just like when you draw notes in an editor.

❐ A directly created Part never replaces an existing Part, but might overlap one.

❐ Group Parts are created differently, see page 142.
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Overlapping MIDI Parts

Parts on the same MIDI Track might overlap or be completely on top of one an-
other. You can make good use of this feature in many ways:

• Parts which start with an upbeat can overlap the end of the Part before.

• Duplicate Parts (or Ghost Parts, see page 73) which are used to create delay effects, 
double sounds and so on, can be put on top of the original Parts.

You will probably find other creative uses for this feature.

Selecting overlapping Parts

To display overlapped Parts in an Arrangement, use the Select Overlap item on the 
Edit menu. This will select all Parts that are partially obscured by other Parts.

The Select Overlap item...

...selects all overlapped Parts.
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Merging Parts

Merging one Part with another adds all Events in the first Part to the second. It is 
done like this:

1. Hold down [Command] and [Option] on the computer keyboard.

2. Drag the first Part and release it on top of the other Part.

The result of this depends on the Snap Setting and the Record Mode:

• Overdub Mode gives a regular merge, that is the contents of the second Part are kept, 
together with the inserted Events from the first Part.

• Replace Mode will make the inserted Events replace the old Events in the destination 
Part.
Regardless of Record Mode, the destination Part will keep all its Parameters (Output, MIDI 
Channel and so on).

❐ The dragged Part is not erased or even moved. A copy of its contents is made, and it is 
this copy that is merged into the other Part. 

Appearance and size of the merged Part

The start and end points of the two Parts don't have to match at all:

❐ You can only merge two Parts which belong to the same Track class. Group Parts can-
not be merged.

If the two Parts don’t exactly overlap...

...new Parts are created, following 
the same rules as when creating 
Parts in other ways.



- 60 - 

About Cut, Copy & Paste

You can use the commands Cut, Copy and Paste on the Edit menu (or their respec-
tive key commands, by default [Command]-[X], [Command]-[C] and [Command]-
[V]) to rearrange your Parts within the Arrangement, or to move Parts between dif-
ferent Arrange windows. Cut, Copy and Paste works according to standard princi-
ples. However, there are a few things to note:

• The Parts are always Pasted in beginning at the current Song Position. Before Pasting, 
move the Song Position to where you want the beginning of the first Part.
The Song Position is automatically moved when a Cut or Copy is executed. When you Copy, 
the Song Position is moved to the end of the last of all selected Parts, making this position a 
suggestion for Pasting. When you Cut, the Song Position is moved to where the first of the 
Cut Parts started.

• If you Paste into the same Arrange window as the Parts came from, they are put in on 
the same Tracks as they originally were on.

• If you Paste into another Arrange window, Cubase VST tries to use existing Tracks if 
possible.
This means that Parts are Pasted in on existing Tracks with the same channel and Output set-
tings, if there are any. If not, new Tracks are created for the Pasted Parts.
New Tracks are also created if Pasting would result in overlapping Parts, i.e. if there already 
are Parts on the existing Tracks, at the position you Paste.

• If you hold down [Option] and select Paste from the Edit menu, all the subsequent 
Parts in the Arrangement will be moved forward to “make room” for the Parts you 
Paste.
Note that the inserted Parts will end up on the same Tracks they have been Copied from.
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Part Operations using the Toolbox

All the operations described in the following section can be executed on an indi-
vidual Part or several Parts simultaneously. You can also use some of the tools on 
several Parts at the same time, taking into account the relative size and position of 
the Parts.

Resizing Parts

You can change the length of a Part using the Pencil tool. There are two ways of do-
ing this:

• Position the pointer close to the end point, and drag to the left (shorten) or to the right 
(lengthen). 
This changes the length of the Part (without changing its start position). 

• Position the pointer close to the beginning, and drag to the left. 
This lengthens the beginning of the Part. This does not move the Events in it, it just sizes it as 
if recording had been activated earlier.

An outline of the Part shows the size while you are dragging. The Mouse box aids 
you in positioning the pointer so that you can set the length exactly as you want it, 
and the Snap function helps you to restrict your changes to some even note value 
(see the Getting Started book).

❐ If you make a MIDI Part shorter, the Events outside the new length are lost.

Shortening a Part with the Pencil.

If several Parts are selected

❐ For this to work, the option “Tools work on All Selected Parts” has to be activated in 
the Preferences–General–Arrangement dialog.

If you have more than one Part selected, and resize one of the Parts with the Pencil 
tool, all selected Parts are resized, so that they get the same end or start position.

Resizing Parts and their Events (“Stretching”)

If you want to resize a Part and make its contents “fit” the new size, you should use 
the Stretch tool. Proceed as follows:

1. Select the Stretch tool.

2. Point close to the end point of the Part you want to stretch.
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3. Click and drag left or right.
When you move the mouse, the mouse position box indicates the stretch factor as a percent-
age (where 100% equals the original length). Note that the Snap value applies, as with any 
Part operation.

4. Release the mouse button
The Part is “stretched” or “compressed” to fit the new length.

• For MIDI Parts, this means that the Events are moved, so that the relative distances be-
tween the Events is maintained.

• For Audio Parts, this means that the Events are moved, and that the referenced audio 
files are time stretched to fit the new length.
A dialog box shows the progress of the time stretch operation. For more general information 
about time stretch, see page 397.

❐ Note that this operation changes the audio file(s) permanently! If you want to use the 
unprocessed audio file(s) in other Parts (or in other Songs), you must make a copy of 
each file first (see page 318).
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Repeating Parts

If you hold down [Option] while lengthening a Part with the Pencil tool, new Parts 
will be created, all lined up end-to-start after the Previous Part. The new Parts will 
be copies of the original, including all Events and playback parameters.

The outline shown when you drag the Pencil can be thought of as a “frame”, that becomes filled 
with as many copies of the original Part as possible.

If you instead hold down the [Command] key, the repeated Parts will be Ghost 
Parts (see page 73).

If several Parts are selected

❐ For this to work, the option “Tools work on All Selected Parts” has to be activated in 
the Preferences–General–Arrangement dialog.

If you have several Parts selected and use the Pencil tool to repeat Parts as de-
scribed above, all the selected Parts are repeated as a “block”, with the relative po-
sitions of the Parts retained.

You can also repeat Parts using the Repeat Part(s) function on the Structure menu 
(see page 74).
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Deleting Parts

This is done with the Eraser tool. Select the Eraser and click on the Parts you want to 
delete. If you hold down [Option] while doing this, the Part you click on and all con-
secutive Parts on the Track will be erased.

If several Parts are selected

If the option “Tools work on All Selected Parts” is activated in the Preferences–Gen-
eral–Arrangement dialog, clicking on a Part with the Eraser tool will delete all se-
lected Parts.

• You can also delete Parts by selecting them and pressing [Backspace] or selecting De-
lete Parts from the Edit menu.

About Deleting Audio Parts

If you delete a Part as described above, the Part is removed from the Arrange win-
dow, but its segments remain in the Pool, and the file is of course left on disk.

If you wish to also delete all segments and the files referenced by the Part, proceed 
as follows:

1. Select the Part(s).

2. Hold down [Command] and press [Backspace].

3. Click OK in the dialog that appears.

❐ This removes the audio file permanently from disk! Make sure no other Songs use the 
audio files.
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Splitting Parts

A Part can be split or cut up using the Scissors tool. This operation creates two com-
pletely independent Parts, both named after the original Part:

Splitting into several Parts

1. Hold down [Option].

2. Split the Part as described above.
The Part will be split up into many Parts, all with the length of the cut you indicated. 

About Splitting Audio Parts

• When you Split a Part in two you also split the Events at that position and therefore create 
new segments. 

• If Snap to Zero is activated on the Audio Setup submenu on the Options menu, the splitting 
of the audio will occur at the closest zero crossing. See page 342. 

Click with the Scissors on the 
Part you want to Split.

The exact position of the 
Split is determined by the 
set Snap value.

For example, if you have a six bar Part 
and cut it after the two first bars while 
pressing [Option]...

...it will be cut into three 
two bar Parts.
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If several Parts are selected

If the option “Tools work on All Selected Parts” is activated in the Preferences–Gen-
eral–Arrangement dialog, you can split all selected Parts at the same time. The fol-
lowing rules apply:

• If you click with the Scissors tool on one of the Parts, all selected Parts will be split at 
the same position.
For a selected Part to be split, the split position must of course be within the boundaries of 
the Part.

• If you hold down [Command] and click on one of the Parts, all selected Parts are split at 
a position relative to their starting point.
This means that if you click one bar into one of the Parts, all selected Parts are split at one bar 
after their start position.

• If you hold down [Option] and click on one of the Parts, all selected Parts are split into 
several Parts.
The lengths of the resulting Parts are determined by the distance between the split position 
and the start position of each selected Part.
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• If you hold down both [Option] and [Command] and click on one of the Parts, all se-
lected Parts are split into several Parts, starting at a position relative to their starting 
point.
The resulting Parts will have equal lengths, determined by the distance between where you 
click and the start of the clicked Part.
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Joining Parts together

Joining Parts means turning two shorter Parts (on the same Track) into one long 
Part. This is done by clicking on the first Part with the Glue Tube tool:

• If the Parts overlap, they are merged in the overlapping area. No Events are lost.

• The resulting long Part will get the properties of the first Part (the one on which you 
clicked).
This includes Part name, Inspector settings, Part Mute status, etc.

Joining several Parts into one

If you hold down [Option] and click on a Part with the Glue Tube tool, all consecutive 
Parts on that Track will be glued together:

Joining all Parts on a Track into one

This can be done in two ways:

• Hold down [Option] and click on the first Part on the Track.

or

• Click with the Glue Tube tool on the Track in the Track List.
For this to be possible, the option “Allow Tools on Track List” must be activated in the Prefer-
ences–General–Arrangement dialog.

If several Parts are selected on different Tracks

If the option “Tools work on All Selected Parts” is activated in the Preferences–Gen-
eral–Arrangement dialog, you can select Parts on different Tracks and use the Glue 
Tube tool on one of them (holding down the [Option] key if you like). The result is 
the same as if you had performed the operation on one Track at a time.

Gluing two Parts together, regardless of if they are spread apart...

...gives you one long Part with the name of the first.
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Monitoring Parts

With the Speaker tool, you can perform what is known as “Scrubbing”. This means 
that you can listen to the contents of each Part separately in Stop mode:

1. Select the Speaker tool.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you clicked, for as 
long as you keep the mouse button pressed (or until the end of the Part).

3. To monitor the contents of a MIDI Part, drag the pointer forwards or backwards over 
the Part.
Notes and other MIDI Events will be played back according to how fast you drag the pointer.

Muting Parts

To mute a Part, click on it with the Mute tool (the cross). To “unmute” a Part, just 
click on it again. Muted Parts are displayed with a grey pattern.

The Play Parameter Tools

Three of the tools in the Arrange window Toolbox are used to set play parameters 
(volume, pan and transpose) directly for one or several Parts. This is described in 
the chapter “Play Parameters” the Getting Started book.

The Mute tool.

A muted Part.
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Match Quantizing

Why Match Quantize?

Match Quantizing allows you to match the feel of one Part with the feel of another. 
If you for instance have made up a great “live” bass drum Part and wish to pass the 
timing of it on to a hi-hat you should use Match Quantize.

This type of Quantizing takes the positions of the notes in one Part as a reference. It 
uses them to move some or all notes in another Part to similar positions. By setting 
a Quantize value you control how far the notes can be moved forward or back-
wards in time. If you for instance select the Quantize value 8, notes will maximally 
be moved backwards or forward to the nearest 8th note position in the reference 
Part, but not beyond.

Say for instance that you have a bass drum playing on every beat (quarter) in a bar. 
The feel of this is to be passed on to a hi-hat playing eighths.

But, you don't want all notes in the hi-hat Part to be moved to the quarters of the 
bass drum, since this would not give you an eighth note hi-hat Pattern but a 
strange quarter note one. You only want the notes on the quarter beats to be af-
fected.

To achieve this, you use the Quantize value to put a grid on the Match Quantize ef-
fect. In our example, you set Quantize to 8. This will only move the notes in the hi-
hat Part that are positioned near one of the four quarter notes in the bass drum 
Part. The notes between them will “slip through”, and not get Quantized.

Before Match Quantizing.

After Match Quantizing.

The Quantize value is used to put a filter, or grid, on the Quantizing so that notes in 
the “affected Part” that are close to notes in the “feel Part” are moved, while notes 
that are closer to one of the Quantizing values between the dots are unaffected. If 
this all sounds technical, experiment a bit and you will soon get the hang of it.

Bass Drum

hi-hat

Bass Drum

hi-hat
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How to use Match Quantize

1. Set a suitable Quantize value.
See the explanation above.

2. Select the Match Quantize (Q) tool.

3. Drag the Part with the desired feel, to the Part you want to Quantize.

4. Release the mouse button.
A dialog box pops up, asking you if you want to “Include Accents?”

5. Select one of the options in the dialog (See below).

If the Source Part is shorter than the Destination Part, the Source Part's contents are repeated 
so that the whole Destination Part is Match Quantized.

Option Description

No No velocities are copied from the Source Part to the Destination Part.

Merge The velocity values in the Source Part are copied to the Destination Part, but if there are 
already very strong accents in the Destination Part, these are preserved. Using Match 
quantize repeatedly on the same two Parts with this option, may give unpredictable re-
sults with regards to the velocity value in the Destination Part.

Copy The velocity values in the Source Part are copied to the Destination Part.

The feel of the first Part will now be passed on to the second Part.
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Using Match Quantize with Audio Parts

This is described on page 373.

Using Match Quantize with Chord Parts

If you are using the Score or VST/32 version of Cubase VST, the Match Quantize tool 
can also be used to “Scale-Map” MIDI Parts, using the chords and the Scale Events 
in a Chord Part to determine transposition. For more info on Chord Parts, see the 
“Score Layout and Printing” document.

❐ For the Scale-Map operation to work, the “Compute Scale”-function must have been 
performed for the Chord Track. See the “Style Tracks” document.

1. Select the Match Quantize tool.

2. Drag a Part from a Chord Track onto a Part on a MIDI Track.

3. Release the Mouse button.
A dialog will appear, asking you if you want to “Use Chords?”.

• If you click “No”:
The program looks at each note in the MIDI Part, and transposes it so that it fits the scale de-
termined by the Chord Part.

• If you click “Yes”:
The program will transpose notes so that they fit into the chord type, and then transpose 
them according to the chord root-note.

❐ The “Use Chords” option is only useful if the MIDI Part is completely played in C.

Renaming Parts

If you hold down [Option] and double click on a Part, a name box appears in which 
you can change the name of the Part. If you hold down [Option] when hitting [Re-
turn], the new name is copied to all the Parts on the Track.

Parts can also be renamed in the Inspector.
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Ghost Parts

A Ghost Part is a linked copy of an existing Part. This means that even though the 
original and the copy share contents (notes and other MIDI data) they may play 
back on different MIDI Channels and Outputs and with different settings of the Part 
parameters (see the chapter “Play Parameters, Part and Track Settings” in the Getting 
Started book).

Creating a Ghost Part

1. Hold down the [Command] key.

2. Drag the Part you want to copy to a new position.

3. Release the mouse button.
The Ghost Part appears, shown with a dotted outline and the Part name in italics.

Creating several Ghost Parts

1. Hold down the [Command] key.

2. Lengthen the Part with the Pencil tool.
A number of Ghost Parts will be created, all lined up end-to-start after the original Part (the 
number of Ghost Parts is determined by the length of the “frame” you draw with the Pencil, 
see page 63).

About Ghost Parts

• Ghost Parts can also be created using the Repeat Parts function on the Structure menu.
• A Ghost Part can be moved as any other Part. 
• It can also overlap existing Parts, just as any other Part.
• If you edit the original or the Ghost Part in any of the Edit windows, the changes show up in 

both the original and the Ghost Part. But, the changes don’t take effect for the other Parts 
until you close the Edit window.

• If you alter the contents of a Ghost Part by recording over it, merging it with another Part or 
by splitting or joining, it is automatically converted to a regular copy.

• You can “Ghost” any type of Part, but for Group Parts, “real” and Ghost Parts are the same 
thing.

• For details about Ghost Audio Parts, see the chapter “Making the Most of the Event/Segment 
Relationship”.

❐ Do not simultaneously edit (in an Edit window) several Ghost Parts that are made up 
from the same Real Part. It won’t make the program crash or anything, it will just lead 
to confusing results when you close the editor.
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Using the “Repeat” function

This function lets you repeat one or several Parts, on the same or different Tracks:

1. Select the Part(s) you want to repeat.

2. Select the “Repeat Parts” item on the Structure menu...
...or use a key command (by default [Command]-[K]).

3. Enter the desired number of copies in the dialog box that appears.
Here you can also decide if the copies are to be Real Parts or Ghost Parts.

4. Click “Do It”.
The selected Part(s) are repeated, and the copies are lined up “end-to-start” after the origi-
nal(s). The Parts selected are treated as one block, so the relative spacing between the cre-
ated Parts is determined by the beginning of the first selected Part and the end of the last.

You can also repeat Parts using the Pencil tool and the [Option] key, see page 63.
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Trim Events to Part

This command makes sure that all Events in a Part end where the Part ends and no 
later. It only applies to Events which have a length. With MIDI, this means notes 
only.

About Trim Events to Part

Cubase VST works differently from MIDI when it comes to handling notes. Where 
MIDI regards Note Ons and Note Offs as separate entities, Cubase VST stores notes, 
their position and length. This means that even if you change the length of a Part 
by using the Pencil or Scissors tool you may get notes that play past the end of the 
Part. This is a valuable feature, but you may not always want this to be the case. If 
you don't, you should use Cut Events on the Part(s).

Performing Trim Events to Part

1. Select the Part(s) that are to have their notes Trimmed.

2. Select Trim Events to Part from the Structure menu.

Cut At Locators

This command removes the area between the Locators (on all Tracks):

1. Set the Locators around the area you want to delete.

2. Select Cut At Locators from the Structure menu.
The area between the Locators is removed, and the Parts to the right of the Right Locator are 
moved to the left, to fill up the gap.

❐ Muted Tracks are excluded from the operation, i.e. they are not Cut, but the Master 
Track is affected like any other Track.

Any Parts that lie inside 
the Locator Positions....

...are shortened (cut).
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Insert At Locators

Insert at Locators is the opposite of Cut at Locators; an empty area is inserted be-
tween the Locator Positions (on all unmuted Tracks):

1. Set the Left Locator to where you want the inserted area to start.

2. Set the Right Locator to where you want the inserted area to end.

3. Select Insert At Locators from the Structure menu.
All Parts to the right of the Left Locator are moved to the Right Locator.

❐ As with the Cut At Locators function, muted Tracks are excluded from the operation, 
but the Master Track is affected like any other Track.

Parts that have their start point 
before the Left Locator and 
their end point after it, are 
lengthened the selected 
amount of bars, but of course 
contain no Events in their 
lengthened sections.

All Parts that started after the Left 
Locator Position are moved the 
selected amount of bars.
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Split At Locators

Split at Locators is a function that works like a giant version of the scissors tool. Us-
ing it you can split all Parts on all non-muted Tracks. Actually it’s two cuts you make 
in one go, one at the Left and one at the Right Locator position. 

Where Cut at Locators actually removes part of your music from the Arrangement, 
Split At Locators does not. It just splits several Parts at the same positions.

• If you only want the Parts to be split in one place, set the Left and Right Locator to the 
same position.

❐ Muted Tracks are excluded from the operation.

An alternative splitting method (that will include muted Tracks), is simply to select all Parts 
and then split using the Scissor tool.

Copy Locator Range

This command is used to copy a section of the music, on several Tracks, to some 
other position in the Arrangement:

1. Set the Left and Right Locator to the beginning and end of the section you want to 
copy.

2. If the range includes parts that you don’t want to copy, Mute their respective Tracks.
Just as with Cut-, Insert- and Split At Locators, muted Tracks are excluded from the operation.

3. Set the Song Position to the point where you want the copied section to be placed.

4. Select Copy Locator Range from the Structure menu.
Cubase VST makes up one new Part for each Track, containing all the music between the Lo-
cators, and then puts (Pastes in) these new Parts at the Song Position.

❐ For more information on alternative ways of performing Copy, Cut and other Part op-
erations see the Getting Started book.
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Explode By Channel 

This command works differently for different Track Classes:

With MIDI Tracks

If you have one or several MIDI Parts containing Events on several MIDI Channels, 
these Parts can be split up into new Parts, one for each MIDI Channel.

You may get a MIDI Part with Events on several different MIDI Channels if you for ex-
ample record music from another sequencer into Cubase VST, or record using a split 
keyboard that sends on two MIDI Channels. This is just fine, if all you want to do is lis-
ten to the recorded music – just set the Channel setting for the Track to “Any”, and 
each Event will be played back on its own, associated MIDI Channel (and therefore 
the right sound). But if you want to edit or rearrange the music you probably wish to 
work with the different “instruments” separately.

Explode By Channel therefore allows you to split up a Track into new Parts on new 
Tracks so that Events get separated according to the MIDI Channel stored with the 
Event.

Performing the Explode operation

1. Select a MIDI Track to be Exploded. 

2. Set the Left and Right Locators as boundaries for the Explode operation.
All music between the Locators will be Exploded. 

3. Select Explode By Channel from the Structure menu. 
• If possible, the Parts are put in on existing Tracks set to the same MIDI Channel and Output. 

Otherwise, as many new Tracks as necessary are created. New Parts with Events on one MIDI 
Channel each are created on those Tracks, between the Left and Right Locators. 

• For MIDI Tracks, each Track is set to the MIDI Channel the Events in them are stored on.

If you look at a Part in List Edit, you can see the MIDI Channel value for each Event.

When you perform the Explode operation, the Events with different MIDI Channel values are 
placed in new Parts, on new Tracks, each set to the Channel of their respective Events.
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Using Explode By Channel with Drum Tracks

Explode By Channel splits up the Drum Track into several new Tracks, one per used 
Sound in the Drum Track. The new Tracks that are created are either MIDI or Drum 
Tracks (depending on the selected setting in the Preferences - MIDI - Others dialog), 
with notes on only one Sound per Track. If you want some of the Sounds back into 
composite Parts, you can always use the Merge Tracks function (see page 59 and be-
low).

With Audio Tracks

You may want to split up a Track set to “Any” and which contains Events on several 
channels, into one Track for each channel. This is done using Explode By Channel on 
the Structure menu.

1. Select an Audio Track to be Exploded. 

2. Set up the Left and Right Locators as boundaries for the operation.
All audio between the Locators will be Exploded. 

3. Select Explode By Channel from the Structure menu. 
New Tracks are created, as many as needed. New Parts with Events on one channel each are 
created on those Tracks, between the Left and Right Locators. Each Track is set to the Chan-
nel the Events in it are stored on.

The Drum Part is split into 
new Parts on one Track per 
Sound (in this case MIDI 
Tracks).
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Merge Tracks

Merge Tracks allows you to merge all Parts on some (or all) MIDI, Audio or Drum 
Tracks into one composite Part.

With MIDI and Drum Tracks

When you Merge Tracks, the MIDI Channels that the Parts or Tracks are set to will be 
stored as a permanent part of their MIDI data. That is, the MIDI Channel set for each 
Part replaces the MIDI Channel originally recorded. So, when you play back the 
Merged Part with the MIDI Channel set to “Any”, you will actually get the same thing 
back as when you played back all the Tracks that are now merged into the Part.

Furthermore, the Playback parameters are used when creating the merged Part. 
For example, a temporary transposition in one of the Parts will be a permanent one 
in the merged Part. The Output setting, on the other hand, is lost in the merged 
Part, since one Part can output on one Output only.

Proceed as follows:

• Drum Tracks are merged after the O-Note setting in the Drum Map (see page 201).

• Tracks that are included in the merge can be set to MIDI Channel “Any” themselves, so 
that their original MIDI Channels values will be preserved in the Merged Part.

1. Set the Left and Right Locator. (The Locators determine the start and end of 
the merged Part.)

2. Mute the Tracks 
containing Parts 
(between the 
Locators) you don’t 
want to Merge.

3. Select a Track for 
the Merge Tracks 
Part.

4. Select Merge Tracks 
from the Structure 
Menu.

A new Part, named Merged, is created on the selected Track.

5. Set the new Track to channel “Any” and Mute the Parts you have 
merged, to get the correct sounds and avoid double notes.
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With Audio Tracks

The Merge Tracks function also mixes down Audio Events. This means that it moves 
Audio Events from several Tracks into one Track. It should not be confused with the 
Export Audio Tracks command on the File menu, which works directly on audio (as 
described on page 499).

When do I need to Merge Tracks?

If you record a number of Tracks from the Arrange window, you wind up with one 
recording per Track. Using Merge Tracks on the Structure menu allows you to pack 
all the Events on these Tracks into a Part on one Track. Then, setting this track to 
channel “Any” will make it play back as before the mixdown. 

The benefit of this operation is that when you edit the mixdown Track, all the audio 
channels are put above each other on one lane each.

Performing the Merge Track operation.

The Merge Track operation is mainly done as with MIDI Tracks. The big difference is 
that you select an Audio Track as a destination, and thereby tell the program that it 
is audio you want Mixed down, not MIDI.

1. Mute all the Audio Tracks that you want excluded from the merge operation.

2. Select an (empty) Audio Track where you want the mixdown to appear.

3. Set the Left and Right Locators to encompass the section of the Arrangement you want 
to merge (or mix down).

4. Select Merge Tracks from the Structure menu.

5. Check the Part you get, by setting it to channel “Any”, so that all Events in it play back 
on their original channels. 
When you play back the Merged Part, also make sure all the original Tracks are muted so that 
they don't compete for audio channels.

With Mix Tracks

If you are working with more than one Track Mix Part, as explained in the chapter 
“The MIDI Track Mixer”, you can merge these together just as with MIDI or other 
Track classes.
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Merge Audio Segments

This function combines all audio segments in a Part into one continuous audio file. 
The new file is added to the Pool and a new segment is created, replacing the origi-
nal segments in the Part. This can be useful for “cleaning up” after doing overdub 
recordings, assembling the best pieces after cycle recording, etc.

Proceed as follows:

1. Select one or several Audio Parts containing segments you want to merge.
Note that each Part is processed separately, i.e. only the segments within the same Part are 
merged. In some situations you may want to glue several Parts together before you use the 
Merge Audio Segments function.

2. Select “Merge Audio Segments...” from the Structure menu.
A dialog box appears.

3. Set up the parameters as desired.
The options are:

4. Click OK.
You are warned that this operation cannot be undone.

5. Click OK.

Setting Description

Create one File per Part All segments in a Part will be merged into one new audio file.

Create New File when 
Silence exceeds...

As above, but if the Part contains silence (empty space) exceeding a spec-
ified length, more than one audio file will be created. This is useful for sav-
ing disk space if the Part contains a lot of empty space between 
segments.

Delete Unused Files 
afterwards

If this checkbox is activated, Cubase VST will perform a “Delete Unused 
Files” operation after merging the segments (see page 319).
Note that this will permanently delete all unused audio files from 
your hard disk, not just files originally played by the merged seg-
ments! Proceed with caution!
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Merge Overlapping Parts

For MIDI and Audio Parts, this feature simply cuts the overlapped section from the 
first Part and merges it into the second Part. Just as with regular Merge, the results 
depend on the Record Mode:

• Overdub Mode gives a regular merge, that is the contents of the second Part are kept, 
together with the inserted Events from the first Part.

• Replace Mode will make the inserted Events replace the old Events in the destination 
Part.
Merge Overlapping Parts cannot be undone.

Optimize Arrangement

In certain cases, you may end up with long Parts having sections containing no 
Events. For example, you may have recorded a MIDI Part to a Song in real time, 
playing in certain places and not playing in other places, but recording it as a con-
tinuous take. The resulting Part will have “empty” sections, containing no Events. 
The Optimize Arrangement operation will automatically cut and resize Parts so that 
all empty sections are removed, thereby “tidying up” the Arrangement.

❐ For Audio Tracks, remember that silence in a recording is part of the Audio Event, and 
that Optimize Arrangement will only cut portions of Parts not containing any Events. 
See page 379 for information on how to delete silence from Audio Files.

1. Select the Track or Part(s) you want to Optimize.
If you want to Optimize the complete Arrangement, select all Parts.

2. Select “Optimize Arrangement” from the Structure menu.
A warning that the operation can’t be undone appears.

3. Click “Continue”.
Now all sections of Parts containing a Bar (or more) without Events will have been cut out 
and removed.

❐ When you use Optimize Arrangement, the Snap setting does not affect where the Parts 
are split. The resulting Parts will always start and end on whole bar positions.
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7
Instruments
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About Instruments

In Cubase VST, an “Instrument” is a combination of a certain MIDI Output and a cer-
tain MIDI Channel. Each Instrument can be given a name, allowing you to quickly di-
rect MIDI and Drum Tracks to the desired MIDI devices in your studio, without having 
to remember the exact Output and Channel configurations. Furthermore, you can 
specify which patch names should be used, individually for each Instrument. 

❐ Don’t confuse Instruments with “VST Instruments”, which are MIDI-controlled soft-
ware synthesizers (or other sound sources) handled from within Cubase VST. See the 
chapter “VST Instruments”.

Setting up

To be able to select and use Instruments, you must first name them. This is done in 
the Setup Instruments dialog:

1. Select a MIDI or Drum Track and click in the “Instrument” box in the Inspector.
A pop-up menu appears. You can also display this by clicking in the Instrument column in 
the Track List.

2. Select “Setup Instruments...”.
The Setup Instruments dialog appears.

3. Select a MIDI Channel and an Output at the top of the dialog.
The “All Channels” checkbox is described below. Leave it deactivated for now.

4. Enter a name for the Instrument in the Name field.
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5. If you like, enter an Extended Name in the field below.
The Extended Name serves as a more detailed specification for the Instrument. When you 
later select Instruments in the program, the Instrument Names will be listed on a pop-up 
menu, with the Extended Name(s) on hierarchical sub-menus. Different Instruments can 
have the same Name but different Extended Names.

A typical use for this feature would be if you have a multitimbral MIDI instrument, 
and have made it a habit to use different types of sounds on different MIDI chan-
nels (piano on channel 1, bass on channel 2, drums on channel 10, etc.). All Instru-
ments using the corresponding MIDI Output could then be given the name of the 
instrument, with different Extended Names according to the MIDI Channel:

• You can also assign a common Name to all Instruments that use the same MIDI Output, 
and have the program automatically assign MIDI Channel numbers as Extended 
Names.
This is done using the All Channels option, as described below.

6. At this point, you may also want to specify a Patchname Source for the Instrument.
However, you can adjust this later. Patchname Sources are described on page 91.

7. Select another Output/Channel combination and make settings for it in the same way.
You can name or rename Instruments at any time.

• Note that an Instrument Name isn’t necessarily associated with a single MIDI Output - 
Instruments using different Outputs could have the same Name but different Ex-
tended Names.
Let’s say you have several MIDI instruments, each set up so that you use certain MIDI chan-
nels for drum and percussion sound.The MIDI instruments are connected to different MIDI 
Outputs, but it may be more useful to organize things so that all drum and percussion Instru-
ments are gathered on one submenu instead:

8. When you are done, click OK to close the dialog.
The Instruments are named and will appear in the Instruments pop-ups throughout the pro-
gram.

❐ Please note that naming an Instrument is not the same as creating an Instrument! In 
fact, Instruments cannot be created or deleted - there is always a fixed number of In-
struments (the number of MIDI Outputs x 16). Nameless Instruments are merely hid-
den from view. This is important to know if you use the Redirect function (see page 89).
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The All Channels option

If you activate the “All Channels” checkbox in the Setup Instruments dialog, all In-
struments that use the selected MIDI Output will be given the Name you specify. 
Regarding the Extended Name, the following rules apply:

• If you don’t specify an Extended Name, each Instrument is automatically assigned the 
corresponding MIDI Channel number as Extended Name.

• If you specify an Extended Name, each Instrument will get their corresponding MIDI 
Channel number added after the Extended Name.
In fact, the MIDI Channel numbers will be listed on yet another sub-menu, serving as “exten-
sions to the Extended Name”. Such deeper hierarchical Instrument lists can also be created 
manually, as described below.
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The Instrument names you specify with the “All Channels” option activated will re-
place any names previously specified for Instruments using the same MIDI Output. 
Therefore, if you want some Instruments to have the “automatic” MIDI Channel 
numbering and some Instruments to have specific Extended Names, you should 
first specify the Instrument name with the “All Channels” option, and then rename 
individual Instruments.

Creating deeper hierarchical name structures

There may be situations when you want to create further extensions to the Ex-
tended Names, so that the Extended Names sub-menu has further sub-menus, and 
so on. This is done by inserting the character “@” into the Extended Name field in 
the Setup Instruments dialog. Each “@” denotes a new sublevel.
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Selecting Instruments

Most often, you will select Instruments for Tracks or Parts (by using the Instrument 
fields in the Inspector or the Track list), but virtually everywhere where you can se-
lect MIDI Channels and Outputs you will also find an Instrument field. In the Track 
list in the Arrange window, you can gain space by hiding the Chn and Output col-
umns (provided you have named Instruments for all Channel/Output combinations 
you use).

Clicking an Instrument field brings up a pop-up menu, listing the defined Instru-
ment Names. Selecting a Name from the list will either open another sub-menu list-
ing the available Extended Names, or select the associated Instrument (if no 
Extended Names are defined).

Redirecting Instruments

If you make some physical changes in your studio setup (move a MIDI device to an-
other MIDI Output, add or remove MIDI devices, change your MIDI interface config-
uration, etc), your Instrument definitions may no longer be relevant (since the 
Output/Channel combinations are no longer the same). Instead of re-defining all 
Instruments, you can remedy this problem by using the Redirect function in the 
Setup Instruments dialog:

1. Pull down an Instrument pop-up menu and select an Instrument for which you need to 
change the Channel/Output combination.

2. Select “Setup Instruments” from the Instrument pop-up menu.
The Setup Instruments dialog appears, with the selected Instrument displayed.

3. Click the “Redirect” button.
The Redirect MIDI Connections dialog appears.

4. Select the Output and MIDI Channel that the Instrument should use and click OK.
In some cases it won’t be possible to Redirect the Instrument according to the settings you 
made (the OK button will be greyed out). This has to do with the Patchname Sources (see 
page 91). For example, if “VST Instrument” is selected as Patchname Source for the current 
Instrument, it can only be Redirected to an Output to which a VST Instrument is connected. 
If this is the case, click Cancel to go back to the Setup Instruments dialog, set the Patchname 
Source to “None” and try the ReDirect function again.
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5. Click OK to close the Setup Instruments dialog.
Now, the Instrument’s original Output/Channel combination is “swapped” with the “target” 
Output/Channel combination (the MIDI Channel and Output you specified in the Redirect 
MIDI Connections dialog). 

❐ This means that not only will the Instrument you redirected be changed, but all in-
stances of the “target” Output/Channel in your Song will automatically be redirected 
too. Note that this happens regardless of whether you had previously named the In-
strument for the “target” Output/Channel!

An example: Let’s say you have an Instrument with the name “K2000 Drums”, using 
MIDI Output A and MIDI Channel 10. Now you want to redirect the Instrument so 
that it uses MIDI Channel 11 instead:

1. Select the Instrument and open the Setup Instruments dialog.

2. Click the “Redirect” button.

3. In the Redirect MIDI Connections dialog, change the Channel setting to 11, and click 
OK.

4. Click OK to close the Setup Instruments dialog.
The “K200 Drums” Instrument will now use MIDI Output A and Channel 11. But, as indicated 
in the picture below, any Tracks (or other instances) that were previously set to Output A and 
Channel 11 are now set to Channel 10.
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Working with Patch Names

❐ For details about Program Change and Bank Select messages, see the chapter “Pro-
gram Changes and MIDI Volume”.

While it’s perfectly possible to select patches for your MIDI instruments numerically 
(using the Prg field in the Inspector), it is often preferable to be able to use the ac-
tual patch names instead. In Cubase VST, there are several different methods for 
the program to identify and display patch names.

For each Instrument, you can choose one of these methods by selecting a 
Patchname Source in the Setup Instruments dialog.

The available Patchname Sources are described on the following pages.
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Patch Name Script

When “Patch Name Script” is selected as Patchname Source, Cubase VST looks for 
scripts (text files) in the folder “Scripts\Patchnames” within your Cubase VST pro-
gram folder. A Patch Name Script file contains a list of patch names for a certain 
MIDI device, along with Program and Bank settings (see page 114) and additional 
information. 

Setting up the Patch Name Script list

Patch Name Scripts for a large number of MIDI devices are included with Cubase 
VST, but by default only the GM and Yamaha XG scripts are activated. To make 
other scripts available for selection (or to deactivate unnecessary scripts), proceed 
as follows:

1. In the Setup Instruments dialog, pull down the Patchname Source pop-up menu and 
select “Patch Name Script”.

2. Pull down the Patchname Device pop-up menu and select “Setup...”.
The program collects all installed script files and prepares a list, which may take a few sec-
onds. The Setup Patch Name Scripts dialog appears.

3. Pull down the pop-up menu, locate and select the desired MIDI device.

4. Click the “Active” checkbox to activate or deactivate the script for the MIDI device.
When you activate a script, it will become available on the Patchname Device pop-up menu. 
What really happens is that the corresponding text file is moved to the “Scripts\Patchnames” 
folder from the “Inactive” subfolder. Deactivating a script moves the text file back to the “In-
active” subfolder, and removes it from the Patchname Device pop-up menu.

5. Repeat the procedure for other MIDI devices if necessary.

6. Click OK.
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Selecting a Patch Name Script

Patch name scripts are selected from the Patchname Device pop-up menu in the 
Setup Instruments dialog. Some devices on the pop-up menu may also have sev-
eral “modes” as in the picture below.

The Yamaha XG Device has two modes, for regular voices and drumkits.

• Once you have selected a device from the Patchname Device pop-up menu, you can se-
lect patches for the Instrument by using the Patchname pop-up menu in the Inspector.
Depending on the selected device, the patches may be divided in groups on hierarchical 
submenus.

The Patchname pop-up menu with the XG Device selected.

About Patch Name Scripts for Drumkits

Patch Name Scripts can contain “key names”, that is, certain key numbers (pitches) 
can have specific names. In Cubase VST, this is used in the following way:

• If a MIDI Part is set to a Patch with key names, and you open the MIDI Part in Drum Edit, 
the key names will appear in the Sound list.
This does not affect Drum Parts, only MIDI Parts.

Adding your own Patch Name Scripts

Since Patch Name Script files are regular text files, you could easily write your own 
scripts for your instruments. In the Scripts\Patchnames folder you will find a file 
called “script documentation.txt”, containing all the information you need to create 
a Patch Name Script file.
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OMS

If you are using OMS (Open Music System), the Patchname Source pop-up menu 
will contain an OMS option. If this is selected, the Instrument will use the patch 
names set up with the OMS Name Manager.

See the separate OMS document.

VST Instrument and Omni VST Instrument

If a VST Instrument is selected as Output, one of these Patchname Source options is 
automatically selected.

• If the VST Instrument supports the VST 2.1 standard (a recent extension to the VST 2.0 
plug-in protocol), the “VST Instrument” option will be selected.
When you select a patch from the Inspector’s Patchname pop-up menu in this mode, Cubase 
VST sends MIDI Program Change and Bank Select messages to the VST Instrument, just as 
with “real” physical MIDI instruments.

• If the VST Instrument doesn’t support VST 2.1 (i.e. if it supports the original VST 2.0 
standard only), the “Omni VST Instrument” option will be selected.
This offers limited support of patch selection from the Inspector. In this mode, making a se-
lection from the Patchname pop-up menu in the Inspector will actually ask the VST Instru-
ment to change “Plug-in Program”, which is not the same as selecting a “Patch” by sending 
MIDI Program Change and Bank Select messages.

You will notice the difference between VST 2.0 and VST 2.1 Instruments in two main 
areas:

• With a multitimbral VST 2.0 Instrument (“Omni VST Instrument” Patchname Source), you can-
not select different patches for different MIDI channels. This requires a multitimbral VST 2.1 
Instrument, such as the included Universal Sound Module.

• VST 2.1 Instruments allow you to “automate” patch selections by selecting different Patch-
names in the Inspector for different Parts on the same Track. This is not possible with VST 2.0 
Instruments.

No Source

When this is selected, patch selection can only be done “numerically” (by using the 
Prg pop-up menu in the Inspector). If “No Source” is selected, clicking the 
Patchname pop-up menu in the Inspector will open the Setup Instruments dialog.



- 95 - 

8
More about Play Parameters and the Inspector
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What are Play Parameters?

Play Parameters are a number of settings for MIDI and Drum Tracks (or Parts). As de-
scribed in the Getting Started book, there are three ways to make Play Parameter 
settings: In the Inspector, in the Track Columns and using Tools (some parameters 
only). Using the Play Parameters you can:

• Change one or several aspects in the playback of your recorded music (like volume, ve-
locity, pitch, selected sound, etc).
These changes are easily reversible as they are made to what is played back, not to what has 
actually been recorded.

• Change your music in real-time - i.e. while you play - for instance have it transposed. 
This is done in connection with the Thru-function in Cubase VST and is called Realtime Thru-
ing. 

For a detailed description of how to make Play Parameter settings, and what is af-
fected by the settings, see the chapter “Play Parameters, Part and Track Settings” in 
the Getting Started book. This chapter mainly explains the parameters in detail. 
Just remember the following:

• The settings you make will affect the material during playback. You do not change anything 
recorded.

• Since the Play Parameter settings don’t actually change anything recorded, they will not be 
reflected in the MIDI Editors. To convert the settings to “real” MIDI Events, you need to use 
the Freeze Play Parameter function on the Functions menu (see the Getting Started book).

• When you change the value of a Play Parameter, the new value is immediately sent out to 
the MIDI Output. 

• The values sent out will not only affect the sound source assigned to the selected Track, but 
all MIDI devices on the same Output and MIDI Channel.
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The Parameters

Volume

MIDI contains a number of different “Controllers”, that is messages for continuously 
changing aspects of a sound or an instrument. One of the most important Controllers 
is MIDI Volume (MIDI Controller 7). In the Volume field in the Inspector, you can spec-
ify a volume value (0 – 127) for a MIDI or Drum Track or for the selected Part(s). This 
value will be sent out at the start point of the Track/Part and then changes the overall 
volume for the sound.

• You can specify how you wish to make Volume settings (numerically or by using a 
slider) in the Preferences–General–General dialog.

• You can also make Volume settings using the MIDI Track Mixer (see the chapter “The 
MIDI Track Mixer”).
Provided the “Read” button is switched off, any Volume settings you make for a Track in the 
Inspector or Track Columns will automatically be reflected in the MIDI Track Mixer and vice 
versa.

Pan

This parameter allows you to send Pan messages (MIDI Controller 10) to your MIDI 
instrument, placing different sounds in different stereo positions. The possible val-
ues are Off, L64–L1 (left), “0” (center) and R1–R63 (right).

• You can specify how you wish to make Pan settings (numerically or by using a slider) in 
the Preferences–General–General dialog.

• Check the MIDI specification of your instrument to make sure it responds to Pan 
messages.
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Transpose

Changing this value will transpose the notes from a MIDI or Group Track. Remem-
ber that it is only the output that is transposed, not the actual recorded material. 
Transposing a Group Part means transposing all notes from all the Parts within the 
Group (see the chapter “Groups”).

You can specify a transpose value between –127 and +127 semitones, but remem-
ber that the total range of MIDI note numbers is 0–127. Furthermore, not all instru-
ments can play back notes over the whole range. Therefore, extreme transpositions 
can give rather strange and unwanted results.

Drum Parts (or Drum Tracks) have no Transpose parameter.

• You can specify how you wish to make Transpose settings (numerically or by using a 
graphical keyboard) in the Preferences–General–General dialog.

Velocity

This value is used to change the dynamics of a MIDI or Drum Part. The value in this 
field is added to the velocity of each note message that is sent out from the Part. A 
positive value means that the resulting volume is raised and a negative that it is 
lowered. The range is –127 to +127 and 0 is of course no change.

❐ Not all instruments handle the velocity range identically. A certain value might lead to 
more drastic changes on one instrument than on another.

Delay

This is used to delay a MIDI or Drum Part relative to other Parts (or, if you use a neg-
ative value, to make it play earlier than other Parts). The value is displayed in six-
teenth notes and ticks, with a range of ± 2 sixteenth notes and a sixteenth triplet 
note (with the maximum display resolution selected, this range would be displayed 
as ±2.2560). Use this feature to adjust the feel of a Part or Track or to compensate 
for “slow reactions” in a MIDI instrument.

❐ Notes that wind up either before the beginning (1.1.0) or outside a set Cycle, due to de-
lay settings, are not played.
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Length

This value adjusts the lengths of all notes in a Drum or MIDI Part. The range is Off 
and 25% to 200%. 200% means that all notes get played with double the length of 
the recorded. 25% means they get a quarter of their actual length.

Compression

This parameter acts on MIDI and Drum Parts and can be made to compress or expand 
the dynamic range of MIDI notes. It does this by adjusting velocity values (make sure 
that your sounds are velocity sensitive!) It can be set to Off and 25% to 200% (where 
25% means that all velocity values are divided by four, and 200% that they are dou-
bled). The point is, that this will also affect the difference in velocity between the 
notes. By combining this with the Velocity parameter, you can compress or expand 
the velocity range of the notes in a Part. An example:

Let’s say you have three notes with the velocity values 60, 90 and 120, and wish to 
“even out” the velocity differences somewhat. If you set the Compression value to 
50%, the notes will play back with the velocity values 30, 45 and 60. By adding 60 in 
the Velocity field, you will have the notes playing back with the velocity values 90, 
105 and 120, meaning you have in effect compressed the velocity range. 

In a similar way, you can use Compression values greater than 100% together with 
negative values in the Velocity field, to expand the velocity range.

❐ Remember that the maximum velocity is always 127 no matter how much you try to ex-
pand.
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Using the Multi Out feature

This feature allows you to add “Outs” to a Track. An Out is an “invisible copy” of the 
Track, but with its own set of adjustable Inspector parameters. Outs can be viewed 
as extra outputs for a Track. 

Initially when you add an Out, it is identical to the original Track, effectively dou-
bling what the Track contains, using the same Inspector parameters. The new Out 
can then be set to a different MIDI channel or Output port, be transposed etc. You 
can add as many Outs as you like, all with different parameter settings in the In-
spector. The only limit is how many voices are available in your MIDI instruments.

The Multi Out feature can only be used on Tracks, not Parts. Also remember that if 
an Out is set to the same MIDI channel (and Output Port) as the original Track, it 
cannot be set to play a different program. You can still change Inspector parame-
ters such as Transpose, Velocity etc, but (logically) not the global Volume, Pan and 
Program settings as these cannot represent more than one value at a time (for ex-
ample, a single channel can’t be panned both left and right at the same time).

❐ If the parameter settings in the Inspector window belong to a Part, it indicates this by 
showing “Partinfo” at the top of the Inspector window. In this mode, Multi Out cannot 
be activated, although any currently stored Out settings are still active.

Adding an Out

For practical purposes, select Tracks with Parts that do not contain Program Change 
or other control messages when first trying out the Multi Out feature. If you disre-
gard this “warning”, please remember that any added Out will copy these messages 
from the original Track, and that Program Change, Pan or Volume messages in a Part 
override the chosen values in the Inspector.

1. Select a MIDI Track.
Make sure no Parts are selected.

2. Open the Inspector window and click on the Arrow button in the top right corner.
The Extended Inspector area appears.

Click here to open the 
Extended Inspector area.
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3. Pull down the Multi Out pop-up menu in the top right section of the Inspector, and se-
lect “Add Out”.

Now, the Track name box in the Inspector has become a pop-up menu, and displays the orig-
inal name preceded by an “&” symbol. If you pull down this pop-up menu, you will find both 
the original Track and the new Out listed there. 

4. Double click on the Track name to rename the new Out. 
All subsequent added outs are initially named “&” + the original Track name. It is recom-
mended that you do rename each new Out, to help you identify it later on.
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Using an Out

As mentioned before, the new Out is a copy of the original Track. You can use the In-
spector parameters to change the Out in a number of ways. In this example, we will 
transpose the new Out up a fourth and have it play over a different MIDI channel:

1. Pull down the Track name pop-up menu and select the new Out.
The name of the new Out should be displayed in the Track name box.

2. In the Inspector, set the Out to play over a different, unused MIDI channel.

3. Set the Transpose value to +5.
If you have activated the “Transpose MIDI with Mini-Keyboard” option in the Preferences–
General–General dialog, drag the key 5 semitones up from the middle key.

4. Play a few notes on the keyboard, or start playback.
The Track now plays over two separate MIDI channels, and the new Out is also transposed up 
a fourth.

Use the Mini-
Keyboard to set the 
transpose value...

...or enter a value by 
double-clicking in the 
transpose box if the Mini-
Keyboard is inactive.
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Selecting, Muting and Deleting an Out

❐ All Outs are active unless you mute or delete it from the list.

• To select an Out for making settings, pull down the Track name pop-up menu and se-
lect the name of the Out.

• To delete or mute an Out, first select it and then use the Multi Out pop-up menu to se-
lect the appropriate action.
For muted Outs, the “Mute” item on the pop-up menu is renamed to “Unmute”. Select this to 
unmute the Out.

❐ The “original” Out cannot be muted or deleted.

Since this Out is already muted...

...you can select unmute from 
the Multi Out pop-up menu.
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Using the Randomize feature

The Randomize section is located in the extended Inspector section (opened by 
clicking the arrow Icon located in the top right corner of the Inspector). As the name 
implies, the Randomize feature works by introducing random values to various pa-
rameters in a Track or Part. Anything from very subtle variations to dramatic changes 
can be applied.

❐ The Randomize feature is only available for MIDI Tracks and Parts (not for Drum 
Tracks).

Randomizing a Track or Part

There are two separate “Random generators”, each of which can affect the position, 
pitch, velocity or length of the notes in a Track or Part. To use the Randomize fea-
ture, proceed as follows:

1. Select the Track or Part you wish to Randomize.
Keep in mind that depending on the content of the Track, certain parameter changes might 
not be immediately noticeable, or have any effect at all (as would be the case if applying Ran-
domize Length to a Drum Track playing “one-shot” samples for example). To best audition the 
random changes choose a Track or Part with clearly defined rhythm and note content, if pos-
sible (as opposed to a string pad).

2. Open the Inspector and click the Arrow button to display the Extended Inspector area.

3. Point at the “Off” label in the first Randomize window, and press the mouse button.
A pop-up window appears allowing you to select which note property should be affected by 
the Randomizing.
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4. Set the range of Randomization by entering values in the two number fields.
The two values govern the limits of the randomization, so that the values will vary between 
the left value and the right value (you cannot set the left value higher than the right value). 
The maximum Randomization range for each note property is listed in the table below: 

In this example, the Pitch of each note in the selected Part(s) will be raised by a random 
amount, ranging from 0 to 12 semitones.

5. Start Playback.
The selected note property is Randomized according to the range you defined.

6. If you like, repeat steps 3 to 4 for the other Randomize window.

• To disable Randomize, pull down the pop-up menu in the upper left corner and select 
“OFF”.

Property: Range:

Position –4000 to +4000 ticks (at the highest display resolution)

Pitch –100 to +100 semitones

Velocity –100 to +100

Length –4000 to +4000 ticks (at the highest display resolution)
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Using the Dynamic feature

❐ The Dynamic feature is only available for MIDI Tracks and Parts (not for Drum Tracks).

Also located in the Extended Inspector area, the Dynamic feature allows you to 
specify various ranges and options affecting how the pitch and velocity values of 
notes are played back. There are two separate “Dynamic controls”, and you can se-
lect a function and specify a range individually for each of them. This makes it pos-
sible to control pitch and velocity values with great precision and flexibility.

Below, the general procedure for using the Dynamic feature is outlined, and the 
different available functions are listed on the following pages.

1. Select a Track with a wide range of Velocity and Note values, or simply record a new 
Track with these properties.

2. Open the Inspector and click the Arrow button to display the Extended Inspector area.

3. Point at the “Off” label in the first Dynamic window, and press the mouse button.
A pop-up menu appears allowing you to specify what Dynamic function to use.

4. Select the function you want to use.

5. Set the min and max values.
Exactly what these values govern depends on the selected function (see below).

6. Start playback and change the settings until you get the desired result.

7. If you like, repeat steps 3 to 5 for the other Dynamic window.

• To turn off the Dynamic feature, pull down the pop-up menu (in the upper left corner 
of the Dynamic window) and select “OFF”.

On the following pages, the five different Dynamic functions are described.
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Velocity Limit

This function affects all velocity values outside the specified range. Velocity values 
below the lower limit are set to the lower limit value, and velocity values above the 
upper limit are set to the upper limit value. Use this if you want to force all velocity 
values to fit within a certain range.

The original velocity values.

The velocity values as they will be played back.
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Velocity Filter

Velocity Filter works by removing all notes with velocity values outside the specified 
range. Notes with velocity values below the lower limit or above the upper limit will 
not be played back. Use this to “isolate” notes with certain velocity values.

The original notes.

Only these notes will be played back.
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Velocity Optimize

This function allows you to set min and max values just like Velocity Limit, but it 
works differently. Instead of replacing velocities outside the set range with either a 
minimum or maximum value, it scales all the velocities to fit within the set range. 
The relative difference between the velocity values is kept intact as far as possible. 
If you set the range 1 to 127, and the original velocities are between 35 to 85, the 
velocity is scaled “up”. Conversely, if you set the range to 35 to 85 and the original 
velocities are between 1 to 127, the velocities will be scaled “down”.

The original velocity values.

The velocity values as they will be played back (scaled down).
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Note Limit

This function allows you to specify a pitch range, and forces all notes to fit within 
this range. Notes outside the specified range are transposed up or down in octave 
steps until they fit within the range:

• If the range is too “narrow”, so that some notes cannot be fit within the range by oc-
tave-transposing, these notes will get a pitch in the middle of the range.
For example, if you have a note with a pitch of F3, and the range is C4 - E4, that note will be 
transposed to D4.

The original notes.

The notes as they will be played back.
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Note Limit and Drum Maps

If you hold down [Option] and click on any of the Note Limit value parameters, a di-
alog titled “Drum Notes” appears. This allows you to select any loaded Drum Map, 
and to select a Drum Sound from the Map. Click OK, and the note number for the se-
lected Drum Sound is copied to both Note Limit values. This can be useful for quickly 
isolating a single drum in a MIDI Track (if you are not using Drum Tracks) for exam-
ple.
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Note Filter

Note Filter works by removing all notes with pitches outside the specified range. 
Notes lower than the lower limit or higher than the upper limit will not be played 
back. Use this to “isolate” notes with certain pitches.

❐ As with the Note Limit function, you can [Option]-click on the value parameters to 
make settings according to a Drum Map (see above).

The original notes.

Only these notes will be played back.
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9
Program Changes and MIDI Volume
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Why you should read this Chapter

When you work with Cubase VST you will find yourself spending some time select-
ing Programs and setting Volumes for each instrument. This will be significantly eas-
ier if you understand exactly how and where Program and Volume Changes can be 
inserted and the advantages the different methods provide.

About Program Change

Program Change messages are used to switch between sounds in your instruments. 
By inserting Program Change messages for all MIDI Channels, at the beginning of the 
Song, the instruments will automatically play with the correct sounds when you 
open and play the Song (if you haven’t “re-programmed” your instruments since you 
played the Song last).

By inserting Program Change messages somewhere in “the middle” of a Song, you 
can use one MIDI Channel for playing several different sounds throughout the Song. 
This allows you to use “limited MIDI resources” as effectively as possible.

Program Change Numbering

Program Change numbers range from 1 to 128 in MIDI. Some instruments use 
other types of numbering; some count from 0 to 127 and others have the numbers 
divided into Banks (A 1 to 32, B 1 to 32 etc).

To compensate for some of these variations, Cubase VST allows you to specify 
which method you want to use for each Part or Track:

1. Select a Track you want to make Program Change settings for.

2. Open the Inspector.

3. Click on the arrow button next to the Program Change value, to pull down a small pop-
up menu.

There are three options: 1–128, 0–127 or “A11–B88” (two groups - A and B - each containing 
eight banks with eight programs).

4. Select the best option for the instrument that the Track is set to transmit to.
Consult the operation manual for the instrument if you are unsure.

• If you have specified a Patchname Source for the Track (see page 91), you can make 
Program Change settings by selecting patch names from the Patchname pop-up menu 
in the Inspector or Track Columns.
Just as when making numerical settings, this results in Program Change messages (and pos-
sibly Bank Select messages) being sent to the corresponding MIDI Output. Therefore, the 
considerations and procedures described on the following pages still apply.
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Entering Program Change as a Play Parameter

As described in the Getting Started book, you can enter Program Change messages 
in the Inspector, either for one Part at a time or for the whole Track (for this you 
could also use the Track Columns). If you’re not sure how this is done, refer to the 
chapter “Play Parameters, Part and Track Settings” in the Getting Started book.

• If you enter a Program Change for the Track, this Program Change will be sent out at 
the beginning of the first Part only.
This avoids that a lot of MIDI data is sent out at the beginning of each Part.

• If you enter a Program Change message for one certain Part, this is sent out where that 
specific Part starts (and for no other Part).
For instance you can enter one Program for the first Part on the Track and then another for a 
Part later in the Song, where you want the device to switch to another Program.

This Part sends out Program 
Change number 4 when you start 
the Song from the beginning.

Later in the Song, this Part sends out 
Program Change 52 to make the 
device switch to another Program.
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Program Change in copied Parts

When you copy Parts (see page 74), you can choose whether you want Program 
Change settings (and other Play Parameters) to be included in the copy or not, by 
activating or deactivating the option “Include Part Parameters in Copy” in the Pref-
erences–MIDI–Others dialog.

Resetting Program Change

If you for example duplicate or split a lot of Parts, Program Change messages set up 
in the Inspector might get copied or moved too, ending up in positions where you 
don’t want them. The quickest way to get around this might be to start over from 
scratch:

1. Make sure no Part is selected.

2. Select the Track for which you want to “reset” Program Change.

3. Use the Inspector to set the Program Change to “Off”.
Even if the box already says “Off”, adjust the value up and then down again to make sure all 
Parts are set to “Off”.

4. Now select each Part for which you want a Program Change message, and enter it in 
the Inspector.

Make sure that the Inspector says 
“Trackinfo” at the top. Then, if you set 
Program Change to Off, this setting is 
“copied” to all Parts on the Track
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Program Change and Delay

Many devices shut off their sound momentarily when they switch to a new Program. 
Other devices don’t, but still might need some time from the moment the Program 
Change messages is received until the Program is “loaded and ready”. This will be 
apparent since the device will “choke” on the first notes after the Program Change 
message, or not play them at all.

For this situation, Cubase VST has a special setting in the Preferences–MIDI–Play-
back dialog which allows you to have Inspector MIDI messages sent out in advance:

1. Open the Preferences–MIDI–Playback dialog.

2. Adjust the “Play Parameter Delay” value.
Use positive values to have the messages sent out in advance (before the Part starts).

• If the value is too close to zero, your instrument will “choke” just when the Part with the Pro-
gram Change message begins.

• If you enter too large a positive value, the instrument will switch to a new Program before 
the previous Part has ended.

Play Parameter Delay
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Recording or Entering Program Change in the Editors

You can record Program Change messages if you have equipment that can trans-
mit them. This is done as with any other MIDI recording in Cubase VST, simply enter 
Record mode and transmit the message (probably by selecting a new Program on 
the front panel of your instrument). Please also refer to the chapter “Filtering and 
Mapping MIDI Data”.

You can also enter Program Change messages “by hand” in the Controller Editor, in 
List Edit or in Key Edit’s and Drum Edit’s Controller Display. List edit is often the best 
choice, since it shows you more precisely where the message has been entered.

Entering Program Change messages in List Edit allows you to put them anywhere 
you want them, even in the middle of a Part. It also allows you to perform editing 
functions on them.

Finding Program Change messages in Parts

If you are unsure whether a Part contains Program Change messages or not, there 
are two easy ways to find out:

Method 1

1. Pull down the Options menu.

2. Switch Part Appearance to “Show Events”.

3. Use the lower half of the Part Appearance menu to deactivate all options except “Pro-
gram Change”.
The Arrange window now shows Program Change messages as vertical lines in the Parts.

If you select Show Events...

...and the only Event 
type activated is 
Program Change...

...then only Program Changes are shown in the Parts.
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Method 2

1. Click the “Link Editors” button in the Arrange window so that it lights up.
When this is activated, open editors will always show the currently selected Part.

2. Open any Part of the Track, in List Edit.

3. Move the Editor window so that you can see the Parts you want to check in the Arrange 
window, but so you still see the List Editor window.

4. Click on the “F” (Display Filter) button in the List Editor.

5. Make sure that Program is the only un-checked item.
Now only Program Change messages are shown in the List.

6. Click on the Parts you want to check for Program Messages.
You can also use the left/right arrow keys to step through the Parts.

Which should I choose?

Well it’s of course up to you. The only advice we’d like to give is not to mix the two 
methods unless you are absolutely sure of what you’re doing. For more help in your 
decision, please check the table below:

Method Advantages Disadvantages

Play Parameter 
(Inspector or Track 
Columns)

• Can be viewed and changed in real time 
from the Arrangement, while the music is 
playing.

• Always positioned at beginning 
of a Part.

Recording or 
entering into an 
editor

• Can be entered anywhere in a Part.
• Can be edited using all the available edit 
tools.
• Finding the right Program number might be 
easier by recording a button on the synth 
front panel than by typing in a number.

• Cannot be changed from the Ar-
range window.

The F-button reveals the filters

Program Change unchecked
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About Bank Select

With Program Change messages, you are able to select between 128 different pro-
grams in your MIDI device. However, many MIDI instruments contain a larger num-
ber of program locations. To make these available from within Cubase VST, you 
need to use Bank Select messages, a system in which the programs in a MIDI instru-
ment are divided into Banks, each Bank containing 128 programs. If your instru-
ments support MIDI Bank Select, you can use the Bank field in the Inspector to 
select a Bank, and then the Prg field to select a program in this Bank.

In the MIDI standard, Bank Select messages consist of two separate numbers the 
“Most Significant Byte” (MSB) and the “Least Significant Byte” (LSB). However, differ-
ent instruments use different methods of combining these two numbers when trans-
mitting and receiving Bank Select messages. To compensate for these variations, 
Cubase VST allows you to specify which method you want to use for each Part or 
Track:

1. Select a Track you want to make Bank Select settings for.

2. Open the Inspector.

3. Click on the arrow button next to the Bank Select value, to pull down a small pop-up 
menu.

There are five options:

4. Activate the suitable options for the instrument that the Track is set to transmit to.
Consult the operation manual for the instrument if you are unsure.

Option Use when

Swap Value Bytes (Roland) When this is activated, the MSB and LSB values are swapped when 
the Bank Select messages are transmitted from Cubase VST. This 
mode is suitable for some Roland instruments.

Send MSB first When this is activated, the MSB number is sent out before the LSB, 
instead of the other way around.

Send Only One Byte Sends only LSB values, use for devices that don’t differentiate be-
tween the two Bank select types.

Send as PRG Change For devices that use Prg change messages 101 - 128 to change 
Banks.

Edit as MSB-LSB When this is activated, the Bank Select value will be displayed in 
the Inspector as two separate numbers (MSB–LSB).
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About MIDI Volume

MIDI Volume is a MIDI Controller message, Controller 7 to be exact. When a device 
receives MIDI Volume messages it is supposed to adjust its volume for that MIDI 
Channel, just as if you had changed it directly from the front panel.

❐ Some older synthesizers might not be able to respond to MIDI Volume!

Entering Volume as a Play Parameter

Just as with Program Change messages you can enter MIDI Volume messages in 
the Inspector for individual Parts or in the Track Columns for Tracks, for example to 
get a basic mix at the beginning and to introduce volume changes at different po-
sitions in the Song.

• If you enter a Volume Change for the Track, this Volume Change will be sent out at the 
beginning of the first Part only.
This is to avoid having a lot of MIDI data sent out at the beginning of each Part.

When Cubase VST plays back this 
Part, the instrument will receive 
a MIDI Volume message to set its 
Volume to a value of 115.
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Entering Volume in an Editor

You can enter MIDI Volume messages in the MIDI editors, but it is probably more 
convenient to use the Controller Editor for this. This allows you to “paint” volume 
curves, to easily create fade ins and fade outs, etc.

A Fade in, drawn in the Controller Editor.

For information about the Controller Editor, see the chapter “The Controller Editor”.

Finding Volume messages in Parts

The same method described above for finding Program Changes can be used to find 
Volume. The only difference is that you specify Controllers in the Part Appearance 
pop-up or in the List Edit Filter section. Please note that this displays all Controllers, 
though, not only Volume.
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Entering Volume in the MIDI Track Mixer

Volume can also be changed in the MIDI Track Mixer window. This method allows 
you to use faders for real-time volume control, and to have complete level automa-
tion for all MIDI Tracks in a Song. See the chapter “The MIDI Track Mixer” for more 
information.

Which should I choose?

Again – it’s your choice, but the table might give some advice:

❐ When working with MIDI volume, we absolutely recommend that you stick to one of 
these methods, to avoid confusion!

About Chase

Chase is a function that makes sure your devices are always set to the right Program 
and Volume among other things as you move around the song. Chase works both 
on Inspector settings and on “real data” in the Parts. See the Online Help for more 
information.

Method Advantages Disadvantages

Inspector • Visible directly from the Arrange window.

• Can be changed in real time from the 
Arrangement, while the music is playing.

• Can only be used for “direct 
changes” not for fades.

• Always appears at the beginning 
of the Part.

Recording or 
entering into an 
editor

• Can be entered anywhere in a Part.

• You can draw in smooth curves in the 
Controller Editor.

• Can be recorded from external equipment 
such as a foot pedal or slider.

• Can be edited using all the available edit 
tools.

• Not visible from the Arrange win-
dow.

MIDI Track Mixer • Can be entered anywhere in a Part.

• Can be changed in real time.

• Gives you overview of the volume settings 
for all MIDI Tracks at once.

• Can be completely automated, and the au-
tomation data can be edited in the Controller 
Editor.

• Not visible from the Arrange win-
dow.
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10
Programming and Recording Mutes and Solo
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Pre-programming Mutes

You can define and store up to ten Track Mute settings. These can be used for in-
stant recall of any combination of muted Tracks.

1. Mute the Tracks you want Muted.
You can use either the Mute function or the Solo function, as described in the Getting 
Started manual.

2. Hold down [Shift]+[Option] and press one of the keys [1] to [0] on the typewriter part of 
the keyboard.
The Mute setting is now stored under that key.

3. To recall a setting: Hold down [Shift] and press the corresponding key ([1] to [0]) on the 
typewriter part of the keyboard.

❐ Remember that all Key commands can be customized! The key combinations men-
tioned above are the default key commands.

Recording Mutes and Solo

It is possible to record Mutes and Solo, just like any regular MIDI data. Recording 
Mutes can be very handy, since it allows you to have automated Mutes happening 
at certain positions on playback, as an alternative to permanently deleting some 
music or other information on a Track. You can record Mutes in several ways: 

• Record a single Mute-click in the Track list.
Instead of clicking on the Mute button, you can press [Option]-[M] to mute the selected MIDI 
Track.

• Record pre-programmed Mutes on several Tracks.
See the previous page.

• Record the fact that you activated the Solo function. 
Solo is just a special case of Mute, where all but one Track are muted.

• Record Mutes using the MIDI Track Mixer.
With this method you can only mute MIDI and Drum Tracks. See the chapter “The MIDI Track 
Mixer”.
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Performing the Recording

1. Activate the “Record Tempo/Mutes” option on the Options menu.
When this is ticked, recording of Mutes is possible. The option is also used for recording 
tempo changes, see page 534.

2. Select a MIDI Track to record the Mutes on.
You should not select a MIDI Track onto which you have recorded music. We strongly recom-
mend you to use a separate Track for recording Mutes, to avoid confusion (see later in this 
chapter). You can then record all the different mute settings for any and all other Tracks on 
this single Track.

3. Activate recording at some point. 
If you want to mute a Track from the beginning, put your Mute Events one or two ticks be-
fore the first notes, so that you are sure the first note also gets muted.

4. When you reach the point where you want the mute to happen perform it by clicking in 
the Mute column, by pressing [Shift] and [1] to [0] or by activating the Solo function.

5. Keep on muting and un-muting Tracks for as long as you wish.
The Record mode switch (Overdub/Replace) applies, so that you can overwrite or add Mute 
and Un-mute Events as you wish. 

6. Terminate recording as usual.
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About recording Mutes

There aren’t really any restrictions to what you can do. Things can get quite involved 
if you indulge in complex mute setups. Observe the following:

• Muting silences all output from a Track, notes, Continuous Controllers, MIDI Mixer 
data, System Exclusive, everything - including the mute Events themselves! 
This means, that you should avoid recording mute Events for the very Track you are record-
ing on. 
An example might clarify this: Let’s say you are recording mutes on Track 1, and happen to 
record a mute Event followed by an un-mute Event, both for Track 1. When you play back the 
Track and the song position reaches the first Event, the Track will mute itself. The un-mute 
will never happen since the Track is muted for all output. This is why you should always 
record mutes on a separate mute-Track, and never record any mutes for that Track.

• A mute Track may of course be muted by another Track, which leads to the same confu-
sion as above. 

• Notes that have started before the mute are not cut off by the mute itself. They always 
play to their end.

• Mutes are chased (see page 123) if the Chase Events function on the Options menu is 
activated, but only within one Part. Make sure to end your Mute recording with the 
Track in the right status (muted or un-muted).

About editing recorded Mutes

If you need to edit or delete your recorded Mute Events, this is done in List Edit. The 
Mute Events are shown just like any other Events, and are handled in the same way.

The Mute Events that get recorded are of two types: Mute Events and Un-mute 
Events. When one of these Events is played back, the Track changes to the status of 
that Event. This means that if the Track is already muted when a mute Event is played 
back, nothing happens. This may sound obvious, but when you rewind or fast for-
ward to some point, and start playback from there, this might confuse you. A Track 
that is “manually” muted is also un-muted by an Un-mute Event.

Value 1 indicates the number 
of the muted Track.

Value 2 indicates if the Event is a Mute (1) 
or an Un-Mute Event (0).
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11
Folder Tracks
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About Folder Tracks

Just as the name implies, a Folder Track is a folder that contains other Tracks. Moving 
Tracks into a folder is a way to structure and organize Tracks in the Arrangement 
window. For example, grouping several Tracks in a Folder Track makes it possible for 
you to “hide” Tracks (thus giving you more working space on the screen), Solo and 
Mute several Tracks in a quicker and easier way, as well as edit and mix several Tracks 
as one entity etc. Folder Tracks can contain any type of Track including other Folder 
Tracks.

Using Folders

Creating a Folder Track

Folder Tracks are created just like any other Track.

1. Select “Create Track” from the Structure menu.

2. Pull down the pop-up menu in the “C” column for the newly created Track and select 
“Folder Track”.
A folder symbol appears in the C-column indicating that the Track is a Folder Track.

• Folder Tracks are named just like other Tracks.
See the Getting Started book.
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Moving Tracks into a Folder

There are two main ways to move Tracks into Folders:

Using Drag and Drop

You can move any type of Track into a Folder by using drag and drop:

1. In the Track List, click on a Track that you want to move into a Folder, and drag it onto 
a Folder Track.

2. When the Folder Track is highlighted, release the mouse button.
The Track is now placed in the Folder Track.

Since you can move any type of Track into a Folder Track, it is possible to create sub-
folders by moving one Folder Track into another. This is called “nesting”.

Using the Structure Menu

This method allows you to move several Tracks into a Folder in one go:

1. Select the Folder Track.

2. Select Parts on the Track(s) you want to move into the Folder.
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3. Pull down the Structure menu and select “Move Track to Folder”.
All Tracks on which you had selected Parts are moved into the Folder.

Hiding/Showing Tracks in a Folder

You can hide or show the Tracks located in a Folder by using the arrow button to 
the left of the Folder Track name. Hidden Tracks are still played back as usual.

When a Folder is “closed” this way, you will still get a graphic representation of the Parts within 
the Folder.

These Four parts are 
selected.

Their Tracks are now 
moved into the Rhythm 
folder.
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Muting and Soloing Folder Tracks

One of the main advantages of using Folder Tracks is that they provide you with a 
way to Mute and Solo several Tracks as one unit. Muting and Soloing a Folder Track 
affects all Tracks in the Folder. There is also an additional Solo function for Folders 
that Solos one Track in the Folder. 

Muting a Folder Track

You can Mute a Folder Track (and thereby Mute all Tracks within it) the same way 
you Mute other Tracks by clicking in the “M” column.

Soloing a Folder Track

You can Solo a Folder Track (all Tracks outside the Folder are Muted) the same way 
you Solo other Tracks, by selecting it and clicking the Solo button.

Soloing a Track within a Folder

When a Folder Track is selected, the Inspector contains a special Solo button. This 
allows you to Solo one Track within the Folder and Mute all others. All Tracks out-
side the Folder remain unaffected. For example, this function is useful if you have 
several “takes” of the same phrase located on several Tracks within a Folder and 
want to find out which one of them works best.

1. Select a Folder Track containing several other Tracks.

2. Open the Inspector and click the “Folder Solo” button.
This Mutes all Tracks within the Folder except one (initially the top Track in the folder). All 
Tracks outside the Folder Track remain unaffected.

3. In the Track list, select one of the Muted Tracks within the Folder.
The selected Track is now unmuted, the others are Muted. 

4. To Solo another Track in the Folder, select it in the Track list.

• The Soloed Track within the Folder will remain Soloed, even if you “close” the Folder 
(hide all Tracks within it).

• You can use the regular Mute and Solo functions for the other Tracks in the Arrange-
ment as usual.
However, Muting the Folder Track itself, or Soloing another Track in the Arrangement, will 
also turn off the output from the Soloed Track within the Folder.
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Editing

Tracks inside a Folder can be edited as one entity by selecting a Folder Track and 
opening an Editor. However, which Events are shown or in the Editor depends on 
the classes of the Tracks within the Folder. 

❐ The Audio and List editors cannot be opened by selecting a Folder Track.

1. Select a Folder Track.

2. Open the Editor of your choice.
All Events located on the Tracks within the Folder, that can be viewed in the particular Editor, 
are displayed as if they were on the same Track.

• To be able to discern the different Tracks in the Editor, give each Track a different color 
in the Arrange window and use the “Part Colors” option in the Editor (see page 165).

Folder Tracks in the MIDI Track Mixer

Folder Tracks will appear in the MIDI Track Mixer, on a regular channel strip (but 
without the arrow button for displaying the “extended” channel strip - see page 
295). This allows you to use the Folder Track’s fader and pan control as “master” con-
trols, governing the volume and pan of all Tracks in the Folder but retaining their rel-
ative settings. Folder Tracks in the MIDI Track Mixer have the following properties:

• If the Folder Track is “open” (the Tracks within the Folder are visible in the Arrange 
window), each Track in the Folder appear on separate channel strips.
If the Folder Track is “closed” in the Arrange window, only the Folder Track itself will be visi-
ble in the MIDI Track Mixer.

• Even though Folder Tracks can contain all sorts of Tracks, only MIDI and Drum Tracks 
are visible in the MIDI Track Mixer.

• For Folder Tracks, only the “regular” channel strip is available.
There is no “extended” channel strip. This means that you can control volume, pan, Mute and 
Solo on a Folder Track.
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12
Groups
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About Groups

❐ Audio Parts cannot be Grouped.

Defining a Group is a way to make Cubase VST look at several Parts as one entity. 
This allows you to handle a set of Parts as one section, making it easier for you to ex-
periment with the structure of your song. To play back Groups, you need to place 
them as Group Parts on a special Track called a Group Track. Groups can be used in 
many ways:

• Group all the brass parts in a chorus (trumpet, sax, trombone...) so that they can be 
handled as a section of the orchestra and easily be repeated in every chorus.

• Turn every section of a song (intro, verse, chorus, etc), into a Group so that the song 
can be remodelled fast, on a separate Group Track.

• Build up each part of the song (intro, verse, chorus...) in one Arrange window each, and 
assemble the song on a Group Track in yet another Arrange window.

As you understand from the examples above, the Groups are global for the whole 
Song. A Group created in one Arrange window can easily be played back in another. 
All in all you can have 64 groups, which are saved with the Song.

❐ A Part isn't muted or deleted when it is used in a Group. Parts can both be used as 
members of one or several Groups and as regular Parts at the same time. Therefore, 
you might have to Mute the Tracks with the Parts that make up the Group. If you don’t 
and both the Group and the regular Parts are positioned at the same positions, you will 
get double notes that might give you an increase in volume, reduced polyphony or un-
wanted flanger effects.

❐ Parts that have been used as components in a Group, can be moved around without af-
fecting what the Group plays. However, if you change the contents of the Parts, this will 
be reflected in the Groups.

Parts that belong to Groups

Group Parts on a Group Track

The Group List

Groups
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How to use Groups - The basic steps

Using Groups can be broken down into the following steps:

1. Use the “Build Group” command to assemble Parts into one or several Groups.
This determines which Parts should be in each Group. The created Group is placed in the 
Group List (see page 139).

2. Create a Group Track.
This is necessary to be able to play back the Groups (see page 141).

3. Select Groups from the Group list, and place them on the Group Track as Group Parts.
This is how Groups are played back - see page 142.

Building Groups

Creating a new Group

1. Select the Parts you want to include in the Group.
A Group can contain any type of Part, except other Group Parts and Audio Parts.

2. Select “Build Group” from the Structure menu, or use a key command (by default 
[Command]-[U]).
A dialog appears:

3. Enter the name you want for the Group.

4. Click “New” or press [Return] on the computer keyboard.
The Group is created and added to the Group List. If the list is hidden, it is automatically dis-
played when you create a new Group.

❐ The Parts keep their Playback Parameter settings within the Group. They also keep 
their relative starting points.

The above means that all the Parts that are selected when you created the new 
Group are considered as one block of music. This block is made up of several Parts 
which all have a relation to each other, positionwise, and which all send out on 
their respective MIDI Channel, and Output, and which all can have different Play-
back Parameter settings.
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Adding Parts to a Group

If you already have created a Group, but want to add one or more Parts to it, pro-
ceed as follows:

1. If the Group List is hidden, display it by selecting the “Show Groups” item on the Struc-
ture menu.

2. From the Group List, select the Group you want to add to.
How to scroll, show/hide and generally handle the Group List is described on page 139.

3. Select the Parts you want to add.

4. Select “Build Group” from the Structure menu.
The Build Group dialog appears.

5. Click on “Add to”.
The selected Parts are added to the selected Group.

❐ The Added Parts keep their relative position in relation to the existing Parts in the 
Group, and they also keep their internal relative starting points.

The above basically means that they wind up where you want them. Let's say that 
you have a Part that starts one bar later than the first Part in a Group. When you add 
that Part to the Group, it is put in so that it starts one bar later than the first Part in 
the Group. The only exception is if the Part starts before the Group. In this case it will 
be put in at the beginning of the Group.

Displaying the Group List.
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Replacing all Parts in a Group with new Parts

This function is used when you already have created a Group with a certain name, 
and want to keep it but completely change its contents:

1. From the Group List, select the Group you want to replace.
The Group List is described on page 139.

2. Select all the Parts you want the Group to include.

3. Select “Build Group” from the Structure menu.
The Build Group dialog appears.

4. Click on “Replace”.
The new Group takes the place of the selected one in the list. If you have Group Parts from 
this very Group placed on a Group Track, the contents of these will change too.
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Using Groups

The Group List

On the right side of the Arrange window a special column can be made to appear, 
containing all the Groups. This list, called the Group List, is used as a “palette” when 
placing the Groups on Group Tracks (see page 142).

Showing and Hiding the Group List

The list is first displayed when you create the first Group. To hide the list, select 
“Hide Groups” from the Structure menu. To show the hidden list, select “Show 
Groups” from the Structure menu (this menu item toggles between “Show Groups” 
and “Hide Groups” depending on whether the Group List is visible or not).

Scrolling the Group List

Since you can have up to 64 Groups in a Song, you may have to scroll the list to be 
able to see all Groups. This is done by clicking on the UP and DOWN buttons on the 
top and bottom of the Group List.

The Groups in the list are always sorted so that those Groups that were created in 
the selected Arrange window appear at the top of the list.

Displaying the contents of a Group

When you click on a Group in the List, all the Parts in the active Arrange window 
that are members of the Group get selected. This can also be used as a quick way of 
selecting a number of Parts, for example for editing.

Renaming a Group in the Group List

1. Double click on the name of the Group in the Group List.

2. Type in the new name.
The change is also reflected in the corresponding Group Parts on Group Tracks (see page 
142).
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Deleting a Group from the Group List

• Drag the Group past the top or bottom of the Group List.
This deletes the whole Group. The individual Parts that have made up the Group are of 
course not affected.

Deleting a Part that is in a Group

If you delete a Part from the Arrange window it is also deleted from the Group.

How Groups are saved

The Group List and all the Groups in it are part of the Song. When you Save or Open 
a Song, all the Groups are saved/opened with it. On the other hand, when you save 
an Arrangement, only the Groups created in that Arrange window are saved.
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Creating a Group Track

You use Groups by placing Group Parts on a Group Track. To create a Group Track, 
select the Create Track item on the Structure menu and then change the Track 
Class for the new Track to “Group Track”.

You can create several Group Tracks if necessary.

❐ Group Tracks can't be set to a certain MIDI Channel, Instrument or Output, since this is 
independent for each Part in the Group.

Group Tracks only have one Playback 
Parameter in the Inspector: Transpose, 
which transposes all notes in MIDI 
Parts in the Group.
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Placing Groups on Group Tracks

As explained earlier, you need at least one Group Track to place the Groups on. You 
also need to have the Group List displayed to do this.

1. Drag a Group from the Group List.
An outline is shown to help you position the Group.

2. Place the outline at the desired position on a Group Track and release the mouse but-
ton.

A Group Part is created. This has the name of the Group, and is as long as the Parts the Group 
is made up of. The Group Part will start where you place the outline.

❐ If you hold down [Option] while dragging, the Group Part will be inserted on the Track 
instead. This means that all the Group Parts after it will be moved down the line to 
make room for the new Group Part.

3. Continue placing Groups on the Group Track.
The same Group can be used as many times as you like, on one or many Group Tracks, in the 
same or different Arrange windows.
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About Parts and Group Parts

• If you want to be able to Mute the “original” Parts (or their Tracks) without affecting 
the playback of any Groups they are part of, activate the option “Groups do play muted 
Parts” in the Preferences–MIDI–Playback dialog.
For example, you might need to Mute a Track if the Parts on it are used in a Group and the 
Group is played back at the same time as these Parts (to avoid double notes).

• On the other hand, there might be occasions when you want to be able to exclude cer-
tain Parts from the playback of a Group by muting them.
If this is the case you should deactivate “Groups do play muted Parts”.

• A Group Part has “living” links to all the Parts in it. 
If you delete a Part, it disappears in the Group, and if you change its Playback parameters, 
this is also reflected in the Group. If you move it, however, this is not reflected in the Group.

• If you add Parts to a Group, so that this lengthens the Group, this is not shown in the 
Group Parts on the Group Tracks.
That is, the already placed Group Parts keep the original length. Use the Pencil tool to lengthen 
the Group Part and “reveal” the added music. When you place Group Parts from the Group List 
after having added Parts to the Group, these new Group Parts automatically get the right 
length.

Once they're on the Group Track, Group Parts are treated just as regular Parts. They 
can be:

• Moved.
• Selected in any way that regular Parts can.
• Duplicated (Hold down [Option]).
• Muted.
• Deleted in any way that Parts can.
• Sized using the pencil tool.

❐ You can also use any function, like Quantizing, directly on a Group Part. However, this 
will not affect the Group Part itself, but rather all Parts that make up the Group.

Group Parts can not be:

• Recorded into.
• Merged with other Parts.
• Grouped.
• Edited in any way (split, joined, or edited in the Edit windows. You can edit the contents by 

editing the Parts that make up the Group).



- 144 - 

Placing Groups on a Group Track during playback

It is possible to actually build the Group Track in real-time, while the music is play-
ing:

1. Start playback.

2. Hold down [Command].

3. Click on a Group in the Group List.
The Group is inserted on the active Group Track, at the beginning of the next bar.

❐ If you have already made up the basics of your Arrangement and wish to experiment 
with adding Group Parts this way, create a separate Group Track for the Group Parts 
you are adding in real-time. This will give you a better overview of what is going on.

Unpacking Group Parts

About Unpacking

You can take a Group Part apart into its original components by using the “Unpack 
Group” command on the Structure menu. 

An example: you have repeated a verse several times during a piece of music by 
making a group out of all the Parts that make up that verse. This Group has then 
been used several times on a Group Track. Now you find that you want to leave out 
one of the instruments in the first verse only. A convenient way to do this is to Un-
pack the Group Part on the Group Track that plays that first verse, and then simply 
Mute the desired Part.

❐ It is the Group Parts on the Group Track that can be Unpacked, not the Groups in the 
Group List.
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Performing the Unpacking

1. Select the Group Part (on the Group Track) that is to be Unpacked. 

2. Select Unpack Group from the Structure menu. 
One of two things happens:

• If the Group was created in the same Arrange window as it is used, Ghost Parts are cre-
ated on the original Tracks at the same Positions as the Group Part.

• If the Group was created in another Arrange window, real Parts are created at the same 
Position as the Group Part. 
If possible, the Parts are put in on existing Tracks set to the same MIDI Channel and Output. 
Otherwise, new Tracks are created as needed.

In both cases, the Group Part is removed from the Group Track.

❐ Unpacking can be undone using the Undo command.

The Group feature can be used to an extreme by packing all different sections of a 
song (intro, verse, chorus...) into Groups to get an overall feeling of the structure of 
the song. Then you can Unpack all Groups and start making detailed changes.

❐ If you want to use the Unpack feature for detailed editing this way, make sure that the 
Group Parts you Unpack are in another Arrange window than the Parts that make up 
the Groups. If not, Unpacking will create Ghost Parts, and if you make changes to a 
Ghost Part, they will affect all Group Parts containing the original Part.
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13
More about Quantizing and Grooves
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About this chapter

This chapter describes some of the more advanced Quantizing options, such as cre-
ating your own Grooves. For basic descriptions of how to use Quantizing, refer to 
the chapter “Quantizing and using Functions” in the Getting Started book.

Using Groove Control

The Groove Control window is a special window designed for creating, editing and 
applying Grooves. To open the Groove Control window, pull down the Functions 
menu and select “Groove Control”.
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Applying Grooves from the Groove Control Window

As described in the Getting Started book, you can apply Groove quantizing just like 
any other type of quantizing. However, this can also be done from the Groove Con-
trol window, which gives you greater control over the degree of quantization, allows 
you to try out different Grooves, etc. Proceed as follows:

1. Select the material you want to Groove Quantize.
This could be one or several Parts in the Arrange window or a group of Events in an Editor.

2. Set up a cycle around the music you want to quantize and start playback.
Of course, you don’t need to have playback activated to Groove Quantize, but it allows you 
to try out different Grooves and settings without actually “doing it”.

3. Select a suitable Quantize Value.
This determines the maximum range a note can be moved to fit to a “groove point”. Most of-
ten you would select 1/16th notes or 1/8th notes, depending on the character of the music 
and the musical results you want to obtain. You can go back and change the Quantize Value 
later if you wish.

4. Pull down the Functions menu and select “Groove Control”.
The Groove Control window appears.

5. Locate and select the Groove you wish to try out in the list to the left in the window.
Each Groove on the list is actually a Groove file on your hard disk. By default, the files and 
folders in your Grooves folder (within the Cubase VST folder) are listed in the Groove Control 
window, but you can change the default folder by clicking the “Set Path” button.

6. Activate the Prelisten checkbox.
This allows you to listen to the effects of the selected Groove “on the fly” without actually ap-
plying it (assuming you activated playback in step 2 above).

7. Use the Timing slider to determine how much the timing of the Groove should affect 
the music (expressed as a percentage).
0% means that the timing of the music is unaffected, while 100% means that the timing is 
adjusted to match the Groove completely.

• If you don’t get the expected result, try using the Pre Quantize pop-up to apply “regu-
lar” quantization before the Groove.

You might for example want to apply a shuffle Groove to a 1/16th note pattern. If the timing 
of the pattern is “off” from the beginning, notes may end up in the wrong place when you 
Groove Quantize. Pre Quantizing the pattern with a Quantize Value of 16 will “straighten up” 
the timing before applying the Groove.
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8. Use the Vel slider to determine how much the velocity values included in the Groove 
should affect the music.
Note that not all Grooves contain velocity information.

9. Use the Duration slider to govern how much the length of the notes should be affected 
by the Groove.
Actually it is the Note off event that is affected here. Furthermore, keep in mind that drum 
sounds often don’t take the length of the notes into account. Changing the Duration factor 
while Groove Quantizing a drum pattern will most likely have no effect.

10.When you are satisfied with the Groove, click “Do it” to actually quantize the music.
As usual, you can use the Undo Quantize function later to restore the original music if you 
wish.

11.To close the Groove Control window, click in the window’s close box.

❐ Note that the settings of the three sliders are retained when you close the Groove Con-
trol window, and will be taken into account the next time you use Groove Quantize 
(even if you don’t do this from the Groove Control window).

Editing Grooves

Creating a copy

When you are editing a Groove, you are changing an actual file in your default 
Groove folder. Since most of your Songs probably use the same Groove folder, it 
may be wise to create a copy of the Groove and edit that one instead. This can be 
done without leaving Cubase VST:

1. Open the Groove Control window and select the Groove you want to edit.

2. Drag the Groove from the list in the Groove Control window onto a MIDI Track in the 
Arrange Window.
The Groove is copied and converted to a MIDI Part.

3. Change the name of the MIDI Part.
This is the name your new Groove will get.

4. Drag the Part into the Groove Control list again.
Now, your renamed Part is re-converted to a Groove. The list will now contain both the orig-
inal Groove and the renamed copy.
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Editing the Groove

1. In the Groove Control window, select the Groove you want to edit.
If you made a copy as described above, select this.

2. Use the Editor pop-up to select which MIDI Editor you want to use.

3. Click the Edit button.
The selected Editor opens, displaying the selected Groove.

❐ Depending on which note has been used to create the Groove, you might have to scroll 
the view up or down to see the notes.

4. Edit the Groove as you would a regular MIDI Part.
This includes adding or removing notes, moving notes to change the timing, and adjusting 
velocity and duration.

5. Press [Return] to close the Editor.
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Creating New Grooves

There are two principal ways to create new Grooves:

• Convert a MIDI Part to a Groove.
• Extract the timing from an Audio Part and convert this into a Groove, using the “M-Points to 

Groove” function.

The “M-Points to Groove” function is described on page 585, while this chapter 
handles the conversion of MIDI Parts to Grooves:

1. Create a MIDI Part in the Arrange window.
This could be of any length, but usually it’s most convenient with Grooves that are one or 
two bars long.

2. Draw in the notes you want to be included in the Groove.
You could of course also record the MIDI Part. No matter which, it might be a good idea to 
play back the Part in Cycle mode, to see that it loops OK.

3. Close the Editor.

4. Name the Part.
This is the name your new Groove will get. You can rename the Groove later in the Groove 
Control window if you wish.

Now there are two ways to go. Either:

5. Pull down the Functions menu and select “Convert to Groove”.
The Part will be converted to a Groove, and placed in the root of your default Groove folder.

Or:
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5. Open the Groove Control window and drag the Part into the Groove list.
This allows you to place the Groove in any subfolder you like, by dropping the Part in a sub-
folder list.

6. In the Groove Control window, you can specify the length and time signature if 
needed.

Note that if you have a Groove which originally is two bars long, and set the Length to 1, all 
data in the second bar is removed!

Now you have created a Groove of your own. You can now apply, edit and rename 
it from the Groove Control window if you like.



- 153 - 

Importing, Exporting and Managing Grooves

As already mentioned, all Grooves are stored as individual files (actually Part files) 
on your hard disk. 

This means you can reorganize and manage your Grooves on the desktop, but 
there are also several features in the program that makes this easier.

Setting the default Groove folder path

By default, Cubase VST looks for Grooves in the “Grooves” folder within your Cu-
base VST folder. If you have stored your Grooves elsewhere, you can change the de-
fault Groove folder location in the following way:

1. Open the Groove Control window.

2. Click the “Set Path” button.
A file dialog appears.

3. Locate the desired folder, select it and click the “Select” button.
The Grooves and subfolders in the selected folder are displayed in the Groove list. Note that 
you shouldn’t open the folder in the file dialog, only select it.

Importing Grooves

You can add separate Grooves to your Groove folder, by dragging their file icons 
from the desktop directly into the Groove Control list. This allows you to import 
Grooves from floppy disks, etc.
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Importing Grooves from previous Cubase versions

In Cubase versions before 5.0, Grooves were stored in a special file format, contain-
ing a complete set of Grooves. You can import such Groove files the following way:

1. On the File menu, open the Import submenu and select “Cubase 3.x Groove”.
A file dialog appears.

2. Locate and select the Groove file.

3. Click Open.
Cubase VST creates a new subfolder with the name of the file, within your default Groove 
folder. Each individual Groove within the imported file is converted and saved as a Part File in 
the subfolder.

Exporting Grooves

Since the Grooves are already separate Part files on your hard disk, there is no need 
to actually export them from the program. If you need to copy a Groove to another 
location, simply locate and open the Grooves folder on your hard disk, and copy 
the Groove as any other file.

Removing Grooves

If you wish to remove a Groove, proceed as follows:

❐ Note that this procedure deletes the actual Groove file from your hard disk. Only use 
this method if you are sure you don’t want to use the Groove in any Song.
If you want to remove the Groove from your Groove list, but still keep it for future use, 
locate the file on the desktop and move it to another folder instead.

1. In the Groove Control window, select the Groove you want to remove.

2. Click the “Remove” button.
You will be asked whether you really want to remove the Groove.

3. Click Yes to confirm, or No to abort the operation.
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Using the Groove Tool

In the Arrange Window toolbox, you will find a tool labelled “Grv”. This is the 
Groove Tool, which allows you to quickly apply Grooves to separate Parts:

1. If you wish to Groove Quantize several Parts at once, select these.
This requires that the option “Tools work on All Selected Parts” is activated in the Prefer-
ences–General–Arrangement dialog.

2. Select a suitable Quantize value.

3. Select the Groove Tool.

4. Point at one of the Parts you want to Groove Quantize and press the mouse button.
A pop-up menu appears, showing the available Grooves and subfolders in the default 
Groove folder path.

5. Select the desired Groove.
The Groove is applied, with the slider settings in the Groove Control window taken into ac-
count.

Additional Quantizing Types

In the Getting Started book, the three most common Quantizing Types are de-
scribed: Over Quantize, Iterative Quantize and Groove Quantize. There are two other 
types available on the Functions menu:

Note On Quantize

This function quantizes the start positions of the notes just like Over Quantize, but 
doesn’t move the end positions. In effect, this means that the note lengths are ad-
justed.

Analytic Quantize

This is a special Quantizing method, intended for rhythmically complex material. 
You may for example use this on music that consists mainly of straight notes, but 
also contains some triplets, trills or glissandos. Analytic Quantize uses the Quantize 
value, but doesn’t touch notes that are considered “too far” from the Quantize value.
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14
The MIDI Editors - General Information
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About this Chapter

This chapter is similar to the chapter “An Introduction to MIDI Editing” in the Get-
ting Started book, but contains more detailed information. Please read the chapter 
“An Introduction...” first to get familiar with the basic concepts and procedures. It is 
also a good idea to have the Getting Started book at hand, since this Chapter refers 
to the chapter “An Introduction...” now and then.

Similarities and differences between Editors

Even though the Edit windows all look fairly different, they have many similar func-
tions. In this chapter you will find all things common to several editors, while the 
features that are unique to the different editors are described in the following 
chapters.

You will no doubt find a special way to work with the editors that fits you person-
ally, but the following suggestions may be of help if you’re new to the program:

Use Key Edit when...

• You want to get a quick overview of the Events.
• You want to edit several Parts at the same time.
• You’re editing velocity values or when you’re editing Continuous messages and want to 

view the notes at the same time (see page 185).

❐ Normally, continuous messages are often best edited and created in the Controller Ed-
itor. See the chapter “The Controller Editor”.

Use List Edit when...

• You need to perform detailed editing of single Events.
• You’re editing System Exclusive, Mute or Stop Events (see page 220).

Use Drum Edit when...

• You are editing Drum Parts.

Use Score Edit when...

• You are used to reading and writing scores.
• You are using a professional score printing version of Cubase VST, and are preparing your 

music for printing.

Use Logical Edit when...

• You want to edit MIDI data “mathematically”, by setting up criteria for which Events should 
be affected, and specifying exactly how these should be changed. See the chapter “Logical 
Edit”.

❐ Key, Drum and Score Edit can be used to edit any combination of Parts from different 
Tracks. List Edit can only be used for Parts on one Track at a time.
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Opening an Editor

If you double click on a Part, a default editor is opened (if appropriate). Exactly 
which editor opens, is determined by the Track Class of the Part’s Track and the set-
tings in the Preferences dialog in the Edit menu, according to this table:

• If you want to edit several Parts of the same type, select them and double click on one 
of them.

❐ In List Edit, only Parts on the same Track can be edited simultaneously.

Opening a non-default Editor from the Edit Menu

If you want to open another editor than the default, select the Part(s) you want to 
edit (or a whole Track), and use the Edit menu to select a specific editor. The follow-
ing options are available (note that not all combinations of Track class and editor 
are possible):

Track Class Default editor opened

MIDI Track Key Edit, Score Edit or List Edit, depending on the “Double Click Opens” setting in 
the Preferences-General-Editors dialog (found on the Edit menu).

Audio Track Audio Edit.

Drum Track Drum Edit.

Mixer Track MIDI Mixer (see the separate document “MIDI Mixer and Mix Tracks”) or Controller 
Editor, depending on whether the Track contains MIDI Mixer data or Audio Chan-
nel/MIDI Track Mixer automation data.

Group Track None.

Tape Track None.

Chord Track Score Edit.

Folder Track None (There are no regular Parts on Folder Tracks, but the Tracks within a Folder 
can be edited together using the Edit menu, see below).

Style Track None (There are no Parts on Style Tracks).

Editor Key command (de-
fault)

Can be opened for

Key Edit (“Edit” 
on the Edit 
menu)

[Command]-[E] MIDI Tracks and Folder Tracks (see below). For other Track 
classes, “Edit” opens the default editor as listed above.

List Edit [Command]-[G] All Track classes except Tape and Group Tracks.

Drum Edit [Command]-[D] MIDI, Drum and Folder Tracks.

Score Edit [Command]-[R] MIDI, Drum, Folder and Chord Tracks.
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A note about editing Folder Tracks

As mentioned above, you can edit a Folder Track in any of the four types of MIDI Edi-
tor. Editing a Folder Track is the same as selecting all Tracks within the Folder, and 
opening an editor. Since Folder Tracks can contain Tracks of different classes, this can 
cause some confusion. For example, if you have a Folder Track containing a Drum 
Track, and open the Folder Track in Key Edit, the drum notes will be displayed with 
the “wrong” pitches (see page 202 for the background to this). Therefore:

❐ Avoid editing Folder Tracks containing different Track Classes.

Opening several editors at once

Normally you will want to use one editor at a time for a Part or a selection of Parts. If 
you for example have Key Edit up on the screen and open List Edit from the Edit 
menu, Key Edit will disappear and be replaced by List Edit. However, two (or more) 
editors can be open at the same time:

1. Open an editor as usual.

2. Press [Shift] on the computer keyboard.

3. While holding down [Shift], open a second (or third, or fourth) editor.
The other(s) are not closed, but remain on the screen and can be selected and resized as 
usual.

• To be able to see all open editors, use the Tile Editors item on the Windows menu.

You can also switch back to the Arrange window and select other Part(s) and open 
the same type of editor (or another type) for these. The possible number of editors 
might be restricted by the available RAM in your computer.

Communication between Open Editors

The editors communicate in “real-time”, sharing the following information:

• Changes made to the Events.
• What Events are currently selected.
• The Loop settings.

Other settings remain independent for each editor.

This makes it easy to switch between editors, taking full advantage of their differ-
ent styles of presentation. You will probably establish working practices whereby 
you utilize specific editors to perform particular functions.

❐ Remember: the changes you make while editing will not be permanent until all open 
editors (editing the same Parts) are closed! If you Cancel changes (by pressing [Esc]) in 
the last open editor, changes made in any of the editors will be cancelled.

Selected Events

Which section is shown in the editors is based on the selected Event (if there is a 
single Event selected). Selecting an Event in one editor forces all other open editors 
to “jump to” the new selection.
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Using the Link Editors Function

By activating the Link Editors button in the Arrange window, you can link the editors 
so that they automatically display the selected Part or Track. For example, if you have 
the Key Editor for the first Part on a Track open, you can view the next Part on the 
Track (or a different Track) in the same Edit window by clicking on the Part in the Ar-
range window. The Key Edit window will automatically jump to the Part that you 
have selected. This also works for different Editors. You can for example have both 
the Key- and List Editor open at the same time, displaying the same selected Part or 
Track:

1. Select a Part in the Arrange window and open the Key Editor and the List Editor as de-
scribed above.
Choose the “Tile” option on the Windows menu if you want Cubase to size and place the win-
dows on the screen so that all are visible and equal in size.

2. In the Arrange window, click on the Link Editors button.
The button will become highlighted.

3. Click on a different Part (other than the one you selected in step 1) in the Arrange win-
dow.
Both the Key- and List Editor will jump to display the selected Part.

❐ Do not confuse Link Editors with the Link button in the Score Editor (Score and VST/32 
versions only - see the “Score Layout and Printing” document).

When switching between different Parts or Tracks in Link Editors mode, you are ac-
tually opening and closing Editors. The same rules apply, see page page 158.
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Closing an Editor

As described in the Getting Started book, when closing an editor, you can choose 
between keeping the changes you made, and cancelling (undoing) all changes.

To close the editor and keep the changes:

• Press [Return].

Or

• Close the edit window by clicking on its close box.

Or

• Select Close from the File menu.

If you are editing a Ghost Part (described on page 73), and close the editor as above 
(keeping the changes), a dialog box will ask if you want to convert the Ghost Part to 
a real Part. If you answer Yes, the changes will only appear in this new Part. If you 
answer No, the Ghost Part will remain a Ghost Part, and the changes will appear in 
the real Part the Ghost Part was made from, as well as in all other Ghost Parts made 
from the same real Part.

To close the editor and cancel the changes:

• Press [Esc] on the computer keyboard.
If “Only Show Important Alerts” is activated in the Preferences–General–General dialog, all 
changes you have made since you opened the editor are undone. Otherwise, a dialog box 
appears, asking you if you really want to discard your changes.

❐ If you have entered Events outside the range of the edited Part(s), a dialog with the 
text “Keep Appended Events?” will appear when you close the Editor. 
Clicking “Yes” will extend the Part to make room for the new Events while clicking “No” 
will discard any Events outside the Part.

❐ If you enter the Edit window while recording, stop the recording while in the editor and 
then Cancel, the whole recording is deleted.
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Editing music during playback

Often it is very practical to be able to make changes to the music while you are ac-
tually listening to it. There are some features included to make this easier:

Edit Solo

Using this function you can mute playback for all Parts that make up your Arrange-
ment except for those currently edited in the open editor. To activate/de-activate 
Edit Solo click on its button in the upper left corner of the Status Bar in any of the 
editors, or use the corresponding key command (by default [A]).

Follow Song

Normally, the Follow Song option will be turned on, making the Arrange and Edit 
windows “follow” the music at playback, so that the Parts or Events currently 
played always are visible. However, when you are editing Events in an editor, you 
may want to turn Follow Song off, either on the Options menu or by using a key 
command (by default [F]). This way the Events you’re working with will stay visible.

• If you activate the option “Stop Follow Song after Scrolling” in the Preferences–Gen-
eral–General dialog, Follow Song will temporarily be turned off, as soon as you scroll 
the window with the horizontal scrollbar.
Follow Song will remain deactivated until you press Stop and start playback again. If you 
want to activate Follow Song again without stopping playback, use the Follow Song key 
command twice.
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The Loop Function

In all of the MIDI editors you can set up a local Loop, which is a sort of “mini-cycle” for 
the Parts being edited. The Loop facility operates in addition to the Cycle, meaning 
you can Loop the Parts you are editing while Cycling Parts that are not being edited!

There are two principal ways to set the Loop:

• Drag the mouse in the Ruler to draw the Loop area.
This will also automatically turn on the Loop (see below).

This method does not work in Score Edit, since it has no Position Ruler.

• Use the mouse and/or computer keyboard to set the values in the Loop boundary 
boxes on the Status Bar.

These boxes can also be opened for editing by using key commands (by default [Option]-[L] 
and [Option]-[R], respectively).

Either way, the current Loop area is shown in white on the Ruler when it is acti-
vated, and in light grey when it is deactivated.

Turning the Loop on or off

• Turn the Loop on/off by clicking on its button or by using a key command (by default 
[Option]-[O]).
For this to work, you have to define the Loop first, as explained above.

When the Loop is active, the Parts within the Loop in the Edit window loop almost 
independently of the rest of the music. We say “almost”, because the Loop is still 
dependent on the Cycle. Every time the Cycle starts over again, so does the Loop.

The Loop is also used to direct editing to the Events inside the Loop. See page 169 
in this chapter.

The upper box is the start of the Loop, the lower is the end.

The Loop On/Off button.
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How Events are displayed in the Editors

This is where the various editors differ most. The different representations of Events 
are described in the chapter “An Introduction to MIDI Editing” in the Getting 
Started book, but there are some common properties worth pointing out:

Active and Inactive Parts

In Key, Drum and Score Edit, several Parts on different Tracks can be displayed at 
the same time. However, only one at a time is active. The active and inactive Parts 
are separated graphically. In Key and Drum Edit, notes belonging to an active Part 
are bright-colored or white (dark or black when they are selected, see below) and 
notes belonging to an inactive Part are dimmed. In Score Edit, different parts are 
put on different staves.

An active and an inactive Part in Key Edit.

• To activate a Part, click on any Event that belongs to that Part.
You can also use the Next/Previous Part commands on the Goto menu, which is convenient 
if the Part is empty.

❐ When you record, use Step Input or make any other changes via MIDI, it is always the 
active Part that is affected.

Notes and Continuous Events

Even though every MIDI message consists of single Events, the editors make a dis-
tinction between regular notes and what is called continuous Events. The Continu-
ous Events (Pitch Bend, Modulation, Aftertouch and many others) have special 
displays in all editors except Score Edit. They are described separately in the Get-
ting Started book and on page 185 in this chapter.

❐ Again, Continuous Events are often best viewed and edited in the Controller Editor, as 
described in the chapter “The Controller Editor”.

Selected notes.
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Playback Parameters

The Playback settings you may have done in the Inspector are not visible when you 
edit the Part. This means that if a Part is transposed using the Inspector, it will be 
shown at its original recorded pitch in the editor, even though you will hear it play-
ing back transposed. 

• If this is a problem, use the “Freeze Play Parameters” function on the Functions menu.
This function, explained in the chapter “Play Parameters, Part and Track Settings” in the Get-
ting Started book, transforms the settings in the Inspector (e.g. a transposition) to “real” MIDI 
data (in the case of transposition, changed pitches for each note), visible and editable in the 
editors.

Coloring notes in the editors

In Key, List and Drum Edit, you can use the Color pop-up menu on the Status Bar to 
add color to the notes.

1. Pull down the color pop-up menu.

2. Select one of the five options on the pop-up menu. 
The options are described below.

❐ Score Edit has a different color palette, which lets you choose colors individually for 
each note, much like you color Parts in the Arrange window.

Color options

No Color No color is used for the notes.

Channel colors The notes get different colors depending on their individual MIDI Channel values. 
Which color is associated with which MIDI Channel, can be set with the Edit option 
(see below).

Pitch colors The notes get different colors depending on their pitch. Which color is associated 
with which pitch, can be set with the Edit option (see below).

Velocity colors The notes get different colors depending on their velocity values. Which color is as-
sociated with which velocity, can be set with the Edit option (see below).

Part Colors The notes get the same color as their respective Part in the Arrange Window. Use 
this option when you are working with two or more Tracks in an editor, to better see 
which notes belong to which Track.
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Editing Color

1. Select the Edit option at the bottom of the color pop-up menu.
The MIDI Colors dialog is opened. This can also be opened by selecting Preferences–Gen-
eral–MIDI Colors on the Edit menu.

There are 13 velocity colors (each corresponding to a range of 10 steps in velocity), 12 pitch 
colors (one for each semitone) and 16 MIDI channel colors.

2. Double click on the color field you want to edit.
This opens the standard Macintosh Color Picker, where you can change the color for the se-
lected velocity/pitch/channel.

3. When you have edited the colors, click on the “OK” button.
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Moving around and the Goto pop-up menu

You can move directly to certain useful positions in an editor by selecting from the 
Goto menu on the Function Bar. These options will scroll your view to show the 
Events at the chosen position.

❐ Normally, the Goto commands only change the view, as if the scroll bars were used. 
However, if you activate the option “Goto Menu sets Song Position” in the Preferences-
General-Editors dialog, the Song Position will follow the view when you use the Goto 
commands.

SongPos to Selected Event

The Key Command called SongPos to Selected Event (found in the Preferences-Key 
Commands-Transport and Locators dialog) allows you to move the Song Position 
to the selected Event. This function is available in the Arrangement and the MIDI 
Editors only.

❐ For the function to work, a single Event must be selected.

Song Position Takes you to the Song Position.

First Event Takes you to the first Event in the active Part.

Last Event Takes you to the last Event in the active Part.

First Selected Event Takes you to the earliest of all the selected Events.

Next Selected Event Takes you to the next selected Event.

Last Selected Event Takes you to the last of the selected Events.

Prev Selected Event Takes you to the selected Event before the one currently in view.

Next Part Takes you to the beginning of the next Part. This might just lead to a verti-
cal scroll if there are several Parts beginning at the same Position.

Prev Part Takes you to the beginning of the previous Part. This might just lead to a 
vertical scroll (see above).



- 168 - 

Monitoring Events in the Editors

As already mentioned, you can have playback running while you are editing. But 
there are two more ways to listen to your music in the editors:

The Speaker Tool

The Speaker Tool tool is common to all MIDI editors. When you click on an Event us-
ing this tool, the Event is played back. You can also hold the mouse button and 
drag the Magnifying Glass around over the Events.

The Speaker Icon

When you click on the speaker symbol on the Status Bar, Events will be output au-
tomatically when you click on them, when you create them using the pencil or 
paint brush, and when you make changes on the Info line.

Selecting and the To pop-up menu

The concept of selecting Events is much the same as selecting Parts, described in 
the Getting Started book. You can:

• Click on an Event to select it (and deselect all others).

• Hold [Shift] and click on an Event to select it, keeping any previously selected 
Events.

• Select several Events by enclosing them in a rectangle using the Arrow tool.

• Use the Select All item on the Edit menu to select all Events in the editor.
By default, the key command for this is [Command]-[A]. 

• Hold [Shift] and double click on an Event to select all following Events of the same 
pitch.

• Use the [←] and [→] keys to select the previous/next Event in the Active Part.
If you hold down [Shift] and use the arrow keys, the next/previous Event will be selected, 
without deselecting already selected Events.

• Use the “Select” submenu on the Edit menu.
The contents of this submenu vary depending on which editor you’re in. See the Online Help.
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Selecting Events from different Parts

You can select Events from both an active and an inactive Part:

1. Select the Events you want in the active Part, using any method described above. 

2. Hold down [Shift].

3. Select one Event from an inactive Part by clicking on it. 
This Part now becomes active. 

4. While keeping [Shift] pressed, use any method to select more Events from the now 
active Part. 
As long as you keep [Shift] pressed, you can switch active Parts and select from as many as 
you like, using this method.

❐ Usually, any type of editing you do (like moving, copying and so on) will affect all se-
lected Events, whether they are in active or inactive Parts. See also below.

The To Pop-up

All the editors have a pop-up menu called “To”. This is used together with the Loop 
and Cycle functions to collectively choose a group of Events to be affected by your 
editing.

All Events, active or inactive, will be affected.

All Events inside the Loop 
will be affected, whether the 
Loop is On or Off, and 
regardless of whether the 
Events come from active or 
inactive Parts.

All Events inside the Cycle will be affected, 
whether the Cycle is On or Off, and 
regardless of whether the Events come 
from active or inactive Parts.

All selected Events, inactive 
or active, will be affected.

Those Events that are 
inside the Loop and 
selected will be affected.

Those Events that are inside the Cycle 
and selected will be affected.
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The Do pop-up menu

This pop-up menu is found on the Status Bar, next to the Goto pop-up. It contains 
some special functions to make editing and creating Events easier. The items com-
mon to all editors are described below (the Do Pop-ups in the Score Edit Window in 
score printing versions of Cubase VST have even more options, described in the 
“Score Layout and Printing” documentation).

❐ Use the To menu to first define a selection of notes you want to edit. Then use the com-
mands on the Do menu to perform one of the available actions.

Fixed Note

It gives all the affected notes (all notes in the Loop, Cycle or Part(s), depending on 
the To pop-up menu) the same pitch as the selected note. The positions, velocity 
and MIDI Channel values for the notes are left intact.

❐ Make sure you only have one note selected when you use this function.

Delete Note

Deletes all affected notes with the same pitch as the selected note, but leaves all 
other notes. This means that if you select a C3 then all C3's (in the range defined by 
the To menu) will be deleted.

❐ Make sure you only have one note selected.

Keep Note

This function is sort of the reverse of Delete Note. All notes (in the range defined by 
the To menu) that have the same pitch as the selected one are kept. All others are 
deleted. 

❐ Make sure you only have one note selected.
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Repeat

This function is used to repeat a section of the Part until the end of the Part. You de-
fine the “repeat cycle” by setting the Loop or the Cycle. From there on there are two 
options:

• The To menu is set to “Looped Selected Events” or “Cycled Selected Events”:
The selected Events (notes and other) inside the Loop/Cycle are repeated until the Part is 
filled. The created Events are added to the existing.

• The To menu is set to just “Looped Events” or “Cycled Events”:
All the Events inside the Loop/Cycle are repeated and the created Events replace the existing. 
The repeating goes on until the Part is filled.

Fill

This function only works when the To menu is set to “All Events”, “Looped Events” 
or “Cycled Events”. It then fills the whole Part/the Loop/the Cycle with notes that 
have the same pitch. The notes are spaced according to the Snap value and are all 
given a length corresponding to the Quantize value (or, in Drum Edit, the Len value 
of the Drum Sound).

• In Drum Edit and Key Edit you can specify the pitch of the “Fill notes” by selecting a 
Drum Sound or clicking on a key on the keyboard display before you perform the oper-
ation.

Reverse

This reverses the order of all Events (notes and other) in the range defined by the To 
menu.

Delete

This deletes all Events in the range defined by the To menu (notes, Controllers, the 
lot).

Compute Scale (Score and VST/32 versions only)

This function computes scales. Used for correct Score display and when using Style 
Tracks. See the respective documentation for details.

Selected to Hitpoints

This function (available in Key, Drum and List Edit) creates Hitpoints on the posi-
tions of the selected Events. To see the created Hitpoints, the Hitpoint Strip must 
be visible (see page 556). Read more in the chapter “Hitpoints”.

Unmute All

This unmutes all muted notes in the edited Part.
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An Example

This example shows one way to use the To and Do pop-ups in conjunction. Let’s say 
you want one and a half bars of short, staccato-like 16th notes. Instead of drawing 
or playing them from your instrument, you can proceed like this:

1. Open the Part in Key Edit.

2. Set up the Loop to the range you want filled with notes.

The Loop does not have to be active.

3. Set Snap to 16.

4. Set Quantize to 64.
This should give the notes the desired, short length (in Drum Edit, this could be achieved by 
setting the Len value for the Drum Sound).

5. Make sure that “Looped Events” is selected on the To pop-up menu.

6. Click on the “piano keyboard display” to indicate which note should be created by the 
Fill function.
In Drum Edit, you would instead select a Drum Sound in the list. In Score and List Edit, you 
cannot specify the pitch before you perform the function.

7. Pull down the Do menu and select “Fill”.

The Loop area is filled with 16th notes, each with the length of a 64th note.
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The Info Line

The Info Line is the area directly above the main display in the Key, Drum and Score 
editors.You use the Info Line for precise, numerical editing.

Editing on the Info Line

1. To show/hide the Info Line, click the i-button on the Status Bar.

2. Select the Event(s) you want to edit.
If a single Event is selected, its values are displayed in yellow on the Info Line. If several 
Events are selected, the Info Line shows the values of the first selected Event. Furthermore, 
the displays in the Info Line turn white to indicate that more than one Event is selected.

Several Events selected.

3. Change the desired values using regular value editing.
As always, you can use the mouse or type in values from the computer keyboard.

• If you have several Events selected and change a value, all selected Events will be 
changed relatively.
In other words, the value will be changed by an equal amount for all selected Events.

• If you have several Events selected, hold down [Option] and change a value, the 
changes will be absolute.
In other words, the value will be set to the same for all selected Events.
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Info Line Parameters

The following parameters can be changed on the Info Line:

❐ Not all MIDI Instruments send and/or read velocity (especially true with Note Off veloc-
ity). Check your instrument’s operation manual if you are unsure.

Parameter Remark

Start Changing this value is the same as moving the note.

Length/End Normally, this shows the Length of the selected note, in beats-sixteenth notes-
ticks. However, if you activate the option “Show End Position in Info Line” (Prefer-
ences–General–Editors), this field will be labeled “End” instead, and show the end 
position of the note. Either way, changing this value is the same as resizing the 
note(s).

Pitch Changing this value transposes the note.

Velo-On The Note On velocity; the speed with which you press a key on a MIDI keyboard.

Velo-Off The Note Off velocity; the speed with which you release a key on a MIDI keyboard.

Chan The “original” MIDI Channel associated with the note (see page 37).
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Quantize and Snap Values

The Quantize and Snap values work exactly like in the Arrange Window (see the 
Getting Started book). However, there are a couple of things worth pointing out:

• Each editor has separate settings for Quantize and Snap values.
This means that the settings you make in the Key Edit window will not automatically be 
transferred to Score Edit. This is practical, due to the different work methods you will employ 
in the different editors.

• The Quantize value also works as a length determinator when inputting notes.
If you for example have the Quantize value set to 8, the notes you create will automatically 
become 1/8-notes.

• The Snap value also defines the spacing between input notes.
This applies when you use the paint brush or the Fill command from the Do pop-up. With a 
Snap value of 4 and a Quantize value of 16, you will get sixteenth notes, positioned on the 
beats (quarter-note positions).

❐ In Drum Edit, each Sound has separate Quantize and Length values.

• The Snap pop-ups in the editors contain more options than the one in the Arrange 
Window.
The reason for this is of course that you do not need small or uneven Snap values when mov-
ing Parts. In the editors, however, you do. The following Snap values are available:

About the Snap to Groove option

In the MIDI Editors, you will find a “Groove” option on the Snap menu. Activating 
this tells Cubase VST to use the currently selected Groove as guide for the Snap 
value. This allows you to move notes so that they fit with the Groove, or draw 
Groove patterns with the Paint Brush tool, etc. Proceed as follows:

1. Select a Groove from the Quantizing Type submenu on the Functions menu (or from 
the Groove Control window, see page 147).

2. In the Editor, select a “regular” Snap value based on the timing of the Groove.
For example, if you have selected a Groove based on 1/16th notes, you probably 
want to set the Snap value to 16.

The Frame and Second 
options are suitable when 
you are working with time-
based material, and don’t 
want editing to snap to meter 
positions.

The values ranging from 
128 to 1 are regular note 
values. Triplets (T) and 
dotted (.) note values can 
be selected.

If the Groove option is 
selected, editing will snap 
to the selected Groove 
(see below).
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3. Activate the Groove option on the Snap pop-up menu.
Snap to Groove is indicated by a “g” after the Snap value.

Now, Events will Snap to the selected Groove (see page 147). If you use the Paint 
Brush or the Fill function, Events will be spaced according to the Groove.

• To deactivate Snap to Groove, select “Groove” from the Snap pop-up menu again.

A “g” appears after the snap value when you 
choose Groove from the Snap pop-up menu.
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Creating Note Events

You can paint new notes into the active Part using different Toolbox tools. Which 
tools are available depends on what editor you are using:

Using the Pencil tool

You can use the Pencil (or Drum Stick, in Drum Edit) to draw new notes one at a 
time. This is described in detail in the Getting Started book, but here are a few rules-
of-thumb (the Quantize and Snap values apply as described on the previous 
pages):

• Click once with the Pencil to create a single note.
The new notes will get the length of the Quantize value.

• Click and drag with the Pencil to create a note with a length of your choice.

• In Score Edit, you use the note and rest tools in a manner similar to the Pencil, see 
the chapter “Score Edit”.

Using the Paint Brush tool

Use the Paint Brush tool to ‘paint’ in several new notes at a time. The following rules 
apply:

• The notes are created at a spacing defined by the Snap value.

• The new notes will get the length of the Quantize value.

• If you hold down [Shift] on the computer keyboard, movement is restricted to horizon-
tally only when you are dragging. 
That is, in Key edit for example, all notes will have the same pitch, and in Drum Edit they will 
belong to the same “Sound”.
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Velocity and MIDI Channel values for Created Notes 

When you draw or paint notes, you can give them one of four fixed velocity values 
by holding down modifier keys on the computer keyboard while you are painting.

• Note that the settings in the Preferences–General–Modifiers dialog may conflict with 
the modifier keys for velocity values!
If one of the above modifier key combinations is specified for use in the Preferences–Gen-
eral–Modifiers dialog, this overrides the corresponding velocity input feature.

• Drum Edit has a special function for assigning velocity values to created notes, see 
page 210.

• The Note-Off velocity for notes will always be set to 64.

• Created notes will get the MIDI Channel value of their respective Parts.
In Drum Edit, created notes get the MIDI Channel value set for their Drum Sounds, respec-
tively.

The Insert Button

If the Insert button is activated on the Status Bar when you use the Pencil or Brush, 
then all Events in the Part will be moved one Quantize value forward when you in-
put new Events, just as with Step Input.

❐ You can also create new Events using the pop-up Do menu, see page 170 in this chap-
ter.

Key Velocity value

No key 110

[Command] 96

[Option] 64

[Command]+[Option] 48
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Editing Notes

To edit the values of a note in detail, select it and edit on the Info Line (as described 
on page 173 in this chapter) or make the changes in List Edit or Logical Edit. How-
ever, there are quicker and more intuitive ways to edit notes in the Graphical edi-
tors:

Using the Tools

Using Tools on multiple Events

In the Preferences–General–Editors dialog, you will find an option called “Tools 
work on all selected Events”. If this is activated, many of the Tools can be used to 
edit all selected Events at once. If the option is deactivated, only the Event you click 
on is affected, no matter which Events are selected.

Moving Notes with the Arrow tool

You can move notes by dragging them around using the Arrow tool (also see the 
chapter “An Introduction to MIDI Editing” in the Getting Started book). As in the Ar-
range window, the Snap value determines where you can “drop” the notes.

Moving Notes with the Nudge tool

The Nudge tool.

For fine adjustment of a note’s position, use the Nudge tool:

1. Set the Snap value to the distance you want to move the note.

2. Click on the note with the Nudge tool, to move it one Snap unit to the left. 
If you hold down the [Option]-key and click, the note is moved to the right instead.

For example, if you set the Snap value to “8” and click on the note with the Nudge tool, the note 
will be moved an eighth note to the left.
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Resizing a single Note with the Pencil tool

In Key and List Edit, you may change the size of notes that you have drawn or re-
corded, using the Pencil tool:

1. Set the Snap value.
What you do when you resize a note, is moving the position where the note ends. You can 
only move notes in multiples of the set Snap value. That means, if Snap is set to 8, you can 
move the end-position of a note to 1/8, 1/4, 3/8, etc.

2. Press the mouse button with the Pencil tool selected, and the pointer inside the 
note you want to resize.

❐ It might be hard to determine whether you have the pointer inside a note or not. To 
avoid painting in new Events, activate [Caps Lock] on the computer keyboard. This dis-
ables creation of new Events. Remember to deactivate [Caps Lock] when you are done.

3. Position the pointer at the length you want the note to have, and release the 
mouse button.
The note gets resized, taking the set snap value into account.

Resizing multiple notes with the Pencil tool

If the “Tools work on all selected Events” is activated in the Preferences–General–
Editors dialog (see page 179), you can set the note-off value of multiple selected 
notes with the Pencil tool:

1. Set the Snap value as described above.

2. Select two or more notes.

3. If you want to resize the notes relative to their original lengths, hold down [Command].

4. Press the mouse button with the Pencil tool selected, and the pointer inside any of the 
selected notes you want to resize.

5. Position the pointer at the new note-off position and release the mouse button.
If you pressed [Command] in step 3 above, you will change the length of the notes by an 
equal amount. The notes will retain their relative lengths:
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If you didn’t press [Command] in step 3 above, you will move the note-off position of the 
notes to the same position:

The snap value is taken into account as usual. 

Resizing multiple notes with the Line tool

In Key Edit, it is also possible to use the Line tool to resize multiple notes. For this to 
work, you don’t have to select the notes first:

1. Select the Line tool.

2. Drag a vertical line, so that the notes are “cut off” by the line at where you want them 
to end.

3. Release the mouse button.
The notes are resized.

• If you hold down [Option] and drag with the Line tool, the start of the notes will be af-
fected instead.
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Muting Notes with the Mute Tool

You can mute one or several notes using the Mute tool. This can be useful if you 
only want to listen to some Events while editing a Part, or if you want to remove 
some notes from your music with the option of bringing them back later.

The Mute tool.

• Click on an Event with the Mute tool to mute it.

Muted Events are ”greyed out”.

• If the “Tools work on all selected Events” option is activated (see page 179), you can 
also select several Events and click with the Mute tool on one of these to mute them all.

• If you double click on a note with the Mute tool, all notes of the same pitch are muted.

Unmuting Notes

To unmute a note, click on it again with the Mute tool. To make sure no notes are 
muted, select “Unmute All” from the Do pop-up menu.
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Editing Notes via MIDI

You can change the properties of notes via MIDI. This can be a handy and fast way 
to get for example the right velocity value, since you will hear the result even as you 
edit:

1. Select the note you want to edit.

2. Click on the MIDI Connector symbol on the Status Bar.

The symbol should be “lit”. This enables editing via MIDI.

3. Use the Note buttons on the Status Bar to decide what properties will be changed 
by the MIDI input.
You can enable editing of Pitch, Note On- and/or Note Off-velocity.

With this setting, the edited notes will get the Pitch and Velo-off values of the notes inputted 
via MIDI, but the Velo-on values will be kept as they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will take on the properties of the played note, according to 
the setting made in step 3.

The next note in the active Part automatically gets selected. A series of notes can therefore 
quickly be edited.

• If you want another try, select the note again (easiest by pressing the [←] key on 
the computer keyboard) and again play a note on your MIDI Instrument.

Cutting, Copying and Pasting

You can use standard Cut, Copy and Paste commands to move Events between ed-
itors or to duplicate a series of Events.

• Cut or Copied Events are Pasted in starting at the Song Position. The Events will 
keep their relative positions, pitch and other properties.



- 184 - 

Deleting Events

Events can be deleted in several ways:

• Select them and select Delete Events from the Edit menu.

or

• Use the Delete command on the Do pop-up menu (see page 171).

or

• Select them and press [Backspace] on the computer keyboard.

or

• Click on them with the Eraser tool.
If the “Tools work on all selected Events” option is activated (see page 179), you can select 
several Events and click with the Eraser tool on one of them to delete them all.



- 185 - 

Creating and Editing Continuous Data

The first-hand choice for creating and editing all kinds of continuous data would be 
the Controller Editor. This is specially designed for graphical editing of Events other 
than notes, including Modulation, Volume, Pitch Bend etc. The Controller Editor is 
described in detail in the chapter “The Controller Editor”. However, it is also possi-
ble to edit and create continuous MIDI data in Key and Drum Edit (both of which 
have special Continuous Controller displays) and List Edit (which lets you edit the 
data in several different ways - see the chapter “List Edit”).

For a basic introduction to the Controller Displays in Key and Drum Edit, see the 
chapter “An Introduction to MIDI Editing” in the Getting Started book. Below, you 
will find a rundown of the features.

Displaying Events in the Controller Display

• Open and close the display by clicking on the icon in the lower left corner of the Edit 
window.

• Change the size of the display by dragging the Divider up or down.

• To select data type to be displayed, press the mouse button with the pointer on the 
data type icon (to the left in the display).
This opens the data type pop-up menu. 

This pop-up menu contains the most common Event types. To see the full list of MIDI Con-
trollers, move the pointer to the “Other” option at the bottom of the list.
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• You can also switch data type by changing the numerical value in the field under the 
data type icon.

• If you move the pointer up and down in the Controller Display, the value correspond-
ing to the pointer position is shown in the box directly above the open/close icon in the 
lower left corner.
This helps you position the Pencil/Line tool when creating or editing Events.

❐ All values range between 0 and 127, except Pitch Bend, which has a value range from –
4096 to +4095. For Pitch Bend, value 0 is equivalent to no Pitch Bend (the Pitch Bend 
wheel/lever in center position).

Editing Velocity

The velocity values of notes are shown as thin vertical bars, with higher bars repre-
senting higher velocity values. Since a velocity value always belongs to a note, you 
cannot create new velocity “bars” in the Controller Display, only edit existing.

• In Drum Edit, only the velocity values for the selected Drum Sound are displayed.
You select a Drum Sound by clicking on it in the Sound list.

• Selecting a note also selects the velocity bar in the Controller Display.
And in the same way, selecting a number of velocity bars, by enclosing them with a selection 
rectangle, will select the notes in the note display.

• To change a velocity value, click on it with the Pencil tool (or Drumstick tool in Drum 
Edit).

• To create a velocity ramp, click and drag with the Line tool.
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Editing Non-Note Events

These Events include all Controllers, Pitch Bend, Sustain-pedal, etc - in other words, 
all Events that are not associated with a note.

• To create a non-note Event, hold down [Option] and click with the Pencil tool (or Drum-
stick tool in Drum Edit).
The value field to the left helps you get the correct value.

• To draw a ramp of non-note Events, hold down [Option], click and drag with the Line 
tool.

• To select a non-note Event you have to enclose it in a frame, using the Arrow tool. 
Note that it is the start of the Event that has to be enclosed:

• To edit existing non-note Events, click with the Pencil tool or create a ramp with 
the Line tool.

Drawing a rectangle like this... ...selects nothing.

But this rectangle... ...selects one Event.
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• To delete non-note Events, either click on them with the Eraser tool, or select them and 
use any of the delete options ([Backspace] key, Edit menu or Do pop-up menu).
The Delete command on the Do pop-up menu allows you to delete all Events within a certain 
range, set by the Loop or Cycle.

❐ Please observe that deleting an Event makes the last Event before this valid up until 
the next Event. It does not “zero” any Controller changes.

Editing Poly Pressure

Polyphonic pressure data has two values that go with it. The key that was pressed, 
and the amount of pressure. To edit or create Polyphonic Pressure Events, proceed 
as follows:

1. Select “Poly-Press.” from the data type pop-up menu.

2. Select the note for which you want to create or edit Poly Pressure data.
Make sure you only have one note selected!

• In Drum Edit, you can instead select the Sound for which you want to edit Poly Pres-
sure, by clicking in the Sound list.

3. Create and edit the Events as with non-note Events.
If you create new Events, they are automatically associated with the note number (pitch) of 
the selected note.
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15
Step Recording
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Introduction

Step Input is when you enter notes one at a time (or one chord at a time) without 
worrying about the exact timing. This is useful when you know the part you want to 
record but are not able to play it exactly as you want it.

Preparations

1. Create an empty Part, as a container for the notes you are about to Step Record.
You can of course also use an existing Part.

2. Open the Part in a MIDI editor of your choice.
In the pictures below we will use Key Edit, but it doesn’t matter which editor you select.

3. Click on the Step button.
This automatically activates the MIDI In icon and the Step Position box.

Determining Note Lengths and Positions

• To set the length of the notes you are about to input, adjust the editor’s Quantize 
value.
If you e.g. set this to “16” all notes you input will be sixteenth notes.

• To set the “spacing” between the notes and chords, adjust the editor’s Snap value.
If you e.g. set this to “8” all notes will appear on eighth note positions.

Setting the Position for the first note

To set the position where you want the first note to appear, adjust the regular Song 
Position (for example on the Transport Bar) and the Step Position is automatically 
set to the same value.

Click the Step button...

...the MIDI connector is automatically activated...

...and the Step 
Position box appears.

Note length.

Note “spacing”.
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Selecting a Track for input

If you are editing several Tracks at the same time, you must decide which Track to 
enter notes into by making a Part/Track active (see page 164).

Entering notes and chords

1. Play one key or a chord.
If you just played one key it appears as soon as you release it. If you play a chord it appears 
when you release the last key. In either case, the velocity you played is recorded with the 
note. No matter how long you hold down the key, the note will get the length set in the 
Quantize box.

2. The Step Position has now advanced one Snap value.

3. Enter the notes for the next position.

Adding Rests

To move one step without entering any notes, press the default [Tab] key on the 
computer keyboard. Alternatively, in the Preferences–MIDI–Others dialog, you can 
set a MIDI Controller to remote control this command (Controller for Step Mode 
Tapping).

1. Start by setting 
the Step Position.

2. Press and release the first key.
The note appears and the Step Position box advances one step.

3. Press and release a chord. It appears and 
the Step Position advances again.
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Changing note values and positions as you go along

• If you want to enter notes of another length, simply change the Quantize value at any 
point.

• If you want to input notes with a different “spacing” simply adjust the Snap value.

• If you want to move to a completely new position, change the Song Position or use Fast 
Forward or Rewind.

• To move one step back or forward in time, use the [←] and [→] keys. The Step Position 
Box shows you the current position.

If you change the Song Position...

...the Step Position is set to the same value.
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If you make a mistake

If for example you entered a note with the wrong pitch or made a mistake when 
playing a chord, press [Backspace]. This deletes the last note/chord you entered, 
and moves the Step Position one step backwards. You can press this key repeatedly 
to “delete backwards”.

You can also use the tools and menu for editing (deleting, moving etc).

...the last entered notes are deleted and the Step Position moves back one step.

If you have this, and press [Backspace]...
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Using the Insert button

If the Insert button on the Status Bar is activated, the notes are inserted rather than 
added. That is, any existing notes are moved to a later position to make room for 
the new notes.

The Insert button.

With Insert on, and the 
Step Position here...

...the new note is inserted, 
and the following notes 
are “pushed forward”.
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Playing back

You can activate playback at any time and from any position, to hear the results. 
Please note, though, that moving the Song Position also moves the Step Position.

When you are finished

When you have entered all the notes you want, don’t forget to deactivate step 
mode by clicking on the MIDI In button.

Click on the “MIDI connector”, and the Step button is automatically deactivated.
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16
Key Edit
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About this “Chapter”

You do not find any additional information here because Key Edit is a very straight-
forward editor. We have therefore used it as an example in the chapters “An Intro-
duction to the MIDI Editors” (in the Getting Started book) and “The MIDI Editors - 
General Information” (in this document). If you have read these two chapters, you 
do know everything there is to know about Key Edit.



- 198 - 

17
Drum Edit and Drum Tracks
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About this Chapter

This chapter contains two general topics: 

• The concept of Drum Maps and how to handle them.
This is described on page 199 to page 208.

• Editing in the Drum Editor.
This is described on page 209 and onwards. Note, however, that a lot of the basic editing fea-
tures are described in the chapter “The MIDI Editors - General Information”.

About Drum Tracks and Drum Parts

In MIDI instruments, drum sounds most often are separated by being placed on dif-
ferent keys, i.e. assigned to different MIDI note numbers. This means that when you 
use a keyboard to record a drum part in a sequencer, you usually use one key for 
bass drum, one for snare and so on. On many instruments used to play back drum 
sounds (drum machines, samplers and some synths) you can re-arrange the order 
in which the sounds of the single instruments are assigned to the keys. (Instead of 
assigning the bass drum to the key C1 you could for instance assign it to D1, or any 
other key available on your keyboard).

Unfortunately, most MIDI instrument manufacturers place their drum sounds on 
different keys and in different orders. This can be troublesome if you have made a 
drum pattern using one instrument, and then want to try it on another. When you 
switch instrument, it is very likely that your snare drum becomes a ride cymbal, or 
your hi-hat becomes a tom, etc, just because the drum sounds are distributed dif-
ferently in the two instruments.

To solve this problem, and simplify several aspects of MIDI drum kits (like using 
drum sounds from different instruments, in the same “drum kit”), Cubase VST fea-
tures a Track class called Drum Tracks. Parts on Drum Tracks are called Drum Parts.

The thing that separates Drum Tracks from MIDI Tracks is that everything played 
back from (or routed Thru) a Drum Track, is “filtered” through a Drum Map. Among 
other things, this Drum Map (described in detail on the next page) determines ex-
actly which MIDI Note Number is sent out for each sound in your drum pattern (and 
thereby which drum sound is played in the receiving instrument). A solution to the 
problem above, would therefore be to make up Drum Maps for all your instru-
ments. When you want to try your drum pattern on another instrument, you simply 
switch to the corresponding Drum Map as well, and your snare drum sound will re-
main a snare drum sound.
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About Drum Maps

A Drum Map consists of settings for 128 drum sounds, from now on called Sounds. 
You can have up to 64 Drum Maps in your Song at the same time. This allows you to 
create several different Drum Tracks, each with its own Drum Map (please note 
though, that each Drum Track only uses one Drum Map at a time). How to select, 
load and save Drum Maps for each Drum Track is described on page 203.

The Default Drum Map

One of the loaded Drum Maps is called the Default Drum Map. This has the follow-
ing general properties:

• There is always a Default Drum Map present in a Song.

• When you create a new Drum Track, it is automatically set to use the Default Drum 
Map.

• When you edit MIDI Tracks in Drum Edit (see the Getting Started book), the Default 
Drum Map is used.
Not all parameters are available when you edit MIDI Tracks in Drum Edit.

When you load a Drum Map from disk (see page 203), you can choose whether you 
want it to be the default Drum Map or not.

The Drum Map Parameters

For each Sound in the Drum Map, you may define the following values:

Though this may seem a lot of parameters, only two are really important for under-
standing Drum Maps: The I-note and O-note values.

Parameter Description

Drum Name The name of the Sound.

I-note When this MIDI note is sent into Cubase VST, (i.e. played by you), the particu-
lar Sound is “triggered” (played).

O-note When the Sound is triggered (either by you playing it, or by the program 
playing back a Drum Part), this is the MIDI note number that is sent out.

Chn The MIDI channel that the Sound will be output on 
(see page 201).

Output The MIDI Output used by the Sound (see page 201).

Instrument A way to name the combination of MIDI Channel and Output (just as in the 
Track Columns).

Q A Quantize value used when editing (see page 209 and 
page 211 in this chapter).

Len A Length value used when inputting notes (see page 210 in this chapter).

“Diamond values”

These are four different velocity values, used when you create notes in Drum 
Edit (see page 210).

Delay The Delay column shifts the timing of a Sound forwards or backwards.
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I-note

This is a certain key (MIDI note number) used for playing the Sound. Setting the I-
note value will let you choose a key on your MIDI instrument (or drum pad or what-
ever) to play the Sound.

❐ Two Sounds cannot share the same I-note.

O-note

This is the MIDI note number that the Sound actually outputs when played by you 
or played back by the program.

Say that you have a rack synth with some drum sounds in it. They are spread over 
the keyboard range in a way that is inconvenient for your playing style. First set the 
O-notes in the Drum Map so that they match the actual notes that play back the 
sounds on your instrument. If the instrument plays back the bass drum on the C2 
key, then set the O-Note for the bass drum sound to just that, C2, so that the Sound 
plays the bass drum. Now you can rearrange the whole “drum kit” so that the finger-
ing suits you, just by setting the right I-notes.

❐ Since you use the Drum Map in Cubase VST to redirect certain note numbers (the ones 
that you play, the I-notes) to other note numbers (the ones that are sent back into your 
MIDI Instrument, the O-notes), this assumes that you use Cubase VST’s Thru-mode 
(and your instrument is in Local Off-mode). See the Getting Started book for details.

About Output and MIDI Channel

You can set separate Outputs and MIDI Channel for each Sound in a Drum Map. 
This allows you to use sounds from several different MIDI instruments or sound 
modules in the same Drum Map. There are a few things to note:

• For the MIDI Output Channel settings in the Drum Map to apply, you have to set the 
MIDI Channel of the Track (in the Track list) to “Any”.
Otherwise, all Sounds will be directed to the MIDI Output Channel set for the Track in the 
Track List.
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How Cubase VST looks at the Drum Map

“Inside” the program, the 128 Sounds each have a note number. This is neither the 
I-note nor the O-note value, but simply a note number used to sort and keep track 
of the Sounds. This may seem superfluous knowledge for you, but it is actually only 
this “real” note number that is recorded, and as soon as you open a Drum Part in an-
other editor, the “real” note numbers will be revealed. The figure below shows how 
the Drum Map system works when you record a Drum Part:

❐ If you open a Drum Track in List Edit, or open a Folder Track containing Drum Tracks in 
Key Edit, the notes will be shown with their “real” note numbers, which could make 
things rather confusing. Therefore we recommend that you edit Drum Tracks in Drum 
Edit only.

When you play a key on your 
keyboard controller, etc... ...the input is directed to the Sound 

with the corresponding I-Note. 
Internally, the “real” note number for 
the Sound (here: E0) is recorded.

Then, in order for you to hear anything, Cubase 
VST sends out the O-Note set for the Sound.

Finally, when you play back the recorded note, the program doesn’t care about the I-Note 
value, just looks at the recorded, “real” note number, and outputs the O-Note stored with that 
Drum Sound.
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Loading and Selecting Drum Maps

Included with the Cubase VST CD-ROM are a number of Drum Maps for different 
MIDI instruments. There are two ways to load a Drum Map into your Song:

By using the Open command

This method will replace one of the currently loaded Drum Maps with the one you 
open.

1. Select the Drum Track to which you want to apply the Drum Map.
If you select a Track of any other Track Class, the Default Drum map will be replaced.

2. Pull down the File menu and select Open.
The Open dialog appears.

3. Select “Drum Map” on the Filetype pop-up menu.
This assures that only Drum Map files are listed in the file list.

4. Locate the Drum Map you want to open, select it and click Open.
The selected Drum Map is loaded, replacing one of the Drum Maps in the Song (depending 
on which Track you selected in step 1). Note that all Tracks that previously used that Drum 
Map will now use the Map you loaded.

By using the Inspector

This method will add a Drum Map to the Song, without replacing any existing 
Drum Map. To load a Drum Map this way, you need to have at least one Drum 
Track:

1. Select a Drum Track.

2. Open the Inspector.

3. From the Drum Map pop-up menu, select “Load from Disk”.
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A dialog appears:

4. If you want to load the Drum Map as Default Drum Map, click “Yes”, otherwise click 
“No”.
If you click “Yes”, the current Default Drum Map will be moved down one step on the Drum 
Map pop-up menu and become a “regular” Drum Map.

5. Use the file dialog that appears to locate and select the Drum Map.

6. Click Open.
The selected Drum Map is added to the Song. However, note that it isn’t automatically ap-
plied to the selected Track - you have to manually select it for the desired Track(s).

Selecting a Drum Map for a Track

If you have several Drum Maps in your Song, you can select which one to use for 
each Drum Track (MIDI Tracks always use the Default Drum Map). Proceed as fol-
lows:

1. Select a Drum Track and open the Inspector.

2. Pull down the Drum Map pop-up menu.
The available Drum Maps are listed in the upper section of the menu. The Default Drum Map 
is always at the top of the list.

3. Select a Drum Map from the list.
The Drum Map is applied to the selected Track.
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Editing and Creating Drum Maps

If you have a MIDI Instrument for which there are no Drum Maps included with Cu-
base VST, you might want to create your own Drum Map. The best way to do this is 
by editing an existing Drum Map:

1. Select a Drum Track, and set its MIDI Channel value to “Any”.
This assures that the MIDI Channel settings in the Drum Map will be used.

2. Create and select a Drum Part.

3. Load and/or select a Drum Map that is as similar as possible to the drum sound layout 
in your MIDI Instrument.
If there are Drum Maps available for older instruments from the same manufacturer, it might 
be a good idea to select one of these. If you cannot find any similar Drum Maps, use the 
“General MIDI Drum Map”, which is compatible with the General MIDI standard.

❐ The General MIDI Drum Map is included with Cubase VST, and is automatically in-
stalled in the “Library Files” folder within your Cubase folder. It is also the Default 
Drum Map in the Autoload Song.

• It is also possible to start “from scratch” by using the “New Empty Map” command on 
the Drum Map pop-up menu in the Inspector.
This creates a new Drum Map, with all Sounds listed in the order of the note numbers, and in 
which the I-Note for each Sound is the same as the O-Note.

4. Select the Drum Part, pull down the Edit menu and select “Drum”.
The Drum Editor is opened. 

5. Click on the Speaker icon on the Status Bar.
When this is activated, a note will be sent out every time you change a value in the editor. 
This is essential when setting up and selecting Drum Sounds.
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6. Drag the Divider all the way to the right, so that all columns are visible.

• If you like, you can rearrange the columns by dragging their headings left or right.

7. Hold down [Option] and set the “Chn” column for a Sound to the MIDI Channel you 
want to use for drums in your instrument.
Holding down [Option] causes all Sounds in the Drum Map to be set to the same MIDI Chan-
nel. You can later change MIDI Channel for individual Sounds if you wish.

8. Choose a Sound and change its O-Note value until you find a sound you want to in-
clude in your Drum Map.
Each time you change the O-Note value, the new note is output. A quick way to set O-Notes 
is to use the MIDI Input function (see page 208).

❐ If you want your Drum Maps to be as “compatible” as possible, try to match the 
Sounds, so that a Kick Drum Sound in the original Map is a Kick Drum Sound in the new 
Map, etc.

9. Double-click in the Drum Name column and type in a suitable name for the Sound.

10.Repeat steps 8 and 9 until you have all the sounds you want in your Drum Map.

• If you want to incorporate sounds from several different instruments (or several drum 
kits from a multitimbral instrument) in the same Drum Map, set the Output and Chan-
nel values for each Sound so that the right instrument is addressed.
To avoid redoing this over and over again, you can define Instruments just like you do in the 
Track Columns in the Arrange Window.

❐ Again, for the MIDI Channel settings to be valid, the Track must be set to MIDI Channel 
“Any” in the Arrange Window.

11.When you have all the sounds you want, set the I-Note values for each Sound.
Setting the I-Notes allows you to place your Sounds on convenient keys on the keyboard. A 
quick way to set I-Notes is to use the MIDI Input function (see below).
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❐ Please note that two Sounds cannot have the same I-Note value! When you change an 
I-Note value, Cubase VST will automatically make sure that no double I-Notes occur, by 
swapping I-Note values between Sounds.
Therefore it is a good idea to decide upon the I-Note settings for all Sounds before you 
start making the settings.

• You may move and re-sort the Sounds in the editor if you for example want to have 
your snare drum sounds gathered on consecutive rows.
This is done by dragging the rows in the list, just like re-arranging Tracks in the Track list. 
Changing the order of the Sounds in the list does not affect the I-Note, O-Note or “real” note 
values - it is just a display feature, to make editing easier.

You now have a basic Drum Map. You may want to set the Q and Len parameters 
and the four pre-defined velocity values when editing or inputting notes in Drum 
Edit. This can be done for some or all of the Sounds, as described on page 211 in 
this chapter.

For example, if you change the 
I-Note value for a Sound from E3 
to C3...

...the Sound that previously had 
the I-Note C3 will now get the I-
Note E3.
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Making parameter settings via MIDI

The I-Note, O-Note and Velocity Value parameters can be set using your MIDI con-
troller, which often is a lot easier:

1. Click on the MIDI connector symbol on the Status Bar to activate it.

2. Select the parameter you want to change by double clicking on it.
The value gets highlighted.

3. Play a note on your MIDI controller.
The note number (I-Note, O-Note) or velocity value changes accordingly. If you do not get it 
right, try again.

• The four velocity values are always ordered according to the “diamond symbols”. 
See page 210.

4. Click Return to “close” the parameter value box, and repeat the procedure for the next 
Sound.

5. When you are done, deactivate the MIDI connector symbol.

Saving your Drum Map

Drum Maps are included in the Song files, so you don’t have to save any new Drum 
Map specifically to keep it. However, if you want to be able to use the Drum Map in 
another Song, you need to save it as a separate file:

1. Make sure the correct Drum Map is selected on the Drum Map pop-up menu in the In-
spector.

2. Select “Save to Disk” from the Drum Map pop-up menu.
A file dialog appears.

3. Choose a folder and name for the Drum Map and click Save.

Removing Drum Maps

If you have Drum Maps in your Song, which you don’t use on any Drum Track, you 
can remove these:

❐ If you want to keep the Drum Maps for future use, you need to save them as separate 
files before you remove them this way!

1. Select a Drum Track and open the Inspector.

2. Pull down the Drum Map pop-up menu and select “Remove unused”.
Any Drum Maps that are not selected for any Drum Track, are removed from the Song. Note 
that it isn’t possible to remove the Default Drum Map.
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Editing Drum Parts in the Drum Editor

Inputting Notes with the Drum Stick

The Drum Stick tool is Drum Edit’s equivalent of the Pencil tool in Key and List Edit. 
There is however one difference:

This makes it easy to try out rhythmic variations; adding and removing notes with-
out having to switch tools.

• If you delete a note this way, you can continue dragging to delete other notes, as long 
as you don’t release the mouse button.

The Q Value

Exactly where a created note is placed, is determined by the Q value set for its 
Sound. This works just like Snap value in the other editors, except you can have dif-
ferent settings for each Sound.

❐ Note that the Q value only applies when you create notes. When you Quantize notes, 
the regular Quantize value on the Status Bar applies (with one exception - see page 
211), and when you move a note, the Snap value (on the Status Bar) determines its ex-
act position.

If you click with the Drum 
Stick in the Event display...

...a new note is created.

If you click on the created 
note again...

...the note is erased!

Pressing the mouse button with the 
pointer in the Q column...

...opens the Q pop-up 
menu for the Sound.
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The Len Value

You don’t change the length of created notes with the Drum stick (as you can with 
the Pencil tool in Key Edit). Instead, you can predefine a length value for each 
Sound, that created notes automatically get.

❐ The length of a drum note may or may not be important, since many drum sounds play 
to their end regardless of how long notes you play.

Velocity Values

You can give the notes one of four “levels” (velocity values), by holding down keys 
on the computer keyboard while you are drawing. The created notes are shown in 
the display as diamonds with different fill patterns for different levels:

The table above shows the default velocity values associated with each “level”, but 
you can modify these individually for each Sound in the Drum Map. Note that the 
levels will always be ordered according to their icons - you cannot set a velocity 
value for the  level that is higher than the value for the  level, etc.

• You can set these values via MIDI, as described on page 208.

• Note that the settings in the Preferences–General–Modifiers dialog may conflict with 
the modifier keys for velocity values!
If one of the above modifier key combinations is specified for use in the Preferences–Gen-
eral–Modifiers dialog, this overrides the corresponding velocity input feature.

Modifier key Diamond symbol Default Velocity

No key 120

[Command] 110

[Option] 90

[Command]+[Option] 70

The Len value is specified as a 
regular note value, while the 
Note Info Line shows lengths in 
beats, 1/16th notes and ticks.
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Making Settings for All Sounds at Once

You can set a parameter to the same value for all Sounds by holding down [Option] 
when you change the value.

Inputting Notes with the Paint Brush

The Paint Brush tool works just like in the other editors (see page 177). Just remem-
ber that each Sound has individual Q and Len values.

• When inputting notes with the brush, you can use the modifier keys to control the note 
velocity in the same way as when you input notes with the drum stick tool. 
See above.

Quantizing

Quantizing Events in the Drum editor works just like quantizing in any other editor, 
with one exception:

• If the To menu is set to Selected Events, Looped Selected Events or Cycled Selected 
Events, and no Events are actually selected, then the selected Sound will be Quan-
tized after its individual Q value.

In all other cases, quantizing works “as usual”, that is: All Events set to be affected 
will be Quantized after the Quantize value on the Status Bar.

Delaying Drum Sounds

If you have a pattern that is slightly “off”, or if you want to create a special rhythmic 
feel, you can use the Delay column to shift the timing of a Sound forwards or back-
wards. Positive Delay values put the Sound “behind” the beat, negative Delay values 
put it “ahead of” the beat.

• This feature can also be useful to compensate for varying MIDI response times if you 
are using different MIDI Instruments for different Drum Sounds.
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Muting and Soloing Drum Sounds

You may mute individual Sounds in the Drum editor. This is done just like muting 
Tracks in the Arrange Window, by clicking in the M (Mute) column. Please note that 
the mute state for Drum Tracks is part of the Drum Map, so any other Track or Part 
using the same map will also be affected. It is also possible to mute individual Note 
Events, using the Mute Tool.

Muting a Sound.

There is also a Solo button, just below the Ed Solo button in the upper left corner of 
the window. This will Mute all Sounds but the selected one. Solo is automatically 
deactivated if you close the Drum editor.

Editing MIDI Parts in Drum Edit

You may also edit regular MIDI Parts in Drum Edit, by selecting the Part(s) and se-
lecting Drum Edit from the Edit menu. When you do this, a simplified Drum Map is 
used where there is no O-note, Delay, Output or Instrument settings:

If you open a MIDI Part in Drum Edit, each note will be displayed on the “line” 
(Sound) whose I-note setting is the same as the note’s actual note number. If you 
for example have a MIDI Part containing a note with the note number D2, this note 
will be displayed on the line of the Sound with the I-note value of D2.

When you use Drum Edit to edit MIDI Tracks, some of the columns work differently 
than with Drum Tracks:

I-Note The I-Note is the note (the key, the MIDI Note number) used to input, display and play 
back the Sound. 

Chn This will be the Channel number for the notes you draw in or in any other way input di-
rectly in the editor. For this to have any effect you must set the Part (or Track) to MIDI 
Channel “Any” in the Arrange Window.
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Converting between MIDI and Drum Parts

You may at any time change a MIDI Track to a Drum Track and vice versa. When you 
change the Track class, a dialog box appears, asking you if you wish to transform the 
Parts on the Track. These options are slightly different depending on “which way” you 
are converting.

From MIDI to Drum Track

• “No” cancels the conversion of the Track.

• “Yes” will convert all Parts on the MIDI Track to Drum Parts. 
The notes will appear on the Sounds with the corresponding O-note values. If you for exam-
ple have a note with the pitch C3, it will end up on the Sound with the O-note C3.

From Drum to MIDI Track

• “Cancel” will cancel the conversion of the Track.

• “In Notes” will set the note numbers of the converted notes to the I-Note values they 
had in the Drum Map.

• “Out Notes” will set the note numbers of the converted notes to the O-Note values they 
had in the Drum Map.

❐ When you convert a Drum Part to a MIDI Part, the Output settings in the Drum Map will 
be lost.
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18
List Edit
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The Columns in the List

In List Edit, you can view and edit most of the various Event Types in all of Cubase 
VST’s different Track Classes. The columns in the List represent different values de-
pending on the Track Class and Event Types, as described on the following pages.
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Audio Tracks

If you open an Audio Part or Track in List Edit you get a list of the Audio Events. This 
is useful when you want to find and keep track of Events, since no Events ever ob-
scure and hide each other as they can do in Audio Edit. When it comes to editing, 
List Edit is limited to moving the Audio Events around. The columns have the fol-
lowing labels and functions for Audio Tracks:

• Start Position/Time
The meter (or time) position of the Start Inset. Changing this is the same as moving the Audio 
Event.

• Length/End Time
When meter position is selected (see page 224), this shows the length of the segment (which 
cannot be edited here). 
When time position is selected, this shows the position of the End Inset. Cannot be edited, 
but changes automatically when you edit the Start Time value.

• Chn
The Audio Channel that each Event plays back on. Cannot be edited here.

• Comment
This column displays the name of the segment played back by the Event. Cannot be edited.

❐ The rest of this chapter does not apply to Audio Tracks.
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MIDI and Drum Tracks

Common to the various Event types are the Start Position, Length and Chn param-
eters. As you expected, these show where an Event starts (as a meter or time posi-
tion value, see page 224 in this chapter), its length in ticks and its MIDI Channel 
value, respectively. The table below shows the List columns and the parameters for 
the different Event types (the rows):

There is also a column named Event Type. For all Event types except Control 
Change (see below), this is just an explanatory value that can’t be changed, e.g. 
“Note” for Note Events etc.

Transforming Controller Events

If you change Value 1 for a Control Change Event, you actually change the Control-
ler from one type to another. To simplify this, the name of the Controller type is 
shown in the “Event Type” column in the List. You can change the value either in 
the “Val 1” column or the “Event Type” column.

• If you want to transform all Controller Events of a certain type to another type, use this 
feature in conjunction with the Mask function (described on page 228 in this chapter) 
and the [Option] key on the computer keyboard (which makes changes affect all 
Events in the List, see page 222 in this chapter).

Val 1 Val 2 Val 3 Comment

Notes Pitch Note On velocity Note Off 
velocity

Sound Name 
(Drum Tracks)

Poly Pressure Note Number Pressure Amount Not used Not used

Control Change Controller Type Change Amount Not used Not used

Program Change Program Number Not used Not used Not used

Aftertouch Pressure Amount Not used Not used Not used

Pitch Bend Bend value (fine) Bend value (coarse) Not used Not used

System Exclusive Not used Not used Not used The Sys Ex message 
– see page 218

Changing the value in the “Val 1” column...

...will simultaneously affect the “Event Type” column, and vice versa.
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About System Exclusive Messages

A complete package of System Exclusive data is shown as one Event in the List. The 
first part of the message is shown in the Comment column, and the Event Type Sta-
tus column will show the manufacturers ID code, if known. 

You can view and edit the complete message in a special System Exclusive window, 
opened by double clicking in the Comment column. This is described, together 
with other aspects of handling SysEx, in the separate document “System Exclusive 
Handling”.
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Mixer Tracks

Mixer Tracks can contain three different types of information: 

• MIDI Mixer Events, created by activating the Write mode in the MIDI Mixer (see the 
“MIDI Mixer and Mix Tracks” document).

• MIDI Track Mixer automation data, created by activating the Write button in the MIDI 
Track Mixer (see page 299).
By default, these Mixer Tracks will be named “Track Mix”.

• VST Channel Mixer automation data, created by activating the Write button in the VST 
Channel Mixer (see page 464).
By default, these Mixer Tracks will be named “Audio Mix”.

Depending on the type of mixer data on the Track, the Event values are used 
slightly differently: 

• For “on/off-type” mixer objects (mute buttons, EQ switches, etc) on Audio Mix Tracks, 
Value 3 is used both to specify the object and its value.
See page 470.

❐ The Event value usage for “Mixer” Events described in the table above is only valid for 
the first 128 Mixer Objects.

Event Type Val 1 Val 2 Val 3 Comment

“Mixer” 
(MIDI Mixer Events)

Object Number Value Not used Object Name and 
Instrument setting

“Mixer” (Track Mixer 
Automation data)

Object Number Value Not used Mixer Object Name

“AUDIOMIX” 
(VST Channel Mixer 
Automation data)

These two values are used in 
conjunction to specify the Mixer 
Object.

Value (see note 
below)

Mixer Object Name
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Special Events

These, like Mixer Events, are not really MIDI Events, but rather Events used inter-
nally in Cubase VST. Therefore they have no MIDI Channel value.

Event Type Val 1 Val 2 Val 3 Comment

Track Mute Track Number 1: Mute, 
0: UnMute

Not used Track Name

Scale Event Type of Scale 
(Major, minor, etc).

Scale Root Key 
(0–11 = C–B)

Not used Value 1 (the type of Scale), 
displayed in words.

StyleTrax Event Style Variation Not used

Stop Event No values are used. Stop Events just make Cubase VST stop, just as if you had 
clicked the Stop button yourself.

Text Event Text Events let you enter comments in the list. Click in the Comments column to 
enter and edit text.These texts do not affect MIDI in any way, they are just meant 
to serve as remarks for System Exclusive and other Events.

Score Event These reflect Symbols in Score Edit. Score Events can not be created in List Edit, 
but they can be deleted.

SMF Event This is the format Cubase uses internally to store events from a SMF file. You can 
restore a Standard MIDI file to it’s original format on Export.
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Creating Events

1. Use the Insert pop-up menu to decide what type of Event to Insert.

2. Set the Snap value to the smallest position you want to enter a note at.

3. If you are entering notes, set their length with the Quantize value. 

From here there are three ways to go:

• Select the Pencil or the Paint Brush and draw the Event in the Event display.
The Event appears both in the display and in the List to the left.

• Activate Step Input by clicking on the foot symbol on the Status Bar.
Step programming is described in “Step Recording”.

• Create notes using the Do menu, see page 170.

If you are inputting notes, they will have...

• the pitch C3.
• a Note On velocity of 110 (unless you have pressed modifier keys while inputting the note 

(see page 178).
• a Note-Off velocity of 64.
• the MIDI Channel value of the Part.
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Editing in the List

The positions and values of Events can be edited in the List, using the regular pro-
cedures. There are some things to note:

Selecting Events

You select Events by clicking as usual. The following rules apply:

• Hold down [Shift] and click to select several Events.

• Hold down [Command] and click to select a range of Events.
Note that you need to click on an unselected Event to set a range - if you [Command]-click on 
an Event that is already selected, you will change its value instead (see page 223).

• You can also hold down [Shift] and press the up or down arrow keys to select several 
Events.

...hold down [Command] 
and click on another Event...

If you have one Event selected...

...all Events in between 
are selected.
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Changing Values

The usual value editing procedures apply, with the following additions:

• To give several Events the same value, hold down the [Option] key and change the 
value.
Only Events of the same Event type are affected. Furthermore, the setting on the To pop-up 
menu is taken into account, allowing you to edit all selected Events of a certain type, or all 
Events within the Cycle, etc (see page 169). 

• To edit several Events relatively, hold down [Command] and change the value.
The value is changed by an equal amount for all affected Events. Again, which Events are af-
fected is determined by the Event Type and the To pop-up menu.

• Note that the settings in the Preferences - General - Modifiers dialog may conflict 
with specified commands using modifier keys!

• If you wish to edit only a certain type of Control Change Events, e.g. Modulation 
Events, use the Mask function.
See page 228.

• If you change an Event’s Start Position, the List will be re-sorted.
The Events are always shown in the order they are played back, with the earliest Event at the 
top and the latest at the bottom.

If you change Value 2 for a note and hold down the [Option] key at the same time...

...Value 2 changes for all notes.
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Switching to Time Positions

The default way for Cubase VST to show a note’s position in the List, is by showing 
its Start Position (as Meter position) and Length (in ticks). A note can also be shown 
as Time position, with Start and End Time shown in hours:minutes:seconds:frames. 
For more info on Time positions, see the Basic Methods chapter in the Getting 
Started book.

To return to Meter Position, click on the mouse box again.

Clicking on the Mouse box...

...will make the Start Position column show an Event´s 
Start Time, and the Length column (notes only) will 
show its End Time.

The Loop settings will also be 
shown as time positions.
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Editing in the Event Display

Moving Events

You can use the Arrow tool to move Events in the Event Display, much like in Key or 
Drum Edit. However, there is one big difference. This is how you should look at the 
horizontal and vertical positions:

• The horizontal position of an Event in the Event Display is directly related to its Start 
Position in the Song (just like in Key or Drum Edit).

• The vertical position of an Event is just related to the order of the Events, like in the 
List. It has no direct relation to time.
The figure below shows an example of this.

Changing the Lengths of Notes

You can click inside a Note Event and drag it to the desired length, using the Pencil 
tool. The new length is shown in the Length column in the List.

Let’s say we have three Events, positioned at 2.1.1.0, 2.2.1.0 and 
2.4.1.0 If you move the Event in the middle a bit to the right...

...it will still keep the exact same vertical position, since its 
position is still after the first Event but before the third.

But if you move the Event further to the right, past the third Event...

...the Event suddenly appears on another vertical position, 
since the order of the Events has been changed.
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Editing in the “Value 2” Display

The graphical display to the right shows Value 2 for the Events in the List (where ap-
plicable) as horizontal bars. You may use this to change values, create ramps etc.

As you can see in the tables on page 217 and page 219 in this chapter, the Event 
types that use Value 2 are Notes, Poly Pressure, Control Change, Pitch Bend and 
MIDI Mixer Events. Perhaps the most common use for the display is to edit Value 2 
for Note Events, that is, the Note On velocity value.

• You do not have to select the Pencil tool to change the bars in the “Value 2” display; 
the pointer automatically changes to the Pencil when you move it into the display.

For other Event types they are grey.

For note Events, the bars are black, 
in order to make it easy to 
distinguish velocity values.
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Hiding Events

You might not want to see all types of Events in the list. For example, if you are only 
interested in editing Program Change, then all other Events are just in the way. Use 
the Display Filters to determine which Event types should be shown:

1. Click on the “F”-button on the Status Bar.

2. Tick the checkboxes for the Event Types you want to hide.
These types disappear from the List.

❐ The Display Filters do not remove, mute or in any other way change the Events. Editing 
may affect both visible Events and Events hidden with the Display Filters.

❐ Special Events cannot be hidden.

A line with checkboxes for the different Event Types appears.
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Using Mask

You can Mask Out certain Events in List Edit. This goes beyond the Display Filters in 
two ways:

• Masking really hides Events from any type of editing like Quantizing, Deleting, etc.
• Masking makes it possible to hide Events not only of a certain Type, but also with certain val-

ues.

Masking out all Events of a certain type

To make List Edit only show Events of a certain Type (notes, Controllers, Aftertouch 
etc), proceed as follows:

1. Select an Event in the List.
Let’s say that you select a note.

2. Pull down the Mask menu and select “Mask Event Type”.

Any editing you do now, including functions in the Do pop-up and on the Func-
tions menu, will only affect the displayed Event Type.

Masking out all Events of a certain type and with the same values

This makes List Edit show only those Events that are of a certain Type and have the 
exact same Value 1 (for notes, this means the same Pitch, for Control Change 
Events it means the same type of Controller, etc).

1. Select an Event in the List.
Let’s say that you select a note with the pitch C3.

2. Pull down the Mask menu and select “Mask Event Exactly”.

All Events that are not of the same type (here: all non-
note Events) are hidden.

In this example, only notes with the pitch C3 will be 
shown and affected by editing.
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Unmasking Events

• To make all Events visible and possible to change, pull down the Mask menu and select 
“No Mask”.

An Example:

Let us say that you have been using a MIDI Instrument with a Breath Controller, and 
therefore have a lot of Breath Controller Events (Continuous Controller 2). Now you 
want to transform these Events to Modulation Events (Continuous Controller 1). 
Proceed like this:

1. Select a Breath Controller Event.

2. Pull down the Mask menu and select “Mask Event Exactly”.
Now, only Control Change Events with Value 1 set to 2 (that is, Breath Controller Events) will 
be shown and affected by editing.

3. Make sure that the To pop-up menu is set to “All”.
Or, if you want to restrict the conversion to the Events inside the Cycle or Loop, select “Cy-
cled Events” or “Looped Events”. 

4. Hold down [Option] on the computer keyboard.
This will let you edit all Events in the List at once (taking the To pop-up menu setting into ac-
count).

5. Change Value 1 of the selected Event to 1.
You may also change the value in the Event Type column; it is the same value, only expressed 
in words.

6. Release the [Option] key.
You will note that all Events disappear from the list. Don’t be alarmed - since you have trans-
formed all Events, they are simply hidden by the Mask function.

7. Pull down the Mask menu and select “No Mask”.
The Events appear again. All Events that were previously Breath Controller Events, will now 
have Value 1 set to 1 - they have been transformed to Modulation Events. 

❐ The only function not affected by the Mask command is Playback. All Events are always 
played back.

About Quantizing and Functions

In List Edit, you can use all the Functions on the main Functions menu, but many of 
them, like quantizing, only work on notes.
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Printing the List

It is possible to print out the Event List from List Edit. Proceed as follows:

1. Open List Edit.

2. Pull down the File menu and select “Print...”.
The standard Macintosh Print dialog appears.

3. Make any necessary settings for the printer.
See the printer documentation for details.

4. Click Print.
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Score Edit
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About this Chapter

This is a brief description of some of the editing features specific to Score Edit. We 
will not deal with score printing or the finer aspects of working with scores here. If 
you want to use the extensive Score layout features of Cubase VST, you should read 
the “Score Layout and Printing” document, included with the Score and VST/32 ver-
sions of the program.

Cubase VST vs. Cubase VST Score/32

Cubase VST Score and Cubase VST/32 have much more advanced score printing 
features than the “regular” version of Cubase. If you have Cubase VST Score or Cu-
base VST/32 and plan to use the Score Editor for printing, we recommend that you 
turn to the “Score Layout and Printing” document rather than reading this chapter.

❐ Whenever a description in this chapter applies to one version only, this is made explicit 
in the text.

About the Score menu and the Do pop-up menu

One of the big differences between the Score Editors in the “regular” Cubase VST 
and the Score/32 versions, is that the latter have a dedicated Score menu, which is 
only accessible when Score Edit is open. The regular Cubase VST does not have a 
Score menu. Instead, the necessary Score commands and functions have been 
placed on the Do pop-up menu.

Page Mode and Edit Mode (Cubase VST Score and Cubase VST/32 only)

In the Score and VST/32 versions of Cubase, the Score editor has two principal 
modes, Page and Edit Mode. The difference and implications of these modes are 
described in the “Score Layout and Printing” book. In this chapter, we assume that 
you are in Edit Mode.

Switching to Edit Mode (If there is no Edit Mode option on your Score menu, then you already 
are in Edit Mode).

If you don’t use Cubase VST Score or Cubase VST/32, you don’t need to worry about 
any “modes” in the Score Editor.
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Overview

Score Edit displays your music as regular notation. Below you will find a description 
of some of Score Edit’s main features:

• If you are editing one Track, as much of it as possible is shown on several staves - one 
above the other - just as with a score on paper.

• If you edit Parts on several Tracks, they are put on a grand staff (multiple staves, tied 
together by bar lines).

• The number of measures across the screen of course depends on how many notes 
there are in each measure.

• The last measure in the Part is indicated by a double bar line.

About the “Score Toolbar”

When we talk about the Score Toolbar, we mean the bar with icon buttons just 
above the actual score. Don’t confuse this with the Toolbar window (described on 
page 632).

The Score Toolbar.

“Inverted” notes 
are selected.

The Song Position Pointer.

The mouse position is shown in the mouse box and the pitch is shown as 
a note name in the box below. When you move a note, the lower box 
instead shows the amount of transposition in semitones.

If you are editing several Tracks at the same time, 
the black rectangle at the beginning of the score 
indicates the Active Track.
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Getting the Score displayed correctly

Time Signature

Score Edit always uses the Time Signatures specified in the Master Track.

Staff Settings

When you open Score Edit for a Part played in real-time, the score may not look as 
legible as you would first expect. The Score editor can ignore the minor time vari-
ances in performance and make a neater score almost instantly. To achieve this, there 
are a number of settings in a Staff Settings dialog box that determine how the pro-
gram displays the music. In this chapter we will describe the options in “regular” Cu-
base. Cubase VST Score and Cubase VST/32 have additional options.

There are two ways to open the Staff Settings dialog:

• Double click in the white area to the left of the staff.

• Activate a Staff by clicking in it, and select “Staff Settings” from the Do pop-up menu 
(or, if you are using Cubase VST Score or Cubase VST/32, from the Score menu).
The Staff Settings dialog appears: 

❐ The settings you do in this dialog box are independent for each Staff (Track), but com-
mon for a piano staff which you have created by choosing the “Split” option in the Staff 
Mode pop-up menu (see below).
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Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & Clef section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct clef, 
judging from the pitch of the music.

Staff Mode

This pop-up determines how the staff should be shown: 

• When set to “Single”, all notes in the Part are shown in the same staff.

• When set to “Split”, the Part is split on the screen into a bass and treble clef, as in a pi-
ano score. 
You use the Splitpoint value field to set the note where you want the split to occur. Notes 
above and including the split note will appear on the upper staff, and notes below the split 
note will appear on the lower staff.

Before and after setting a split at C3.

• To set the clef and key for the lower staff, activate the “Lower Staff” checkbox in the 
Key/Clef section.
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Display Quantize

Notes are not an absolute language, and you must give the program a few hints on 
how the score should be displayed. This is done using the Display Quantize section 
of the Staff Settings dialog.

❐ These are only display values used for the graphics in the Score Editor. They do not af-
fect the actual playback in any way.

Here is a description of the functions:

Parameter Description

Notes Determines the smallest note value to be displayed and the “smallest position” to 
be recognized and properly displayed. Set this to the smallest significant note po-
sition used in your music. 
For example, if you have notes on odd sixteenth note positions, you should set 
this value to 16.
The “T” values are for triplet note values.
This setting is partly overridden by Auto Quantize (see below).

Rests This value is used as a “recommendation” - the program will not display rests 
smaller than this value, except where necessary. In effect, this setting also deter-
mines how the length of notes should be displayed. Set this value according to 
the smallest note value (length) you want to be displayed for a single note, posi-
tioned on a beat.

Auto Quantize Generally, if your music contains mixed triplets and straight notes, try activating 
this checkbox. Otherwise, make sure it is deactivated.

Auto Quantize uses involved methods to make your score look as legible as possi-
ble. Auto Quantize allows you to mix straight notes with tuplets (triplets) in a Part. 
But, Auto Quantize also uses the (display) Quantize value. If it can't find an appro-
priate note value for a certain note or group of notes, it will use the set Quantize 
value to display it.

If the part is imprecisely played and/or complex, Auto Quantize may have a prob-
lem “figuring out” exactly what you “mean”.

If you are using Cubase VST Score or Cubase VST/32, there is more information in 
the chapter “Transcribing MIDI Recordings” in the Score Layout and Printing doc-
ument.
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Flags

These provide additional options for how the score should be displayed:

Closing the Dialog

• When you are done with the settings, close the dialog, by clicking the OK button.
This applies the settings to the active Staff/Track. If you are editing several Tracks at once (see 
next page), you can apply the Staff Settings to all these Tracks at once, by holding down the 
[Option] key when you click OK.

❐ Remember that the Staff settings are done independently for each Track.

Parameter Description

Clean Lengths When this is activated, notes that are considered to be chords will be shown with 
identical lengths. This is done by showing the longer notes as shorter than they are. 
When Clean Lengths is turned on, notes with very short overlaps are also cut off; a 
bit as with No Overlap (see below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as overlapping another, 
lengthwise. This allows long and short notes starting at the same point to be dis-
played without ties; the long notes are cut off in the display. This will make the mu-
sic more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.

Syncopation When this function is activated, syncopated notes are shown in a more legible way.

This is a dotted quarter at the end of a bar when Syncopation is Off...

...and when it is On.

Shuffle Activate this function when you have played a shuffle beat and want it displayed as 
straight notes (not triplets). This is very common in jazz notation.

Flat Beams When this is ticked, the beams over the notes will be flat (as opposed to slanted).

No Beams When this is ticked, there will be no beams whatsoever in the Part. This is good for 
example for vocal scoring.
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Editing several Tracks

You may edit several Tracks simultaneously in Score Edit. The Tracks are shown as 
multiple staves, tied together by bar lines and placed in the order they appear in 
the Track List.

• If you need to rearrange the staves: close the editor, go back into the Arrange window, 
drag the Tracks to the order you want them, and open Score Edit again.

The Active Staff

Just as in the other editors, all MIDI input (as when recording from your instrument) 
is directed to one of the Tracks, here called the Active Staff. The Active Staff is indi-
cated by a black rectangle in the left part of the first visible bar.

To change Active Staff:

• Click anywhere in the Staff you want to activate.

or

• Step to the Staff you want to activate, using the up/down arrow keys on the computer 
keyboard.

The Active Staff rectangle.
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Editing Muted Tracks

If you are editing a Track that is muted in the Arrange window, a black dot will be 
shown to the left of its staff to indicate this:

You can unmute and mute Tracks from within Score edit in the following way:

1. Make the staff (Track) you want to mute or unmute the Active Track.

2. Press [Option]-[M] on the computer keyboard.
This is the default key command - you can change this in the Preferences–Key Commands–
Arrange/Editors dialog (“Mute Selected Track”).

• If Solo is activated in the Arrange window, making a Staff active will unmute the corre-
sponding Track (and mute the others).

Manipulating Notes

There are a few special features for manipulating notes:

Moving Notes

• Use the two mouse boxes to determine where to place notes.

When you move several notes, the upper mouse box shows the position of the note you 
clicked on when starting to drag.

• If the option “Keep Moved Notes within Key” is activated in the Preferences–Scores–
Editor Behaviour dialog (Score and VST/32 versions only), notes will only be trans-
posed within the set key.
If, for example, the key is C major (set in the Staff Settings dialog), you will only transpose to 
notes belonging to the C major scale.

This Track is muted.

The upper box shows the position of the moved note.

The lower box shows the pitch when inputting notes, 
and the transposition value when moving notes.
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Creating Notes and Rests

When you input music “by hand” in Score Edit, you can use the Note and Rest tools. 
The length of the note or rest to be input, is determined by the Quantize value. 
However, the easiest way to input notes and rests, is to use the note symbols in the 
Score Toolbar:

• To input a note, first click on the desired note value in the Score Toolbar (the Note tool 
is automatically selected), then click in the staff where you want the note.
If you want to insert a triplet or dotted note, click on the “T” or “·” button when you select the 
note value.

• To input a rest, first select the Rest tool, then proceed as when inputting notes.
There is one big difference between inputting notes and rests:

❐ Rests are always inserted (as if Insert was activated) into the music.

When you change Quantize value, no matter if you use the Q pop-up menu or the 
note value icons in the Score Toolbar, the shapes of the Note and Rest tools in the 
Toolbox are automatically changed.
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Joining Notes

The Glue Tube allows you to join two or more notes of the same pitch.

• Click on a note with the Glue Tube tool.

The note is joined to the next note with the same pitch.

Splitting Notes

The Scissors tool does the opposite of the Glue Tube; it splits two tied notes into 
separate notes:

• Click on the second of two tied notes.

The notes are split into two.

Enharmonic Shift

The buttons to the right on the Score Toolbar are used to shift the display of se-
lected notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and 
vice versa:

1. Use the arrow tool to select the note(s) you want to affect.

2. Click on one of the buttons to display the selected note(s) a certain way.

The middle button resets the notes to original display. The other four options are double flats, 
flats, sharps and double sharps.

Flip Stems

By selecting the Flip Stems item from the Do pop-up menu, you change the stem 
direction of the selected note(s).
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Adding Text

❐ This procedure applies to the “regular” Cubase VST only. If you have Cubase VST Score 
or Cubase VST/32, please refer to the chapter “Working with Text” in the Score Layout 
and Printing document.

Adding Text

1. Select the “Text” Tool.

2. Click anywhere in the score.
A text input line dialog box appears. 

3. Enter the text.

4. When you are done, click outside the text box.

Changing the Font and Size

If you wish to change the font and size for some text you already put in, proceed as 
follows:

1. Select the text.

2. Select “Text settings” from the Do pop-up menu.

3. Use the Font pop-up, the size setting and the style options in the dialog box that ap-
pears.
The fonts you find on the menu depend on what fonts you have installed in your computer

4. Click OK to apply your settings to the selected text object(s).

The font and size settings you just made will also apply to all the text you input on-
wards (until you change them, of course).

❐ On your font menu you will also find one or more Cubase fonts. These are not intended 
for text, but for the non-text symbols used in the program.

The Text Tool.
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Cutting and Pasting Text

Using the keyboard short-cuts (not the menus) you can Cut and Paste text. Select 
some text, press [Command]-[X] or [Command]-[C] to Cut or Copy. Click for a new 
insertion point, and press [Command]-[V] to Paste.

❐ These are the default key commands. In the Preferences–Key Commands–Edit Menu 
dialog, you can select other keys for Cut, Copy and Paste if you like.

Editing text

To edit text, just double click on it with the Arrow tool and enter new information 
on the input line, just as when you put in the text the first time. 

To change the size or type face of a block of text, select it and then select “Text Set-
tings” from the Score menu, as described above.

Moving and Duplicating Text

Text Symbols can be moved freely within the “page”, one at a time or together, just 
drag it/them to the new location. 

If you hold down [Option] when you drag, you are making copies instead of just 
moving.

Deleting Text Symbols

As with all other objects in Cubase there are two ways to erase Text Symbols. Either 
select them and press [Backspace] on the keyboard, or select the Eraser from the 
Toolbox and click on them.

Title, Comment and Copyright

These are three standard text elements on the first page of your score. To make set-
tings for these, select “Score Title” from the Do pop-up menu (if you are using the 
regular Cubase VST version) or double-click on the title in Page Mode (if you are us-
ing Cubase Score VST or Cubase Audio VST). This opens a dialog box, in which you 
can input texts and make settings for font, size and attributes for each of the three 
elements. Cubase VST will automatically position the elements as follows:

• The Title is always centered, at the top of the page. 
• The Comment is always positioned just below the Title. 
• The Copyright notice is always positioned at the right side of the page, just above the first 

system.

In the “regular” Cubase VST, none of these elements are visible on-screen but will 
be printed out properly.
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Printing

❐ If you have Cubase VST Score or Cubase VST/32, you should also refer to the chapter 
“Printing and Exporting Pages” in the “Score Layout and Printing” document.

To print your score, proceed as follows:

1. Make settings for the Text, Title, Comment and Copyright elements, as described on 
the previous pages.

2. Select Page Setup from the File menu.
This opens the Page Setup dialog, which is a standard Macintosh dialog, with one exception 
(the Margins settings, described below).

3. Choose paper size and direction, and make any other desired settings, just as when 
printing from a word processor or layout program.

4. Locate the Cubase VST-specific settings.
Depending on which Macintosh operating system you use, you may have to use a pop-up 
menu in the dialog to display these settings.

5. If you need to, change the margins by setting the Left, Right, Top and Bottom settings.
Please note that each printer has a minimum margin. To automatically set the values to this, 
click the Default Values button.

❐ If you set margins smaller than the Default values, not everything on the page might 
get printed!

6. If you want the left and right margin settings to be swapped on pages with even num-
bers, activate the “Toggle Margins” checkbox.
Use this if you are planning to print scores more than one page of length, and want to have 
opposite sides “symmetrically mirrored”.

7. Close the Page Setup dialog by clicking OK.
The Page Setup settings are included when you save the Song.

8. Select Print from the File menu.
A standard Macintosh Print dialog opens. Its options depend on the type of printer you use 
(explained in the manual for your Macintosh or printer). Normally you should be able to de-
cide to print a number of copies, all pages, or just a specified range, etc.

9. Click Print.
Provided that you have your printer connected correctly, your score will now be printed.

❐ Note that score printing is only available from within Score Edit!
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20
The Controller Editor
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What can I do with the Controller Editor?

The Controller Editor is specially designed for graphical editing of Events other than 
notes. These include, among others, Audio and MIDI Mixer automation Events and 
MIDI Events such as Modulation, Main Volume and Pitch Bend Events, but also Veloc-
ity values (which are not really Events of their own but rather properties of notes). 
There are many similarities to the Controller strip in the Key and Drum Editors, but the 
Controller Editor has several additional features. In brief, this is what you can do in the 
Controller Editor:

• Create and Edit all types of MIDI Continuous Events.

• Display and Edit Events in Audio or MIDI MixTracks.

• Display several Event types in a Track simultaneously.

• Edit values for MIDI Mixer objects.

When should I use the Controller Editor?

Generally, use the Controller Editor whenever you want to edit Continuous Events. 
If you want to edit Note- and Controller Events together, use the Key (or Drum) Ed-
itor. Read on for more specific information on what you can do with the Controller 
Editor.

About Editing Various Types of Track Classes

You can use the Controller Editor for the following Track Classes:

• MIDI Tracks.

• Audio and MIDI Mix Tracks.
See page 464 and page 299 for information about Audio and MIDI Mix Tracks respectively.
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Opening the Controller Editor

❐ Only Parts on one Track at a time can be open in the Controller Editor.

Opening for a MIDI Track

To open the Controller Editor for a MIDI or Drum Track, proceed as follows:

1. Select a Track (or Part).

2. Select Controller from the Edit menu.
The Controller Editor window appears.

Opening for a MIDI or Audio Mix Track

To open the Controller Editor for a MIDI or Audio Mix Track, there are two options:

1. Select a MIDI or Audio Mix Track.

2. Select Controller from the Edit menu.

Or

• Double click a MIDI or Audio Mix Track in the Arrange window.
The Controller Editor window appears.

Opening from a MIDI Mixer Map

It is also possible to open the Controller Editor from a MIDI Mixer Map. The MIDI 
Mixer is explained in a separate document. To Open the Controller Editor from a 
MIDI Mixer Map, proceed as follows:

1. Select the Arrow Tool in the MIDI Mixer.

2. Double click any Object in the MIDI Mixer Map.
The Controller Editor opens.
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Selecting which Event Types should be displayed

About the Event Type List

The Event Type List is located to the left of the main Controller Editor window. De-
pending on the Track Class, there are certain differences in what is available on the 
Event Type List. The following applies:

• For MIDI Tracks, all the Controller Types available in the MIDI specification are in-
cluded in the list.
These are divided into two sublists, named “Common” and “Controllers”. In the list named 
“Common” you will find a short-list of the most commonly used Continuous Event types, 
whereas the other list named “Controllers” contains all the available Event types. To open a 
sublist, click on the arrow button next to the sublist name.

❐ “On/off Events” such as Mutes and Solos cannot be edited in the Controller Editor.

The bullet indicates 
that the Part contains 
data of this type.
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• For MIDI Mix Tracks, Volume and Pan are by default always shown.
If any Track (or Tracks) has the “extended area” displayed in the MIDI Track Mixer, these Event 
Types in that area are shown as well. See page 295 for a description of the “extended area” in 
the MIDI Track Mixer.

• For Audio Mix Tracks, all the available (continuous) Controllers are displayed.
These are Volume, Pan, Send, Eq and Effect parameters. The number of Audio Channels dis-
played depends on the “Number of Channels” setting in the Audio System Setup dialog on 
the Options menu.

The settings in the 
“extended area”…

…are reflected in the 
Event Type list.
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• For MIDI Mixer Maps, the Event Type list is divided into sublists, one for each general 
type of Mixer Object. 
Each Object included in the current Map is listed on its appropriate sublist.

❐ In the Event Type List (regardless of Track Class), you will notice that certain Event 
Types are marked with a black dot. This indicates that the selected Track, Part or Mixer 
Map contains data of that type.
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Displaying One Event Type at a Time

When you open the Controller Editor, it will display the first Event Type on the list 
by default. If you wish to view or edit another Event Type, click its name in the Event 
Type List. 

Displaying Several Event Types

In the Event Type List you can select one or any number of Event types to display.

To display several Event Types, proceed as follows:

1. Click on an Event Type to view it in the main display to the right.

2. To add other Event Types to the display, hold down [Shift] and click on their names in 
the list.
The display to the right is now divided into several smaller displays, each showing one Event 
Type.

• To select a range of Event Types for displaying, click on the first Event Type, hold down 
[Command] and click on the last Event Type.
All Event Types in between the ones you clicked on are now displayed.

❐ For all Track Classes, when viewing several Event types, the “active” (or currently se-
lected) Event Type is colored green. 
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How different Event Types are Displayed

Depending on the Event Type and Track Class, the Controller Editor main window 
displays the data in slightly different ways. Here are a few examples:

Modulation, Volume etc. are shown as easy to read graphical curves representing the flow of 
Events.

Pitch Bend data is shown as either up- or downward curves from a horizontal (zero value) 
center line.

Velocity values are displayed as vertical bars, with higher bars representing higher velocity 
values.
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For Audio Mix Tracks, Controller Events are superimposed over the waveform.
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Customizing the Display

There are various ways you can customize the way Events are displayed:

Grid

The spacing of the vertical gridlines shown in the Controller Editor change accord-
ing to the Snap setting. The Snap setting determines the “density” of Events when 
creating continuous Controller curves. For very smooth curves set Snap to a small 
note value. However, please note that using small note values for Snap creates a 
very large number of Events when you draw Controller curves. This can in some in-
stances cause MIDI playback to “stutter”. A medium-low density is often sufficient. 
If you do set Snap to a very small note value like 64, you may have to zoom in the 
window to be able to “see” the gridlines.

• You can hide or show the grid by selecting “Hide/Show Grid” from the Do pop-up 
menu.

Ruler formats 

Click the mouse position box to change the Ruler format between time position 
and bars, beats and ticks.

Labels

The labels display the Controller Type, and what Channel or Track it belongs to, 
which is very convenient when you are displaying an Audio or MIDI Mix Track con-
taining mixes for multiple Audio Channels or MIDI Tracks.

• You can hide or show the labels by selecting “Hide/Show Labels” from the Do pop-up 
menu.

Using Window Sets

You can use the Window Sets function on the Windows menu to switch between 
several appearances for the same window. For example, if you are editing Audio 
Mix Tracks you can store all the Volume Events for all channels as one Window Set. 
By saving several Window Sets, all for the same window (Top Window Only acti-
vated and with the “Save Settings” option active), each Window Set can be used to 
recall a different selection of data types. See page 646 for information about Win-
dow Sets.
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Creating and Editing Continuous data

There are two basic methods you can use to control continuous Event data:

• Create new Events with the Pencil or Line tool.

• Edit existing Events.

Creating new Events

You can create new Events by using the Pencil or Line tool. Proceed as follows:

1. Select a MIDI or Mix Track (or Part).

2. Open the Controller Editor.

3. Select the desired data type by clicking in the Event list.

4. Use the Snap value to decide the “density” of the created Events.

5. Hold down the [Option] key.
From here there are basically three ways to go:

If you want to enter a single Event, click once with the Pencil.

To “paint a curve”, drag the Pencil (with the mouse button pressed).
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To create a ramp, use the Line tool to “draw” the outline of the ramp.

6. Release the [Option] key.
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Editing existing Values

This is done in much the same way as when creating Events, except you do not 
press the [Option] key:

• To change one value with the Pencil, simply click on it:
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• To change a series of Events, drag over them with the pencil:

• To draw a ramp, use the Line tool:
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Editing Velocity

As mentioned in the introduction to this chapter, velocity values are not really 
Events of their own but rather properties of notes. That means that if there are no 
notes in the selected Track or Part, you won’t see any velocity values. Also, you can-
not create velocity values (you have to record new notes, or enter them in another 
editor).

To edit velocity, proceed as follows:

1. Select a MIDI Track (or Part) containing notes.

2. Open the Controller Editor.

3. Select Velocity from the Event Type List.
The velocity values are shown as bars, with higher bars representing higher velocity values.

4. Select the Pencil tool.

5. To change the velocity of a note, click on its velocity bar.

6. To change a series of values, drag over the bars.
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Creating a velocity ramp

To create a ramp of values, for example a fade-in or fade out, proceed as follows:

1. Select the Line tool.

2. Position the pointer where you want the ramp to start and press the mouse button.

3. Draw the outline of the ramp with the mouse button pressed.

When you release the mouse button, the velocity values are changed.

Using the Slider to scale Volume values

If you select Volume (or MainVolume for MIDI Tracks) from the Event Type List, you 
can see a vertical slider to the left of the Controller Editor window. This allows you to 
“scale” Volume curves up or down, whilst retaining the proportional differences in 
values. This is useful if you don’t want to redraw the whole curve, but simply want to 
raise or lower the overall level. If you try to scale out of range, a message will appear 
telling you so.

The Scale Slider.
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Editing Non-Note Events

These Events include all Controllers, Pitch Bend, Sustain-pedal etc. There is one very 
important thing to observe about non-note Events. If you for example put in one 
single MIDI Modulation wheel Event with a value of 63, this will be displayed like 
this:

The figure above might look like an “infinite” series of modulation Events all with 
the value 63, but it is not, it is only one. It is a graph of instantly moving the modu-
lation wheel to position 63 and leaving it there. 

It is important to remember that drawing Controllers or inputting them in any 
other way, makes them stay at the last set value for an infinite amount of time (or 
until you change it the next time). Sustain pedal (damper) for instance, will vary be-
tween 0 and 127 every time you press or release the pedal, but stay at the last value 
as long as you don't move your foot on or off it. Draw in one “foot down” Event, and 
the notes will sustain until a “foot up” Event appears.
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Various Functions on the Do menu

The Do pop-up menu (located on the Status bar), contains some special functions 
to make editing and creating Events easier:

Closing the Editor

The following options apply when you close the Controller Editor:

• To close the Editor and discard all changes made, use the [Escape] key.

• To close the Editor and keep the changes made, use the window’s close box or press 
[Return].

The “Keep Appended events” Dialog

If you close the editor and a dialog appears asking you if you want to “keep ap-
pended events”, this is because you have added Events outside the Part(s) being ed-
ited.

Click “Yes” to lengthen the Part and encompass the added Events, click “No” to dis-
card the Events.

Function Description

Mirror Active If two or more Event types are displayed, this function copies the selected Events 
from the active display to the others. If no Event is selected, all Events are copied. 
Note that all Events in the other (inactive) displays are overwritten!

Expand Opens all the sublists in the Event Type List.

Collapse Closes all the sublists in the Event Type List.

Reduce This “thins” out Events for the selected Event Type.

Smooth Attempts to make an Event curve smoother by adjusting the values of the se-
lected Events.
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21
Logical Edit
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Why Should I Use Logical Edit?

Most of the time you will probably perform your MIDI editing graphically, from one 
of the main graphic editors. But there are times when you want more of a “search 
and replace” function on MIDI data, and that’s where Logical Edit comes in. It allows 
you to find certain MIDI Events, based on criteria that you set up.

Once those Events are found, you might want to delete them, change them in one 
way or another, or to move them to another Track for example.

To master Logical Edit you need a fair amount of knowledge about how MIDI mes-
sages are built up.

Opening Logical Edit

1. If needed, select Parts or Events you want to operate on.
See below for details.

2. Select Logical Editor from the Functions menu or use a Key Command (by default 
[Command]-[L]).

What will be affected?

As always, this depends on the window you “come from” and the selection:

What is currently edited is displayed in the title bar of the Logical Edit window.

❐ Before you enter Logical Edit from an editor, check that the “To” menu is set as desired.

About using Logical Edit with different Track Classes

The natural choice is of course to use Logical Edit on MIDI Tracks. But Logical Edit 
can also be used on Drum Tracks to edit MIDI data and on Mixer Tracks to edit Mix 
data (see page 219 for a description of the Mixer Track Event values).

Window/Selection Logical Edit operates on

Arrange Window – No Parts Selected All Parts on the active Track.

Arrange Window – One or more Parts selected The selected Parts.

Any MIDI editor The Events that the “To” menu is set for.
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Working with Presets

A Preset includes all the settings in Logical Edit. For example, one Preset might find 
all your Modulation wheel Events and convert them into Breath Controller Events. 
Another Preset might find all very short notes and delete them.

When you install the program the first time, a number of Presets will be included. 
These are described in the online Help texts.

The Logical Presets on the Functions menu.

Applying Ready-made Presets

From the Functions menu

Presets can be accessed from the Logical item on the Functions menu, without dis-
playing the Logical Edit window. Simply select the objects you want to apply the 
preset to, and select the desired item from the menu.

Using the Logical Preset tool

You can also apply a Preset directly to Parts in the Arrange window, by using the 
Logical Preset tool (marked “Log”) from the Tools menu. 

1. Select the “Log” tool.

2. Click on the Part(s).
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3. Hold down the mouse button and select a Preset from the menu that appears.

From the “Edit List...” Window

This window can be opened from the Logical Presets. It is mainly used for renaming 
Logical Presets as described later in this chapter. However, you also use it to apply 
Logical Presets:

1. Select the objects you want to apply the preset to (Parts or events).

2. Select Edit List from the Logical menu.
A dialog opens.

3. Fold out the items in the list until you can see the desired Preset.

4. Select the Preset.

5. Click Do It.
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From within Logical Edit

To apply a Preset from within Logical Edit, proceed as follows:

1. Select a Preset from the pop-up menu.

The Logical Presets in the Logical Edit dialog box.

2. Click “Do it”.

Managing and Creating Presets

How the Presets are Stored

Each Logical Preset is a file on disk. When you use the “Create New” and “Store” 
functions described later in this chapter, a Logical Preset file is created on disk.

In other words, the Preset list is common to all Songs.

Deciding from where Presets are Stored and Read

Since Logical Presets are disk files, you need to specify in which folder you keep 
your Presets. By default, the program assumes all your Logical Presets are in the 
“Logical Presets” folder in your Cubase VST folder. If this is OK, you don’t need to 
change anything.

Furthermore, the subfolders can be used to create hierarchical menu items, which 
proves a very neat way to organize your Presets, if you have many.

If you need to specify another folder than the current, proceed as follows:

1. Select Edit List from the Logical Preset menu.

2. Click the “Set Path” button.
A file dialog appears.

3. Locate and select a folder on your hard disk.

4. Click Select.
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Reorganizing Presets

If you use the Finder to check the Logical Presets folder in your Cubase VST folder, 
you will see all the items that make up the Logical Presets in the program. Note that 
the structure of the files correspond to the way the Presets are shown on menus in 
Cubase VST.

• To move items between the hierarchical menu items, drag and drop files between the 
folders inside your Logical Presets folder.

• To create a new hierarchical menu item, create a new folder inside your Logical Presets 
folder and put the desired files there.

Making up your own Presets

If you make settings of your own and wish to save them as a Preset, proceed as 
follows:

1. Open Logical Edit.

2. Select “Create New” from the Preset pop-up menu.

3. Double click on the current name (“Untitled”) and type in a new.

4. Set up all the fields and values as desired.

5. Click the Store button.
A new file is created in your Logical Presets folder.
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Modifying a Preset

If you make settings of your own and wish to save them as a Preset, proceed as 
follows:

1. Open Logical Edit.

2. Select the Preset in the list.

3. Change the fields and values as desired.

4. Click the Store button.

Changing the Name of a Preset

From Logical Edit

1. Open Logical Edit.

2. Select the Preset in the list.

3. Double click on the name and type in a new name and hit [Return].

4. Click Store.

From the “Edit List...” Window

1. Select Edit List from the Logical Preset menu.

2. Select the Preset in the list.

3. Double click on the name and type in a new name and hit [Return].

4. Close the window.

Deleting Presets

To delete a Preset, simply go to the Finder, locate the file on the hard disk and move 
it to the Trash.

Selecting Easy or Expert Mode

The Logical Edit window can be switched between two modes, Easy and Expert. 
The Expert mode has more possibilities than Easy (see page 282), but is also harder 
to grasp. Most of the “normal” logical editing like deleting certain types of Events 
etc, can be performed in Easy mode.

Click to switch to the mode 
labelled on the button.
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Initializing the Settings

The “Init” button returns all settings to “normal” default values.

How Logical Edit Operates

Filters

The principle for Logical Edit is this: First you set up Filters. These are used to decide 
which MIDI messages will be affected and which will not. An example of a specified 
Filter could be “all notes that have a pitch of F#3 and a velocity value that is larger 
than 37”. Filters can be set up for all aspects of almost all types of MIDI messages.

This is similar to using “Find” or “Search” in a word Processor, where you specify 
which text to find, by typing it, in a dialog box.

After setting up Filters, the simplest thing you can do is to perform a function like 
Quantizing or Deleting on the Events that are “found” by the Filters, see below.

Processing

A more advanced option is to apply some Processing. An example of this would be 
to “add 7 to all the notes' note number”, which would be the same as transposing 
them all a perfect fifth.

Processing can be thought of as “replace” in a word processor, where the found 
text is replaced by some other text.

Functions, Quantize and Do It

In the bottom section of the dialog is a pop-up menu where you select what type of 
functions to actually perform.

The Functions pop-up.

Most of the functions, like Quantize and Delete, only need the Filters to perform their 
trick. But Transform and Insert also use the Processing settings.

The Quantize setting is for deciding what note value to Quantize to, in Quantizing 
operations.

The “Do it” button, finally, is used to actually perform the Function.
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About Setting Values

In some cases you will define a a range of values by setting two values (for example 
to define “all pitches between C2 and F3”).

Initially both values are set to 0. To set the values, start raising the “high” value (in 
the lower field), and then set the “low” value. This is because the program won’t let 
you raise the “low” value above the “high”. This means that as long as the “high” 
value is set to 0, the “low” value can’t be raised at all! Not all operations use both 
values, and some use none of them.

Start by changing 
the “High” value...

...then adjust the 
“Low” value.
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Setting up Filters

In Easy mode, there are four columns in the Filter area of the dialog box.

Event Type

The first column is called Event Type. This is for setting what type of Event the Fil-
ters should operate on.

• The upper field is used to set up a condition for the Event type selected in the pop-up above, 
as described in the table below.

• The lower field lists all types of MIDI Events. 

❐ This cannot be adjusted if the upper field is set to “Ignore”, see table below.

Here’s some special information for Cubase VST and MIDI experts: Using a “Higher” 
setting with Pitch Bend selected on the Event pop-up will make Logical Edit “catch” 
System Exclusive data. Using a “Lower” setting with “Notes” selected, will make it 
“catch” Mute Events and Stop Events.

Condition Explanation

Ignore This means that all Event types will be affected by the operation. The Event type pop-
up setting is then of no relevance.

Equal Only Events of the type indicated on the Event type pop-up will be affected.

Unequal Only Events that are not of the selected type will be affected.

Higher Events that are below the selected Event type, on the Event type pop-up, will be af-
fected.

Lower Events that are above the selected Event type, on the pop-up will be affected.

Condition pop-up

Event Type pop-up
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About the Following three columns (Easy Mode)

For each of the next three columns in the Filter section there is one condition pop-
up and two value fields. Here is an explanation of each column:

Value 1

The second column in the Filter section is used for the same part of the MIDI mes-
sages as the “Val1” column in the List editor displays.

Condition

This pop-up is used to set how the values you set in the field(s) below should be 
used to pick Events for processing:

Condition Explanation

Ignore This means that all Events are affected regardless of the set values. Therefore, both the 
values below are dimmed.

Equal Events that have a value equal to the set value are affected. This means that only one 
value is used, the lower field is therefore dimmed.

Unequal Events that have a value that is not equal to the set value are affected. This also means 
that only one value is used, and the lower field is dimmed.

Higher Events that have a value that is higher (not “equal to or higher”) than the set value are 
affected. Only uses top field.

Lower Events that have a value that is lower (not “equal to or lower”) than the set value are af-
fected. Only uses top field.

Inside Events that have a value that falls inside the range formed by the two values are af-
fected. You therefore need to set both fields.

Outside Events that have a value that falls outside the range formed by the two values are af-
fected. Uses both fields.

Condition pop-up

Value fields
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Value Fields

You use these to specify value(s) for the condition. The exact meaning of the values 
is different for each Event type:

Event Type Meaning of Value 1

Notes The Note Number/Pitch. The pitch is shown to the right of the number (like F#3, 
C2 and so on).

Poly Pressure The key that was pressed, also easily found by looking at the letters showing the 
pitch.

Control Change The type of Controller, displayed as a number.

Program Change The Program Change number. (Please note that many MIDI units do not display 
the real Program Change number on the front panel.)

Aftertouch Simply the amount of pressure.

Pitch Bend The “fine tune” of the bend. Rarely used.
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Value 2

This corresponds to Val2 in the List editor. 

Condition

This is exactly the same as for Value 1, see above.

Value Fields

Here is a list of the meaning of the values for each type of Event:

Channel

This is the MIDI Channel stored with the Event, not the one set for the Part. See page 
37 for a detailed explanation.

Condition

This is exactly the same as for Value 1, see above.

Value Fields

This is simply the MIDI Channel number (1 to 16).

Example

The filter below allows you to find notes with the pitch C3 and a velocity range 
between 23 and 85.

Event Type Meaning of Value 1

Notes The velocity of the note.

Poly Pressure The amount of pressure for the note.

Control Change The amount of Control Change.

Program Change Program Change messages don't have a Value 2.

Aftertouch Aftertouch messages don't have a Value 2.

Pitch Bend The coarse amount of bend.

These settings limit the 
“search” to notes only.

This pinpoints the filter 
to one pitch (C3).

This limits the “search” to a 
certain velocity range.
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Applying a Filter

Just setting up the filters is enough for some very complex Logical Editing. Proceed 
as follows:

1. Open Logical Edit from the Arrange window or from the editors, depending on what 
you want to process.
See page 264 in this chapter for details.

2. Set up the Filters to “find” the desired Events.

3. Select one of the Functions from the pop-up menu.

The Function pop-up. See the table below for details.

4. If you have selected “Quantize”, set the Quantize value as desired.

5. Click “Do it” to perform the function.
• You can make as many edits as you wish without leaving Logical Edit. 
• Note that Events that do not pass through the filters remain intact, they are not affected in 

any way by the operation.

Functions

Function Description

Quantize The Events that pass through the filters are Over-Quantized to the Quantize value set 
with the Quantize Pop-up menu.
Quantizing non-note data, allows you to “thin out” for example Controllers or Pitch 
Bend.

Select This Function is only active if you selected Logical Edit from one of the other Edit win-
dows: Key, Drum, List or Score. It simply selects the Events that pass through the fil-
ters for future processing directly in the editor, after you have exited Logical Edit.

Delete The notes that pass through the filters simply get deleted.

Extract This Function is only active if you selected Logical Edit from the Arrange window. It 
Cuts the Events that pass through the filters out of the Part, and then creates new 
Part(s) with the extracted Events only. These new Part(s) are put on a new Track and 
have the same start and end points as the original(s).

Copy This Function is only active if you selected Logical Edit from the Arrange window. It 
works just as Extract, only it doesn't Cut the Events from the Part(s), it Copies them.
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Setting Up for Processing

If you decide to Process Events (Transform existing or Insert new Events) you must 
decide how the Events that pass through the Filters should be processed. This is 
done using an Operator and one or two Values for each column. 

The Operators are found on pop-up menus in the Processing section of the dialog.

The Values are displayed below each operator.

Event Type

For the Event type column you have two Operators to choose from:

❐ If you Edit Mix Tracks, you cannot change the Event type.

Menu option Description

Keep The Events will stay the same type as they are.

Fix The Events will be transformed into some other Event type, as set on the lower 
pop-up. The options are all the different MIDI types of Events. 

Operator pop-up

Value fields
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Value 1

For the Value 1 Column you have a number of different Operators:

Value 2

Value 2’s Operators are practically identical to Value 1. There’s only one difference:

Operator Description

Keep The value is not affected in any way. You don't set any number in the value fields.

Plus A number is added to the existing. You use the upper value field to set how much 
should be added.

Minus A number is subtracted from the existing. You use the upper value field to set how 
much should be subtracted.

Mult The existing value is multiplied by a number. You use the upper value field to set how 
much it should be multiplied with. The Operator contains an integer and two decimals, 
but the result is always rounded to an integer.

Div The existing value is divided by a number. You use the upper value field to set how 
much it should be divided by. Uses integers and decimals, just as Multiply.

Fix The existing values are simply replaced by a fixed value that you set in the upper value 
field.

Value 2 When you select this, the existing Value 2 value in each Event is copied to its Value 1. If 
you for example use this on notes, this would mean copying its velocity value to the 
note number. If you used it on Controllers it means replacing the Controller number 
with the Controller value. 

Dyn This function is used to create a “ramp” from one value to an other, like for example a 
crescendo or a diminuendo. This function involves four things, the Start and End Value 
and the Start and End Point.
If you open Logical Edit from the Arrange window, the Start and End points will be the 
start and end of the Part(s). 
If you open Logical Edit from one of the editors, Start and End points will be one of 
three things: The start and end of the Part, the Left and Right Locator values, or the 
Loop boundaries, all depending on how the To menu was set in the editor.
The two value fields are used to set the initial value – at the beginning of the range, and 
the final value – at the end.

Random This replaces the values with random numbers within a range specified by the two val-
ues.

Value 1 This is the reverse of its “Value 1“column counter part, that is, the existing Value 1 value in 
each Event is copied to its Value 2. If you for example use this on notes, this would mean 
copying its the note number (pitch) to velocity. 
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Channel

You can also process the MIDI Channel of the Event. The Channel Operator menu 
only has five options, identical to the same items on the Value 1 and Value 2 menus:

❐ For this to have any effect when you play back the Part, the Track/Part must be set to 
MIDI Channel “Any”.

Examples

The Example below, applied to notes, would transpose them a fifth and set their ve-
locity to a fixed level of 100.

The next example converts Aftertouch into Modulation wheel Events.

Operator Description

Keep The Channel is not affected in any way.

Plus A number is added to the existing Channel.

Minus A number is subtracted from the existing Channel number.

Fix The existing Channel number is simple replaced by the number you specify.

Random This replaces whatever Channels the Event originally was on, with a random number. 
The two values fields are used to set the lower/upper limit of the random numbers.

The Event type is 
“kept”, that is, it 
is not affected.

The number 7 is 
added to the Pitch.

The existing velocity 
values are replaced by a 
fixed number (100).
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The last example allows you to make up a bass drum part that exactly follows for 
example a bass part on the selected Track. Work on a copy of the bass Track. The 
value in the Value 1 Processing field is the key you have the bass drum on.

For further examples, please examine the Presets included with the program.

The Event type is 
changed to 
Control Change.

Modulation wheel is Controller 1, therefore a 
fixed value of 1 is entered here.

This setting “moves” the Aftertouch 
amount (stored in Val 1) to the 
Controller amount (stored in Val 2).

Transform is chosen 
since Events are to 
be converted.

Only Aftertouch Events will 
be affected.

Regardless of their original pitch, the new 
Events will have a fixed pitch of C3.

Regardless of their original velocity, the new 
Events will have a fixed velocity of 100.

Transform is chosen since 
Events are to be converted.

Only notes will 
be affected.
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Processing Functions

To use the Processing functions, proceed as follows:

1. Open Logical Edit from the Arrange window or from the editors, depending on what 
you want to process.
See page 264 for details.

2. Set up the Filters to “find” the Events that you want processed.

3. Set up the Processing.

4. Select Transform or Insert from the pop-up menu.

The Function pop-up. See the table below for details.

5. Click “Do it”.
The processing is performed.

• You can make as many edits as you wish without leaving Logical Edit. 
• Note that Events that do not pass through the filters remain intact, they are not affected in 

any way by the operation.

Functions

Function Description

Transform The notes that pass through the filters have their values Transformed (i.e. changed) 
according to the values set in Processing. This doesn't add any new Events, it just 
changes the existing ones.

Insert The Events that pass through the filters get copied, transformed (see above) and 
then inserted among the existing Events. This adds new Events to the Part(s).
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Expert Mode

When you switch Logical Edit to Expert Mode (by clicking the “Expert” button) you 
get two more columns in the Filter and Processing sections, plus a graphic Bar Range 
setting in the Filter section. The pop-ups in the Processing section are also extended 
with additional functions.

Additional Filter Columns

Bar Range Example

Check out the settings above. If you have a snare drum playing on the key C#1, this 
setting will allow you to pin-point all snare drum beats that lie around the fourth 
quarter in each bar and transpose them up two octaves to C#3. This is useful if you 
want to double up the second snare drum in each bar in a basic rock beat, with 
some other Sound. Since this example uses Copy, it assumes that you entered Log-
ical Edit from an Arrange window. Click on “Do it” to make up a Part with the copied 
beats only. Then use transposition and MIDI Channel settings to assign the new 
Track to another Sound.

Column Description

Length This allows you to select notes depending on their length. This value is displayed in 
ticks.

Bar Range This allows you to only include Events at a certain position within each Bar in the editing. 
You can type the beat and tick value. Or, you can drag a range in the Bar Range graphic 
at the lower part of the whole dialog box. This is done in the same way as when you drag 
to set the Loop range in Key, Drum or List Edit.
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Additional Processing Columns

The Processing section also gets two new columns in Expert mode.

Spread

A lot of MIDI data starting on the same tick could lead to a MIDI overflow situation 
in some older devices (producing stuck notes etc). The Spread operator “spreads” 
out the data according to the tick value specified in the Position field. If you set this 
value to three ticks the Events’ start positions are thus spread 0, 3, 6, 9, 12 etc. 

Additional Operators

In Expert Mode, the Value 1 and Value 2 pop-up menus in the Processing section 
contain additional Operators:

Column Description

Length By using processing on this value, you can manipulate notes' lengths. The Operations 
for it are Keep, Plus, Minus, Multiply, Divide, Fix.

Position Processing position will affect the Events' position values so that you are able to move 
Events and create Events at new positions. The Operations for it are Keep, Plus, Minus, 
Multiply, Divide and Spread (see below for details about the Spread operator).

The integer (the number to the left of the decimal point) represents ticks.

If you for example add to the Position value and use Insert, this will result in some sort of 
echo effect. If you multiply or divide the Positions, this will be the same as changing the 
tempo of the music in the Part. There are examples of this in the Logical Presets that 
come with the program.

Processing Description

Invert This inverts the values, so that the bigger it originally was the lower it comes out. If 
you for instance select Controller values in Key or Drum Edit and Invert them, you will 
find that it looks as if the graph has been turned upside down. An upwards scale be-
comes a downwards scale etc. This Operation needs no values.

Scale Appears for Value 1 only. This works like Scale Correction in the Transpose/Velocity 
dialog box. The upper value field is the Scale type, which is selected from a pop-up, 
and the second value is the Key Signature.

Flip Appears for Value 1 only. This flips the Events around a set axis. For notes this will in-
vert the scale, with any key as a “center point”. For velocity it will make high velocities 
low and low velocities high, with any value as a flip axis. It will have similar effect on 
Controller values etc.

Rel. Dyn This Operator adds or subtracts values relative to the original values, as opposed to 
the Dyn. Operator, which creates a ramp. For example, setting the values to 0 and -
127 will produce a velocity fade-out, with the relative velocities intact.

Rel. Random This adds or subtracts random values relative to the original. If you set the lower 
value to 40, and the upper to 0, it will add values between 0 and 40 to the original (as 
opposed to the Random Operator which would set all values randomly between 0 
and 40).
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Filtering and Mapping MIDI Data
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Introduction

Cubase VST has a number of real time features for filtering out MIDI data and for con-
verting one type of MIDI data into another. These are called “real time” functions be-
cause they work “in the background” while the program is recording or playing back. 
It is these features that are described in this chapter.

In addition, Cubase VST has a number of filtering and mapping (transformation) ed-
iting features, in List Edit, Logical Edit and on the Functions menu. These perma-
nently change the recorded data. They are described in their respective chapters.

Recording Filters

By Event Type

You might want to prevent some type of MIDI data from being recorded. If for exam-
ple you have a master keyboard transmitting Poly Pressure, but no sound module 
set to react to it, recording the Poly Pressure data wastes precious memory space 
and might even clog up the MIDI data stream.

1. Pull down the Options menu and select “Filtering...” from the MIDI Setup submenu.
The MIDI Filter dialog opens.

2. In the “Record” section, activate the check boxes for the MIDI data types you don’t 
want to record.

In this example Poly Pressure and System Exclusive data will not be recorded.

3. Close the dialog box.
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By MIDI Channel

You might also want to filter out all Events that are coming in on a certain MIDI 
Channel. For example, if you are transmitting data from another sequencer, this will 
allow you to record only a selection of the MIDI Channels it is transmitting.

1. Open the MIDI Filter dialog.

2. In the “Channel” section, activate buttons for the MIDI Channels you don’t want to 
record.

In this example, data coming in on MIDI Channels 9 and 16 will not get recorded.

3. Close the dialog box.

Controllers

As explained above, you can filter out all Controller data. But Cubase VST offers 
more detailed filtering than just filtering a whole class of Events! If you need to you 
can filter out up to four user-specified Controllers.

1. Open the MIDI Filter dialog.

2. Make sure Controller messages are not filtered out altogether (see above).

3. Locate the Controller Filters.
As you can see, there are four of them.

4. To filter out one certain Control Change message set one of the four fields to that Con-
troller number or name.
To turn off one of the four Filters, set it to “No Ctrl” (the lowest value).

In this example, Expression pedal and Local Control On/Off messages will be filtered out.

5. Close the dialog box.
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Thru Filters

There might be situations where you want to have MIDI Thru active (see the Getting 
Started book), but still don’t want one certain type of MIDI message to be sent “Thru” 
Cubase VST.

For example, System Exclusive that you send out from a MIDI Instrument to record 
into Cubase VST, should most probably not be immediately sent back to the instru-
ment, since this might lead to serious confusion.

1. Open the MIDI Filter dialog.

2. In the “Thru” section, activate the check boxes for the MIDI data types you don’t want 
to record.

In this example System Exclusive and Program Change will not be Thru-put.

3. Close the dialog box.
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Mapping Controller Messages

There might be situations where you want one Control Change message to “mas-
querade” for another. For example, you might have a unit that reacts to Breath Con-
troller messages, but nothing to generate them with. You might then set up 
Cubase VST to convert for example Modulation Wheel Events to Breath Controllers, 
before recording them. Proceed as follows:

1. Pull down the Options menu and select “System...” from the MIDI Setup submenu.
The MIDI System Setup dialog opens.

2. Locate the Controller Map section.

3. If you want to make sure no mapping takes place, click the Reset Map button.
This turns off mapping for all Controllers.

4. Scroll the upper field to select the Controller you want to map.
In our example, this would be Modulation Wheel.

5. Use the lower field to set which type of Controller to map to.
In our example this would be Breath Controller.

6. Continue setting up mapping for as many Controller as you wish, in the same way.
Any Controller can be mapped into any other, and all at the same time if you wish.

7. Close the dialog box.

This Controller
is converted into 
this Controller.
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The MIDI Input Transformer

This function (reached from the Panels menu) is used to selectively filter out and 
change data that is coming in to Cubase VST, before it is recorded. To use the Input 
Transformer you should be reasonably acquainted with Logical Edit, since the two 
are very similar.

Here are some of the things the Input Transformer allows you to do:

• Use four different filters/transforms at the same time.
• Make up split keyboard combinations for recording left and right hands separately.
• Turn a Controller like a foot pedal into MIDI notes (for playing bass drum the right way)
• Filter out one specific type of MIDI data on one MIDI channel only.
• Turn Aftertouch into any Controller (and vice versa).
• Inverse velocity or pitch.
• etc...

And again: four of these things can be done at the same time.

Filter and Processing

The Filter and Processing sections work exactly as in Logical Edit in Easy mode (see 
page 270). The big difference is that the Input transformer acts in real time on the 
incoming MIDI signals.
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Selecting and Activating

The buttons labelled 1-4 at the bottom of the window are used to decide which of 
the four transformers should be displayed.

The check boxes just below these are for turning each of these four transformers on 
and off.

Initializing

If you want to reset any of the transformers to its initial setting (everything turned 
off), select it and click the Init button.

Functions

When you have set up the Filtering and Processing sections, you have to select one 
of two functions from the pop-up menu in the lower half of the dialog box, Filter 
(remove, delete) or Transform (change using Processing settings). If you select the 
Filter option, only the Filter settings are of any interest. If you select Transform, 
both the Filter and Processing settings apply, just as in Logical Edit.

Events are put through module 1 first, then 2 etc. But, if a module “selects” Events 
for filtering or processing, they will not reach the other modules at all.

❐ It is possible to create transformations that lead to “hanging” notes! (Note Ons without 
Note Offs).

Input Transformer 1 
selected for editing.

Input Transformer 
1 and 2 activated.
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About the Default settings

The following four Input Transformations come with the program. They are all 
turned off initially, so you will have to open the MIDI Input Transformer and turn on 
the ones you plan to use.

“Preset” Description

1. Split Keyboard This Transformation takes all notes from C3 and up, and adds 1 to their MIDI 
Channel. For this to have any effect you must set the Track to MIDI Channel 
“Any”. If you do this and for example set a regular MIDI keyboard to send on 
MIDI Channel 3 you will get an output where all notes below C3 come out on 
MIDI Channel 3 and all notes above come out on MIDI Channel 4. Use this to 
play one sound with the left hand and another with the right hand.

2. Fix Velocity This Transformation makes all notes have velocity 100, regardless of how you 
play. It is easy to change the output velocity value in the dialog box, if you need 
to.

3. Modulation 
Transformed into 
Aftertouch

This Transformation takes incoming Modulation wheel Events and turns them 
into Aftertouch. Many rack synthesizers can receive Aftertouch, but not all key-
boards send it. This allows you to use your “mod wheel” to send Aftertouch to 
a synth and there use it to control volume, filter or anything else the synth 
module is capable of doing via Aftertouch.

4. Invert keyboard This Transformation turns your keyboard “upside down”, “Joe Zawinul Arp 
2600” style. Enjoy!



- 292 - 

23
The MIDI Track Mixer
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About this chapter

This chapter contains descriptions of the controls in the MIDI Track Mixer, together 
with information about more advanced MIDI mixing techniques. For a basic descrip-
tion of how to use the MIDI Track Mixer, you should read the Mixing chapter in the 
Getting Started book.

The MIDI Track Mixer layout

The MIDI Track Mixer, in an Arrangement with eight MIDI Tracks.

• Each “channel strip” corresponds to a MIDI, Drum or Folder Track in the Arrangement.
If you add or delete Tracks, the MIDI Track Mixer window adjusts accordingly.

• Folder Tracks are not visible in the Track Mixer, unless they contain MIDI Tracks.

• The MIDI Track Mixer works by sending out MIDI messages to your connected instru-
ment(s).
If the instruments are not able or set to respond to the MIDI messages (such as MIDI Volume, 
Pan, etc), the MIDI Track Mixer will not work properly.

• If you have several MIDI Tracks set to the same MIDI channel, making settings for one 
of these Tracks will also affect all other Tracks set to the same channel. 
For example, if you move the fader for one of the Tracks, the faders for the other Tracks on 
the same channel will move accordingly.

• Tracks set to channel “Any” are displayed in the MIDI Track Mixer, but many of the set-
tings will be disabled.
The “Any” channel concept is explained on page 46.

• The MIDI Track Mixer can handle up to 128 Tracks.
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The Controls

The Channel Strips

Each basic channel strip contains the following controls:

Control Description

Mute button Clicking this mutes the corresponding Track in the Arrange window. This is a “mir-
ror” of the Mute column in the Track List, which means that muting a Track in the 
Arrangement is reflected in the MIDI Track Mixer and vice versa.

Solo button Clicking the Solo button for a Track mutes all other Tracks in the MIDI Track Mixer. 
Tracks that are not visible in the MIDI Track Mixer (Audio Tracks, Chord Tracks, 
etc) are not affected by this.

Pan Control Use this to control the Pan (stereo position) of a sound. When you change the 
setting, the pan value is displayed numerically below the fader.

Volume fader Use this to control the volume of a sound. When you move the fader, the volume 
value is displayed numerically below the fader.

Level meter Indicates the velocity values of the notes played back on each Track.

Numerical display Indicates the numerical values when you change the volume or pan. You cannot 
change anything in this value field.

MIDI Output Shows the MIDI Output setting for the Track. You cannot change this value here.

MIDI Channel Shows the MIDI Channel setting for the Track. You cannot change this value 
here.

Track Name Shows the name of the corresponding Track. You cannot change this value here.

Click this button to display the extended Channel Strip (see below).

Mute button.

Solo button.

Pan control.

Volume fader.

Level (velocity) meter.

Numerical volume/pan display.

MIDI Output.

MIDI Channel.

Track Name.
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The “Extended” Channel Strip

If you click on the arrow button at the top of a channel strip (MIDI Tracks only), the 
strip is extended to the right. Pressing [Option] and clicking on any arrow button 
will extend all Tracks.

Which controls are available in the extended area differs depending on the mode 
selected on the pop-up menu at the top:

The “Extended” Channel Strip for MIDI Track number 2.
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When you first install Cubase VST, the following modes are available (you can also 
add custom-made modes yourself, as described on page 306):

The controls in each mode are described below. For information about the XG, GS 
and General MIDI standards, see page 309.

About the Reset and Off buttons

Regardless of the selected mode, you will find two buttons labelled “Reset” and “Off” 
at the top of the extended channel strip. These have the following functions:

• Clicking the Reset button will set all parameters to their default values, and send out 
the corresponding MIDI messages.
For most parameters, the default values will be zero or “no adjustment”, but there are excep-
tions to this. For example, the default Reverb Send settings are 64.

• Clicking the Off button will set all controls to their lowest value, without sending out 
any MIDI messages.

XG 1 - Effects & Sends

The following controls are available when the XG 1 mode is selected:

Mode names Description

XG 1 - Effect & Sends Effect Sends and various sound control parameters for use with instru-
ments compatible with the Yamaha XG standard.

XG 2 - Global Settings Global settings for instruments compatible with the Yamaha XG stan-
dard.

GS - Effect & Sends Effect Sends and various sound control parameters for use with instru-
ments compatible with the Roland GS standard.

GS - Global Settings Global settings for instruments compatible with the Roland GS stan-
dard.

Off In this mode, no control parameters are available.

Control Description

Send 1 Send level for the reverb effect. 

Send 2 Send level for the chorus effect.

Send 3 Send level for the “variation” effect.

Attack Adjusts the attack time of the sound. Turning the knob to the left shortens the attack, 
while turning it to the right gives a slower attack. Middle position means no adjustment 
is made.

Release Adjusts the release time of the sound. Turning the knob to the left shortens the release, 
while turning it to the right makes the release time longer. Middle position means no 
adjustment is made.

Harm.C Adjusts the harmonic content of the sound. Middle position means no adjustment is 
made.

Bright Adjusts the brightness of the sound. Middle position means no adjustment is made.
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XG 2 - Global Settings

In this mode, the parameters affect global settings in the instrument(s). Changing 
one of these settings for a Track will in fact affect all MIDI instruments connected to 
the same MIDI Output, regardless of the MIDI Channel setting of the Track. There-
fore, to avoid confusion it might be a good idea to create an empty Track and use 
this only for these global settings. The following controls are available:

GS 1 - Effects & Sends

The following controls are available when the GS 1 mode is selected:

Control Description

Eff. 1 This allows you to select which type of reverb effect should be used: No effect (the 
reverb turned off), Hall 1-2, Room 1-3, Stage 1-2 or Plate.

Eff. 2 This allows you to select which type of chorus effect should be used: No effect (the 
chorus turned off), Chorus, Celeste or Flanger.

Eff. 3 This allows you to select one of a large number of “variation” effect types. Selecting “No 
Effect” is the same as turning off the variation effect.

Reset Sends a XG reset message.

MastVol This is used to control the Master Volume of an instrument. Normally you should leave 
this in its highest position and set the volumes individually for each channel with the 
volume faders.

Control Description

Send 1 Send level for the reverb effect. 

Send 2 Send level for the chorus effect.

Send 3 Send level for the “variation” effect.

Attack Adjusts the attack time of the sound. Turning the knob to the left shortens the attack, 
while turning it to the right gives a slower attack. Middle position means no adjustment 
is made.

Decay Adjusts the decay time of the sound. Turning the knob to the left shortens the decay, 
while turning it to the right makes the decay longer. Middle position means no adjust-
ment is made.

Release Adjusts the release time of the sound. Turning the knob to the left shortens the release, 
while turning it to the right makes the release time longer. Middle position means no 
adjustment is made.

Cutoff Adjusts the filter cutoff frequency. Middle position means no adjustment is made.

Reson. Adjusts the filter resonance. Middle position means no adjustment is made.

Press. Allows you to send out aftertouch (channel pressure) messages on the Track’s MIDI 
channel. This is useful if your keyboard cannot send aftertouch, but you have sound 
modules that respond to aftertouch. The default value for this parameter is zero, i.e. fully 
left.

Modul. Allows you to send out modulation messages on the Track’s MIDI channel. The default 
value for this parameter is zero, i.e. fully left.
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GS 2 - Global Settings

In this mode, the parameters affect global settings in the instrument(s). Changing 
one of these settings for a Track will in fact affect all MIDI instruments connected to 
the same MIDI Output, regardless of the MIDI Channel setting of the Track. There-
fore, to avoid confusion it might be a good idea to create an empty Track and use 
this only for these global settings. The following controls are available:

The global panel

To the left of the channel strips you find a couple of global controls:

• Write and Read buttons.
These are described in the section about automating your mix, see below.

• Solo indicator.
Lights up when you activate Solo for a Track. This serves to remind you that Solo is activated.

• Audio Mute button.
Clicking this button mutes all Audio Tracks. Click it again to unmute them. This feature is 
handy if you want to concentrate on mixing the MIDI Tracks.

Control Description

Eff. 1 This allows you to select which type of reverb effect should be used: Room 1-3, Hall 1-2, 
Plate, Delay or Panning Delay.

Para 1-4 Allows you to edit the four first parameters of the selected reverb effect.

Eff. 2 This allows you to select which type of chorus effect should be used: Chorus, Flanger, 
Short Delay or Feedback Chorus.

Para 1-4 Allows you to edit the four first parameters of the selected chorus effect.
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Automating the MIDI Track Mixer

All actions in the MIDI Track Mixer window can be automated in a very straightfor-
ward way: by “writing” them into a special “Track Mix” Part. When played back, this 
Part will repeat your fader and knob movements just like you performed them. You 
will even see the faders and buttons move on the screen, like on a physical mixer 
with motorized controls.

❐ As described in the chapter “More about Play Parameters and the Inspector”, it is also 
possible to “automate” for example volume, simply by entering different volume val-
ues for different Parts in the Arrange window. Since these volume changes are not re-
flected in the MIDI Track Mixer, this could cause some confusion. Our suggestion is that 
you stick to one method at a time: 
If you want to use the Volume and Pan settings in the Inspector, or if you want to insert 
“real” Volume and Pan Events in the Parts, don’t use the MIDI Track Mixer Automation. 
If you want to automate your mix in the MIDI Track Mixer, don’t enter any volume or 
pan settings in the Inspector or directly in the Parts.

Recording your actions

1. Open the MIDI Track Mixer window.

2. Click on the Write button in the upper left corner to activate recording.
While this button is “lit” (activated), every volume, pan, mute or effect setting you make will 
be recorded.

3. Start playback.

4. Move the faders and pan controls as you would during a manual mixdown.
Since you can repeat this recording several times, it is probably easiest to mix one or a couple 
of channels at a time, and stop and deactivate the Write function in between. That way, you 
can also Undo your last run if you’re not satisfied, using the Undo command on the Edit 
menu.

❐ Note that you can record Mutes but not the Solo buttons!
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5. Stop playback.
If you check the Arrange window, you will note that a special Mixer Track called “Track Mix” 
has been created. This Track contains one long Part named “Track Mix”, in which all your MIDI 
Track Mixer actions are stored. Don’t worry about the length of this Part; it will automatically 
be lengthened if you record past its end.
Please note that there is only one Track Mix Part/Track, created the first time you use the 
Write function in your Arrangement. No new Parts are created the next time you use the 
Write function; information is added to the existing Part instead.

6. Deactivate the Write function by clicking on the button.

Recording Mixer settings in Stop mode

The Write function works in Stop mode as well as during playback. If you activate 
Write when Cubase VST is stopped, all changes you make to your mixer parameters 
are recorded at the current Song Position. This feature can be used creatively if you 
need initial mixer settings, abrupt changes, etc.

Undoing your recording

If you select Undo from the Edit menu, all actions recorded since you last activated 
Write will be undone. Therefore, make it a habit to always deactivate Write after 
each recording “pass” and listen to what you recorded.

• If you find this too cumbersome, you can make separate Track Mix Parts for the differ-
ent MIDI Tracks or recording “passes”, and edit/delete these afterwards.
This is described on page 301.

Playing back your recorded Mixer actions

1. Check that the Track Mix Track or Part are not muted.

2. Activate the Automated playback by clicking on the Read button in the upper left cor-
ner of the MIDI Track Mixer.

You may have Write and Read activated simultaneously, if you want to watch and listen to 
your recorded mixer actions while you’re recording fader movements for another mixer 
channel, etc.

3. Start playback as usual.
The faders and controls will move automatically, following your recorded 
actions.
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About re-doing recordings

If you have recorded a mixer action that you’re not satisfied with, you can simply 
“overwrite” this by recording again. Proceed as follows:

1. Move the Song Position to before the section you want to re-record.
If there are several mixer actions to re-record, it might be a good idea to set up a cycle 
around the section.

2. Activate the Write button and start playback.

3. Click on the control you want to re-record, keep the mouse button pressed and move it 
as desired.
Keep the mouse button pressed during the whole section, even if you just want to set the 
control to a fixed value. This way, you make sure that all previously recorded control move-
ments are overwritten.

4. When you are finished, click Stop and deactivate the Write button.

Combining manual Mixing and Automation

Even if you automate the volume or pan for a MIDI Track, you can still make a man-
ual adjustment by dragging the fader/pan control in the MIDI Track Mixer. Just re-
member to leave the Write function off, or your movements will be recorded “on 
top of” the already recorded automation.

Moving and Muting the Track Mix Part

The Track Mix Part can be handled as any Mixer Part:

• If you want to turn off MIDI Track Mixer automation from the Arrange window, you can 
mute the Track Mix Part or Track.

• You can copy recorded mixer actions to several places in your Arrangement by cut-
ting out the relevant section of the Track Mix Part with the Scissors tool and duplicat-
ing it, placing the copies wherever you want them.

Working with more than one Track Mix Part

Although Cubase VST only creates one dedicated Track Mix Track, there is a way to 
structure your Mixer Automation into different Parts for different MIDI Tracks, 
which makes it easier to edit and redo mixer recordings you’re not satisfied with:

1. Record your fader movements and other mixer actions for the first MIDI Track, as de-
scribed on the previous page.

2. Deactivate the Write function and go to the Arrange window.

3. Make a new Mixer Track.
It might be a good idea to give it a name similar to the MIDI Track you just mixed, to avoid 
confusion later on.

4. Move the entire Track Mix Part to the new Track.
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5. Open the MIDI Track Mixer again, activate the Write function and record your mixer ac-
tions for the next “channel strip” in the Mixer.
Now Cubase VST creates a new Track Mix Part on the original, empty Track Mix Track. If you 
activate the Read function, your previously recorded Part will be played back from its new 
Track, so you can watch your recorded fader movements while you continue with new MIDI 
Tracks.

6. Repeat steps 2 to 5 for as many channel strips you like.
You will end up with a number of Mixer Tracks, all playing back simultaneously, affecting dif-
ferent MIDI Tracks in the MIDI Track Mixer. If you want to, you can keep it that way. If you like 
to clean up your Arrange window, you can put all the Mixer Tracks in a Folder Track (see page 
129), or Merge the Mixer Parts into one (see page 59).
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Editing the Track Mix Part

The Track Mix Part contains Mixer Events, which can be edited in the Controller Edi-
tor and/or the List Editor. The Controller Editor provides a graphic display and is very 
suitable for editing and drawing fader and knob movements. However, parameters 
with on/off values, such as the Mute buttons, can only be edited in List Edit.

Editing in the Controller Editor

1. Double click on the Track Mix Part in the Arrange window.
The Controller Editor opens. To the left, you will find all available parameters in the MIDI 
Track Mixer listed for each Track. A dot next to a parameter name indicates that there is data 
recorded for the parameter.

❐ Even though you only have recorded a single fader movement, you will find that all 
Volume and Pan parameters are marked with a dot. The reason for this, is that the first 
time you activate the Write function, the current values for all Volume and Pan param-
eters are written into the beginning of the Track Mix Part. All other parameters are 
only marked with a dot if they have been “touched” during the Write mode.
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2. Select the parameter you want to display, by clicking on it in the list to the left.
You can select several parameters by pressing [Command] or [Shift] and clicking (see page 
251).

Now, the recorded mixer actions for the selected parameters are shown graphically to the 
right in the Controller Editor.

3. Modify the mixer actions in various ways by using the tools, Cut and Paste, the func-
tions on the Do pop-up menu, etc.
This is all described in detail in the chapter “The Controller Editor”.

4. Press [Return] to close the Controller Editor.
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Editing in List Edit

1. Select the Track Mix Part in the Arrange window.

2. Open List Edit.

3. Pull the divider to the right so that you can see the Comment column.
This column shows which Mixer parameter (volume, pan etc.) and Track each Event controls.

4. Locate the Events you want to edit, and change their values in the Value 2 column.
For “switch” parameters such as Mute, value 127 represents “On” and value 0 represents 
“Off”.

• You can also use the Mask feature (see page 228) to display the Events for one parame-
ter only, and edit these “graphically” in the Value 2 display to the right in the editor, if 
you wish.
This display shows Value 2 for each Event as a horizontal bargraph.
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Customizing the MIDI Track Mixer

It is possible to add your own custom set of controls to the Track Mixer. The controls 
will appear on separate panels, selectable from the pop-up at the top of the ex-
tended channel strips. This allows you to for example add parameter knobs for your 
MIDI instruments, program selectors, effect parameters for non-GS/XG instruments, 
etc. Up to 32 panels can be created.

A custom panel.

There are two ways to create custom control panels: by using the MIDI Mixer or by 
creating a Track Mixer Script:
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Setting up a Track Mixer Control Panel in the MIDI Mixer

The method described below allows you to create your own Track Mixer control 
panel, by creating a “special” Mixer Map, which is then automatically included in 
the Track Mixer. Proceed as follows:

❐ This section assumes that you are familiar with the MIDI Mixer and the Mixer Map con-
cept. If not, please refer to the separate document “MIDI Mixer and Mix Tracks”.

1. Create a Mixer Track and select it.

2. In the Inspector, pull down the Mixermap pop-up menu and select “New Empty Map”.

3. Double click on the Mixermap name field in the Inspector and type in “TRACKMIXER”.
Make sure you type it exactly like that (without the quote marks, though). This makes Cubase 
VST recognize the Mixer Map as a Track Mixer control panel.

4. Create a Part on the Mixer Track, and double click on it.
The MIDI Mixer opens. There will be no controls, since you have an empty Mixer Map se-
lected.

5. Create the mixer objects you wish to include in the Track Mixer control panel.
How to create mixer objects is described in the separate MIDI Mixer document. However, 
there are a few things to note when you are creating a Track Mixer control panel:

• Set each mixer object to the same Master Group (1 or higher)!
Mixer objects with the same Master Group will appear on the same Control Panel in the MIDI 
Track Mixer.

❐ Mixer objects with Master Group 0 will not appear in the MIDI Track Mixer!

• You don’t have to care about MIDI Channel settings.
The controls will be rechannelized so that they send out MIDI messages on the MIDI channel 
selected for each Track in the Track Mixer.
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• You don’t have to care about the size and placement of the objects.
In fact, you only need to decide whether the object should be a knob or a fader (buttons will 
be shown as faders in the MIDI Track Mixer) and select a name. The name of the mixer object 
will be shown in the MIDI Track Mixer, regardless of whether you activate “Show Title” for the 
object or not.

6. When you have created the desired mixer objects, name the control panel by creating 
a text object and giving it the title you want for the control panel.
The actual text object will not be shown in the control panel, but its title will be shown on the 
MIDI Track Mixer “mode” pop-up, helping you quickly select the control panel you want.

7. If you want to create several different control panels, repeat the steps 5 to 6 above, but 
make sure to set the objects to another Master Group.
Again, it’s the Master Group setting that tells Cubase VST to put different objects in different 
control panels.

8. Close the MIDI Mixer.

9. Open the MIDI Track Mixer, and bring out the extended channel strip for a Track (by 
clicking the arrow button at the top of the strip).

10.Pull down the pop-up at the top of the extended channel strip.
Your newly created control panel(s) should now be listed there.

11.Select a control panel.
Your custom parameters are shown in the extended channel strip area.

• Note that you can select the same control panel for different Tracks.
The parameters will automatically send out MIDI messages on the correct MIDI channel.

Creating a Track Mixer Script

By writing scripts you can tailor your Track Mixer control panels to an even higher 
degree. For example, scripts allow you to give titles to different parameter values (so 
that, for example, a program change slider could display program names instead of 
numbers).

Creating Track Mixer Scripts is a very technical subject, closer to programming than 
to making music. If you feel you’re up to it, you will find a script template file and an 
example script in the folder “TrackMixer” within your Cubase VST CD-ROM folder 
“Scripts”. Open these in a text editor and experiment!



- 309 - 

What is GM/GS/XG?

General MIDI

General MIDI (GM) is a standard set up by the MIDI Manufacturers Association 
(MMA) and the Japanese MIDI Standards Committee (JMSC).

It defines a standardized group of sounds and the minimum requirements for Gen-
eral MIDI compatible synthesizers or sound modules, so that a specially prepared se-
quence or MIDI file that is sent to the instrument via MIDI will play back the correct 
sound types, regardless of make and model of the instrument.

MIDI identifies sounds by their program change number. Before the General MIDI 
standard was introduced, the same MIDI program change number often addressed 
totally different types of sound in any two synthesizers or sound modules from dif-
ferent manufacturers, eg a flute type sound in one instrument and a piano type 
sound in the other. 

With the introduction of General MIDI standard compatible instruments this 
changed. These instruments use the same program change numbers for the same 
types of instruments.

So, if the person that prepared a sequence or MIDI file wants the melody to be 
played by a “piano”, he can use a certain program change command embedded 
into the sequence to automatically select a piano sound in any GM compatible 
sound module. The GM standard does not specify in great detail how that piano 
should sound. It is simply assumed that the manufacturer reproduces an acoustic 
piano within the capabilities of the instrument.

General MIDI supports all 16 MIDI channels. Each channel can play a variable num-
ber of voices (thus be polyphonic). Each channel can play a different instrument (or 
sound, or program). A minimum of 24 fully dynamically allocated voices are simul-
taneously available for both melodic and percussion sounds.

Furthermore, in GM compatible instruments, percussion and drum instruments 
which are key-based always use MIDI channel 10 and specific note numbers are re-
served for specific drum sounds.

There are a number of other MIDI messages that GM compatible instruments should 
respond to. Among these are the MIDI controller events for Volume (Controller 7) 
and Pan (controller 10). By using these controllers it is possible to create a MIDI Mix 
for a piece of music.

Roland GS

This is a variation of General MIDI introduced by Roland. It defines additional stan-
dard procedures for selecting alternate drum kits and sound variations, and for set-
ting a number of other parameters in Roland GS compatible instruments. 

Yamaha XG

This is a variation of General MIDI introduced by Yamaha. It defines additional stan-
dard procedures for selecting alternate drum kits and for setting a number of other 
parameters in Yamaha XG compatible instruments. 
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24
The Audio Pool
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Introduction

Just as you can use the Finder to manage your files and folders, you use the Audio 
Pool to manage your audio segments and files.

The Audio Pool is opened by selecting it from the Panels menu.

Overview of the Window

The Audio Pool lists all the audio files in the Song. Please note that this means it 
shows the files for all Arrange windows that belong to the Song.

Files

Each file is represented by a line in bold text, preceded by a triangle. For each file 
there are a number of settings and information, plus a waveform image on the 
right side.

The files in the Audio Pool each represent an audio file on one of your hard disks 
that is (or has been) used in the Song.

Files are never used directly in the Song. Instead it is the “segments” that are played 
back from the Tracks.

Segments

For each file you have one or more segments. Segments are specifications for a sec-
tion of a file. An introduction to the concept of segments can be found on page 34.

Segments are mainly created when you record audio and when you edit in the Au-
dio editor.
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Displaying Segments

For one File

To display/hide the segments belonging to one file, click on the triangle preceding 
the file.

For all Files

• To Show all segments for all files, select Expand from the pop-up View menu.

• To Hide all segments for all files, select Collapse from the same menu.

• To toggle between showing and hiding all segments for all files, hold down [Option] 
and click on one of the triangles preceding the files.
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The Headings and Columns

For each file/segment you have a number of information and setting fields. The 
names for these are displayed in two rows of headings at the top of the window. On 
the following pages you find brief descriptions of each entry in the headers. Many 
of these are used in various operations described later in this chapter.

File Headings

To make it easier to see which heading corresponds to which item, only the File headings and 
the corresponding file items are shown in this picture (Segments are removed).

• There are also two additional columns called “Quality” and “Broadcast” - these are re-
lated to the RocketPower feature (see the separate RocketPower document).

File Heading Explanation

File Name The name of the file, on disk.

Disk The Disk the file resides on. If the file can’t be found, three question marks are 
shown instead (see page 321).

S/M Stereo/Mono - one bullet indicates mono, while two bullets indicate a stereo 
file.

F A tick mark indicates the file has been found, a crossed circle shows that it has 
not been found (see below). Clicking in this column lets you replace an audio 
file, as described on page 320.

Img This shows you the status of the waveform image for the file, see below.

Length This shows the size of the file in kilobytes.

Date and Time This shows the date and time the file was created.
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Segment Headings

To make it easier to see which heading corresponds to which item, only the Segment headings 
and the corresponding Segment items are shown in this picture (Files are removed).

Segment Heading Explanation

Hear To play the segment, click in this column (on the speaker symbol) and hold 
down the mouse button.

Segment (name) The name of the segment.

Start The segment’s Start Inset in the file. Displayed in samples, as a meter posi-
tion, or as time code, depending on the selected format (as described on 
page 316). This value can be changed, see below.

End The segment’s End Inset in the file. Can be changed.

Length The length of the segment. Cannot be changed.

SRate The Sample Rate of the file.

Range An overview of the segment in the file.
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Customizing the View

Hiding Headings

If you don’t need the Headings at the top of the window you can hide them using 
the “Show/Hide” item on the View pop-up menu.

Turning on and off Information

If you don’t need all the information fields for the files and segments, you can deac-
tivate these by clicking the “i” icon at the top of the window. Among other things 
this allows you to get a more detailed overview of the waveforms.

Use Part colors

If this item on the View pop-up menu is checked, the files and segments will be dis-
played with the colors of their respective Parts in the Arrange window.

Turning on and off Waveforms

If you don’t need to see the waveforms for the segments, you can hide them by 
clicking on the waveform icon at the top of the window.

Zooming and setting Sizes of the Waveforms

If you change the width of the window, the waveforms are scaled accordingly. That 
is, the bigger you make the window the more detailed view of the waveform you 
will have.

By using the vertical zoom control (below the scrollbar to the right) you can set the 
vertical size of each line, to get a better overview of the waveforms.
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Selecting Time Formats

You can set whether the Start, End and Length values should be displayed in sam-
ples, as meter positions, or as time code values, by clicking the Time Format button at 
the top of the window. Each time you click, the symbol in the button changes, and a 
new format is selected.

• If you select samples, the values are shown as numbers of samples. 
How many samples there are to a second, depends on the sample rate (48000 samples per 
second at 48kHz for example).

• If you select time code format, the values are shown in the format “hours:minutes:sec-
onds:frames:subframes”. 
How many frames there are to a second depends on the Time code Frame rate setting in the 
Synchronization dialog (typically 30 or 25).

• If you select meter position format, the start and end inset values indicate the start and 
end position of the first instance of the segment in the Song, as bars, beats and ticks.
If the segment is not used, the start inset will show 1.1.0 and the end inset will show the end 
position as it would be if the segment had really started on 1.1.0. 
The length value shows the length of the segment in bars, beats and ticks, starting with 0.0.0 - 
in other words the difference between the end inset value and the start inset value.

❐ Please remember that if you have meter position format selected, the End Inset and 
Length values are tempo dependent. That is, if you change the tempo, these values will 
change as well.

Setting File and Segment Order

File Order

On the View menu, you can determine in which order the files should be displayed:

Segment Order

By selecting “Order Segments” from the pop-up View menu, you re-arrange the 
segments so that they are shown in the order they appear in the file.

Option Description

By Name Files are shown alphabetically.

By Date Files are shown chronologically according to the time they were created, with the 
newest file on top.

By Size Files are shown in size order, with the largest one on top.

Sample format Time code format (“frames”) Meter position format
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Finding Out how a Segment is used in the Song

One segment can be used in more than one place in a Song. There are a number of 
situations where you will want to find out where a segment is used, for example:

• So that you can tell that a segment isn’t used anywhere and possibly delete it.
• If you want to know if a segment is used in more than one place, so that you can decide how 

editing the segment affects the Song.

Number of Times the Segment is used

Next to the speaker icon for each segment, you will see a number telling how many 
times in the Song this segment is used. A “greyed out” segment without numbers is 
not used anywhere.

Finding Out Where the Segment is used

1. Select one or more segment(s).

2. Select Find Parts from the Do pop-up menu.
Now the Parts that play the selected segment(s) get selected in the currently active Arrange 
window.

3. If desired, select Edit from the Edit menu, and the selected Parts are opened in the au-
dio editor for further examination.
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File Operations

Renaming a File

To rename a file, proceed as follows:

1. Double click on the existing name, or select the file and press [Option]-[N].

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

❐ Renaming a file this way is much preferred to renaming it from the Finder. This way, 
Cubase “knows” about the change and will not lose track of the file the next time you 
open the Song. See page 321 for details about lost files.

Locating a File on the Hard Disk

To find out where on the hard disk a certain file is located, hold down [Command] 
and click on the file. A pop-up showing you the file location appears.

Duplicating Files

To make a duplicate of an audio file, proceed as follows:

1. Select the file.

2. Pull down the File pop-up menu and select “Duplicate File”.
A file dialog opens where you can enter a name and location for the duplicate. To minimize 
the risk of Cubase VST “losing track” of your audio files, use this function instead of duplicat-
ing files in the Finder.
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Deleting Files

Removing from Audio Pool

If you want to remove one or more files from the Audio Pool without actually delet-
ing them from the hard disk, proceed as follows:

1. Select the file(s).
Selecting more than one is done just as with any other object in Cubase, by clicking in com-
bination with the [Shift] key.

2. Select “Delete Entry” from the Edit menu or press [Backspace].

• This way you can only delete Audio Files from the Pool which are not used in any Part 
in the Arrange window (and which are greyed out in the Pool).

Removing from the Audio Pool and deleting from Hard Disk

If you want to remove the file from the Audio Pool and also delete the file perma-
nently from the hard disk, proceed as follows:

1. Select the files.

2. Hold down [Command] and press [Backspace].
A dialog box asks you if you are sure you want to follow through. Remember that this opera-
tion can not be undone!

Deleting all Unused Files

This function finds all files in the Audio Pool that are not used in the Song, and 
removes them permanently from the hard disk.

1. Pull down the File pop-up and select Delete Unused Files.
If there are unused files in the Audio Pool, a dialog reminds you that the operation cannot be 
undone, and asks you if you want to go on.

2. If you change your mind, click Cancel. Otherwise, click OK.
Please note that you cannot undo this operation - make sure the unused files aren’t used in 
any other Songs!

Creating a Segment

You can create a “default” segment for the file, that is one that plays the entire file.

1. Select the file.

2. Select Duplicate Segment from the Do pop-up menu.
The new segment can be edited to play any part of the file (see page 324).



- 320 - 

Replacing a File in the Pool

There are situations when you may want to replace an audio file in the Pool with 
another, but keep all segments that are in use. As an example, consider the follow-
ing situation: 

You have used an external Wave Editor (see the chapter “Using an External Wave 
Editor”) to perform some dynamic or spectral editing on an audio file. To be on the 
safe side, you save the edited audio file under another name than the original. 
When you return to Cubase VST, you will want to be able to replace the original file, 
so that all segments reference to the new, edited audio file instead, and preferably 
be able to switch back if you change your mind. Proceed as follows:

1. Click on the symbol in the “F” column for the file.
A dialog appears, asking if you want to “Re-find” the file. Click “Yes”.

2. In the file dialog that appears, select the audio file that should replace the existing file 
in the Pool.
In our example above, this would be the edited version of the audio file.

3. A dialog appears, telling you that the file you selected has a different name or date 
than the original. Click OK to proceed.
The audio file in the Pool is now replaced with the one you selected in the file dialog. The 
segments keep their names and, if possible, their start and end inset positions. If you later 
want to switch back to the original file, just repeat the operation.

❐ Please note that the replacing audio file must be of the same length as the original file, 
for the segment start and end insets to be relevant! If you perform any editing that in-
volves changing the length of the file (such as time stretch, truncating, etc.), this 
method does not work, since you will have to create new segments.
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Handling “Missing Files”

When you open a Song, you may get a warning that one or more files are “missing”. 
If you click Ignore, the Song will open anyway, without the missing files. In the Audio 
Pool you can check which files are considered missing. This is indicated by a crossed 
circle next to the file (instead of the usual check mark) and three question marks in 
the Disk column.

A file is considered missing under one of the following conditions:

• The file has been moved to another folder or renamed in the Finder since the last time you 
changed the Song, and you ignored the Missing files dialog when you opened the Song.

• You have used the Finder to move, rename or change properties such as date for the file 
since you started the program this time.

Locating a missing file

1. Click on the crossed Circle.

2. In the dialog that appears, decide if you want the program to try the find the file for 
you (Auto) or if you want to do it yourself (Manual).

Auto

If you choose Auto, the program scans all your hard disks for a file with the proper 
name and creation date.

If Auto doesn’t work

Please note that Cubase is quite strict about identifying the files you use. Cubase re-
tains information on the Name and Creation Date of every file saved in a Song. If 
these values are changed by you, or a program you may be using, you will not be 
able to rely on Cubase's “auto-find” function. In this case you will have to use the 
“Manual” option and “over-ride” the subsequent warnings.

Manual

If you choose Manual, the program will display a file dialog allowing you to locate 
the file manually.

When you have found the file, click OK to replace the missing file in the Audio Pool. If 
the name or date is not identical to the missing one, the program will warn you but 
let you proceed. The next time during this session that the program attempts to 
search for a missing file, it will first look at the position of the last found file.

File is found 

File is missing 
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Creating Wave Images and Keeping them up to date

With each audio file goes an image, a picture of the waveform for display in various 
places in Cubase. The wave images are very useful, especially in the Audio editor 
when you are editing your files.

Wave images are created after you have completed recording, in a process that 
may take a few seconds. If you don’t want to wait for this to happen when you stop 
recording, this function can be turned off, by deactivating the “Use Waveforms” 
item on the Audio Setup submenu on the Options menu. The states of the wave 
image are indicated like this:

Updating the Wave Image

To update the wave image for one file, click on its icon.

Icon Description

The image is OK.

The file has no image.
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Segment Operations

The Audio Pool allows you to create new segments, slightly or drastically different 
from those you already have in your Song, and drag and drop these in the Audio 
editor, the Wave editor or the Arrange window.

Auditioning a Segment

From the Beginning

To audition a segment from its beginning, press and hold the mouse button with 
the pointer over the speaker icon to the left of the segment name.

When you press and hold the mouse button, the pointer turns into a loudspeaker symbol.

From any Position

To start playback from any position in the segment, click with the mouse pointer in 
the waveform to the right. Playback will start from the position you click on.

When you press the mouse button, the pointer turns into a loudspeaker symbol.

Renaming a Segment

To rename a segment, proceed as follows:

1. Double click on the existing name or select the segment and press [Option]-[N].

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].
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Duplicating Segments

To create a copy of a segment, proceed as follows:

1. Select the segment by clicking on it.

2. Select Duplicate Segment from Do pop-up menu.
The new segment appears in the Audio Pool.

Changing Start and End Insets

You can change the Start and End points of the segment. This allows you to change 
what part of the audio file the segment plays (this can also be done in the Audio ed-
itor, see page 353).

❐ Please note that this change will affect all places in the song where this segment is used.

By Numerical Editing

You can adjust the Start and End Inset values by regular value editing. See page 316 
for a description of the different time formats.

By Dragging

You can also drag the Start and End Inset directly in the waveform.

1. Position the pointer over the beginning or end of the segment.
If the segment currently plays the entire file, these two points are at the beginning and end 
of the waveform image.

2. Press the mouse button and drag left or right.

Moving the Segment

To move the segment within the file, without changing its length, proceed as follows:

1. Hold down [Command].

2. Position the pointer over the segment and drag left or right.
A dotted outline of the segment is shown while you are dragging.
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Deleting segments

Deleting one or several segments from the Audio Pool

1. Select the segment(s).
Selecting more than one segment is done just as with any other object in Cubase VST, by 
clicking in combination with the [Shift] key.

2. Select Delete from the Edit menu or press [Delete] or [Backspace].

• This way you can only delete Audio Files from the Pool which are not used in any Part 
in the Arrange window (and which are greyed out in the Pool).

Deleting all Segments not used in the Song (Purge)

To automatically delete all segments that are currently not used in the Song, select 
Purge Segments from the Do pop-up menu.

Creating Regions

Cubase VST can import Sound Designer II files, which can contain something called 
Regions. Regions are roughly equivalent to segments, in that they are a specification 
for a certain section of the file, a start and an end point. If you are working with a 
Sound Designer II file, you can turn one or more segments into Regions in the file:

1. Select the segments that you want to convert into regions.

2. Select “Save Segment as Region” from the Do pop-up menu.
If the file is of Sound Designer II type, Regions are now inserted into the relevant files. You can 
then use the Regions in a program that reads Sound Designer Regions.

❐ If you selected an AIFF file (which doesn’t support Regions), the program will tell you 
that it cannot insert the Regions.
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Deleting Unused Portions of Audio Files (Erase Unused)

“Erase Unused” allows you to “trim” down your Audio files so that they only contain 
the sections actually referenced by that file’s segment. This helps you maintain as 
much free space on the hard disk(s) as possible.

The idea behind this is that hard disk space is most often precious, and recorded si-
lence (for example) takes up as much hard disk space as recorded “noise”. When 
you adjust Start and End Points in segments to “hide” the sections of audio you 
don’t want to hear, you are still using up valuable disk space for those unheard bits. 
To “fix” this, use Erase Unused.

Which Parts of the Files are considered Unused?

Unused portions of a file are the sections not played back by any segment currently 
used in the Song.

These segments are each used in 
one place in the Song.

These segments are 
not used in the Song.
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Applying Erase Unused

❐ Erase Unused changes the contents of one selected audio file. If you use the file in an-
other Song, or if you want to be able to go back to the original recording, make sure 
you have a copy of the file before you begin!

1. Select either the file or one of it's segments.
This command works on “one sound file at a time”. For this function to work, two criteria 
have to be fulfilled:

• The audio file must be used by at least one Event somewhere in the Song.
• There must be some section of the audio file that isn’t used by any Segment (otherwise 

there’s nothing to erase, right?).

2. Select the “Erase Unused” command from the pop-up menu.
A dialog box will display how much of the original audio file will be kept, and ask you if you 
want to go on.

3. Click Compact.
First the unused Segments are deleted. Then a new audio file is created, containing only the 
used sections of the original file, “joined together” with only a short section of silence in be-
tween. New segments are created accordingly, and the audio file references in the Song are 
adjusted to use the new segments and file. Finally, the original audio file is permanently de-
leted from the hard disk.
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Importing Audio Files into the Audio Pool

From the Audio Pool you can import files created by other programs, or files you 
have created in another Cubase VST Song.

File Formats

Files in the following formats can be imported:

• Sound Designer II, Wave (WAV), Audio IFF (AIFF) or MP3.
• Mono or Stereo.
• Any Sample Rate.
• 16 or 24 bit resolution (if you are using Cubase VST/32, you can also import 32 bit float audio 

files).

❐ If you import files with another sample rate than the one used in the Song, they will 
play back at the wrong speed and pitch.

Proceed as follows:

1. Pull down the File pop-up menu and select Import Audio.
A file dialog appears.

2. Select a file format from the Show pop-up menu.
Files of the selected type(s) will be listed in the file dialog box.

3. Use the file dialog box to locate the file and select it.

• You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Playing” and the selected audio file is 
played back. To stop playback, click on the button again.

• You can select several files by using the [Shift] key.

4. Click “Open”.
Now, the File(s) will appear in the Audio Pool window, each complete with a segment which 
can be dragged into the Arrangement, as described above.

❐ You can also import audio files by dragging them from the Finder directly into the 
Pool.
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Importing Split Stereo Files

Apart from “normal” stereo interleaved audio files (where one file plays both chan-
nels), you may want to import a “Split” stereo recording, consisting of two mono 
files. If the two files have the same name, but with the characters “(L)” and “(R)” re-
spectively (or “.L” and “.R” respectively), you only need to select one of them for im-
porting - Cubase VST will automatically import the other file as well.

A Split Stereo file pair in the Audio Pool.

❐ The best way to add an imported split stereo recording to the Arrangement, is to drag 
one of the files directly into an “Any”-channel Part in the Audio Editor. The other file 
will automatically be added as well, and the two resulting Events will automatically be 
grouped and locked, positionwise.

Converting Sound Designer II files to AIFF files

As described above, Cubase VST can import SD II files, and some file operations in 
the program will also create SD II files. However, in some situations this may not be 
the desired file format:

• If you are planning to move projects or files to the PC (SD II files are not used by PC applica-
tions).

• If you are using the RocketPower feature for collaborating with other Cubase VST users over 
the Internet. This requires the audio files to be in AIFF or Wave format.

• If you want to edit or use the files in other applications that don’t support SD II.

For these reasons, you can convert SD II files by selecting them in the Pool and select-
ing “Convert SDII to AIFF” from the File pop-up menu. If you are uncertain of which 
files are of which format, you can simply select all files and perform the conversion - 
files in other formats are not affected.
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Exporting Files and Segments

You can export segments from the Audio Pool as individual files, for use in other 
applications:

1. Select the segment you wish to export.

2. Select “Export Segments” from the Do pop-up menu.
A file dialog appears.

3. Use the file dialog to find a location and name for the file.

4. Click Save.

Embedding Regions

If you are working with an imported Sound Designer II file, and want the segment 
to appear as a Sound Designer Region in the file, use the command “Save Segment 
as Region” before exporting. See page 325.

Dragging Segments into Other Windows

Introduction

To move segments into other windows, Cubase uses drag and drop techniques. 
You can do the following:

• Drag a segment into the Arrange window for use on any audio Track.
• Drag a segment into the Audio editor for detailed positioning on a Track.

General Procedure

1. Arrange the windows so that as much as possible of the window into which you 
want to drag the segment is visible, when you have the Audio Pool window active.

2. Position the mouse button over the name of the segment and press the mouse button.

A dotted rectangle appears around the name of the segment.
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3. Drag the segment out of the Audio Pool window and release it somewhere on top of 
the other window.

In this example the segment is dragged to the Arrange window. A new Part is then 
created, containing an Event which plays the segment you dragged.

Dragging into the Arrange Window

When you drag into the Arrange window, you must release the segment on an Au-
dio Track. When you do this, you get the following:

• A new Part, beginning at the position you pointed at when you released the mouse button. 
The Snap value applies as with all editing in the Arrange window.

• Inside this Part is one Audio Event which plays the segment.
For more information on Audio Events and their relation to segments, see page 34.
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Dragging into the Audio editor

When you drag into the Audio editor there are a few things you should be aware of:

• The mouse position in the Audio editor shows you where you are about to “drop” the seg-
ment. The Snap value applies as always.

• If the Track is set to channel “Any”, or if you are editing several Parts, it matters very much 
which “lane” you put the segment on, since each lane uses its own audio channel, as de-
scribed on page 339.

• When you “drop” the segment in the Audio editor, an Audio Event that plays the segment is 
created and appears in the window.
For more information on lanes, audio events and other Audio editor concepts, see page 338.

Insert at Record Position

This function allows you to insert an audio file into the Arrangement on the active 
Track, at the position where it was originally recorded. This is useful if you remove a 
recorded file from the Arrangement, either by accident or while editing the music, 
and find out that you want to put it back again.

❐ This is only possible with audio files recorded in Cubase VST 4.1 or later. Files recorded 
in previous Cubase VST versions (or in other audio applications) do not contain any 
Record Position information.

Proceed as follows:

1. Select the Audio Track on which you want to insert the file.

2. Open the Pool and select the audio file you want to insert.

3. Pull down the Do pop-up menu and select “Insert at Record Position”.
The audio file is placed on the selected Track, at its original recording position.

Banish Silence

This function, found on the Do pop-up menu, can also be accessed from the Audio 
editor. See page 379 for an explanation of how to use this function.
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Preparing File Archives and “Masters”

Prepare Archive

This function on the Audio Pool File pop-up menu takes all the audio files used in 
the Song (or, if you wish, all the audio files in the Audio Pool, regardless of whether 
they are used or not) and puts them in a new folder that you specify. This folder can 
then easily be backed up to another disk or other media, using normal copy com-
mands or any backup utility program.

1. Select Prepare Archive from the Audio Pool’s File pop-up menu.
A file dialog appears where you specify a name and location for your new archive folder.

2. Click Save to create the folder.

3. In the new dialog that appears, specify if you want to include All the files in the Audio 
Pool, or only those that are Referenced (actually used in the Song). 
All the sound files are now copied to the selected folder.

4. Save the Song, preferably in the new folder.

Prepare Master

This option takes all the audio files used in the Song, extracts only the used bits of 
each audio file and stores this into new files. The result is a new set of files that play 
back the Song just as before, but now only contains the portions of audio which ac-
tually appears in the song. The Song is also updated to play the new “trimmed” files. 
In a sense, the function is a composite of other Cubase VST operations, those being 
“Purge Segments”, “Erase Unused”, and “Prepare Archive” (with the “Referenced” 
option selected). 

The Prepare Master operation is entirely non-destructive, in that no audio files will 
be erased from your hard disk, new files are created for all the material. Please note 
the following:

• This procedure cannot be Undone.

• Since new files are created, it requires that you have sufficient space on your destina-
tion hard disk.
You will be warned should there be insufficient free space to complete the operation.

Using Prepare Master

1. Make sure your Song is saved.
After the operation, the Song is altered, so this is an important step if you also want to save 
the Song as it is now.

2. Select “Prepare Master” from the Audio Pool’s pop-up File menu.
A dialog box appears, telling you that this operation cannot be undone.

3. A new dialog box appears informing you that you need to create a new folder. 
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4. Use the file dialog that appears to specify a name and location for the new folder, and 
click Save.
The software now examines your use of the audio material in the Audio Pool, discards any-
thing which is not used, and then proceeds to create new audio files which corresponds to 
the sections of the existing material. All the new files which are created are named automat-
ically. The software also creates new segments which play these new files, and swaps these 
in automatically.

5. Save the Song, preferably in the new folder.
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Saving and Loading the Audio Pool

The Audio Pool is automatically saved with the Song or an Arrangement. However, 
by using the Load and Save Audio Pool commands on the pop-up File menu, you 
can freely save Audio Pools and load them into Songs. 

Saving

1. Select Save Pool from the File Pop-up menu.

2. In the dialog box that appears, specify if you want to save all files and segments, or just 
the selected ones. 

3. In the standard dialog box that appears, specify a name and a location for the file.

An Audio Pool document as it looks in the Finder.

❐ The audio files themselves are not saved in the Pool file, only a reference to them. You 
should probably not move any audio file(s) until next time you want to use the Pool. 
You should definitely not delete them!

Loading

An Audio Pool file is opened (loaded) with the Load Pool command on the File pop-
up menu. When you load a Audio Pool file, the files in it are “added” to the current 
Audio Pool.
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25
The Audio Editor
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Introduction

The Audio editor is your main environment for editing, trimming and assembling 
audio recordings into finished Tracks.

Many of the techniques described below are common to the Arrange window and 
the MIDI editors (mainly Key Edit). Examples of such operations are moving, duplicat-
ing, using Tools etc. Therefore this chapter assumes that you are reasonably familiar 
with such basic operations and does not always describe all the details involved.

Opening the Audio editor

The Audio editor is opened just like any other editor, by double clicking on an au-
dio Part or by selecting “Edit” on the Edit menu. You can edit Audio Parts from sev-
eral Tracks at the same time, if desired.

❐ You can only have one Audio editor window open at a time.

About Events, Lanes and Segments

❐ Please take the time to read this section and familiarize yourself with the terminology 
and concepts of the Audio editor. This will help you work as quickly and effectively as 
possible. Bear with us, we’ll try to be as brief as possible in this theoretical section.

Audio Events and Segments

Audio Events appear as boxes, with waveforms in them. You can have a virtually 
unlimited number of Events in the Audio editor at one time; they do not consume 
more memory than MIDI Events.

Audio Events can be arranged in any way, with gaps between them, overlapping 
each other, etc.

An Event plays a Segment (for an introduction to Segments, see page 34). The Audio 
Event specifies where the Segment should start. The Segment in turn specifies what 
part of the audio file should be played, and therefore effectively governs the length 
of the Audio Event.

• If you want two Events to play the same segment, you can use ghost copies. 
A ghost copied Event will play the same segment as the original Event. See the chapter “Mak-
ing the Most of the Event/Segment Relationship”.
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Lanes

When you first open the Audio editor you will note that it is divided into something 
we call “Lanes”.

Lanes bear some resemblance to Tracks in the Arrange window. On each Lane you 
can have as many Audio Events as you like. You might think of your Audio Events as 
“hangers” for the recordings you have made. In this analogy, the Lanes would be 
the “rails” on which the hangers are positioned.

When Editing A Single Channel Track

If the Track is set to play back on one specific audio channel, in the Arrange window 
(as opposed to being set to channel “Any”), the Lanes all have equal value.

You can move the Events between the Lanes as you like, and add new Events on any 
Lane. Playback is not affected by which Lane an Event is on. The only reason for you 
to use more than one Lane when editing a single channel Track is if you find that it 
gives you a better overview of what is going on.

Remember that in a single channel Track, all Events “compete” for one single (mono-
phonic) audio channel. That is, if they overlap timewise, they will cut each other off 
during playback, even if they are on different Lanes.

When the lower Event starts, the sound of the upper Event will be cut off.
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When Editing a Stereo Track

Stereo recordings occupy two lanes. These two lanes use one audio channel each 
(one for each side in the stereo pair). Otherwise editing stereo Tracks is not much 
different from editing mono Tracks.

When Editing an “Any” Channel Track

If you are editing a Track set to channel “Any”, each Lane will represent one of the 
available audio channels. Which audio channel each Lane “uses” is indicated by a 
number on the left side of the window.

If you set your view so that you see many Lanes (see page 344), you will note that 
the channel numbers start repeating as you move down the window. For example, 
in a four channel system, the first four Lanes are numbered 1 to 4, then next four 
Lanes are again numbered 1 to 4 and so on.

As with a single channel Track, all Lanes that use the same channel have “equal 
value”. It does not matter which of them you put your Audio Events on.

By moving an Event between Lanes with different channel numbers, you change 
which audio channel the Event is played back on.
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When Editing Several Tracks

If you open several Parts on different Tracks at the same time in the Audio editor 
you will also get Lanes with multiple audio channels. How many different channels 
and exactly which ones, depends on what audio channels the Tracks are set to.

Editing Parts on three Tracks with different audio channels.

As you will learn later on in this chapter, the Audio editor Lanes can be used as a 
means of moving Events between audio channels and even between Tracks!
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Which Audio Events will I Hear?

If any two Events in your Arrangement try to play back on the same audio channel at 
the same time, only one of them will be heard. This is shown in the pictures below:

The “1st Part” Event is cut off by the “2nd Part” Event.

The ”MainBeat” Event is cut off by the ”Fill-in” Event. After the end of this shorter Event, the 
”MainBeat” Event will be heard again.

Finding Out How Events compete for Audio Channels

In case there is one recording that doesn’t play back as intended, you may want to 
check whether several Events “compete” for an audio channel. Proceed as follows:

1. Select all the Parts you think might compete for audio channels.
This may very well mean selecting Parts on several Tracks.

2. Open the Audio editor, displaying the selected Parts.

3. Select “By Output” from the View pop-up menu in the Audio editor.

Now, all Events that play back on the same audio channel are put on the same Lane, 
regardless of whether they are on different Tracks or on the same Track.

4. Check for overlapping Events along the Lanes. 
If there are any, some audio will be cut off at those points.

❐ Often it is desired to have overlapping Events, for example when you have performed a 
punch in on a Track, to correct a mistake in a vocal part or similar (the punch in recording 
overlaps and therefore hides the original, faulty recording). But then again you might 
accidentally get overlapping Parts, and this feature helps you find those overlaps.
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About Zero Crossings

If you are familiar with audio editing from other digital systems you will know that 
splicing two audio files together might create a “click” just at the split point. This is 
because the two signals happen to have a different amplitude (level) at this point 
which creates a transient (a sudden and dramatic change in signal level).

One way to avoid this is to always make all edits at “zero crossings”.

An analog waveform is a voltage rising and falling around a center axis. This center 
axis is considered “zero” voltage. As indicated in the picture, a zero crossing is when 
the signal passes through this center axis.

To automatically make all edits happen at the closest zero crossing, activate Snap 
To Zero on the Audio Setup submenu on the Options menu. When Snap To Zero is 
activated, the following operations always occur at the closest zero crossing:

• Changing Start and End Insets.
• Splitting Event in the Audio editor.
• Splitting Parts in the Arrangement (the Events in the Parts are split at zero crossings).
• Using Snip Loop (in the Audio editor).
• Using Banish Silence (in the Audio editor or from the Pool).

❐ Note that Snap To Zero only works with mono audio files.

Zero crossings
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Zero Crossing Example

Here, an Event has been split in two places, with Snap to Zero off. When the two sections are moved 
together...

...the result will be a transient, probably causing a “click” or other undesired sound.

Here, an Event has been split in two places, with Snap to Zero activated. When the two sections are 
moved together...

...a fairly seamless splice is created.
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Customizing the View

There are a number of features you can use to tailor the Audio editor view to your 
liking:

The View Menu

The View pop-up menu allows you to select what will be displayed in the Events 
and on the Lanes:

Waveforms

This turns the display of waveforms on and off in the editor. Deactivating this 
speeds up screen redraws.

Names

This turns the display of Segment names in the Events on and off.

Handles

This allows you to decide if you want to see the Start, End and Q-point handles in 
the Events. See below.

By Output

By selecting this item you sort your Events so that all Events that play back on the 
same audio channel are put on the same Lane. See page 338 for details.

Lane Info

This shows/hides the display to the left of each Lane that tells what audio channel 
the Events on the Lane play back on.
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Dynamic Events

If this item is activated, the lower half of each Event displays one of these three 
alternatives:

• The Volume curve for the Event.
• The Pan curve for the Event (see page 387 for descriptions on how to edit Volume and Pan).
• The M-Points (Match Points) for the Event (see page 367).

You determine which of these three Event types is shown, by using the pop-up to 
the right of the To pop-up menu.

A Volume curve:

A Pan curve:

Match Points:
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Magnification

The Magnification controls on the scroll bar can be used to set the amount of detail, 
both horizontally and vertically.

• Zooming in all the way horizontally allows you to see the waveform in ultra-high resolution: 
one sample per pixel (screen “dot”).

• Zooming in vertically makes the Lanes “higher”. This is convenient for example for detailed ed-
iting of Volume and Pan.

Time/Meter Scale and Ruler and Position Formats

Time/Meter Scale

By clicking the Meter Scale button you can decide if the display and the ruler should 
show time or meter linearly:

• In a time linear display, each “second” on the screen occupies equal amount of space, horizon-
tally. This is convenient if you are working with time related material, such as for example narra-
tion or sound effects to be matched to video.

• In a meter linear display, each bar on the screen occupies equal amount of space, horizon-
tally. This is the mode to use if you are working with musically related material.

Ruler and Position Formats

By clicking on the mouse box you can determine whether the rulers and the mouse 
position box should be displayed in time code (SMPTE) format or as bars and beats, 
as in the Arrange window and some of the MIDI editors (see the Basic Methods 
chapter in the Getting Started book).

• Normally, you would match the Time Meter Scale and Ruler formats so that they are 
both set to Time or Meter positions.

• If you set the display to Time Scale and the Ruler to Meter positions, the ruler will not 
be linear. 
That is, if you have tempo changes, there will not be equal spacing between the measures. 
This is natural, since if the measures are played at different tempo, they occupy different 
amounts of “real time” (minutes, seconds etc.)

• If you set the display to Meter Scale and the ruler to Time positions, the same phenom-
enon occur: If you have tempo changes, the ruler will not be “linear”.
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Using Color in the Audio Editor

The Events in the Audio editor can be displayed in color to help you distinguish 
between audio channels, etc. This is done by using the color pop-up menu. 

There are three options on this menu:

No Color

Select this option if you don’t want any color for the Events.

Color by Channel

If you select Color by Channel, Events on different audio channels will get different 
colors. This is useful if for example you are editing a Track with channel “Any”, and 
viewing several Events by Output.

Color by Part

If you select Color by Part, the Events in the editor will get the color that you have 
selected for their respective Parts in the Arrange Window. This allows you to distin-
guish Events from different Parts on the same audio channel, even if View by Out-
put is selected on the View pop-up menu.
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Recording in the Audio editor

Recording from within the Audio editor is no different from recording in the Arrange 
window. If you are editing several Parts at the same time, you will be recording into 
the “active Track”.

• The active Part is indicated by the window title.
To activate another Part, click in the Lane Info field for that Part.

The active Part
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Importing and Dragging Audio into the Editor

About Stereo/Mono files and Track Types

There are some restrictions to which files you can drag or import, depending on the 
type of Track you are editing:

Dragging Audio from the Pool

As described on page 330 you can drag Segments from the Pool window into the 
Audio editor. This creates an Audio Event in the edited Part, that plays back the 
dragged Segment. Here are some points to keep in mind:

• The mouse position in the Audio editor shows you where you are about to “drop” the Seg-
ment. The Snap value applies as always, using the Q-Point in the Event as position reference.

• If the Track is set to channel “Any”, it matters very much which “Lane” you put the Segment 
on, since this determines which audio channel the Event will play back on.

• If the Segment is already used (as indicated by the number beside the speaker symbol in the 
Pool), the created Audio Event will be a Ghost Event (see the the chapter “Making the Most of 
the Event/Segment Relationship”).

Dragging Audio from the Finder

Just as you can drag segments from the Pool, you can drag audio files directly from 
the Finder into the Audio Editor. The file will automatically be added to the Pool (if 
it wasn’t already there), and a new segment will be created, that plays the whole file 
(if such a segment didn’t already exist, in which case a Ghost Event will be created 
instead). Otherwise, the same rules apply as when dragging from the Pool.

This type of file... ...can be imported to this type of Track

Mono files Mono Tracks and “Any” channel Tracks

Stereo Interleaved files Stereo Tracks

Stereo Split files “Any” channel Tracks
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Importing Audio Files

You can import files created by other programs. You can also import files you have 
created in another Cubase VST Song.

File Formats

Files in the following formats can be imported:

• 16 or 24 bit Wave (WAV), Audio IFF (AIFF), Sound Designer II or MP3 files.
• The Sample Rate currently used in your Song (if you import files with another sample rate, 

they will play back at the wrong speed and pitch).
• Mono or Stereo (interleaved or split).
• If you are using VST/32, you can also import 32 bit files.

Importing the File

1. Set the Snap value as desired.
As always, the Snap value restricts what positions you can put the file on.

2. Select the Pencil from the Toolbox.

3. Click at the position where you want the Event to start.
If you are editing an “Any” channel Track or several Parts on different channels, remember to 
click in the Lane on which you want to put the Event.

• You can click somewhere on an existing Event, which means the two Events will over-
lap.
The only place where you should avoid to click is in another Event’s volume, pan or Match 
Point graph, since this will change the graph rather than import an Event.

4. In the file dialog that appears, use the “Show” pop-up menu to select the type of file to 
import.

5. Locate the audio file and click “Open”.
A new Event is inserted in the Audio Part. If you check the Pool, you will find that the im-
ported audio file has been added, together with a segment that plays the full file.

• If you import a split stereo file, the two Events are automatically Grouped (see page 
377).



- 351 - 

Auditioning and Scrubbing

There are a number of techniques for monitoring Events, to aid you in finding posi-
tions for editing operations:

Auditioning

This allows you to play back an Event from any position, at its “normal speed”: 

1. Deactivate the Scrub icon on the Status Bar.

Auditioning mode.

2. Select the Speaker Tool from the Toolbox.

3. Click on an Event.
The Event is played back from that point as long as you hold the mouse button down. 

Scrubbing

This allows you to play the Event back at practically any speed, forwards or back-
wards. This is convenient when trying to find a certain point to perform some edit-
ing at, such as splitting, changing Insets etc. The Scrubbed audio is not affected by 
Dynamic Events or any VST Channel Mixer settings, only by the VST Master Mixer 
faders.

1. Activate the Scrub icon on the Status Bar.

Scrub mode.

2. Select the Speaker Tool from the Toolbox.

3. Press the mouse over an Event and drag sideways.
The faster you move the pointer, the higher the playback speed. If you drag to the left, audio 
will be played backwards.

Monitoring Settings

If the Speaker icon is activated, certain operations will give you audible feedback, 
namely:

• Changing Start and End Insets.
• Setting Q-points.

If you perform one of the above actions with the Speaker icon activated, a short 
section of the segment will be played back, allowing you to monitor your edits. If 
you move the Start Inset, you will hear a short section from the Start Inset and on-
wards. If you move the End Inset you will hear a short section up until the End Inset.
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To set the desired length of the played section, proceed like this:

1. Hold down [Command] on the computer keyboard.

2. Click on the Speaker icon.
A small pop-up menu appears.

3. Select one of the options on the menu.

Editing on the Info Line

Like other editors, Audio Edit has an Info Line.

1. Make sure the “i” button on the Status Bar is activated.

2. Select one or several Events.
If a single Event is selected, the values are displayed in yellow; if more than one Event is se-
lected, the values are displayed in white.

3. Adjust the values as described in the table below:

• If more than one Event is selected, the changes are applied in relation to the original 
value for each Event.

Heading Description

Start Start Position. Adjusting this moves the Event.

End End Inset. Adjusting this shortens or lengthens the Segment played by this Event.

QPoint Q-point. Adjusting this moves the Q-point. See page 357.

Segment Segment name (not shown if more than one Event is selected). If you change this, 
this is reflected in all Events that play the segment, and in the Pool.

File File name (not shown if more than one Event is selected). Changing this means that 
the actual audio file on the hard disk is renamed.

Chan The audio channel the Event plays on (not shown if more than one Event is selected). 
This cannot be changed on the Info Line.
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Changing Start and End Insets

Each Event has a Start and End Inset which represent the Segment start point in the 
audio file, and its length. Handles for adjusting these are visible in the upper and 
the lower corners (respectively) of the Events if the “Handles” option is ticked on 
the pop-up View menu.

Checking if the File plays from the beginning

The shape of the handle indicates what the Event actually plays:

❐ The handles do not actually have to be shown for you to move the Insets. It is sufficient 
to click and drag in the upper left and lower right corner, respectively.

If the Event doesn’t fit in the Window

Even if the Event doesn’t begin or end inside the window, the Start and End Inset 
symbols will be visible at the edges of the window. If you have long Events, this al-
lows you to see the “status” of the Insets (as described above) without scrolling the 
view.

Symbol Description

If this symbol appears at the beginning of the Event, it means that the Event plays the 
audio file from the beginning.

If this symbol appears at the beginning of the Event, it means that the Event plays the 
file from some point later than the absolute beginning of the file. The Start Inset has 
already been adjusted.

If this symbol appears at the end of the Event, it means that the Event plays the audio 
file to its end.

If this symbol appears at the end of the Event, it means that the Event does not play 
the file to its absolute end. The End Inset has already been adjusted.

The Start and End Inset symbols are shown even if the Event extends 
across the window boundaries.
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Changing the Start Inset

The Start Inset is adjusted by dragging in the “upper left corner” of the waveform 
part of the Segment. Usually, you will point at the handle, click and drag, but the 
handle does not actually have to be shown (hide/show it with the View pop-up 
menu, if you like).

❐ The Insets do not “snap” to the closest snap value.

The Start Inset can also be changed numerically from the Info Line.

Position the pointer in the upper left corner of the waveform...

...and drag the Inset left or right.
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What happens when you Change the Start Inset?

Changing the Start Inset adjusts from which point in the file the Segment plays; it 
“hides” more or less of the beginning of the file. It does not move the audio in the 
Song. Note the difference between changing the Start Inset and moving the Event:

Before moving the Event:

After moving the Start Inset:

Before moving the Start Inset:

After moving the Event:
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Changing the End Inset

This is done just as changing the Start Inset, only you click or drag in the “lower right 
corner” of the waveform. Changing the End Inset adjusts the Length of the Event; 
that is, it hides more or less of the end of the file.

The End Inset can also be set numerically on the Info Line.

Changing the Insets with a single click

If you click somewhere along the very top edge of the segment (though not on the 
segment name) the Start Inset will immediately be set to that position. Likewise, 
clicking at the bottom edge of the segment moves the End Inset.

About Snap to Zero

If the option “Snap To Zero” in the Audio Setup menu is enabled, all offset adjust-
ment will be followed by an automatic “search for a zero crossing”. This option will 
always make the resulting Segment very slightly smaller than it was when you re-
leased the mouse button. For more info on Zero Crossings, see page 342.

❐ Grouped Events do not Snap to Zero.
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Working with Q-Points

Introduction

Why Q-points?

Each Event has a Q-point that is used for snapping the Event to musical positions.

The concept behind this is that with audio, as opposed to MIDI, the beginning of the 
Event might not occur at a musical position at all, there might for example be a sig-
nificant amount of silence at the beginning of the recording.

This means that snapping the beginning of the Event to a musical position nor-
mally doesn’t make much sense. Hence Q-points. These allow you to specify a posi-
tion in the Segment which is to be taken as its first “musically significant position”, 
the first down-beat for instance.

When are Q-Points used?

The program uses Q-Points in the following operations:

• When moving Audio Events (the Q-Point snaps to the closest Snap value).
• When Quantizing (see page 370).
• When you drag a Segment from the Pool, into the Audio editor or the Arrangement (the Q-

Point is used to snap the position of the Event to the closest snap value).

Displaying and Hiding Q-Points

For the “Q” handle in an Event to be visible, the “Handles” option must be activated 
on the View pop-up menu.

The Q-point.
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Adjusting Q-points

Manually

• Snapping does normally not apply to “Q” handles, they can be put at arbitrary positions 
within the Segment.

• If you specifically want the Q-Point position to snap to the closest Snap value, hold down 
[Command] while dragging it.

• You can edit the Q-Point position on the Info line. The value is in sixteenth notes and ticks 
counting from the Start Inset.

If you turn on the Speaker icon, a short section of the Segment, from the Q-point and 
onwards will play whenever you move the Q-point. This auditioning takes place at 
full volume. You can set the length of the section to be played back, as described on 
page 351.

Automatically

For newly created Events the Q-point is set automatically as follows:

When you do this The Q-point is set at

Record with Prerecord turned on in the 
Metronome dialog (see the Getting Started 
book).

Exactly the point you specified for the recording to 
start at. However, the actual recording starts slightly 
early to preserve the attack (in case the performer 
started slightly early).

Record with Prerecord off. The nearest sensible bar or beat position.

Punch in manually. The closest beat.

Drag Audio into the Editor. The nearest sensible bar or beat position.

Split an Event with the Scissors. The Segment that contains the existing Q-point after 
the split is not affected. The other Segment gets a Q-
point at the nearest sensible bar or beat position.

Drag Start and End Insets beyond the 
existing Q-point.

The nearest sensible bar or beat position.



- 359 - 

Moving Audio Events

By Dragging

Audio Events are moved just like other objects in Cubase:

1. Select the Arrow Tool.

2. Select all Events you want to move.

3. Press and hold the mouse with the arrow pointer over one of the selected Events (not 
in the handles) and move the mouse.
The mouse box shows you where the Q-point of the first selected and dragged Event will 
wind up when you release the button.

4. If you want to restrict movement to horizontal or vertical only, hold down [Shift] while 
dragging.

5. Release the mouse button, and the selected Events are moved to the new position. 

The Snap function applies, positioning the Event so that its Q-point gets aligned with 
the closest Snap value.

Between Lanes

• If you are editing a single-channel or stereo Track, moving the Event to another Lane 
has no effect on playback. Still, you might want to organize your view of the Events, by 
moving Events between Lanes.

• If you are editing one Track set to channel “Any” you can use this feature to set which 
channel an Event plays back on.
Check the channel indicator on the left side of the window to find out which channel each 
Lane plays back on.

• If you are editing a number of single channel or stereo Tracks simultaneously, moving 
Events between Lanes means you are moving the Events between Tracks.
You can identify the Tracks by which channel they each are set to, as described in the previ-
ous paragraph.

• If you hold down [Shift] while dragging, moving is restricted to vertically or horizon-
tally only (depending on in which direction you dragged first). 
This allows you to move the sound to another Lane without affecting Start position.
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Moving By “Nudging”

You can “nudge” an Event one Snap value at a time, forward or backwards in time. 

1. Select the Nudge tool from the Toolbox. 

2. Set the Snap value to the distance you want to move the Event, with each “nudge”.

3. Position the pointer over the Event you want to move.

4. Click on the Event to move it to the left.
To move the Event to the right, press [Option] and click. 

Duplicating and Repeating Events

Duplicating

There are two slightly different ways of duplicating audio Events:

• Creating a “real copy” also creates a new Segment, which means the two Events are totally 
independent. That is, if you for example change the Start Inset of one of them (in the Editor 
or in the Pool), the other is not affected.

• If instead you create a “ghost copy”, it will use the same Segment as the Event it was created 
from.

Creating Real Copies (New Segments)

1. Select the Event(s) you want to duplicate.

2. Hold down [Option] and drag to the new position.
Everything else is as when moving, see above.

3. Preferably rename the new Segment, to avoid confusion in the Pool (see page 352).
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Creating Ghost Copies (No new Segments)

1. Select the Event(s) you want to duplicate.

2. Hold down [Command] and drag to the new position.
Everything else is as when moving, see above.

Ghost Copies are shown “greyed out”. Please note that the original Event is also 
“greyed out” - the program doesn't differentiate between the “original” and the 
ghost, they are all considered ghost copies of each other.

About Editing Ghost Events

• If you make any changes to the Segment in the Pool, this will equally affect all Ghost 
Events that play this Segment.

• However, if you make changes to the Start and End Insets of one of the ghost Events in 
the editor, this Event will be turned into a real Event, and a new Segment will be cre-
ated for it.

• If you specifically want to make Start and End Inset Changes that will affect all the 
Ghosts that play the same Segment, hold down the [Command] key while editing 
any of those Events.

❐ Read more about working with Ghost copies in the chapter “Making the Most of the 
Event/Segment Relationship”.
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Repeating Events

To repeat Audio Events, use the Repeat command on the pop-up Do menu. This 
works just as the Repeat command in any of the MIDI Editors, see the chapter “The 
MIDI Editors - General Information” in this document.

This function is used to repeat one or several Audio Events until the end of the Part. 
The result of the Repeat operation depends on the setting on the To pop-up menu:

• If the To pop-up menu is set to “All”, all Events in the edited Part will be repeated to fill 
out the Part.
The whole “block” of Events is repeated end to start.

• If the To pop-up menu is set to “Selected”, only the selected Events are repeated.
The repeated Events will replace any other Events in the area.

• If the To pop-up menu is set to any of the Loop or Cycle options, the Loop/Cycle is used 
to define the “repeat cycle”.
The “block” of Events are repeated starting at the end position of the Loop/Cycle, and with 
each repeated “block” spaced according to the length of the Loop/Cycle.

As above, with the “Selected” Loop or Cycle options, only selected Events within the Loop/
Cycle are repeated.
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Repeating Any Section of Audio

By combining a few commands in the Audio editor, you can repeat any section of 
audio:

1. Set up the Loop so that it plays the section to be repeated.

2. Use Snip Loop (on the pop-up Do menu) so that the Events that fall inside the Loop are 
split at the Loop Start and End points.

3. Make sure that the To pop-up menu is set to “Looped Events”.

4. If you want to delete the snippets of audio outside the loop, select Keep from the pop-
up Do menu.
Only the selected Events are kept.

5. Select Repeat from the Do pop-up menu to repeat the selected Events.

Using Cut, Copy and Paste

Cut, Copy and Paste can be used to move and duplicate Events just as in any MIDI 
Editor.

• When you are editing several Parts on different Tracks, you determine which Part to 
Paste into by clicking in the Lane Info field for the Part.
By clicking in the Lane Info field you make the Part “Active”.

The currently Active Part is indicated by the Editor's window title.

Clicking here... ...activates the Part.
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Muting Events

Using the Mute Tool

Using the Mute tool in the Toolbox you can mute an Event. This silences it until you 
unmute it again.

Erase Muted

This function, found on the Do pop-up menu permanently deletes all the Events 
that are currently muted. This is a quick way of “cleaning up” a Part after editing.

❐ Deleting Muted Events does not delete Segments. Neither does it erase any files from 
your hard disk.

This Event is muted.
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Splitting Events

Using the Scissors Tool

To split one Event up into more, proceed as follows:

1. Decide if you want the split to happen on a zero crossing or not by checking or un-
checking “Snap to Zero” on the Audio menu.
See page 342 for details.

2. Set the Snap value as desired.
As always, this determines the “smallest” note value where you can apply the split.

3. Select the Scissors from the Toolbox.

4. Click on the Event.
The Event is split into two.

Deleting while splitting

To automatically delete the left or right resulting Event, hold down [Option] or 
[Command] respectively when you split the original Segment.

Using Snip Loop

This command, on the Do pop-up menu, splits all Events at the positions of the Left 
and Right Loop position. If you want to split several Events in one place only, set the 
Loop End point to the same position as the Loop Start.
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Deleting Events

Audio Events are deleted just as Parts in the Arrange window or Events in a MIDI Ed-
itor.

❐ Deleting an Event does not delete its Segment from the Audio Pool.

Using the Eraser to Delete Events

Clicking on an Event with the Eraser tool will delete it.

Using Keep to Delete Events

To delete all Events but the ones selected, proceed as follows:

1. Select the Events you want to keep.
As in the MIDI editors, the To pop-up menu determines which Events will be affected. If you 
want to be sure only those Events will be kept, that you have selected, the To pop-up menu 
should show “Selected”.

2. Select “Keep” from the pop-up Do menu.
All Events are deleted, except those indicated by the To pop-up menu and your selection.

Using the Menu or Keyboard to Delete Events

1. Select the Events.

2. Press [Delete] or [Backspace] or select Delete Events on the Edit menu.

Permanently deleting an Audio File

To delete an Event and its audio file from disk, hold down [Command] and press 
[Backspace]. 

❐ This operation will permanently delete the referenced audio file from your hard disk, 
and cannot be undone.
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Adding and Editing Match Points

What are Match Points?

Match points, or M-Points, are “markers” within an Audio Event, used to indicate sig-
nificant positions in your Audio file. Furthermore, they contain information about the 
“velocity” of the audio at the positions they indicate. Match Points are used for com-
paring and combining the timing of recorded audio with the timing of recorded 
MIDI material in various ways. Therefore, the goal is most often to get M-Points on all 
“beats” in the recorded audio. The picture below shows a drum pattern, with M-
Points displayed. Note that the horizontal positions of the Match Points coincide 
with the peaks in the audio - the “beats”.

Match points have the following uses:

• Matching tempo to audio.
• Matching audio to tempo.
• Making groove templates by extracting timing and velocity from recorded audio.
• Match quantizing MIDI Parts to Audio Parts, Audio Parts to MIDI Parts or even Audio Parts to 

other Audio Parts (after using “Snip at M-points”).

❐ For more information on the usage of M-Points, see the chapter “Matching Audio and 
Tempo”.

Displaying the M-Points

1. Pull down the View pop-up menu.

2. If the Dynamic Events item is not ticked, select it.
This will make the lower halves of the Events show dynamic data (M-Points, Volume or Pan).

3. Pull down the pop-up menu to the right of the To pop-up menu and select M-Points.

Note that the horizontal positions of the 
Match Points coincide with the peaks in 
the audio - the “beats”.

The velocity values of the Match Points (indicated 
by the vertical position of the black squares) 
correspond to the level of each audio peak.
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Adding M-Points automatically

Cubase VST can automatically analyze the Audio Event for you, find the “important” 
positions and create M-Points:

1. Select the Event.

2. Pull down the Do pop-up menu and select Get M-Points.
A dialog box appears, where you can make various settings for how the Match Points should 
be calculated (described on page 574). 

For now, click on the Default button. This will make the program use default settings, which 
quite often work well.

3. Click Process.
Match Points are calculated and added to the Audio Event.

Adding M-Points manually

You may also add M-Points manually, if for example you find that the automatic M-
Point detection doesn’t find all the “important” beats in the audio.

1. Set Snap to a value of your liking.
This affects on which positions you can place M-Points, just like when adding Events in a 
MIDI editor. On many occasions it may be best to turn Snap off, to be able to freely move cre-
ated M-Points.

2. Select the Pencil tool.

3. Hold down [Option] on the computer keyboard and click where you want the M-
Point(s).

In this case, you may want to add M-Points for 
some of the beats in the audio.
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Editing M-Points

Sometimes you may want to move Match Points to make them better coincide 
with the beats in the audio. It may for example happen that the automatic Match 
Point detection positions an M-Point too early, due to “double” drum hits, diffuse 
sounds etc. If that is the case, you can easily move the Match Points:

• If you want to move an existing Match Point or change the vertical position of the 
black square (i.e. the velocity value), click on it with the Pencil and drag it up/down 
or sideways.
The Snap value applies for which positions you can move the value to. Since the audio mate-
rial is probably not perfectly correlated to the playback tempo, it is often best to turn Snap 
off when moving M-Points.

• If you want to make sure the Match Point isn’t moved left/right, hold down [Shift]. 
This also makes the value change in smaller steps.

Deleting M-Points

If you find that the Match Point detection finds too many M-Points in the audio, you 
may want to delete some of them:

1. Select the Eraser tool.

2. Click on the black square of the Match Point you want to delete.
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Quantizing Audio Events

Quantizing Audio Parts allows you to adjust the positions of your Events, just like 
you adjust the positions of MIDI notes. 

Event Position Quantizing vs. “True” Audio Quantize

There are two types of audio quantize.

• The first type moves the Events to desired positions, without affecting the actual audio file.
• The second type processes and changes the audio recording permanently.

Event Position Quantizing

There is one big difference between quantizing Audio Event positions, compared to 
MIDI Events: It is not the “start point” of each Event that is used to decide what the 
new position should be, but the “Q-point”. Note that quantizing moves the whole 
Event; it does not affect the timing of the recording within the file (for ways of quan-
tizing the actual material in a recording file, see page 372 and the chapter “Matching 
Audio and Tempo”). Quantizing the start of a long Audio Event might therefore be 
pretty pointless. To make quantization affect positions within the recording, split it 
into several shorter Events before you perform the quantization. There are two prin-
cipal ways to do this:

• Use the Scissors tool to manually split the Audio Event in suitable places.
This may work fine if the Audio Event contains several phrases or sounds, and you only want 
to quantize the beginning of these individual phrases/sounds.

• Create Match Points (see page 367) and select Snip at M-Points from the Do pop-up 
menu.
This will split the Event at each Match Point. Use this method if you have audio material with 
short, well separated sounds, like a clean drum loop. You may for example want to tighten 
up an inexactly played hi-hat pattern by quantizing the beats to 16th notes.

❐ If you try the above methods with a less than satisfying result, check out page 372 and 
the chapter “Matching Audio and Tempo” for information about permanent quantiza-
tion of the actual audio file.

There are two Event position quantization methods that can be applied to audio:



- 371 - 

Over Quantize 

This moves the Events in the selected Parts, so that their Q-points line up with the 
selected Quantize value. See page 357.

Groove Quantize

This moves the Events so that the Q-points line up with the “timing map” in the se-
lected Groove. For more information about Groove Quantize, see the Getting 
Started book and the chapter “More about Quantizing and Grooves”.

Undo Quantize

The Undo Quantize item on the Functions menu does not apply to Audio. However, 
you can Undo the last Quantize operation, as with any other operation, by using 
Undo on the Edit menu.

Over Quantizing an Audio Part 
with a Quantize value of 8.
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“True” Audio Quantizing (by Time Processing)

As described in the chapter “Matching Audio and Tempo” there are very advanced 
ways of processing an audio file, to make it fit with other material. However, you 
may also permanently quantize an audio file without leaving the Audio editor.

❐ Since this process permanently alters your audio files, you may want to make a copy of 
the file before proceeding! See the Audio Pool chapter for instructions on how to dupli-
cate files.

Performing the Quantize

1. Select the Event to be quantized, and insert Match Points using the Get M-Points func-
tion on the Do pop-up menu.
This creates Match Points on the musically “important” positions in the Audio Event, as de-
scribed on page 368 in this chapter. You may also add or edit Match Points manually using 
the Pencil tool.

2. Set the Quantize value as usual.

❐ If there are great differences between the spacing of the M-Points and the Quantize 
value, this gives rise to very large Time Stretch factors. Since this may cause undesired 
results, try to use a Quantize value that matches the spacing of the M-Points fairly well.

3. With the Event selected, pull down the Do pop-up menu and select “Quantize at M-
Points”.
This instructs the program to move each M-Point in the Audio Event to the closest Quantize 
position, and timestretch the material in between.

Cubase VST works through the audio file, and each section of the file is time pro-
cessed to fit between the corresponding Match Points. Depending on the length of 
the audio file, the processing may take a while, during which a progress box is 
shown.

4. When this is done, your Audio Event will play a new segment, quantized according to 
the set value.
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Match Quantizing Audio

This allows you to:

• Apply the timing of a MIDI Part to an audio Part.
• Apply the timing of an audio Part to a MIDI Part.
• Apply the timing of an audio Part to another audio Part. 

For basic information on Match Quantize of MIDI Parts, see page 70. Working with 
Audio Parts is different in that it is all based on Match Points. Proceed as follows:

Using an Audio Part to Quantize a MIDI Part

1. Create Match Points for the Events in the Audio Part, as described on page 367.

Match Points in the Audio Editor.

2. In the Arrange Window, select the Match Quantize tool.

3. Drag the Audio Part and release it on top of the MIDI Part.

A dialog appears, asking if you want to include the accents (Match Points velocity values). 
The options are the same as when you Match Quantize with MIDI Parts (see page 70).

4. Select one of the options in the dialog box.
The Events in the MIDI Part are quantized to the positions of the Match Points in the Audio 
Events.
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Using a MIDI or Audio Part to Quantize an Audio Part

This can be done in two ways: By moving the Events to desired positions, without 
affecting the actual audio file, or by processing and changing the audio recording 
permanently.

Match Quantizing by Event Position

1. Create Match Points for the Events in the Audio Part you want to Quantize, as de-
scribed on page 367.

2. If you are Quantizing the Part with another Audio Part, create Match Points for each 
Event in that Part as well.

3. For each Event in the Part you want to Quantize, pull down the Do pop-up menu and se-
lect Snip at M-Points.
The Audio Events are split at the positions of the M-Points.

4. In the Arrange Window, select the Match Quantize tool.

5. Drag the “source” Part (MIDI or Audio) and release it on top of the “destination” Audio 
Part.
A dialog box appears with the text “Use Dynamic Time Compression?”.

6. Click “No”.
The start points of the Events in the “destination” Audio Part will be quantized to the posi-
tions of the Events in the “source” Part. Please note that if the gaps between the Events are 
too big, the process may not give the desired musical result.

Match Quantizing by Time Stretching

1. Create Match Points for the Events in the Audio Part you want to Quantize, as de-
scribed on page 367.

2. If you are Quantizing the Part with another Audio Part, create Match Points for each 
Event in that Part as well.

3. In the Arrange Window, select the Match Quantize tool.

4. Drag the “source” Part (MIDI or Audio) and release it on top of the “destination” Audio 
Part.
A dialog box appears with the text “Use Dynamic Time Compression?”.

5. Click “Yes”.
Cubase VST works through the “destination” audio Part, and processes each section of the file 
to fit the timing of the “source” Part. Depending on the number and length of the audio 
Events, the processing may take a while, during which a progress box is shown.

More advanced Quantizing methods

For even more advanced Quantizing options, see the chapter “Matching Audio and 
Tempo”.
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Fitting Audio Events to the Loop

You may have an audio file with an inherent tempo that does not fit the current 
Arrangement. Cubase VST then allows you to adapt either the audio file to the 
Arrangement (by applying time correction) or the Arrangement to the audio file 
(by adjusting the tempo). Proceed as follows:

1. Import the file into the Arrangement.

2. Open the Audio Editor and adjust the Start and End Insets of the Event so that it exactly 
fits some specified “musical” length, for example an even number of bars.
One good way of doing this is to use the Loop playback feature in the Wave editor. What you 
are trying to achieve here is that the audio file, when played in isolation, is of exactly the cor-
rect length. However, it will not fit in with the metronome or other Events in the Arrangement.

3. Move the Event so that it starts at some sensible musical position, for example the 
downbeat of a bar.

4. Set up a loop of the same “musical” length as the Event.
Since the two are currently not playing in the same tempo, the “graphical” length of the loop 
will not be the same as that of the Event.

The Event and Loop set up correctly.

5. Select the audio Event, and only that Event.

6. Select “Fit Event To Loop Range” from the Do pop-up menu.
You are presented with a dialog that allows to choose between two options:

• Tempo: This will adjust the tempo of the Arrangement so that it fits the Event. If the Master 
Track is activated, a tempo change is added at the Loop start.

• Audio: This will time correct the part of the audio file that the Event plays, so that it fits the 
current tempo. For more info on time correction, see page 395.
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7. Click either, depending on your preference.
The Event now fits the Arrangement.

The same Event, after fitting it to the Loop.



- 377 - 

Working with Grouped Events

If Events are grouped, a number of operations that you carry out on one of them 
are applied equally to all. Examples of such operations are moving, duplicating, ad-
justing Insets etc.

Automatic Grouping

When you record on an “Any” channel Track with two or more channels record en-
abled, the resulting Events are automatically grouped. The same is true if you import 
or drag split stereo files directly into the Audio Editor (see page 349). This is to sim-
plify editing of split stereo or other multi channel material, and to make sure that the 
channels in such recordings remain “phase-locked” at all times.

Manual Grouping

To Group Events “manually”, proceed as follows:

1. Select the Events that should make up the Group.

2. Select “Group” from the Audio editor’s Do pop-up menu.

Ungrouping

1. Select the grouped Event.

2. Select “Ungroup” from the Audio editor Do pop-up menu.

❐ To ensure the position relationship is kept unaffected by editing, generally avoid un-
grouping Events that were automatically grouped when recorded together or imported.
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Operations on Grouped Events

Some operations are done a little bit differently on Grouped Events than on regular 
ones. Below follows a list.

About Snap to Zero

Snap to Zero (see page 342) is not applied to Grouped Events.

Selecting, Moving, Cutting and Pasting, etc.

• When you click on one Grouped Event, all Events in the Group are selected.

• To select one of the Events in a Group, use the cursor keys instead of the mouse.
The only reason to do this is to be able to edit on the Info Line, see below.

• The following operations affect the entire group, as if it was one Event:
Moving (using the arrow pointer or the Nudge tool).
Duplicating.
Quantizing.
Cut, Copy and Paste.
Deleting.
Muting with the Mute Tool.

• If you move, duplicate or Quantize, the Q-point of the top (or first) Event is used for de-
termining where the Event should wind up.

Changing Q-Points and Start and End Insets

• If the grouped Events start at the same position, the Start Inset and Q-Points will be set 
identically for all Events in the Group, when you adjust it for one of them. 

• Likewise, if the Events end at the same position, the End Inset is adjusted simulta-
neously for all.

• If the Events don’t start at the same position, Start Inset, End Inset and Q-point are set 
individually for each Event in the Group.

Splitting

If you split a Group with the Scissors tool or the Snip Loop item on the Do pop-up 
menu, the Group will be split into new Groups.

Using Banish Silence and Export Segments

• Banish Silence and Export Segments only work on one Event at a time. 
To use these on multi-channel material, first ungroup, then apply the Function and finally 
Group again.
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Banish Silence

What is Banish silence?

This function has a similar effect to that of a noise gate. You set a threshold and a 
“length” and all signals with a level lower than the threshold for the whole “length” 
(the sound window, see below), will be “banished”. The banishing itself is done by 
the program by creating Segments with the sections of the sound file considered 
silence “masked out”.

The effect of Banish silence is equivalent to going into the Audio editor, examining 
the waveform, finding the low level sections, and using the tools to split up the Seg-
ment into separate Events while deleting the “silence” between. You can use this to 
get rid of unwanted silence for example at the beginning of the recording. Remem-
ber also that Banish Silence is an entirely non-destructive function.

Audio editor or Pool?

This function can be applied from the Audio editor or the Pool. In the Audio editor 
it is applied by selecting an Event. However, in reality, the function operates on the 
Segment.

• If you select this function from the Pool, Banish silence creates new Segments which 
are added to the Pool.

• If you use it from the Audio editor it creates new Segments which are added to the 
Pool, but in a addition, new Events are created which replace the existing ones.

Using Banish Silence

1. Select one Event (Audio editor) or one segment (Pool), which is at least one second 
long.

2. Select Banish Silence from the Do menu.
The waveform in the Segment is displayed in a dialog box.

3. Decide if you want to see the effect of your settings on the audio or not, by checking/
unchecking the “Interactive” option.
When working with very long Segments you may wish to switch this feature off. The settings 
will be retained.
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4. Use the two horizontal lines to set the Threshold, by dragging either up or down.
The Threshold is also displayed as numbers, and can be set as a numerical value. 
If you slowly raise the Threshold, you will note that parts of the waveform gradually disap-
pear, as the Threshold exceeds their levels.

5. Use the right vertical line to set the size of the sound window.
This is also displayed as a number (the number of samples) which can be adjusted. The left 
vertical line is used to move the sound window around on the screen so that you can match 
the length of it visually to some audio in the window.
If you slowly make the sound window narrower, you will note that parts of the waveform 
gradually disappear.

❐ Please note that the sound window operates on the whole waveform, not just the sec-
tion it encloses in the waveform graphic! It is only the width of the sound window that 
matters, not its position!

6. Check the number of resulting Segments in the lower left corner of the graph.
Only those signals that you see will actually be left if you decide to click OK to go ahead.

7. Use the checkbox “Replace Source” to decide whether the source Segment should be 
left intact or not.

8. Click OK.

Banish Silence and Snap to Zero

Banish Silence uses “Snap To Zero” if that option is enabled. If such is the case, note 
that the image you see in the dialog may differ slightly from the results obtained.
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Creating Crossfades, Fade Ins and Fade Outs

The Crossfade function allows you to create a smooth fade between two sections 
of audio. It also allows you to add a fade-in or out to only one Event. It does so by 
creating one or more new files which contain a new portion of audio – the actual 
(cross)fade.

Events which play these crossfade files are then inserted into the Audio editor at 
the correct position. The Segment settings of the Events are changed, but the orig-
inal files are not affected by the operation.

Which Events can be faded?

The fades are created by “unveiling” sections in the audio file which are currently 
not played. This means that:

• It is not possible to create a fade from the end of one file, because there is no audio to 
fade after the end of the file.

• It is not possible to create a fade to the beginning of a file, because there is no audio 
before the beginning of the file.

To check if there is any audio to fade to/from at the beginning/end of a file, check 
the Inset handles, as described on page 353 in this chapter.

The file ends here. 
You cannot fade out after this point.

The file starts here. You cannot fade in before this point.
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Creating a Crossfade

The two Events you crossfade between must play on the same audio channel(s). 
They should probably either be positioned edge to edge or overlap. 

❐ It is possible to crossfade between Events with a gap between them, but it might not 
create the desired result. If the program can’t make anything sensible out of the selec-
tion of Events you have made, it will tell you so.

1. Select the Crossfade tool from the toolbox.

2. Position the pointer in the Event you want to fade from, at approximately the position 
where you want the crossfade to start.

3. Click and keep the mouse button pressed while you drag to the right.
A dotted line appears, indicating the crossfade area.

4. Release the mouse button in the Event you want to fade to, at approximately the posi-
tion where you want the crossfade to end.
The following dialog box appears.

The Crossfade dialog. The display shows how the two Events will be “mixed”. The two pairs of 
arrows above the display indicate the start and end points for the fade “zones” in the two Events.

5. Drag the lower set of arrows to set the start and end points for the fade of the first Event.
If you want the fade to start earlier than you indicated when dragging with the Crossfade 
tool, you can numerically change the value in the XFade Start Pos value box. You will not be 
able to go past the start/end points of the entire Event.

6. Drag the upper set of arrows to set the start and end points for the fade of the second 
file.
If you want the fade to end later than you indicated when dragging with the Crossfade tool, 
you can numerically change the value in the XFade End Pos value box. You will not be able to 
go past the start/end points of the entire Event.
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7. Use the mouse to draw the shape of the fade in and fade out curves.
Drawing in the overlapping area only affects the start segment (the fade out). If you want to 
change the overlapping part of the fade curve for the end segment (the fade in), start drag-
ging to the right of the overlap and keep dragging to the left. You can also hold down the 
[Command] key; when you do, drawing always affects the fade in, no matter where you start 
dragging.

8. As an alternative to drawing, you can use the buttons to the left of the curve display to 
select “preset” linear or logarithmic curve type.
The logarithmic curve will create the most natural fade.

9. Click Calculate.
A preview of the crossfade gets created, which you can see in the box below the curve dis-
play.

10.Check the fade using the Audition button.

❐ Is is quite possible to introduce clipping (levels higher than the system can handle) 
with inappropriate fade curves. If this happens, adjust the curves and Calculate again.

11.When you have a fade you are happy with, click the OK button.
A new Event appears on top of the two you were fading between. This Event plays a new file 
which contains the actual crossfade. If you delete this Event (and file) you will return to the 
original “unfaded” join between the Events.

The created crossfade file(s) are placed in a folder on your recording hard disk, named 
“Songname.xfades”, where “Songname” is the name of your Cubase VST Song.

12.To ensure the three Events retain their timing relationship even after editing, they are 
automatically Grouped.
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Creating Fade Ins and Outs

A method very similar to the one above can be used to create a fade-in or out from 
only one file:

1. Select the Crossfade tool.

2. Position the pointer in the Event you want to fade, at approximately the position 
where you want the fade-in/out to start.
You cannot start or end a fade outside of the start/end-points of the actual Event. 

3. Click and keep the mouse button pressed while you drag to the right.
A dotted line appears, indicating the fade area.

4. Release the mouse button at approximately the position where you want the fade-in/
out to end.

5. Set the length and shape of the fade-in/out in the Crossfade dialog box that appears.
See the Creating Crossfade description on the previous pages.

6. Click the OK button.
A new Event appears on top of (and grouped with) the one you had. This Event plays a new 
file which contains the actual fade. If you delete this Event (and file) you will return to the 
original Event.

Crossfading by Overlapping Segments

❐ This operation can be performed on multiple, Grouped Segments, such as split stereo 
files, provided they share the same start/end points.

It is also possible to automatically create a crossfade by overlapping two segments. 
Proceed as follows:

1. Select the Crossfade tool.

2. Press [Command] and drag one of the Segments so that they overlap.

Or

3. Drag the Start or End Inset into another Segment.

4. Release the mouse button.
The Crossfade dialog appears, with the Crossfade range determined by the amount of over-
lap between the segments.
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Using Cycled Recording for assembling a “perfect” take

When you record several laps in a Cycle, only one Audio file is created. However, this 
is split up into a number of Segments (one for each lap) which are “stacked” in the 
Audio Editor. Since the Segments are all on the same Track, this normally means that 
only one of them will play back (the one last recorded). However, you can use this 
feature to assemble a “perfect” take from all the different Segments.

Let’s say you have a chorus and you want to record a few different takes of vocals 
for it, to later assemble snippets from each take into one “perfect” recording.

Proceed as follows:

1. Set up the Left and Right Locator to encompass the section you want to record.

2. Activate Cycle on the Transport Bar.

3. Activate Recording from “Stop Mode”.

4. Record for as many laps as you desire.

5. Stop recording.

6. Open the Track in the Audio Editor.

You will now have all the takes stacked above each other. Since the Track plays back 
on one channel only you will only hear one of them at a time. But, you can consecu-
tively mute each one to find which pieces you want to keep from each.
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7. Use the Masking, Splitting, Muting and Delete functions to assemble one single take 
out of all the ones you originally had.

The same recording, after having split the Audio Events at appropriate places and muted or 
deleted the unused sections.

• To view the reassembled recording as it is played back, pull down the View pop-up 
menu and select By Output.
This will show all Events on the same lane.
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Changing the Volume and Panning of an Event

About this Section - What Volume/Pan am I changing?

In this section we deal with the “mechanics” of adding the Volume/Pan changes. 
You will learn how to change the volume and panning of individual Events and 
how to create dynamic changes of the same parameters.The relation between the 
volume you put in for an Event and the volume control in the VST Channel Mixer 
window is described in detail on page 463.

Displaying the Volume/Pan Curve

For the Events to display any Dynamic data, the Dynamic Events item on the View 
pop-up menu must be ticked. To select whether volume or pan should be shown in 
the Events, pull down the pop-up menu immediately right of the To pop-up menu 
and select the corresponding option.

The third option, M-Points, is described on page 367.

Event/Segment relation for Volume/Pan Curves

Even though we are talking about volume and pan for Events here, in fact the dy-
namic data affects the segment that the Event plays. This means that if you have 
Ghost Events (that play the same segment), any changes you do to the volume/pan 
curve for one of the Events, will be reflected in the others.

Creating and Editing Volume/Pan Events

Please note that Volume and Pan curves differ a bit when it comes to default values:

• If you haven’t yet edited the Volume curve for an Event, it consists of one single 
straight line. 
That is, the volume is constant for the entire length of the Event. The default value is 0.0 dB.

• For Pan, there is no default value!
This means, that if you haven’t yet edited the Pan curve for an Event, there is no curve shown at 
all. Instead the Panning set for the channel in the VST Channel Mixer window is used. As soon as 
you insert a Pan value in the Dynamic Events display, a Pan curve is created.

❐ The volume curve ranges from 0.0 dB down to –infinity. If you need to go above unity 
gain (amplify the sound), use the VST Channel Mixer faders (which can be automated 
using the Write function; see page 464).
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Adding new points to the curve

Adding points (“breakpoints”) to the curve is done in a way similar to editing con-
troller data in other editors:

1. Set the Snap value as desired.

2. Select the Pencil.

3. Hold down [Option] (and [Shift] if desired, see previous page).

4. Click somewhere in the “curve area” or press the mouse button and drag up down to 
find the right point.
A value label appears, indicating the Volume (in dB) or Pan position.

Editing points

• If you want to move or change the vertical position of an existing “breakpoint”, click 
on it with the Pencil and drag it up/down or sideways.
The Snap value applies for which positions you can move the value to.

• If you want to make sure the breakpoint isn’t moved left/right, hold down [Shift]. As 
described above, this also makes the value change in smaller steps.

• [Shift]-clicking a point is also the best way to view the current value without acciden-
tally changing it.

Applying the same Curve to all Grouped Events

If you have a number of Grouped Events, you might want them all to have the same 
curve:

1. Select the Pencil from the Toolbox.

2. Hold down [Command].
You might also want to hold down [Option] (to create new breakpoints) and/or [Shift] (to re-
strict movement to vertical), as described above.

3. Edit a breakpoint or input a new to one of the Events.
The entire curve is now copied to all the Events in the Group.

Deleting Volume/Pan Points

• To delete a “breakpoint”, click on it with the Eraser tool.

• Pressing [Option] while deleting will erase all the following breakpoints.
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Making an Event Play another Segment

You can set which Segment an Event plays. Use this to make an already positioned 
Event play back another sound.

Please note that you are restricted to selecting segments from within the same file 
as the Event now plays.

With any type of Event

To make an Event play another segment, proceed as follows:

1. Hold down [Command] and [Option] and click on an Event.
A pop-up menu shows a list of all the available Segments in the audio file, with the one now 
used by the Event highlighted.

2. Select any Segment from the list.
If the Segment you select is already played by another Event, the Event you are working with 
will become a Ghost Event (shown with a dotted outline).

With Ghost Events

To make all Ghost Events that play the same segment play another segment in-
stead, proceed as follows:

1. Hold down [Command], [Shift] and [Option] and click on an Event.

2. Select any Segment from the list.

Exporting Events into Files

Export Segment, on the Do pop-up menu, allows you to save the Segment that an 
Event plays, as a separate audio file.

1. Select the Event.

2. Select Export Segment.

3. In the file dialog that appears, specify a name and position for the file.

❐ You can assign key commands to all functions on the Do pop-up menu in the Audio Ed-
itor. This is done in the Preferences-Key Commands-Arrange/Editors dialog.



- 390 - 

26
Audio Functions
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Introduction

A number of processing functions specifically for audio are included in the program. 
These can be applied in a number of ways:

• On one or more selected Parts in the Arrange window.
This will process all files in the Part(s) by equal amounts.

• On one or more selected Events in the Audio Editor.
This will process those segments of the audio files that the Events play back.

• On one or more files or segments in the Pool.

• A selection, segment or file in the Wave editor.

❐ Note that the audio processing makes permanent alterations to the audio file(s)! If re-
quired, make copies of the files before applying a processing function! If you process a 
segment or Event, be aware that all segments playing this section of the file will be af-
fected by the processing. 
You should also remember that a segment or an Event is most often only a smaller sec-
tion of a complete audio file. If you perform audio processing to this section, you may 
not be able to use the audio file in other Songs, etc. Again, be sure to make copies of 
your audio files before processing them.
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Applying the Processing

1. Select the audio you want to process.

2. Select the relevant Function from the Audio Functions submenu on the Functions 
menu.
The “Launch External Wave Editor” function is described on page 411.
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The Functions

Reverse

This function turns a recording backwards, just as when you turn a tape on a reel-
to-reel recorder backwards.

Silence

This function replaces the audio with absolute silence.

Fade In

This function creates a linear fade in, spanning the whole selected audio range.

Fade Out

This function creates a linear fade out, spanning the whole selected audio range.

Quieten

This function lowers the amplitude of the recording to about half the level.

Invert

Inverts the phase of the audio recording. You could say it turns the waveform “up-
side down”.
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Normalize

This function allows you to adjust the volume of the audio, by specifying the de-
sired maximum level in the recording. The program then scans the audio to find 
the current maximum level, compares that with the desired maximum level, and 
raises (or lowers) the level of the whole recording accordingly.

Typically, this can be used for increasing the level of a recording that was made at 
too low a level, without the risk of introducing clipping (digital distortion) by rais-
ing the level too much.

• Normalizing does not change the dynamics in the recording, since all levels in the 
whole recording are changed by the same amount! 
In fact, the principle is the same as when adjusting the audio level in the VST Channel Mixer, 
except that with Normalizing, you cannot raise the level above 0dB. Do not confuse Normal-
izing with “Maximizing” or “Multiband Compression” functions, which affect the dynamics of 
the recording!

Proceed as follows:

1. Select Normalize.
The program scans the file to find the maximum amplitude, and then displays a dialog for 
setting the maximum level.

2. Use the pop-up menu to the left in the dialog to select how you want the maximum 
level to be displayed.
The dialog can display the setting in three different ways, but the only difference between 
these alternatives is how the Normalize setting is displayed, they do not perform different 
functions.

3. Set the desired maximum level.

❐ Note that the settings you make are used for all audio you have selected for processing!

In this example, the loudest signal in the resulting file will have a level 3 dB below maximum.

4. When you click OK, the file gets processed.

❐ Please note that the level of any background noise is raised just as much as the rest of 
the signal. If you have the option to re-record the file with correct level settings, this is 
in many cases a better option than using Normalize.
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Pitch Shift

This function lets you change the pitch of a recording without affecting the length.

1. Select Pitch Shift from the Audio Functions submenu.
The Pitch Shift dialog appears.

The Pitch Shift dialog.

2. Specify the amount of Pitch Shift by adjusting the “Semitones and Cents” values.
A cent is one hundredth of a semitone. The maximum Pitch Shift range is +/– one octave (12 
semitones).
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3. Make settings for the other parameters in the dialog.
These are:

4. Click Process.
The audio is pitched shifted.

About Audio Quality

In order to get the best possible audio quality when you pitch shift an audio file, 
please follow these rules:

• The smaller the change, the better the resulting sound quality.
• The amount of change that can be applied varies drastically with the complexity of the audio 

material. For example, pitch shifting a complete stereo mix one octave up will most certainly 
make it sound unnatural.

• If you have the possibility to process individual files rather than a mix, this is preferred.

Parameter Description

Formant Mode If you are pitch shifting vocal material, or other recordings with prominent reso-
nant character, you should activate this option for best results.

Exact Length If this is activated, the processed file will have the exact same sample length as the 
original. If it is deactivated the resulting file length may differ by a few milliseconds.
If you don’t need this length accuracy, you should leave this option deactivated, 
for a slightly improved audio quality.

Gain Factor This parameter allows you to lower the volume of the pitch shifted material.
This can sometimes be necessary, as the pitch shift process may raise the volume, 
introducing clipping in the processed file.

Accuracy Set this parameter according to whether the rhythmic feel of the audio material 
has a high priority or not. 
If you set this to a low value (drag the slider to the left), the timing and rhythmic 
feel will be preserved as accurately as possible. If you set it to a high value, the 
tonal quality gets priority, allowing slight changes in timing.

Quality Allows you to select one of three Quality modes for the processing: Quick, Stan-
dard and Best. As indicated by the names, the higher the Quality, the slower the 
processing. For most uses, the Standard mode is probably sufficient.
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Time Stretch 

Time Stretch allows you to alter the length of a recording without affecting the 
pitch. Proceed as follows:

1. Select the file or segment you wish to Time Stretch.

2. Select Time Stretch on the Audio Functions submenu.
The Time Stretch dialog appears.

3. Specify the amount of Time Stretch.
This can be done in several ways:

• By defining a new length in the Time “After...” field.
The length of the currently selected item is displayed in the Time “Before...” field (in seconds). 

• By defining a new tempo (in beats per minute) in the Tempo “After...” field.
For this to make sense, you also need to tell the program the original tempo in the Tempo 
“Before” field. This method is useful if you have e.g. a drumloop of known tempo and want it 
to fit the current Song tempo, etc.

• By defining a new length in the Length “After...” field.
The original length (in samples) is displayed in the Length “Before...” field.

• By specifying a stretch factor using the compress/expand slider.

Note that regardless of which method you use, the other fields will automatically 
be adjusted when you make settings. This makes it easy to see the resulting stretch 
factor when converting to a new tempo, etc.
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4. Make settings for the other parameters in the dialog.
These are:

5. Click Process to Time Stretch or Cancel to exit.

About Audio Quality

In order to get the best possible audio quality when you perform time correction 
on an audio file, please follow these rules:

• The smaller the change, the better the resulting sound quality.
• The amount of change that can be applied varies drastically with the complexity of the audio 

material.
For example, time stretching a complete mix to make it twice as long will most certainly 
make it sound unnatural.

• If you have the possibility to process individual files rather than a mix, this is preferred.

Parameter Description

Exact Length If this is activated, the processed file will have the exact same sample length as the 
original. If it is deactivated the resulting file length may differ by a few milliseconds.
If you don’t need this length accuracy, you should leave this option deactivated, 
for a slightly improved audio quality.

Accuracy Set this parameter according to whether the rhythmic feel of the audio material 
has a high priority or not. 
If you set this to a low value (drag the slider to the left), the timing and rhythmic 
feel will be preserved as accurately as possible. If you set it to a high value, the 
tonal quality gets priority, allowing slight changes in timing.

Quality Allows you to select one of three Quality modes for the processing: Quick, Stan-
dard and Best. As indicated by the names, the higher the Quality, the slower the 
processing. For most uses, the Standard mode is probably sufficient.
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Fade Dialog

The Fade Dialog can be seen as an extension of the regular Fade In/Out functions on 
the Audio Functions submenu. You can choose between Linear Fade in/out (the 
same as in the other Fade functions) or Log Fade in/out (which produces a logarith-
mic, slightly “rounded” Fade curve). It is also possible to “draw” fade curves with the 
mouse directly in the window!

• Note that the fade you set up in the dialog affects the full length of each audio selec-
tion! 
If you want to make a quick fade in at the beginning of a long Audio Event, you should split 
the Event with the Scissors tool at where you want the fade to end, and then only perform 
the Fade operation on the short first Event. 

• If several Parts/Audio Events are selected, the Fade dialog will remain open, allowing 
you to specify a fade for each selected Part/Event.

Remove DC Offset

This function will remove any DC offset in the audio selection. A DC offset is when 
there is too large a DC (direct current) component in the signal, sometimes visible 
as the signal not being visually centered around the “zero level axis”. DC offsets do 
not affect what you actually hear, but they affect zero crossing detection and cer-
tain processing, and it is recommended that you remove them.

❐ It is recommended that this function is applied to complete audio files, since the DC 
offset (if any) is normally present throughout the entire recording.

There are no parameters for this function.
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27
The Wave editor
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What is the Wave Editor?

The Wave editor allows you to perform edits on your audio files. This includes Cutting 
and Pasting real audio data and applying DSP (Digital Signal Processing) functions. In 
other words, it provides more direct control over the audio files than the Audio editor 
does.

The Wave editor also provides additional tools for creating and modifying seg-
ments.

Precautions

In contrast to the Audio editor, the Wave editor makes permanent changes to your 
audio files (sometimes called “destructive editing”). When you for example Paste in 
the Wave editor, this alters the file on disk directly, rather than just adding new seg-
ments or Events.

You can of course Undo the last action in the Wave editor. However, you might want 
to experiment with different editing operations in the Wave editor, and later decide 
to go back to the original file. If you do, use the Duplicate File item on the File pop-
up menu in the Pool to duplicate your audio files before editing them in the Wave 
editor.



- 402 - 

Opening Wave Editor Windows

From the Audio editor

To open the Wave editor, displaying the segment and file played by an Event in the 
Audio editor, proceed as follows:

• Select the Event in the Audio editor and select “Edit” from the Edit menu, or...

• Double click on the Event in the Audio editor.
The Wave editor opens, displaying the file, with the relevant segment indicated in black and 
the rest of the waveform in grey.

From the Pool

To open the Wave editor displaying a certain segment and its file, do one of the fol-
lowing:

• Double click on a segment in the Pool.

• Select the segment in the Pool and select “Edit” from the Edit menu.

Working with Multiple Editors

Using the techniques described above you can open as many Wave editor win-
dows as memory permits.

By switching between the different windows you can work on a number of differ-
ent files at the same time.

Making a Window Display another File

It is possible to make any of the open Wave editor windows display any of the files 
in the Pool:

1. Pull down the File pop-up menu.

The Wave editor’s File pop-up menu holds a list of the files in the Pool.

2. Select the desired file.



- 403 - 

Adjusting the View

Ruler

The rulers in the Wave editor are always in Real Time format (Hours:Minutes:
Seconds:Milliseconds).

Thumbnail View

The thumbnail is a miniature view of the file. The big difference between the thumb-
nail and the main waveform area is that the thumbnail always displays the entire file. 
Use the thumbnail view to quickly navigate around in the file.

The frame in the thumbnail shows what portion of the whole file is shown in the 
waveform display above.

The active segment is shown in black, while the rest of the file is greyed out.

The inverted section 
of the file is selected 
for editing.

The part of the file 
inside this rectangle 
is shown in the 
display above.
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Segment Display

In the waveform area, the currently selected segment is indicated in black with Inset 
arrows (see the Audio editor). We call this the active segment. All audio data outside 
the active segment is displayed in grey.

You can make any of the segments in the file active, see page 408.

The active segment is displayed in black, while the rest of the file is grey.

Scrolling

Using the Scroll Bars

As in all editors, you can use the scroll bars to move through the displayed data.

Scrolling to the segment Start and End

• To move to the beginning/end of the selected segment, click the Go To Segment Start/
End buttons on the Status Bar.
The Song position is then also moved to this position.

The Go To Segment Start/End buttons.

Using the Thumbnail

• By dragging the rectangle in the Thumbnail, you can scroll to any position.

Dragging in the Thumbnail.
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Setting Magnification

There are two ways to set the Magnification:

• Use the magnification controls at the end of the scroll bar.

• Hold down the [Command] key and drag inside the Thumbnail view. 
When you release the mouse button, the selected part of the waveform will be shown in the 
waveform display.

• You can also adjust the existing view by dragging the left or right edge of the rectangle 
in the Thumbnail view.

[Command]-dragging in the Thumbnail view will 
select a part of the file for display.
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Playing Back

The Play and Loop buttons.

From any Position

1. Firstly, make sure no audio is selected, by clicking somewhere in the waveform display.
If some audio is selected, only this will play, see below.

2. If necessary, click in the ruler to set a new Song Position to play back from.

3. Press the Play button.
Playback continues as long as you hold the mouse button down, or until the end of the file.

Playing a certain section

1. Select the audio you want to play, for example by dragging over it.
For more on selecting, see page 407.

2. Press the Play button.
Playback continues as long as you hold the mouse button down, or until the end of the 
selection.

Looping

If the Loop button is activated, audio will loop continuously as long as you press 
the Play button.

• If no audio is selected, and you start playback from outside the segment, the entire file 
will loop.

• If no audio is selected, and you start playback from within the segment, only the seg-
ment will loop.

• If some audio is selected, this will loop.

Scrubbing and Auditioning

• The Wave editor has Auditioning tools like in the Audio editor, see page 351.

The Wave editor’s Audition and Scrub Tools.
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Selecting

A number of operations can be performed on the selected portion of the audio file. 
Making a selection in the Wave editor is very similar to selecting in other windows. 
The selected part of the waveform is displayed in inverse video.

Using the Mouse

To select from one point to another, proceed as follows:

• Click, hold down [Shift] and click again, or...

• Drag to create a selection rectangle.
The area between the two points will be selected.

Selecting all Audio in the Active segment

• If you use Select All on the Edit menu ([Command]-[A]), all audio in the active segment 
will be selected. 

Selecting all audio in the File

• If the active segment is already selected, using Select All will select the entire file. In 
other words, to select the entire file, press [Command]-[A] twice.

Adjusting the Selection’s Start and End Points numerically

In the upper right part of the Wave Editor window there are value boxes for the 
start and end positions of the selection (in samples). These can be adjusted using 
regular value editing.
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Working with Segments

Making a segment Active

As described on page 404, one of the segments in the file is indicated in a special 
way. This is called the active segment. You can display any of the file’s segments in 
this way:

1. Pull down the Segment pop-up menu.

The Wave editor’s segment menu holds a list of the File’s segments.

2. Select the desired segment.

Adjusting the Active segment’s Start and End points

Sample-accurate Editing

Adjusting segment start and end points in the Wave editor has advantages:

• When you adjust segment points in the Audio editor, the points always snap to ticks.
• In the Pool, you can adjust segments down to an accuracy of one single sample, but you have 

no graphical feedback.
• In the Wave editor you can adjust segments graphically and with single sample resolution.

Adjusting the Start and End Points by Dragging

By dragging the Inset handles, you can adjust the start and end points for the seg-
ment, just as in the Audio editor (see page 353), but with single sample resolution. If 
you need to, you may zoom in closely on the waveform for more precision.

Converting the Selection into a new segment

1. Create and adjust the selection as described on page 407.

2. Verify that the selection is as intended, by playing back.
Playing back in a loop is a great way of finding points that make musical sense.

3. Pull down the segment pop-up menu and select “Selection To Segment”.
The new segment will get the name of its audio file, but with an index number at the end of 
the name. If the file is named “Guitar” and there already are segments named “Guitar1”, 
“Guitar2” and “Guitar3”, the new segment will be named “Guitar4”.
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Moving the segment within the file

You can also adjust the segment’s start and end points simultaneously, that is, 
essentially “move” the segment within the file.

1. Select the Hand tool from the Toolbox.

2. Position the pointer somewhere within the segment, press the mouse button and drag 
left/right.

Moving the segment with the Hand tool.

Turning the Selection into a File

If you want to make the selection into a totally separate file, proceed as follows:

1. Make and adjust the selection as described for segments above.

2. Select “Selection To File” from the Wave editor’s File pop-up menu.

3. In the file dialog that appears, name and position the new file.
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Cutting and Pasting Audio

Caution!

❐ Cut and Paste in the Wave editor performs permanent changes to your audio files. If 
you need to make sure you don’t inadvertently change your recordings, use the Dupli-
cate File function in the Pool to make a copy of the file first.

Performing the Cut/Copy and Paste

For basic information on how to Copy and Paste, see the Getting Started book. The 
description below outlines the details specific to the Wave editor.

1. Select the Audio you want to Cut or Copy.

2. Select Cut or Copy from the Edit menu.

3. Set the Song Position where you want the Pasted block of audio to be inserted.

❐ The material you Paste always replaces existing material. This means it overwrites 
whatever audio was there before the Paste.

4. Select Paste.

Applying Processing Functions

On the Do pop-up menu you will find a number of processing functions that can be 
applied to the selection in the Wave editor. These are described in detail in the chap-
ter “Audio Functions”.
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Using an External Wave Editor

While the built-in Wave Editor in Cubase VST is perfectly adequate for many tasks, 
there are more advanced editors available as stand-alone applications. If you have 
such an application installed, you can launch it directly from within Cubase VST, ef-
fectively using it as a “second Wave Editor”.

❐ Note that not all wave editor applications support this feature. Examples of editor with 
which this works include Bias Peak™ and Digidesign Sound Designer II™.

Proceed as follows:

1. Select a Segment.
Only one Segment can be processed at a time. If you select several Segments or Events the 
first Segment in the selection will be edited. If you select a Part, the first Segment in it will be 
edited.

2. Pull down the Functions menu and select “Launch External Wave Editor” from the Au-
dio Functions submenu.

3. If this is the first time you use this command, a file dialog will appear, allowing you to 
locate the wave editor application. Do so and click “Open”.
Background playing in Cubase is automatically turned off and the editor is launched.

• Your choice of application is automatically stored, so that the next time you use the 
command, the correct editor is opened immediately.
Should you wish to open another editor, hold down [Command] and select “Launch External 
Wave Editor” to bring up the file dialog again. If a previously selected application cannot be 
found (e.g. if you have moved it on your hard disk), the file dialog will automatically appear.

4. The file that plays the selected Segment will appear in the editor, and the Segment will 
be made the selection.
You can now use any editing functions on the file and then save it, if required.

Please note the following very important points: 

❐ Deleting sections of the file concerned can produce unexpected results. Don’t do it. It is 
usually much faster to use Cubase’s ”Export Segment” facility to create a new file 
which contains only the Audio you require.

❐ Any editing you perform will be reflected in every Audio Segment which refers to that 
section of Audio File. If you require unique results, use ”Export Segment” to make a 
new file containing only the Audio you intend to edit.

5. When the editing is done, you can simply switch back to Cubase to hear the edited file 
in it's original “environment”.
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28
Mixing Audio and using Effects
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Introduction

The basic audio mixing procedures are described in the Getting Started book. This 
chapter contains detailed information about the elements used when mixing au-
dio, as well as descriptions of more advanced mixing options, such as automation.

• One mixing-related feature is not described in this chapter: how to mix down several 
Audio Tracks (complete with automation and effects if you wish) to a single audio file.
This feature is described in the chapter “Mixing down to an audio file”.

About Routing and Signal Paths

❐ The following descriptions assumes that you haven’t selected or configured a Mixer 
View. Mixer Views are described on page 459.

Cubase VST has a very flexible signal routing system. Below, each “stage” in the sig-
nal path is described briefly:

• Each Audio Channel is represented by a “channel strip” in the VST Channel Mixer. 

This is where you make settings for individual channels (Audio, Group, VST Instrument and Re-
Wire), such as volume, pan, equalization and effects. 
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• In the VST Channel Mixer, you can route each channel either to a stereo Output Bus or 
to a stereo Group.

If you are using audio hardware with one stereo output only, there will only be one Output 
Bus, called the Master Bus. However, there are always eight Groups available, regardless of 
the number of physical outputs on your audio hardware.
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• The eight stereo Groups have channel strips similar to audio channels in the VST Chan-
nel Mixer.
By routing several audio channels to the same Group, you can control them with a single set 
of controls and add the same EQ or effects to all of them. By default, Group channels are 
shown by scrolling the window to the right, where they appear to the right of the audio 
channel strips in the VST Channel Mixer.

The output of each Group can either be routed to an Output Bus, or to another successive 
Group, for further submixing or processing.

• Note that you can freely configure the Channel Mixer windows “1” and “2” with any 
combination of channel types.
Note also that these are not separate mixers, but two separate window “Views” of the same 
Channel Mixer. Configuring Mixer Views is described on page 459.
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• In the VST Master Mixer, you set the output level of each Output Bus.
For the Master Bus, the signal can pass through up to four Master Effects. 

Each Output Bus is connected to a physical output on the audio hardware. Again, if you’re 
using audio hardware with one stereo output only, the VST Master Mixer will only contain 
the Master Bus, which will be connected to this stereo output.

• By clicking the Master “On” button on the leftmost panel in the VST Channel Mixer, the 
Master Bus appears on the right side of the visible Channel Mixer window.
Only the Master Bus is shown here, not the separate Output Buses.
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• Each audio channel or Group can have up to four Insert Effects.

These are individual for each channel or Group, with no routing options. The audio signal will 
always pass through the Insert Effects (from top to bottom) and back to the audio channel or 
Group it came from.
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• Each audio channel or Group has eight effect sends.

• You can have up to eight Send Effects.
The output of each Send Effect can be routed to any of the available Output Buses.

• The Master Effects are stereo insert effects for the Master Bus.

You can have up to four different Master Effects. 

For each send there are the following routing options:

• Any of the eight Send Effects.
• A Group (or rather, the left or right side of the Group, 

since the sends are mono).
• An Output Bus (or rather, the left or right side of an Out-

put Bus). This allows you to use the sends for external 
effect processors, as you would on a physical mixer.
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Volume

On mixdown as well as during recording, the output level of each audio channel is 
controlled in two ways: with the faders in the VST Channel Mixer and with the Dy-
namic Volume Events in the Audio Editor.

VST Channel Mixer

In the VST Channel Mixer, each audio channel has a fader for volume control. You can 
also use the Mute and Solo buttons to silence one or several audio channels. The fad-
ers in the VST Master Mixer determine the final output level of the stereo mix (you 
may also route an audio channel via a Group channel - see page 453).

• The fader settings are displayed numerically below the faders.
The VST Channel Mixer allows you to boost weak signals by +6 dB, if you like. Just be sure to 
avoid signal levels above 0 dB (clipping).

• To make fine volume adjustments, hold down [Shift] when you move the faders.

• If you hold down [Command] and click on a fader, it will automatically be set to posi-
tion 0.0 dB.

• Faders for stereo pairs (both for regular audio channels, Groups and Buses) normally 
move together (move one and the other follows), but if you hold down [Option] you 
can change either independently.
For mono faders, the inverse is true. Hold down [Option] while moving a fader, to simulta-
neously control the other fader in an odd-even pair.

• To hear only the audio playback, click on the MIDI Mute button to the left in the VST 
Channel Mixer.
This mutes all MIDI playback, letting you concentrate on mixing the audio.

• The volume fader for an audio channel is “mirrored” in the Inspector.
Volume changes in the Inspector are reflected in the VST Channel Mixer, and vice versa. 
Please note that for stereo Audio Tracks, only the left channel volume is displayed in the In-
spector.

You can use the Channel, Group and Master faders to set up a volume balance be-
tween the audio channels and perform a manual mix, by moving the faders and 
other controls while playing back. By using the Write function (described on page 
463), you can automate the fader movements and other VST Channel Mixer actions.

• It is also possible to use a Remote MIDI Device to control volume and other VST set-
tings (see the chapter “Remote Controlling VST Objects”).

Dynamic Events

As described in the Audio Editor chapter, you can create a Volume curve for each Au-
dio Event, and thereby get automatic volume changes. The Volume values created 
by this curve are added to the volume fader values in the VST Channel Mixer, so you 
can combine the two ways of automating and controlling volume. The properties 
and differences of the two methods are discussed on page 463.
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Panning

Just as with Volume, the pan (stereo position) of each audio channel can be con-
trolled in two ways: with the Pan controls in the VST Channel Mixer or with the Dy-
namic Pan Events in the Audio Editor.

VST Channel Mixer

The Pan controls in the VST Channel Mixer pans the sound between the left and right 
side of the assigned stereo output bus. If your mix contains stereo recordings, you 
will probably want to pan each stereo pair hard left/right.

• When you are changing Pan for a channel, the setting is shown numerically (L64-<C>-
R64) in the level display below the fader.
To make the display show the fader setting again, click the fader handle.

• To make fine Pan adjustments, hold down [Shift] when you move the Pan control.

• To select center Pan position, hold down [Command] and click on the Pan control.

• The Pan control for an audio channel is “mirrored” in the Inspector.
Changing the Pan value in the Inspector is reflected in the VST Channel Mixer, and vice versa. 
Please note that for stereo Audio Tracks, only the left channel’s Pan is displayed in the In-
spector.

The Master and bus faders determine the levels of each “side” in the stereo output. 
There are no Pan controls in the Master window. Just as with Volumes you can au-
tomate the panning using the Write function or the Dynamic Events (see page 463).

Dynamic Events

You can use the Dynamic Events feature in the Audio Editor to create Pan curves for 
single Audio Events. The Pan value is determined by the last setting of either the Dy-
namic Pan Event, or the automated Pan in the VST Channel Mixer for that channel.
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EQ

Cubase VST is equipped with a powerful equalizer. You can have up to 4 bands of full 
parametric EQ per audio channel!

About EQing stereo channels

To add EQ to a stereo channel pair (or for a Group - see page 453), make the equalizer 
settings for the left side channel. Just as with the volume fader and other controls, 
the settings you make are automatically duplicated for the right side channel and 
vice versa.

❐ If you want to make independent EQ settings for one of the channels in a stereo pair, 
hold down [Option].

Opening the EQ and making settings

At the top of each audio channel strip in the VST Channel Mixer there are four but-
tons, labelled “INS”, “DYN”, “FX” and “EQ”. These all open the Channel Settings win-
dow. The “EQ” button is used to activate equalizing for the channel, but to be able 
to do that, you must first open the Channel Settings window:

❐ The DYN, INS, FX and EQ buttons are duplicated in the Inspector, which means you can 
open a Channel Settings window without displaying the VST Channel Mixer if you like.

1. Click the “EQ” button for the channel you want to apply EQ to.
The Channel Settings window opens. This contains a duplicate of the VST Channel Mixer 
channel strip, an Insert section (see page 437), a section with effect send knobs (see page 
432) and 4 EQ modules with an associated EQ curve display.

A Channel Settings window with two EQ modules active.
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2. Activate as many EQ modules as you need (up to four).
This can be done in two ways:

• By clicking on their “On” buttons.

• By clicking in the EQ curve display.
If you click in one of the divided frequency areas, a new point is added. These points are 
numbered 1 to 4 depending on which frequency area you click. Clicking in the leftmost fre-
quency area (20 - 500 Hz) activates EQ “1” and so on.

As soon as any of the EQs are activated, the “EQ” button indicator in the channel 
strip are lit and there will be a point added in the EQ curve display for each acti-
vated module.

3. Set the parameters for an activated EQ module.
This can be done in several ways:

• By using the knobs.

• By clicking a value field and entering values numerically.

• By using the mouse to drag points in the EQ curve display window.
By using this method, you control both the Gain and Frequency parameters simultaneously. 
The knobs turn accordingly when you drag points.

• If you press [Ctrl] while dragging, only the Gain parameter will be set.
• If you press [Shift] while dragging, only the “Q” parameter will be set.

The three basic EQ parameters are:

For the leftmost (EQ “1”) and rightmost (EQ “4”) modules, the following special 
modes are available:

Note that activating one of these modes disables the Q parameter for the corre-
sponding EQ module.

• To deactivate an EQ module, click its “On” button, double click its point in the EQ curve 
display or drag its point outside the display.

4. Close the Channel Settings window by clicking on its close box or pressing [Return].
In the VST Channel Mixer, the “EQ” button indicator for the audio channel will now be lit, 
which means EQ is applied to that channel.

Gain Governs the amount of boost or attenuation around the set frequency. The range is 
± 24 dB. 

Frequency The center frequency for the equalization. Around this frequency, the sound will be 
boosted or attenuated according to the Gain setting. The range is 20Hz -20kHz.

Q Sets the width of the frequency band around the center frequency to be affected. The 
narrower frequency band, the more drastic effect of the boost or attenuation. 

Low Shelf If this button is activated for the EQ “1” module, it will act as a Low Shelving filter.

Low Cut If this button is activated for the EQ “1” module, it will act as a High-Pass filter.

Hi Shelf If this button is activated for the EQ “4” module, it will act as a High Shelving filter.

Hi Cut If this button is activated for the EQ “4” module, it will act as a Low-Pass filter.
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Opening the EQ Panel without opening a New Window

If an Channel Settings window is open, and you want to make settings for another 
channel, you can have the new panel appear in the window that is already open, by 
holding down [Option] and clicking the EQ button for the new channel.

This makes the Channel Settings window for the second channel “replace” the first. 
This way, you avoid cluttering up your work area, and it also allows you to make all 
FX/EQ settings in the same part of the screen.

EQ Bypass

You can momentarily turn the EQ for a channel on and off, to compare the sound 
with and without EQ. There are two ways to do this:

• By using the Bypass button in the EQ section of the Channel Settings window.
• By [Command]-clicking the EQ button for a channel in the Mixer or in the Inspector.

Using EQ Presets

Some useful basic presets are included with the program, with descriptive names 
like “Boost Bass”. You can use them as they are, or as a starting point for further 
“tweaking”. To call up a Preset, proceed as follows:

• Pull down the Presets pop-up menu, by clicking in the Presets field, and select one of 
the available Presets.

Storing EQ Presets

If you have made EQ settings you wish to store for use elsewhere in a Project, you 
can store them in a Preset. Proceed as follows:

1. After making settings, click on the Store button in the EQ section.
The settings are stored with the default name “Preset” + a number. 

2. Double click in the Preset pop-up field and type in a new name if you wish.

Removing EQ Presets

• To remove a Preset, simply select it and click the “Remove” button.

Resetting the EQ Modules

• If you click the Reset button all EQ modules are deactivated and reset to the default 
settings.
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VST Dynamics

❐ The VST Dynamics panel is only available for regular audio channels (not for Group, 
ReWire or VST Instrument channels). There is, however, a plug-in simply named “Dy-
namics“which is available for all channel types. This plug-in is identical to VST Dynam-
ics panel except that it does not have the “SoftClip” and “AutoLevel” processors. In 
addition, the Dynamics plug-in can also be used as a Master Effect. See the separate 
document “The Included VST Effects” for additional information.

Each one of the “regular” audio channels (as opposed to ReWire, VST Instrument 
and Group channels) is equipped with an advanced Dynamics processor. Each VST 
Dynamics section combines five separate processors: AutoGate, Compress, Auto-
Level, Limit and SoftClip, covering a variety of Dynamic Processing functions. The 
VST Dynamics window is divided into five sections, containing controls and meters 
for each processor. The audio input is tapped pre channel fader and pre EQ, and the 
internal signal flow is printed in the lower right part of the Dynamics panel.

Opening VST Dynamics

The VST Dynamics processors are accessed on a separate panel for every audio 
channel, much like the EQ section. To open VST Dynamics from the VST Channel 
Mixer, proceed as follows:

• Click on the “DYN” button for an audio channel, either on the channel strip, or in the 
Inspector.
The Dynamics window opens, together with a duplicate of the channel strip, the Insert effect 
section and the effect sends section. As described on page 423, once you have opened a Dy-
namics window, you can open Dynamics panels for other channels without opening any new 
windows, by [Option]-Clicking.

This is in fact the same window as the EQ window, only showing another “panel”. 
To view the EQ panel instead, click the EQ button.

About Dynamics on Stereo Channels

If you apply VST Dynamics to a stereo channel pair, the panel for the left channel 
will be used to make VST Dynamics settings for both channels.

Clicking the “Dyn” button... ...opens the VST Dynamics window for that channel.
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Activating VST Dynamics and the individual Processors

You turn the individual processors on (and off) by clicking on their labels. Activated 
processors have highlighted labels.

The AutoGate is activated.

You can activate as many processors as you want, but remember that not all pro-
cessors are designed to work together. For example, “Limit” and “SoftClip” are both 
designed to ensure that the output never exceeds 0dB, but achieves this in differ-
ent ways. To have both of them activated would be unnecessary. 

• To turn off all activated VST Dynamics processors, click the lit On button in the lower 
right corner.
Clicking the button again activates the same configuration of processors.

❐ If you find that the audio playback signal is slightly delayed when you activate VST Dy-
namics, you should activate the “Plug-in Delay Compensation” option in the Audio 
System Setup dialog, as described on page 441.

VST Dynamics Bypass

You can momentarily turn VST Dynamics on and off for a channel, to compare the 
sound with and without processing. There are two ways to do this:

• By using the Bypass button in the VST Dynamics section of the Channel Settings window.
• By [Command]-clicking the “Dyn” button for a channel in the Mixer or in the Inspector.
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AutoGate section

AutoGate section.

Gating, or noise gating, is a method of dynamic processing that silences audio sig-
nals below a certain set threshold level. As soon as the signal level exceeds the set 
threshold, the gate opens to let the signal through. AutoGate offers all the features 
of a standard noise gate, plus some very useful additional features, such as auto cal-
ibration of the threshold setting, a look-ahead predict function, and frequency se-
lective triggering. Available parameters are as follows:

Parameter Values Explanation

Threshold -60 - 0dB This setting determines the level where AutoGate is activated. Sig-
nal levels above the set threshold triggers the gate to open, but sig-
nal levels below the set threshold will close the gate.

Attack 0,1 -100 ms or 
“Predict mode”

This parameter sets the time it takes for the gate to open after being 
triggered. If the Predict button is activated, it will ensure that the gate 
will already be open when a signal above the threshold level is played 
back. AutoGate manages this by “looking ahead” in the audio mate-
rial, checking for signals loud enough to pass the gate.

Hold 0 - 1000 ms This determines how long the gate stays open after the signal drops 
below the threshold level.

Release 10 - 1000 ms or 
“Auto”

This parameter sets the amount of time it takes for the gate to close 
(after the set hold time). If the “Auto” button is activated, AutoGate 
will find an optimal release setting, depending on the audio pro-
gram material.
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Trigger Frequency Range 

AutoGate has a feature that allows the gate to be triggered only by signals within a 
specified frequency range. This is a most useful feature because it lets you filter out 
parts of the signal that might otherwise trigger the gate in places you don’t want it 
to, thus allowing more control over the gate function. The Trigger Frequency 
Range function is controlled using the control in the upper part of the AutoGate 
panel, and the slider located below it. The basic operation of the Trigger Frequency 
Range function is as follows:

1. While playing back audio, drag the slider to the “Listen” position.
You will now monitor the audio signal, and the gate will be bypassed.

2. While listening, drag the two handles in the Trigger Frequency window to set the fre-
quency range you wish to use to trigger the gate.
You will hear the audio being filtered as you move the handles.

• Dragging the left handle to the right will progressively cut frequencies starting from the low 
end of the frequency spectrum.

• Dragging the right handle to the left will progressively cut frequencies starting from the high 
end of the frequency spectrum.

3. After setting the frequency range, drag the slider to the “On” position.
AutoGate will now use the selected frequency range as the trigger input.

4. To disable the Trigger Frequency Range function, drag the slider to “Off”.
AutoGate will now use the unfiltered audio signal as the trigger input.

Calibrate Function

This function, activated by using the Calibrate button located below the Threshold 
knob, is used to automatically set the threshold level. It is especially useful for ma-
terial with consistent inherent background noise in the audio material, like tape 
hiss for example. This may most of the time be masked by the audio content, but 
becomes noticeable during silent passages. Use as follows:

1. Find a part of the audio material, preferably not too short, where only the background 
noise is heard. 
If you can only find a short background noise section, try looping it.

2. Play it back, and click on the Calibrate button.
The button will blink for a few seconds, and then automatically set the threshold so that the 
noise will be silenced (gated) during passages where there is no other signal present.

The frequency range between the two 
handles will be used to trigger the gate.
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AutoLevel section

AutoLevel reduces signal level differences in audio material. It can be used to process 
recordings where the level unintentionally varies. It will boost low levels and attenu-
ate high level audio signals. Only levels above the set threshold will be processed, so 
low level noise or rumble will not be boosted. If the input level is greater than 0dB, 
AutoLevel will react very fast, because it “looks ahead” in the audio material for 
strong signal levels and can attenuate levels before they occur, thus reducing the risk 
of signal clipping. AutoLevel has the following parameters:

Parameter Values Explanation

Threshold -90 to -10dB Only levels stronger than the set threshold will be processed.

Reaction Time 
Switch

Slow, Mid, Fast This parameter sets the amount of time it takes for AutoLevel 
to adjust the gain. Set this according to whether the program 
level changes suddenly or over a length of time.
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Compress section

Compress reduces the dynamic range of the audio, so that softer sounds get louder 
or louder sounds get softer, or both. Compress functions like a standard compres-
sor with separate controls for threshold, ratio, attack, release and make-up gain pa-
rameters. Compress features a separate display that graphically illustrates the 
compressor curve shaped according to the Threshold, Ratio and MakeUp Gain pa-
rameter settings. Compress also features a Gain Reduction meter that shows the 
amount of gain reduction in dB, and a program dependent Auto feature for the Re-
lease parameter. The available parameters have the following functionality:

Parameter Values Explanation

Threshold -60 - 0dB This setting determines the level where Compress “kicks in”. Signal 
levels above the set threshold are affected, but signal levels below 
are not processed.

Ratio 1:1 - 8:1 Ratio determines the amount of gain reduction applied to signals 
over the set threshold. A ratio of 3:1 means that for every three dB the 
input level increases, the output level will increase by only one dB.

Attack 0.1-100 ms This determines how fast Compress will respond to signals above 
the set threshold. If the attack time is long, it means that more of 
the early part of the signal (attack) will pass through unprocessed.

Release 10-1000ms or 
“Auto mode”

Sets the amount of time it takes for the gain to return to its original 
level when the signal drops below the Threshold level. If the “Auto” 
button is activated, Compress will automatically find an optimal re-
lease setting, that varies depending on the audio program material.

MakeUp Gain 0 - 24dB This parameter is used to compensate for output gain loss, caused 
by compression.
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SoftClip section

SoftClip is designed to ensure that the output level never exceeds 0dB, like a lim-
iter. SoftClip, however, acts differently compared to a conventional limiter. When 
the signal level exceeds -6dB, SoftClip starts limiting (or clipping) the signal “softly”, 
at the same time generating harmonics which add a warm, tubelike characteristic 
to the audio material. SoftClip is simplicity itself to use as it has no control parame-
ters. The meter indicates the input signal level, and thus the amount of “softclip-
ping”. Levels in the green area (weaker than -6dB) are unaffected, while levels in the 
yellow-orange-red area indicate the degree of “softclipping”. The deep red meter 
area to the right indicates input levels higher than 0dB. 

• Avoid feeding SoftClip with excessively high signal levels as audible distortion may oc-
cur, although the output level will never exceed 0dB.

Limit section

Limit is designed to ensure that the output level never exceeds a certain set output 
level, to avoid clipping in following devices. Conventional limiters usually require 
very accurate setting up of the attack and release parameters, to totally avoid the 
possibility of the output level going beyond the set threshold level. Limit adjusts 
and optimizes these parameters automatically, according to the audio material. 
However, should you want to, you can adjust the Release parameter manually. The 
available parameters are as follows:

Parameter Values Explanation

Threshold -12 - 0dB This setting determines the maximum output level. Signal levels 
above the set threshold are affected, but signal levels below are left 
unaffected. When a signal is limited, the “Limiting” indicator is lit.

Release 10-1000ms or 
“Auto mode”

This parameter sets the amount of time it takes for the gain to return to 
its original level when the signal drops below the threshold level. If the 
“Auto” button is activated, Limit will automatically find an optimal re-
lease setting, that varies depending on the audio program material.
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Effects

About the difference between the three Effect types

In addition to the EQ, Cubase VST provide effects in three flavors:

• Send effects
Up to eight send effects can be used. When you use send effects, audio is routed through the 
effect processors via independent Effect Sends for each channel, just like on a “real” physical 
mixer. The output from each effect processor is then routed to one of the buses or the mas-
ter faders, where it can be mixed with the “dry” signal, if desired. These effects are mono in-
stereo out.

• Insert effects
An insert effect is inserted into the signal chain of an audio channel, which means that the 
whole channel signal passes through the effect. This makes inserts suitable for effects for 
which you don’t need to mix dry (direct) and wet (processed) sound, e.g. distortion, filters or 
other effects that change the tonal or dynamic characteristics of the sound.
You can have up to four different insert effects per channel.

• Master effects
Up to four stereo in-stereo out effect processors can be added to the signal on the master 
bus, the final stereo mix. Please note that there is no mixing of the dry/fx signals as there is 
with the send effects. Typical uses for master effects would be compressor/limiter effects, 
noise suppression units, etc.

❐ Only effects with stereo inputs can be used as master effects, regardless of whether 
Mono is activated in the Master window or not.

The effect processors are entirely “virtual”, that is, they are all in software. A number 
of effects are provided with the program and additional effects can be purchased 
from Steinberg and third party vendors.

• For descriptions of the included effects, see the separate effect documentations.
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Routing an Audio Channel through the Send Effects

This procedure is divided into three steps: Activating Effects, setting up the send 
section and making effect settings.

Activating Effects

You select effect types and programs in the VST Send Effects window:

1. Pull down the Panels menu and select VST Send Effects.
The VST Send Effects window opens. This resembles an effect rack, with up to eight separate 
“processors” arranged on top of each other. If you have less than eight effects selected, there 
will be a slot at the bottom of the window, labeled “No Effect”:

 

2. Pull down the pop-up menu by clicking in the “No Effect” slot.

In this example, there are four effects activated. 

In this example, there are no effects activated at all - only the “No 
Effect” slot is shown.
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Exactly which effect types are available depends on which VST plug-ins are in-
stalled on your computer. 

3. Select an effect from the list.
When you select an effect, the “No Effect” slot turns into a “normal” effect slot, and another 
“No Effect” slot appears below it in the window (provided that all eight effect slots aren’t al-
ready in use).

4. Activate the effect processor by clicking on its red “Power” button.

5. Make sure the effect output is routed to the desired Output Bus, by checking the bus 
pop-up (below the File pop-up).
The “normal” setting for this is “Master”. See page 493.

6. If you wish to activate more effects, repeat steps 2 to 5.
Remember that the Effects rely heavily on the CPU power in your computer. The more acti-
vated effect units, the more computer power will be used for effects.

❐ To turn off an effect completely, pull down the Effect Type pop-up menu and select “No 
Effect”.
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Setting up the Sends

1. Open the VST Channel Mixer.

2. Click on the FX button for the audio channel you want to add effects to.
The Channel Settings window opens, as described on the previous pages (you can also open 
this by clicking on the FX button in the Inspector). The section to the left of the EQ modules 
contains the effect sends.

3. Make sure the “Bypass” button is not pressed.
When this button is pressed, all eight effect sends are deactivated for the channel. Click on it 
to turn the function on/off.

4. Click on the “On” button for one of the effect sends and turn the corresponding Send 
level knob to a moderate value.

Send level

Pre-fader Send switch

Bypass Button (affects all eight sends)

Send Routing Pop-up

Send On/Off
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5. Pull down the pop-up menu by clicking in the field below the Send level knob.
This is the Send Routing pop-up menu, used for routing the send to the desired effect pro-
cessor.

The first items on this menu correspond to the activated internal effects (up to eight) while 
the following items route the effect sends to Buses and Groups. See page 493 and page 454.

6. Select an effect from the pop-up menu.

7. If you want the signal to be sent to the effects before the faders, click on the Pre button 
for the send.
With Pre-fader effect sends, the amount of effect for the channel is not affected by the volume 
fader. With Post-fader effect sends (Pre button not pressed), the amount of effect is propor-
tional to the channel volume, and will change with the volume fader movements.

8. If you want to use several effects for this audio channel, repeat steps 4 to 7 above for 
the other effect sends.
Make sure to deactivate all effect sends you don’t intend to use. 

• You can open the VST Send Effects window by double clicking on the Send Routing 
pop-up menu field.
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Making settings for the Effects

The final step is to select programs and make settings for the effect processors. 
Since you will probably need to adjust the send levels while doing this, leave the 
Channel Settings window open.

1. Use the Effects Master slider to the left on the processor panel to set the amount of in-
put level to an effect processor.

2. You can switch between different effect program presets by pulling down the Program 
pop-up in the VST Effects panel.
The number of program locations depends on the selected effect type.

Clicking here...

• You can also edit the effect settings, as described on page 442.

3. Use the send level knob in the Channel Settings window to control the amount of 
effect for the audio channel.

4. If you have several effect processors activated, repeat steps 1 to 3 for these. 

❐ The effect settings can be automated, as described on page 464.

❐ You can turn all activated Sends on and off for a channel by clicking the Bypass button 
above the Sends in the Channel Settings window, or by [Command]-clicking the chan-
nel’s “FX” button in the VST Mixer or in the Inspector.

Effects Master slider

...opens the Program pop-up.
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About Cubase VST’s Implementation of Insert Effects

Inserts are serial

You can apply up to four effects per channel. The signal passes through the effects 
in series from the top downwards.

Each Channel has its own Insert Effects

Each channel (and Group - see page 453) has its own set of four effects which are 
totally independent of the other channels. This means that (in a system where addi-
tional effect plug-ins have been added) Channel 1 can be routed through distor-
tion, gating and compression, whereas Channel 2 can be routed through tremolo, 
compression and a spectral enhancer, etc. 

Insert effects require the same processing power as any other effect type. This means 
that applying insert effects on many channels uses up far more processing power 
than the send effects (eight in total for the whole program). Remember that you can 
use the VST Performance window to keep an eye on the CPU load.

Which Effect Plug-ins can I use for Insert Effects?

Most effect plug-ins will work fine as Insert Effects. In general, the only restrictions 
are with the number of Inputs and Outputs in the Effects:

• For a Plug-In to be usable as an Insert Effect, it has to have 1 or 2 inputs and 1 or 2 out-
puts.
This may seem obvious, but it is also possible to have effect plug-ins either with more than 
two inputs or outputs, or even no inputs or outputs at all. These cannot be used as Insert ef-
fects. 

The number of inputs and outputs can also determine whether you use the Insert 
effects on a single (mono) audio channel or on a stereo channel pair:

• For stereo audio channels, you need to use an effect with stereo inputs (e.g. one of the 
master effects).
It is possible to use a mono-input effect with a stereo channel pair, but then only the left 
channel in the pair will be processed, which is probably not what you want.

• For mono audio channels, you can use mono- or stereo-input effects.
However, since the audio channel is in mono, the output of the effect will also be in mono. 
For stereo output effects, the left channel will then be used.
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Routing an Audio Channel through Insert Effects

1. Open the VST Channel Mixer.

2. Locate the audio channel you want to add insert effects to, and click on its “INS” but-
ton.

❐ For stereo Tracks, there will only be one INS button, for the left channel in the audio 
channel pair. However, both channels in the pair are routed through the Insert effect 
(provided it’s a stereo-input effect - see above). 

The Channel Settings window opens. The Insert section is located to the right of the dupli-
cate channel strip.

3. Select and activate an Effect, by clicking in the “No Effect” field.
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4. If required, use the parameters in the effect’s control panel (see page 442) to adjust 
input level and balance between dry and effect signal.
Since the entire signal passes through the effect, you will only hear the “wet” (processed) sig-
nal on the output, unless you adjust the settings of the effect to make the output include 
some of the “dry” (unprocessed) sound as well.

❐ Not all Effect Plug-ins have dry/wet balance controls.

5. If you want to, repeat steps 2-3 for the other effect processors.
Avoid activating effect processors that you don’t use, since this draws extra processor power. 
To minimize the processor load, pull down the Effect type pop-up for the unused processors, 
and select “No Effect”.

• To turn off an Insert Effect, click on its On button.

❐ The INS button in the VST Channel Mixer and the Inspector will light up for channels 
with Insert effects activated.

❐ You can turn all activated Inserts on and off for a channel by clicking the Bypass button 
above the Inserts in the Channel Settings window, or by [Command]-clicking the chan-
nel’s “INS” button in the VST Mixer or in the Inspector.

Using Master Effects

1. Pull down the Panels menu and select “VST Master Effects”.
The VST Master Effect rack appears. You can also click the Master FX button in the VST Master 
window to open the Master Effects panel.

2. Pull down the Effect type pop-up and select the plug-in.

3. Activate the red “Power” button.
The master mix signal is now routed through the plug-in.

4. Make settings for the effect.
This is done by clicking the Edit button to bring up a window with parameters for the effect 
(see page 442).

5. Repeat steps 3 and 4 for all effects you want to insert.
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6. If you open the VST Master Mixer by selecting it from the Panels menu, or by clicking the 
Master “On” button in the VST Channel Mixer, you will find the name of the selected ef-
fect(s) in the Master Effect slots.
These are actually duplicates of the Effect type pop-up menus in the VST Master Effects window. 
Clicking on one of them pulls down the pop-up menu, allowing you to select another Effect 
without having to open the Master Effects window.

• You can switch individual Master Effects on and off in the Master Mixer by using the 
“On” buttons to the right of the Master Effect slots.
This turns the Power button on and off for the corresponding Effect in the VST Master Effect 
panel.

• You can solo one or more Master Effects in the VST Master Mixer by using the “S” but-
tons to the right of the Master Effect slots.
If a “S” button is activated for a corresponding Master Effect, any other activated Master Effects 
will be muted (bypassed).

• You can bypass (mute) all Master Effects by clicking the Bypass button in the VST Master 
Mixer or by [Command]-clicking the “Master FX” button above the Master effect slots.

• You can save “Sets” of Master Effect configurations and settings, for use in other Songs.
This is explained on page 451.

• To completely deactivate a Master Effect (as opposed to just turning off the Power but-
ton), select “No Effect” for the corresponding slot in the Master. 
Simply turning off the Power switch will still cause the effect to use some computer memory.

• Among the Master Effect controls in the Master Mixer panel, you will also find buttons 
for activating Dithering.
This is described on page 446.
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Routing MIDI to VST Plug-ins

Version 2.0 of the VST Plug-in standard allows plug-ins to receive MIDI from the 
host application (in this case, Cubase VST). Possible uses for this feature include 
tempo-based delays, MIDI control of pitch-shifters and harmonizers, etc. The fol-
lowing basic rules apply:

• If a VST 2.0 Plug-in that supports MIDI Input is activated, it automatically appears as a 
MIDI Output in the Arrange window.
To direct MIDI data from a Track to the plug-in, you simply select it in the Output column for 
the Track.

• MIDI Timing information is automatically provided to any VST 2.0 plug-in that “re-
quests it”.
You don’t need to make any special settings for this.

A special application of VST 2.0 plug-ins are VST Instruments.

Plug-In Delay Compensation

Some effect plug-ins may have a certain delay, which will be noticeable especially 
when you use them as Insert effects. If you experience delayed audio playback from 
Tracks with Insert effects, you should activate Plug-In Delay Compensation in the 
Audio System Setup dialog. When this option is activated, the playback timing of 
the delayed Tracks is adjusted to compensate for the delay in the plug-ins.

❐ You may also need to activate this option when you are using the Channel Settings VST 
Dynamics panel. Even though these are not accessed as Insert Effects, technically they 
are just that, and may cause an audible delay.



- 442 - 

Editing Effects

In both the effect windows and in the Channel Settings you will notice a button la-
beled “Edit”. Clicking on the Edit button opens the selected effect’s control panel 
where you can make parameter settings.

• You can also go directly to the control panel of a Send Effect by [Command]-clicking 
the “On” button for the corresponding Send in the Channel Settings window.

Depending on the selected effect plug-in, this will open one of the following two 
types of control panel:

• A “Standard” effect control panel.

The left side of the panel shows the parameter name and current value, the right side contains 
sliders for changing each parameter value. The available parameters depend on the effect.

• A “Custom” control panel.

Other effects have custom windows for making settings. 

• All effect control panels, custom and standard, have a Power button, a name field, a 
Program pop-up menu and a File pop-up menu.
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Editing Standard Effects

For standard control panels you can set parameter values in two ways:

• By using the Value Slider.
Press [Shift] while dragging the slider to set values in finer increments.

• By typing in a new value and pressing [Return].
This feature is only available for plug-ins in the VST 2 format.

Editing “Custom Panel” Effects

Custom control panels may have any combination of knobs, sliders, buttons and 
graphic curves. For specifics about the included effects, please refer to the separate 
document “The Included Effects”.

❐ The Effect settings are saved with your Song. If you want to use your edited effects in 
other Songs, you can save and load them separately, as described on page 444.

Naming Effects

You can freely edit the effect parameters as described on the previous pages, and 
even name your edited effects. If you want to name the current settings, the follow-
ing points apply:

• The basis for the current settings may have been a preset effect program, in which case 
there is a name in the Program Name field.

• The basis for the current settings may have been a default setting program location in 
which case “Init” is displayed in the Program Name field.

In both cases, if you have changed any effect parameter settings, these are already 
saved! To name the current settings, click the Name field, type in a new name and 
press [Return]. The new name replaces the previous name on the Program pop-up 
menu.
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Saving Effects

You can save your edited effects for future use by using the File pop-up menu:

1. Pull down the File pop-up menu.

• If you want to save the current Program only, select “Save Effect”.
Effect Programs have the extension “fxp”.

• If you want to save all Programs for the Effect Type, select “Save Bank”.
Effect Banks have the extension “fxb”.

2. In the file dialog that appears, select a name and location for the file.
It might be a good idea to prepare a special folder for your effects.

3. Click Save.

Loading Effects

You can load effects from disk for use in the selected effect processor:

1. Pull down the File pop-up menu.

• If you want to load a single Program only, select “Load Effect”.

• If you want to load a complete Program Bank, select “Load Bank”.

2. In the file dialog that appears, find and select the file you want to load.

3. Click Open.
If you loaded a Bank, it will replace the current set of all effect programs. If you loaded a single 
effect, it will replace the currently selected effect Program only.

Organizing Plug-ins

If you have a large number of VST plug-ins, having them all on a single pop-up 
menu in the program may become unmanageable. Luckily there is an easy way to 
solve this:

1. Locate and open the folder “VstPlugIns” within the Cubase VST program folder.
This is where all the effect plug-in files are stored.

2. Create sub-folders within the VstPlugIns folder and move different plug-in files to dif-
ferent folders.
For example, you could organize your effects after category (one reverb folder, one chorus/
flanger folder, etc.), or after manufacturer.

3. When you launch the program and pull down an Effects pop-up menu, the sub-folders 
will be represented by hierarchical submenus.
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About the “Earlier” VST Plug-ins

Cubase 5.0 features a completely new set of VST plug-in effects. For the sake of 
backward compatibility, the plug-ins that came with previous versions of Cubase 
VST are also included with Cubase 5.0. These are located in the sub-folder “Earlier 
VST Plug-Ins”, and will therefore appear on a separate submenu on the Effects pop-
up menus.
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Using Dither

Dithering is a method for reducing quantization errors in digital recordings. The 
theory behind this is that during low level passages, only a few bits are used to rep-
resent the signal, which leads to quantization errors and hence, distortion. For ex-
ample, when “truncating bits”, as a result of moving from 24- to 16-bit resolution, 
quantization errors are added to an otherwise immaculate recording. By adding a 
special kind of noise at an extremely low level, these errors are minimized.

In Cubase VST, this is mainly relevant when you are mixing down to a new audio 
file, using the Export Audio Tracks function (see page 499). Since all internal audio 
processing is done at a very high resolution (32 bit float), mixing down to an audio 
file of lower resolution (typically 16 bits) would introduce the kind of quantization 
errors described above. Therefore:

❐ When exporting to an audio file of low resolution, you should activate Dithering. 

Basically, “low resolution” would mean 8, 16 or 24 bits, but in the case of Cubase 
VST/32, this only applies to 16 bit files. As described below, this is because the Apo-
gee UV-22 dithering algorithm used in Cubase VST/32 always dithers to 16 bits.

You could also consider using dithering when mixing down to an external medium 
(such as a DAT recorder). As always, you should let your ears be the judge.

Activating Dither

Depending on which version of Cubase VST you are using, the available Dither 
functions differ:

• In the standard Cubase VST and Cubase VST Score, the function is simply called “Dither”. 
Dither is activated by clicking the Dither “ON” button in the VST Master Mixer (in the signal 
flow chart to the right of the Master Bus faders).

• Cubase VST/32 has an advanced dithering algorithm called “UV22”, developed by 
Apogee.
UV22 dithering is activated by clicking the “ON” button below the UV22 logotype in the VST 
Master Mixer.

The Dither buttons in standard Cubase VST/Cubase VST Score (left) and Cubase VST/32 (right).

• For both versions, to make settings you need to open the control panel by clicking the 
Dither “EDIT” button.
From here on, the descriptions are specific to the respective dithering type.
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Settings in the Dither Control Panel (Cubase VST and Score only)

Dither is always applied post Master bus fader. The control panel comes up as “Master Effect 5" 
to indicate this special Master effect mode.

The following options can be set in the Dither Control Panel:

• Dithering Type
There are no hard and fast rules for the following options, it all depends on the type of mate-
rial you are processing. We recommend that you experiment and let your ears be the final 
judge:

• Noise Shaping Options (Off, Type 1 - 3)
This parameter alters the character of the noise added when dithering. Again, there are no 
fixed general rules, but you may notice that the higher the number selected here, the more 
the noise is moved out of the ear’s most sensitive range, the midrange.

• Dither Bits
This is used to specify the intended bit resolution for the final result. Available options are 8, 
16, 20 or 24 bit resolution.

Option Description

Off No dithering is applied.

Type 1 Try this first, it is the most “all-round” type.

Type 2 This method emphasizes higher frequencies more than Type 1.
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Settings in the Apogee UV 22 Control Panel (Cubase VST/32 only)

Dither is always applied post Master bus fader. The control panel comes up as “Master Effect 5" 
to indicate this special Master effect mode.

The following options can be set in the Apogee UV 22 Control Panel:

❐ Apogee UV 22 always dithers to 16 bit resolution.

Option Description

Normal Try this first, it is the most “all-round” type.

Low This applies a lower level of dither noise.

Autoblack When this is activated the dither noise is gated (muted) during silent passages in 
the material.
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Copying settings between Channels

It is possible to copy all Channel settings for an audio channel and paste it onto an-
other channel. For example, you can copy EQ settings from one channel to another, 
if you want them to have the same sound. Proceed as follows:

1. Locate the channel you want to copy settings from and click on its channel number 
button (at the bottom of the channel strip).

The button lights up, indicating that the channel is selected.

2. Pull down the Edit menu and select Copy (or use the corresponding key command - by 
default [Command]-[C]).

3. Select the channel you want to copy settings to by clicking on its channel number but-
ton in a similar way.

4. Pull down the Edit menu and select Paste (or use a key command - by default [Com-
mand]-[V]).
All settings are copied to the selected channel.

• If you don’t want to copy the Insert Effects, hold down [Shift] while pasting (i.e. press 
[Command]-[Shift]-[V], by default).
This pastes all settings except the Insert Effects.

5. If you wish to copy the same settings to several channels, repeat steps 3 to 4.
You might for example want to apply the same settings to both channels in a stereo pair.
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Saving Mixer Settings

It is possible to save complete Mixer Settings for some or all channels in the VST 
Channel Mixer. These can then later be loaded into any Song. 

Save Selected Channels

This will save all Channel Settings and the Output Bus routing for the selected 
Channels.

• Effects loaded in the VST Send Effects panel will not be saved. 
Thus, the Send routing assigned for the selected channel(s) will not be saved, although the 
Send levels, Pre/post and On/Off settings are. 

• Insert effects settings are saved.

Proceed as follows:

1. Select the Channel you wish to save settings for, by clicking on its channel number but-
ton (at the bottom of the channel strip).
To select several channels, press [Shift] while clicking on the channel number buttons.

2. Pull down the File pop-up located at the bottom left in the VST Channel Mixer and se-
lect “Save Selected Channels” from the menu.

A standard file dialog appears, allowing you to name the file and navigate to a folder to save 
it in.

3. Click “Save” when you are done.

This channel is selected.
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Save Master and Sends

“Save Master and Sends” will save all settings in the Master Mixer, including Output 
Bus levels and Active status, Master Bus level, and all assignments and settings in 
the VST Send Effects and VST Master Effects windows.

• You do not have to select channels for this operation.

1. Pull down the VST Channel Mixer File pop-up and select “Save Master and Sends” from 
the menu.
A standard file dialog appears, allowing you to name the file and navigate to a folder to save 
it in.

2. Click “Save” when you are done.

Save Master Fx

This item will save the current Master Effects configuration and settings. It appears 
both on the File pop-up in the VST Channel Mixer, and on the “Sets” File pop-up in 
the VST Master Mixer. 

1. Pull down the VST Channel Mixer File pop-up and select “Save Master Fx” from the 
menu.
A standard file dialog appears, allowing you to name the file and navigate to a folder to save 
it in.

2. Click “Save” when you are done.

Save All Mixer Settings

“Save All Mixer Settings” saves everything. This is the same as using “Save Selected 
Channels” with all channels selected, and using “Save Master and Sends”, all in one 
go. Proceed as follows:

1. Pull down the VST Channel Mixer File pop-up and select “Save All Mixer Settings” from 
the menu.
A standard file dialog appears, allowing you to name the file and navigate to a folder to save 
it in.

2. Click “Save” when you are done.



- 452 - 

Loading Mixer Settings

Load Selected Channels

To load Mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels in the new Song to match the number of channels 
you saved settings for in the previous Song.
For example, if you saved settings for six channels, then select six channels in the VST Mixer.

• Channel Mixer settings will be applied in the same order as they appear in the VST 
Mixer, when saved.
Thus, if you save settings from channels 4, 6 and 8 and apply these settings to channels 1, 2 
and 3, the settings saved for channel 4 would be applied to channel 1, the settings saved 
from channel 6 to channel 2 and so on.

• If you have selected fewer channels than the number of channels in the saved file, the 
“last” settings in the saved file (the saved settings for the channels with the highest 
numbers) will be disregarded.

• If you have selected more channels than the number of channels in the saved file, only 
the first selected channels (the channels with the lowest numbers) will be affected.

2. Pull down the VST Channel Mixer File pop-up and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Click “Open” to apply the saved settings to the selected Channels.

Load Master and Sends

As these settings are global for the whole Mixer, no channels need to be selected.

1. Pull down the VST Channel Mixer File pop-up and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

2. Click “Open”.
The saved Master Mixer settings, including Bus Output levels and all Send and Master Effect 
assignments and settings are applied.

Load Master Fx

This item allows you to load Master Effect combinations and settings. It is available 
separately on the “Sets” File pop-up in the Master Mixer, as well as on the File pop-
up in the VST Channel Mixer.

1. Pull down the VST Channel Mixer File pop-up and select “Load Master Fx”.
A standard file dialog appears, where you can locate the saved file.

2. Click “Open” to recall the saved Master effects.

Load All Mixer Settings

When this is loaded, the saved complete Mixer settings for all Channels are applied.

• Please note that if the file contains Mixer settings for 24 channels, and the current 
Song uses 16 Channels, only the settings for channels 1-16 will be applied - this func-
tion will not automatically add channels.
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Group Channels

Apart from the “regular” audio channels, Cubase VST provides eight stereo Groups. 
As mentioned on page 413, you can route several audio channels to the same 
Group, to mix them with a single set of controls and add the same EQ or effects to all 
of them. This section describes the VST Groups and how to use them.

Routing an Audio Channel to a Group

1. Open the VST Channel Mixer 1.

2. Locate the audio channel you want to route, and pull down the pop-up menu at the 
bottom of its channel strip.
On the pop-up menu, the Groups are listed after the available Output Buses (see page 413).

In this case, only one Output Bus is available (Master).

3. Select one of the eight Groups.
The output of the audio channel is now redirected to the selected Group.

❐ The Groups are in stereo, which means that the pan setting for the audio channel is 
taken into account when you route the channel to a Group. 
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Routing an Effect Send to a Group

1. Open the Channel Settings window for an audio channel, by clicking on its FX button in 
the VST Channel Mixer or the Inspector.

2. Activate a Send.

3. Pull down the Send Routing pop-up below the Send level knob and select one of the 
Groups on the list.
Note that the Send is routed to one side of a Group.

4. Adjust the volume with the Send level knob.
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Viewing the Groups

• Open the VST Channel Mixer 1 and scroll it to the right.
The Group strips are displayed to the far right in the window.

The Group channel strips are displayed in blue, to distinguish them from the regular channel 
strips.

❐ If the Group channel strips are not visible in any of the two Channel Mixers, you need 
to select a Mixer View that contains the Groups. See page 459.
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Settings for Groups

The Group channel strips have the same functionality as regular stereo channel 
strips. Some things to note:

• The Groups are always in stereo.
As with stereo channel pairs, all controls are “ganged” - dragging one fader will automatically 
move the other as well. If you want to make independent settings for a channel “side”, hold 
down [Option].

• You can route the output of a Group to an Output Bus or to another Group with a 
higher number.
You cannot route a Group to itself or to Groups to the left of it in the VST Channel Mixer. 
Routing is done with the pop-up menu at the bottom of each channel strip, independently 
for each “side” of a Group.

• Group channel strips have no Input (Monitoring) or “In” buttons.
This is because Inputs are never connected directly to a Group.

• Group channel strips have no VST Dynamics panel.

An Example

In this example, we have four Audio Tracks you want to “treat as one”. For example, 
this could be four recordings of background vocals, which you want to mix as one 
entity:

Since you are applying EQ to a stereo submix (two channels) rather than to each 
individual Audio Channel (four channels), you will save processor power. Also, any 
EQ and Effect settings you make will affect all four channels - you don’t have to 
copy settings. To set up the routing like this, proceed as follows:

1. Play back the four audio channels together and set up volume balance and panning.
In the diagram above, each channel has been panned differently, to spread the background 
vocals in the stereo image.

2. For each of the four audio channels, pull down the pop-up menu at the bottom of the 
channel strip, and select “Grp 1”.
This routes the output of the audio channels to the Group instead of to an Output Bus.

Audio Channel 1

Master Bus

VST Reverb

Physical Audio Outputs

Audio Channel 2

Audio Channel 3

Audio Channel 4

Pan L30, Output to Group 1

Pan L15, Output to Group 1

Pan R15, Output to Group 1

Pan R30, Output to Group 1

• Post-fader send

• EQ active

• Output to Master

Group 1 settings:
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3. Pull down the Panels menu and select VST Channel Mixer 1, and scroll to the right until 
you see the Group channel strips.
If you cannot see the Group channels, you may need to select a Mixer View that contains 
Groups, as described on page 459.

4. Locate Group 1 and make sure that its channel strips are panned fully left and right.

5. Pull down the Output Routing pop-up menu at the bottom of the channel strip and se-
lect “Master”.
This routes the output of the Group to the Master Bus.

6. Click on the big FX button to the left in the VST Channel Mixer window.
The VST Send Effects window opens.

7. Select and activate the “Reverb” effect.
How to do this is described on page 432.

8. In the VST Channel Mixer, click the EQ button for Group 1.
The Channel Settings window for Group 1 opens.

9. Activate and set up equalization for the Group.
The parameters are described on page 421.

10.Activate an effect send, and route it to the “Reverb” effect.
See page 432.

11.Activate playback, and use the Group 1 faders to set the level of the combined back-
ground vocal recordings.
The two level faders for a Group are automatically “ganged” so that they move together 
when you drag one of them.
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ReWire Channels

If you have ReWire activated (see the chapter “ReWire”), a number of ReWire chan-
nels will appear in the VST Channel Mixer:

• ReWire channels are displayed in red, and appear to the right of the regular audio 
channels.
If you cannot see the ReWire channels, you need to select a Mixer View that contains ReWire 
channels (see page 459).

• ReWire channels may be mono channels, stereo channel pairs or any combination, de-
pending on the synthesizer application.

• ReWire channels have the same functionality as regular audio channels.
This means you can set volume and pan, add EQ, Insert and Send Effects and route the chan-
nel outputs to Groups or Buses. All settings can be automated using the Read/Write func-
tions. However, ReWire channels have no Input/Monitor buttons and no VST Dynamics.

• All unmuted ReWire channels are included when you mix down to an audio file using 
the Export Audio File function (see page 499).

VST Instrument Channels

If you have one or several Instruments selected in the VST Instruments window, 
(see the chapter “VST Instruments”) a number of VST Instrument channels will ap-
pear in the VST Channel Mixers:

• VST Instrument channels appear to the right of the ReWire channels.
If you cannot see the VST Instrument channels, you need to select a Mixer View that contains 
VST Instruments (see page 459).

• The number of VST Instrument channels depends on the selected Instruments.
A single-timbral stereo Instrument will have two channels, while a multi-timbral Instrument 
will have several channels.

• VST Instrument channels have the same functionality as regular audio channels.
This means you can set volume and pan, add EQ, Insert and Send Effects and route the chan-
nel outputs to Groups or Buses. However, VST Instrument channels have no Input/Monitor 
buttons and no VST Dynamics.

• The VST Instrument channel settings can be automated just as regular audio chan-
nels.
Note however, that the actual VST Instrument parameters have their own automation, as de-
scribed in the chapter “VST Instruments”.

• All unmuted VST Instrument channels are included when you mix down to an audio file 
using the Export Audio File function (see page 499).
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VST Mixer Views

Mixer Views are user definable configurations of the two VST Channel Mixer win-
dows. If you are working with a large number of channels in the VST Mixer, it may be 
convenient to be able to hide certain channels (or channel types) to improve the 
overview. Furthermore, since you can select separate Mixer Views for the two Chan-
nel Mixer windows, you can use the two windows more freely, for example showing 
regular audio channels and Instrument channels in one window and only ReWire 
channels in the other.

You can configure your own Mixer Views, containing any combination of Group, 
ReWire, Instrument and “regular” channel strips. For each Song, you can store up to 
32 different Mixer Views.

Selecting Mixer Views

1. Open one of the VST Channel Mixers from the Panels Menu.
You can select Mixer Views independently for both Mixer windows.

2. Click the “View” pop-up, located below the automation buttons in the VST Mixer.
A list of 32 Mixer Views is shown, 12 of them being preset combinations of Mixer Channel 
types. The remaining 20 are non-configured Views named “Default”.

Opening the Mixer Views list.

3. Select one of the Views by clicking on it in the list.
The list closes and the Mixer is re-configured according to the settings in the selected View.

• The current Mixer View selections (for both the Channel Mixers) are stored when you 
save your Song.
You may customize which Views are initially shown in new Songs, by changing Mixer View 
selections in the Autoload Song.
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Editing Mixer Views

1. Click the “View” pop-up, and select “EDIT” from the top of the list.
This opens the VST Mixer Views window, where you can specify which VST Channels are to 
be shown or hidden in the different VST Mixer Views.

The Mixer Views window.

There are four types of Mixer Channels available, each represented by a folder: Channels, Re-
Wire, Instruments and Groups. The Mixer window is divided into four columns: Type, Channel, 
Visible and Active. At the top of the window there is a pop-up menu for selecting a View to 
edit. This also serves as a name field where you can name the currently selected View.

2. Select one of the “Default” Views from the pop-up.
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3. Open the “Channel” folder by clicking on the arrow beside the folder icon.
The available Audio Channels are shown. 

Mixer Views Channels folder.

4. Hide the desired Audio Channels by deactivating their checkboxes in the “Visible” col-
umn.
Only channels with ticked checkboxes will be visible in the VST Channel Mixer.

5. Use the same procedure for other types of Mixer Channels.

6. Name the edited View by double clicking on the name field at the top of the Mixer View 
window and typing in a new name.
We recommend that you give your Views descriptive names for easier recall.

7. Press [Return] to close the Mixer View window.
The edited View is now available on the View pop-up menu.

The following conditions apply for the Mixer Views:

• The number of Audio Channels that can be shown is dependent on the number of 
available audio channels specified in the Audio System Setup dialog.

• By default, the “All” View contains all available Audio Channels, all eight Groups plus 
all active ReWire channels and the currently activated VST Instruments.

• The Mixer View configurations are saved with the Song.
If you want to work with the same set of Mixer Views in all new Songs, you should edit the 
Mixer View configurations in the Autoload Song.

❐ To be able to select and view ReWire Mixer Channels, you must have a ReWire compat-
ible program (such as ReBirth RB338 2.0.1 or later) installed on your hard drive, and at 
least one channel activated in the ReWire dialog.

❐ To be able to select and view Instrument Mixer Channels you must have a VST Instru-
ment activated (see page 476).

The Channel Type 
column.

The Channel 
number column.

The Visible 
column.

The Active column 
(ReWire channels only).
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Changing the Meter Characteristics

You can change the VST Mixer’s level meters characteristics by using the Meter 
Fast/Hold buttons on the leftmost panel in the VST Channel Mixer. These operate in 
the following way:

• If “Fast” is activated, the meters respond very quickly to level peaks.

• If “Fast” is deactivated (“ON” button is dark), the meters respond more like standard 
VU meters.

• If “Hold” is activated, the highest registered peak levels are “held” and are shown as 
static horizontal lines in the meter.

Reset Switch

By clicking the Reset button in any of the VST Channel Mixer windows, you can re-
set all VST parameters to their default settings. Default VST parameter settings are 
as follows:

• All VST Audio, Group and ReWire channel faders are set to 0dB, and all Solo and Mute 
settings are disabled. 

• All VST Audio and ReWire channel Pan settings are reset to center position, or panned 
left and right for stereo Audio Tracks, Groups and ReWire stereo Mix buses.

• All Insert, Send and Master Effects are unloaded.

• All EQ parameters are reset and disabled.

• Channel Output routing to Groups or output buses will be reset to the Master Output.

❐ ReWire channel strip parameters (level, pan, etc.) will be reset, but the Active settings 
for ReWire channels will be unaffected by the Reset function.
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Volume and Pan Automation – Dynamic Events or VST 
Channel Mixer

Cubase VST offers two ways of automating volume and pan: the Dynamic Events 
set in the Audio Editor and the Write function in the VST Channel Mixer. The two 
methods have their specific properties and uses, as described below:

Dynamic Events

The Dynamic events allow you to control the volume and panning individually for 
each segment. This allows you to create fade-ins, fade-outs and auto-pan effects, 
which are then integral parts of each segment. This is all done in the Audio Editor, 
see page 387.

What this means is that if you for example create a volume curve for one segment, 
and later copy this segment for use in other places in the song, all copies will “in-
herit” the volume curve of the original segment. You can later adjust the curve for 
each individual segment, if needed.

A more advanced possibility is to use Ghost events. These are audio events which 
all share a segment, and thereby share a volume or pan curve. This means that if 
one is adjusted, they are all affected. See page 511.

❐ If you use the Dynamic Events to control volume, you cannot boost the signal above 
unity gain (0.0 dB).

VST Channel Mixer Automation

Using the Write function in the VST Channel Mixer you can automate Volume and 
Panning (actually, virtually all mixer settings and changes) for each audio channel. 
All Tracks in the Arrange window that are set to play back via this audio channel will 
be affected likewise by these controls. This method is described on the following 
pages.

Let’s say, as an example, that one channel is first used for a guitar and later in the song 
for vocals. If you then use the VST Channel Mixer to lower the volume in the guitar in-
tro, you will get the same lower volume for the vocal, since they are on the same 
channel.

When you are using the VST Channel Mixer to control volume, you can go above 
unity gain (actually amplify the sound). Furthermore, you can automate Mutes and 
Solos.

Conclusion

So, when to use Dynamic Events and when to use the VST Channel Mixer depends 
on what is needed at the moment; if you need to make minute adjustment of 
shorter segments and repeat those in the Song, you should choose Dynamic Events. 
If you make longer non-repeating recordings and prefer to adjust volumes via (on-
screen) faders, you use the VST Channel Mixer. 
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When automating volume, do not hesitate to combine the two methods of automa-
tion, simultaneously or during different parts of the Song. The settings you make in 
the VST Channel Mixer are relative to the volume value delivered by the Dynamic 
Events automation. For example, if the Dynamic Event volume has a value of -2.0 dB, 
and the VST Channel Mixer fader is set to -0.4 dB, the resulting volume will be -2.4 dB.

❐ Please note that the VST Channel Mixer automation is not restricted to Volume and 
Pan - Mutes, Solo, EQ and Effect settings can also be automated.

Automating the VST Channel Mixer
Your actions in the VST Channel Mixer window can be automated in a very straight-
forward way: by “writing” them into a special Audiomix Part. When played back, this 
Part will repeat your fader movements and button presses just like you performed 
them. You will even see the faders and buttons move on the screen, like on a physical 
mixer with motorized controls.

❐ Write/Read Automation applies to “both” Channel Mixer windows. As mentioned pre-
viously, these are not separate mixers, but two separate window “Views” of the same 
Channel Mixer. Hence, if you activate Write Automation in VST Channel Mixer 1, Write 
automation is automatically activated in VST Channel Mixer 2 as well.

What can be automated?

Mixdown in Cubase VST can be completely automated! The following parameter 
settings are recorded with the Write function:

For each channel (see below for limitations regarding Insert Effect automation):

• Volume
• Pan
• Mute
• EQ Bypass switch
• Settings for 4 EQ modules
• 8 x Effect Send Active switches
• 8 x Effect Send levels
• 8 x Effect Send PRE switches
• Effect Send Bypass switch
• 4 x Insert Effect Program selection
• 4 x Insert Effect parameters (the 15 first parameters for each effect)

❐ Insert Effects can be only automated for the first 32 audio channels, the eight Groups 
and the 16 first ReWire/VST Instrument channels (depending on what is activated).

Global for all channels:

• Master volume Left and Right
• 8 x Send Effect “Master” level
• 8 x Send Effect Program selection
• 8 x Send Effect parameters (the 16 first parameters for each effect)
• 4 x Master Effect Program selection
• 4 x Master Effect parameters (the 8 first parameters for each effect)
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Recording your actions

1. Open the VST Channel Mixer.

2. Click on the Write button in the upper left corner to activate recording.
While this button is “lit” (activated), every volume, pan, mute or solo movement you make 
will be recorded.

3. Start playback.

4. Move the faders and pan controls, mute and solo as you would during a manual mix-
down.
Since you can repeat this recording several times, it is probably easiest to mix one or a couple 
of channels at a time, and stop and deactivate the Write function in between. That way, you 
can also Undo your last run if you’re not satisfied, using the Undo command on the Edit 
menu.

5. Stop playback.
If you check the Arrange window, you will note that a special Mixer Track called “Audio Mix” 
has been created. This Track contains one long Part named “Audio Mix”, in which all your VST 
Channel Mixer actions are stored. Don’t worry about the length of this Part; it will automati-
cally be lengthened if you record past its end.
Please note that there is only one Audio Mix Part/Track, created the first time you use the 
Write function in your Arrangement. No new Parts are created the next time you use the Write 
function; information is added to the existing Part instead.

6. Deactivate the Write function by clicking on the button.

❐ Exiting the VST Channel Mixer will automatically deactivate the Write function.

Recording Mixer settings in Stop mode

The Write function works in Stop mode as well as during playback. If you activate 
Write when Cubase VST is stopped, all changes you make to your mixer parameters 
are recorded at the current Song Position. This feature can be used creatively if you 
need initial mixer settings, abrupt changes, etc.
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Undoing your recording

If you select Undo from the Edit menu, all actions recorded since you last activated 
Write will be undone. Therefore, make it a habit to always deactivate Write after 
each recording “pass” and listen to what you recorded.

• If you find this too cumbersome, you can make separate Audiomix Parts for the differ-
ent audio channels or recording “passes”, and edit/delete these afterwards.
This is described on page 467.

Playing back your recorded Mixer actions

1. Check that the Audiomix Track or Parts are not muted.

2. Activate the Automated playback by clicking on the Read button in the upper left cor-
ner of the VST Channel Mixer.

You may have Write and Read activated simultaneously, if you want to watch and listen to 
your recorded mixer actions while you’re recording fader movements for another mixer 
channel, etc.

3. Start playback as usual.
The mixer faders and controls will move automatically, following your recorded actions.
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Moving and Muting the Audiomix Part

The Audiomix Part can be handled as any Mixer Part:

• If you want to turn off VST Channel Mixer automation from the Arrange window, you 
can mute the Audiomix Part or Track.

• You can copy recorded mixer actions to several places in your Arrangement by cut-
ting out the relevant section of the Audiomix Part with the Scissors tool and duplicat-
ing it, placing the copies wherever you want them.

Working with one Audiomix Part for each Audio Channel

Although Cubase VST only creates one dedicated Audiomix Track, there is a way to 
structure your Mixer Automation into different Parts for different channels, which 
makes it easier to edit and redo mixer recordings you’re not satisfied with:

1. Record your fader movements and other mixer actions for the first audio channel, as 
described on the previous page.

2. Deactivate the Write function and go to the Arrange window.

3. Make a new Mixer Track.
It might be a good idea to name it after the audio channel you just mixed, to avoid confusion 
later on.

4. Move the entire Audiomix Part to the new Track.

5. Open the VST Channel Mixer again, activate the Write function and record your mixer 
actions for the next audio channel.
Now Cubase VST creates a new Audiomix Part on the original, empty Audiomix Track. If you 
activate the Read function, your previously recorded Part will be played back from its new 
Track, so you can watch your recorded fader movements while you continue with new audio 
channels.

6. Repeat steps 2 to 5 for as many channels you like.
You will end up with a number of Mixer Tracks, all playing back simultaneously, affecting dif-
ferent audio channels in the VST Channel Mixer. If you want to, you can keep it that way. If you 
like to clean up your Arrange window, you can Merge the Parts into one (see page 59) or put 
all the Tracks in a Folder Track (see the chapter “About Folder Tracks”).
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Editing the Audio Mix Part

The Audio Mix Part contains Mixer Events, which can be edited in the Controller Ed-
itor or in List Edit:

In the Controller Editor

If you open the Audio Mix Part in the Controller Editor, the recorded controls are 
displayed graphically, superimposed on the audio waveforms. You can edit and 
create the controller curves just as you would edit MIDI Controller messages - see 
the chapter “The Controller Editor”.

❐ You cannot view and edit switch parameters (parameters with on/off values) in the 
Controller Editor.
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In List Edit

If you open the Audio Mix Part in List Edit, the recorded controls are shown numer-
ically in the list. This is useful if you want to set a fader to a specific value at a certain 
position, or if you want to edit switch parameters.

1. Select the Audio Mix Part in the Arrange window and open List Edit.

2. Pull the divider to the right so that you can see the Comment column.
This column shows which Mixer parameter (volume, pan etc.) and audio channel each Event 
controls.

❐ Switch parameters (parameters with on/off values) are handled in a special way. All in-
formation about a switch Event (switch name, on/off) will be displayed in the Com-
ments column, but do not try to edit a Switch value if you are not sure about how the 
Value 2 encoding works (see page 470).

3. Select an Event that corresponds to the fader (or other Mixer control) you want to edit.

4. Pull down the Mask pop-up menu and select “Mask It!”.
This will hide all Events except those of the same type as the selected (that is, only Events of 
the same type and the same audio channel as the selected one will be shown).

5. Edit the values in the Value 2 column in the list.
You can also use the “Value 2 display” to the right, to perform a kind of graphical editing.

❐ The value 101 for a fader corresponds to 0 dB (unity gain).

6. When you’re done, pull down the Mask pop-up menu, select “No Mask” and press [Re-
turn] to leave List Edit.
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How List values work for Switches

The text in the Comments column corresponds to the numerical value in the Value 1 
column. Each continuous parameter (such as volume, pan, etc.) on each audio chan-
nel, has a unique Event number (value 1), while the Value 2 column shows the param-
eter values. However, switches (on/off-parameters) are handled in a special way: 
All switches on the same audio channel share the same Event number! 

All other information (which switch is it and what is its state) is encoded into Value 2. 
If you want to edit the values of switch Events, you have to consult the tables below 
to find the appropriate values. This is the Value 2 functionality for switches on each 
audio channel:

Switch Name “On” value “Off” value

Mute 64 0

Solo 65 1

EQ Bypass 66 2

Effect send DRY 67 3

Effect send 1 On/Off 68 4

Effect send 2 On/Off 69 5

Effect send 3 On/Off 70 6

Effect send 4 On/Off 71 7

Effect send 5 On/Off 80 16

Effect send 6 On/Off 81 17

Effect send 7 On/Off 82 18

Effect send 8 On/Off 83 19

Effect send 1 PRE switch 72 8

Effect send 2 PRE switch 73 9

Effect send 3 PRE switch 74 10

Effect send 4 PRE switch 75 11

Effect send 5 PRE switch 84 20

Effect send 6 PRE switch 85 21

Effect send 7 PRE switch 86 22

Effect send 8 PRE switch 87 23

EQ module 1 Enable switch 76 12

EQ module 2 Enable switch 77 13

EQ module 3 Enable switch 78 14

EQ module 4 Enable switch 79 15
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About this Chapter

This chapter describes the general procedures for remote controlling VST parame-
ters (volume faders, pan settings, EQ parameters, etc.) from an external MIDI de-
vice. For details about the supported devices, please refer to the separate 
document “VST Remote Control Devices”.

Setting Up

To set up for remote control of the VST Channel Mixer, proceed as follows:

1. Make sure the MIDI Control device is connected to your MIDI interface.
You need to connect the MIDI Out on the remote unit to a MIDI In on your MIDI interface. De-
pending on the remote unit model, you may also need to connect a MIDI Out on the inter-
face to a MIDI In on the remote unit (this is necessary if the remote unit features “feedback 
devices” such as indicators, motorized faders, etc.). See the MIDI Control Device specifica-
tions on the following pages for details.

2. Pull down the Options menu and select “Setup” from the Remote Setup submenu.
The VST Remote dialog appears.

3. Select your MIDI Control Device model from the Remote pop-up menu.

A Yamaha 01V selected as Remote Control device.

4. Select the correct MIDI Input from the Input pop-up menu.

5. If necessary, select the correct MIDI Output from the Output pop-up menu.
This depends on whether the MIDI Control Device supports “MIDI feedback”, such as motor-
ized faders, indicators, etc.

6. Click OK to close the dialog.
You can now use the MIDI Control device to move faders and knobs, activate mute and solo, 
etc. The exact parameter configuration depends on which external MIDI Control device you 
are using, as described in the separate “VST Remote Control Devices” document.
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Writing Automation using Remote Controls

Automating VST parameters using a Remote Control device is basically done in the 
same way as when you operate on-screen controls in Write mode. However, when it 
comes to replacing existing automation data, there is one important difference:

• If you activate Write mode and move a control on the Remote Control device, all data 
for the corresponding VST parameter is replaced from the Song Position where you 
moved the control, up until the position where playback is stopped!
In other words, as soon as you have moved a control in Write mode, it remains “active” until 
you stop playback. The reason for this is explained below.

As a consequence, two additional precautions must be taken:

• Make sure you move only the controller you want to replace!

• Don’t rewind or move the Song Position backwards while in Write mode.

Background 

In order to replace existing automation data for a control, the computer needs to 
know how long the user actually “grabbed” or used the control. When doing this “on 
screen”, the program simply detects when the mouse button is pressed and re-
leased. When you are using an external Remote Control device, however, there is no 
mouse button involved, and Cubase VST cannot tell whether you “grab and hold” a 
fader, or simply move it and release it. Instead, you have to indicate that you have 
“released” the control by stopping playback.

❐ This is only relevant when you are using a Remote Control device and Write mode is ac-
tivated in the VST Mixer.
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Introduction

As described on page 441, version 2.0 of the VST Plug-in standard allows MIDI input 
to effect plug-ins. Among other things, this makes it possible to play and control soft-
ware synthesizers (or other MIDI controlled sound sources) from within the VST sys-
tem. To facilitate this, there is a special VST Instruments panel, and mixer channel 
strips for the Instrument output.

About the VST 2.1 standard

As of this writing, the latest version of the VST plug-in protocol is called VST 2.1. This 
adds some functionality to VST Instruments, mainly improved support for Patch 
changes via MIDI. See page 94.

About the included VST Instruments

The following VST Instruments are included and automatically installed with Cu-
base VST:

• Neon - a software synthesizer. 

• VB-1 - a virtual bass instrument built on realtime physical modeling principles.

• LM-9 - a drum machine.

• Universal Sound Module - a General MIDI compatible sound module with over 70 MB 
state of the art sampled sounds.

❐ The parameters and functions of these VST Instruments are described in detail in the 
separate document “The included VST Instruments”. This chapter only describes the 
general procedures for handling VST Instruments.

❐ If you have purchased or downloaded additional VST Instruments, please make sure to 
follow the included installation instructions.
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Activating and Using Instruments in Cubase VST

1. Pull down the Panels menu and select VST Instruments.
The VST Instruments panel appears.

2. Pull down the pop-up menu to the right in the panel, and select the desired Instrument.
The Instrument is loaded into the first slot. To access the actual parameters for the VST Instru-
ment, you need to click the Edit button.

3. Make sure the Instrument is activated (the red Power button should be lit).
If not, click the Power button.

4. Select an unused MIDI Track in the Arrange window.

5. Click in the Output column for the Track.
The Output pop-up menu appears. It will now contain an additional item, with the name of 
the activated VST Instrument.

6. Select the VST Instrument on the Output pop-up menu.
The MIDI Output from the Track is now routed to the selected Instrument. 
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❐ As described in the Getting Started book, the System Preroll setting in the Synchroni-
zation dialog should be set to a value larger than the Latency value (displayed in the 
Audio System Setup) for VST Instruments to work properly. If this is not the case, you 
will be asked whether you want this to be done automatically, the first time you acti-
vate playback with MIDI Tracks routed to VST Instruments.

7. Depending on the selected Instrument, you may also need to select a MIDI Channel for 
the Track.
Check the Instrument’s documentation for details on its MIDI implementation. For example, 
multi-timbral VST Instruments will be able to play back different sounds on different MIDI 
channels.

8. Open one of the VST Channel Mixers and scroll the window to the right, past the avail-
able “regular” audio channels.
You will find additional channel strips for the Instrument audio output signal. The number of 
channels depends on the Instrument.

❐ If the Instrument channel strips are not visible, you need to select a Mixer View that in-
cludes Instrument channels (see page 459).

9. Use the pop-ups at the bottom of the channel strips to route the Instrument audio to 
the desired Output or Group.

The Neon has a stereo 
output and thus uses two 
mixer channels.
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10.Play the Instrument from your MIDI keyboard.
You can use the Mixer settings to adjust the sound, add EQ or effects, etc. - just as with regu-
lar audio channels. Of course, you can also record or manually create MIDI Parts that play 
back sounds from the VST Instrument.

❐ You can have up to 8 VST Instruments activated at the same time, different models or 
several instances of the same Instrument. However, software synthesizers can con-
sume quite a lot of CPU power - keep an eye on the VST Performance window to avoid 
running out of processor power.

About Latency

Depending on your audio hardware and its ASIO driver, the latency (the time it takes 
for the Instrument to produce a sound when you press a key on your MIDI controller) 
may simply be too high to allow comfortable real-time VST Instrument playback 
from a keyboard. 

If this is the case, a workaround is to play and record your parts with another MIDI 
Sound Source selected, and then switch to the VST Instrument for playback.

Saving Programs

You create and save programs for a VST Instrument in the same way as with VST Ef-
fect Plug-ins (see page 444).
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Automating a VST Instrument

Automation of VST Instrument parameters is not done using the standard VST Read/
Write automation. Instead, you record parameter changes on a regular MIDI Track:

❐ VST Instrument automation uses System Exclusive messages to record parameter 
changes. Before you follow the steps below, open the MIDI Setup on the Options menu 
and select “Filtering” from the submenu. Check that “Sysex” is not filtered out, i.e. that 
this item is not checked in the Record column of the MIDI Filter dialog.

1. Set up a MIDI Track for playback to a VST Instrument as described above.

2. Select another MIDI Track, and set its Output (and possibly MIDI Channel) to the 
same values as the first Track.
This is the Track on which you will record the Automation data. You could also record the au-
tomation on the MIDI Track used for Instrument playback, but we recommend that you use a 
separate Track, to make editing easier.

3. Set up the Locators to encompass the section you want to record.

4. Start recording, and make the parameter changes you want to automate.
The parameter settings are recorded as special System Exclusive messages.

5. Stop recording and play back the recorded Track.
The parameters will change as you recorded them.
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Introduction

ReWire is a special technology for streaming audio between two computer applica-
tions. Developed by Propellerhead Software and Steinberg, ReWire provides the 
following possibilities and features:

• Real time streaming of up to 64 separate audio channels, at full bandwidth, from the 
“synthesizer application” into the “mixer application”.
In this case, the “mixer application” is of course Cubase VST. An example of “synthesizer ap-
plication” is Propellerhead Software ReBirth RB-338.

• Automatic, sample accurate synchronization between the audio in the two programs.

• The possibility to have the two programs share one sound card and take advantage of 
multiple outputs on that card.

• Linked transport controls that allows you to play, rewind etc, either from Cubase VST or 
from the synthesizer application (provided it has some kind of transport functionality).

• Automatic audio mixing functions of separate channels as required.
In the case of ReBirth RB-338, this allows you to have separate mixer channels for the synthe-
sizers and the drum machines, or even separate channels for separate drum sounds.

• Less total system requirements than when using the programs together in the conven-
tional way.
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Launching and Quitting

When using ReWire, the order in which you launch and quit the two programs is 
very important:

Launching for normal use with ReWire

1. First launch Cubase VST.

2. Enable one or several ReWire channels in Cubase VST’s ReWire dialog.
This is described in detail on page 483.

3. Launch the synthesizer application.
It may take slightly longer for the application to start when you are using 
ReWire.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special order:

1. First quit the synthesizer application.

2. Then quit Cubase VST.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Cubase VST and the synthesizer 
application at the same time on the same computer, without using ReWire, but you 
can:

1. First launch the synthesizer application.

2. Then launch Cubase VST.
You will get an error message in Cubase VST, but you can safely ignore it.

Please also note that the two programs now compete for system resources such as 
audio cards, just as when running either with other, non-ReWire audio applications.
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Activating ReWire Channels

ReWire supports streaming of up to 64 separate audio channels. The exact number 
of available ReWire channels depends on the synthesizer application. Using the Re-
Wire panel in Cubase VST, you can specify which of the available channels you want 
to use:

1. Pull down the Panels menu and select ReWire.
The ReWire panel appears. This consists of a number of rows, one for each available ReWire 
channel.

The ReWire panel for ReBirth RB-338.

2. Click on the green buttons in the “Active” column to activate/deactivate the desired 
channels.
The buttons light up to indicate activated channels. Please note that the more ReWire chan-
nels you activate, the more processing power is required.

• For information about exactly what signal is carried on each channel, see the docu-
mentation of the synthesizer application.

3. If desired, double click on the labels in the right column, and type in another name.
If you do, this label will be used in VST to identify the ReWire channel.
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Using the Transport and Tempo Controls

❐ This is only relevant if the synthesizer application has some sort of built-in 
sequencer or similar.

Basic Transport Controls

When you run ReWire, the transports in the two programs are completely linked. It 
doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. However, 
recording (if applicable) is still completely separate in the two applications.

Loop Settings

If there is a Loop facility in the synthesizer application, that Loop will be completely 
linked to the Cycle in Cubase VST. This means that you can move the start and end 
point for the Loop/Cycle or turn the Loop/Cycle on or off in either program, and this 
will be reflected in the other.

Tempo Settings

As far as tempo goes, Cubase VST is always the Master. This means that both pro-
grams will run in the tempo set in Cubase VST.

However, if you are not using the Master Track in Cubase VST, you can adjust the 
tempo in either program, and this will immediately be reflected in the other.

❐ If you are using the Master Track in Cubase VST (if Master is activated on the Transport 
bar), you should not adjust the tempo in the synthesizer application, since that tempo 
then will not have any effect on playback!
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How the ReWire Channels are handled in Cubase VST

When you activate ReWire channels in the ReWire panel, they will become available 
as channel strips in the VST Channel Mixers. The ReWire channel strips have the fol-
lowing properties:

• ReWire channels are displayed in red, and appear to the right of the regular audio 
channels.
If you cannot see the ReWire channels, you need to select a Mixer View that contains ReWire 
channels (see page 459).

• ReWire channels may be mono channels, stereo channel pairs or any combination, de-
pending on the synthesizer application.

• ReWire channels have the same functionality as regular audio channels.
This means you can set volume and pan, add EQ, Insert and Send Effects and route the chan-
nel outputs to Groups or Buses. All settings can be automated using the Read/Write func-
tions. However, ReWire channels have no Input/Monitor buttons and no VST Dynamics.

• All unmuted ReWire channels are included when you mix down to an audio file using 
the Export Audio File function (see page 499).
This allows you to “convert” your ReWire channels into hard disk Tracks. If you want to mix 
down the ReWire channels only, make sure all Audio Tracks and VST Instrument channels are 
muted.

Considerations and Limitations

Sample Rates

Synthesizer applications may be limited to audio playback in certain sample rates. 
If Cubase VST is set to a sample rate other than those, the synthesizer application 
will play back at the wrong pitch. Consult the documentation of the synthesizer ap-
plication for details.

Play in Background

The “Play in Background” option on the Options menu must be activated for Re-
Wire to work. If not, the communication between the two programs will be lost.

ASIO Drivers

ReWire works well with ASIO drivers. By using the Cubase VST bussing system you 
can route sounds from the synthesizer application to various outputs on an ASIO 
compatible audio card.
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The Input/Output Bus System
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Introduction

The bus system in Cubase VST allows you to take full advantage of audio hardware 
with multiple inputs and outputs, by providing a complete routing system, very 
similar to that on a fully-fledged mixing console with a busing system.

• For this to be useful, you need audio hardware with several inputs and/or outputs.
For more information on setting up and using advanced audio hardware, see the chapter 
“Setting up an Advanced Audio System”.

What you can do with the Bus system

Here’s what you can achieve with the busing system (all of this will be described in 
detail in this chapter):

• Map physical audio inputs on your audio hardware to inputs in VST, and name each in-
put.
This is convenient when you integrate your VST system with other recording equipment.

• Record from any input on any audio channel.
This is done by selecting a VST Input for a channel, prior to recording.

• Route the output of audio channels or Groups to one of the stereo Buses, in any combi-
nation.
The number of stereo Buses depends on the number of physical output pairs on your audio 
hardware. Any channel in the Monitor window can be routed to any Bus.

• Map the Buses to physical Outputs on your audio hardware, and name the Buses.
This allows you to use VST as a true bus mixer, for example when using the program in con-
junction with a digital tape deck such as an ADAT, Tascam DA-88 or similar.

• Route effect sends to any of the Buses, so that they now can be used for external ef-
fects as well as the internal VST effects.
In fact, theoretically, all sends on all channels or Groups can be routed to different destina-
tions, which means VST provides several hundreds of sends, all switchable between pre- and 
post operation.

• Route the outputs of the Send Effects to any of the Buses.

• Do all of this at the same time, so that you for example use a Send to add an external ef-
fect and record the result back on any audio channel.
An example of this is described on page 494.
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Activating Inputs

To be able to record and monitor any audio sources you need to activate the Inputs 
they are connected to:

1. Pull down the Panels menu and select VST Inputs.
The Input window appears:

The left column contains the available “physical” Input ports. The fields in the right column 
show the names that will be used for each Input throughout the program. The indicators in the 
middle column show which Inputs are active (in this figure inputs Main L/R, Ret 1 L/R and S2 1/
2 are active).

2. To rename an Input, click on its name field in the Labels column, and type in a new 
name.
The name can contain up to seven characters, and will be displayed when you select Inputs for 
the audio channels in the Monitor window and the Inspector.

The active Inputs will 
appear on the Input 
popup, for example in 
the Inspector.
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3. Activate the Inputs you need in the VST Inputs window, by clicking on their buttons in 
the middle column.
The buttons lights up, indicating that the Inputs are active. Note that all Inputs are activated 
in stereo pairs.

❐ Make sure not to activate more Inputs than necessary, to possibly conserve processor 
power. In situations when you don’t need any Inputs at all, such as audio mixdown, 
you should consider deactivating all Inputs, to make more processor power available 
for effects, EQs, etc.

4. Press [Return] on the computer keyboard to close the Inputs window.
The Input settings are saved with the Song. However, if you would select another ASIO De-
vice and then open the Song, the Input settings saved in the Song will be ignored.

Recording from an Input

When you record audio in Cubase VST, you need to decide from which input you 
want to record. As described in the Getting Started book, this is best done in the 
VST Channel Mixer, in the following way:

1. Open the VST Channel Mixer.

2. Hold down the [Command] key on the computer keyboard and click on the Input but-
ton for the audio channel you want to record on.
A pop-up menu appears, containing all active Inputs. 

If no Inputs are activated in the Inputs window, the button will be labelled “No Inp”, and no 
pop-up menu will appear.

3. Select an Input from the pop-up.
The Input button now displays the name of the selected Input.
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4. Click the “In” button at the top of the level meter for the selected recording channel.
This activates the Input meter function:

5. Check the Input level and adjust the output level of your audio source, or the input 
gain on your audio card, if available.
The mixer faders control the output level only, no matter whether the “In” button is activated 
or not.

6. Repeat steps 2 to 5 for any other audio channels you want to record on.

7. Continue recording as usual.

Activating and routing Output Buses

As with Inputs, you need to activate the Output Buses you want to use, and assign 
each Bus to an output pair on your audio hardware. This is done in the Master win-
dow:

1. Pull down the Panels Menu and select VST Master Mixer.
Aside from the regular Master panel, the window will contain a number of additional stereo 
“channel strips”, one for each Bus:

❐ The total number of Buses (including the Master Bus) is equal to the number of stereo 
output pairs on the audio hardware. The picture above shows a system with sixteen out-
puts (eight stereo pairs) and eight Buses, where Master is considered to be the first Bus.

When the “In” button is activated, the level meter shows the level of the input signal at 
the selected Input. 
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2. Activate the Buses you need, by clicking on their Active buttons.
The indicator in the button lights up to show that the Bus is active.

To possibly conserve processor power, you should avoid activating Buses that you don’t 
need to use. The Master Bus, however, is always activated.

❐ The Bus settings are saved with the Song. However, if you select another ASIO Device 
and then open the Song, you will be alerted that the Bus settings saved in the Song will 
be ignored.

3. Use the popup menus at the bottom of the window to route each active Bus to an out-
put pair on your audio hardware.

❐ Two Buses cannot be connected to the same output pair.

4. To rename a Bus, click on its label (above the Active button) and type in a new name.

5. Set the output levels for each active Bus, in the same way as with the Master Bus.
Dragging one of the faders for a Bus will automatically move the other fader as well. To move 
the left or right fader for a Bus independently, hold down [Option] and drag.
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Routing Audio Channels to Buses

To route the output of an audio channel to one of the active Buses, proceed as fol-
lows:

1. Open the VST Channel Mixer window.

2. Pull down the Output Routing pop-up menu, at the bottom of the channel strip.
This pop-up menu contains the activated Output Buses, followed by the eight Groups (see 
page 453).

3. Select one of the Buses.
The Master Bus will always be available.

Assigning the Output of a Group to a Bus

You can route the output of a Group in the VST Channel Mixer to any Output Bus, 
following the same procedure as when routing audio channels to Buses. There is 
one thing to note:

❐ You can route each “side” in a Group to a different mono Bus if you like. In most cases, 
you will probably want to route both sides to the same stereo Bus.
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Sends and Effects

Routing an Effect Send to a Bus

The eight effect sends for each audio channel or Group can be routed indepen-
dently to any of the built-in VST effects, to one of the sides in a Group or directly to 
one of the Buses, for use with external effects, etc. This is determined by the Send 
Routing pop-up menus in the Channel Settings window:

❐ Note that this routing is individual for each effect send on each channel. Also, note that 
since the effect sends are in mono, you route the send to one of the “sides” of a Bus.

Routing the Effect Outputs to Buses

The stereo outputs of the Send Effects can be routed independently to any of the 
output Buses:

1. Open the Effects window.

2. Select an Effect and activate it.

3. Click on the button below the File button in the effect unit to pull down a Bus popup 
menu.

This popup menu contains all the active Buses. The Master Bus will always be available.

4. Select one of the Buses to route the output of the effect there.
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An example

In this example, we will set up an Audio Track for playback, route one of the effect 
sends to an individual output, connected to an external (mono) effect, and record 
the output of this effect on another Audio Track. During recording, this Track will 
be monitored, and some built-in VST reverb will be added to the monitored sound:

Setting up the audio channel for playback

1. Make the physical connections between your audio hardware and the external effect 
device.
Connect an auxiliary output on your audio hardware to the input on the external effect. Then 
connect the output of the effect to an input on your audio hardware.

2. Open the VST Master Mixer and activate Bus 2, by clicking its Active button.
This is the Bus you will use to route audio to the external effect.

3. Pull down the Output popup menu for Bus 2 (at the bottom of the Master Mixer win-
dow) and select the desired output on your audio hardware.
This should be the output pair containing the output you connected in Step 1.

4. Set up the Audio Track for playback in the Arrange window.
This may involve muting other Tracks, setting the Cycle, etc.

5. Open the VST Channel Mixer and click on the EQ button for the audio channel.
The Channel Settings window opens.

6. Click on the On and Pre buttons for the first effect send, so that the indicators in the 
buttons light up.
Make sure the Bypass button isn’t activated.

7. Pull down the Send Routing popup and select Bus 2 (Left or Right, depending on which 
output on your audio hardware is connected to the external effect device).

8. Use the Send Level knob to set an appropriate signal level for the external effect.
You may want to play back the audio at this point, to check the connection and the input sig-
nal level on your effect device.

9. Go back to the VST Channel Mixer and click on the Mute button for the audio channel.
Since “Pre” is activated for the effect send, this will not affect the signal to the external effect.

Played back audio 
channel

Audio: VST Channel Mixer: Output Buses:

Bus 2Pre-fader send

External FX.

Recording audio 
channel

Master Bus

Post-fader send

Channel routing

VST Reverb

Monitoring 
Equipment 
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Setting up another audio channel for recording

1. Pull down the Panels menu and select Audio Inputs.
The Audio Input window appears.

2. Activate the Input to which you connected the external effect device.
Leave the other Inputs deactivated.

3. Close the Input window and return to the Arrange window.

4. Prepare a Track for recording.
This Track should be set to another audio channel than the playback Track.

5. Open the Audio Send Effects window, select and activate the WunderVerb3 effect.

6. Pull down the Output Routing pop-up menu for the Effect and select the Master Bus.

7. Open the VST Channel Mixer, locate the audio channel selected for recording and click 
on its FX button.
The Channel Settings window for the channel appears.

8. Activate one of the Effect sends by clicking its On button.
The Pre button should not be activated. Also, make sure that the other Effect sends are deac-
tivated, to avoid any accidental feedback loops.

9. Pull down the Send Routing popup and select the WunderVerb3 effect you activated in 
step 5 above.

10.Set the Send level (in the Channel Settings window) and the Effect Master level (in the 
Effects window) to appropriate values.

11.Return to the VST Channel Mixer, hold down [Command] and click on the Input button 
for the recording channel.
Make sure the correct Input is selected on the pop-up menu that appears.

12.Click on the Input button so that the indicator in the button lights up.
Now, the recorded sound will be monitored (provided that Monitoring is set to “Tape Type” 
or “Record Enable Type” in the Audio System Setup dialog).

13.Try playing back the audio, and set levels for sends, monitoring, etc.

14.When ready, perform the recording.
The audio from the playback Track will be routed through the external effect and recorded 
on the recording Track, and you will monitor the result with some reverb added.
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Importing and Exporting Audio
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Importing audio files into the Arrangement

You can quickly import audio into your Arrangement without having to open the 
Pool. This can be done in two ways: 

• By using the Import Audio function on the File menu.
• By “dragging and dropping” an audio file directly onto the Arrange window.

Using the Import Audio function

1. Select the Audio Track to which you want to import an audio file.
If you want to import a stereo file, make sure that the Track is set to stereo in the Inspector.

2. Move the Left Locator to where you want the audio file to start.

3. Pull down the File menu and select “Import”, then select “Audio File...” from the sub-
menu.
A file dialog opens.

4. Select a file format from the Show pop-up menu.
Files of the selected type(s) are listed in the file dialog box.

5. Use the file dialog box to locate the file and select it.

• You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Playing” and the selected audio file is 
played back. Playback continues until you click on the button again.

6. Click “Open”.
The file is imported into the Pool, just as when using the Import Audio File command on the 
File menu in the Pool. A segment that plays the whole file is created and placed in an Audio 
Part, which in turn is placed on the selected Audio Track, at the position of the Left Locator. 

❐ If you import an MP3 file, the program will create a copy of the file and convert this to 
AIFF format before importing it (the original MP3 file will not be used in the Cubase 
VST Song). The AIFF file will be placed in the currently selected Audio Files folder (if 
you haven’t yet specified one, you will be asked to do so). 
Please be aware that the converted AIFF file will be several times larger than the origi-
nal MP3 file!

You can also import ReCycle Export (REX) files, as described in the chapter Working 
with ReCycle files.
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Importing Audio using “drag and drop”

1. Select an audio file to Import.
This may be located anywhere on your drive - it doesn’t matter as long as you select it from 
the Explorer.

2. Click on the file and keep the mouse button down.

3. Drag the file into the Arrange window and drop it on an audio Track (or in the empty 
area below all Tracks).
In the latter case, an audio Track will be created. Again, the regular mono/stereo conventions 
apply (see the Getting Started book).

4. Release the mouse button.
The audio file appears in the Arrangement at the position where you released the mouse 
button (the Snap setting applies).
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Mixing down to an audio file

The Export Audio Tracks function in Cubase VST allows you to mix down any num-
ber of audio tracks, complete with effects and mixer automation, to a new audio 
file, in one of several file formats, mono or stereo. Furthermore, all ReWire and VST 
Instruments channels that are activated and playing will also be included. 

❐ Please note that MIDI Tracks are not included in this type of mixdown. To make a com-
plete mixdown containing both MIDI and audio, follow the instructions on page 503.

There are three different modes for the Export Audio Tracks function:

• Between Locators
This mode will export all unmuted audio Tracks between the left and right locators and cre-
ate a Mixdown file according to the specified settings in the Export Audio dialog. 

• Selected Parts
This mode will create a separate file for each selected audio Part in the Arrangement. 

• Selection Range
This mode will create a Mixdown file based on the current Selection Range. All unmuted au-
dio within the range will be included in the Mixdown file.

1. Set up the Tracks and Parts according to the Mixdown mode you would like to use:

• For the “Between Locators” mode, set up the left and right locator, to encompass the 
area that you want to mix down.
The rule is: All audio you hear on playback will be included in the Mixdown file!

• For the “Selected Parts” mode, select all Parts that you wish to mix down.
You don’t have to make any settings for unselected Parts, even if they are audible on play-
back. They wont be included in the Mixdown file.

• For the “Selection Range” mode, define a range with the Selection Range tool.

2. Set up your Tracks, so that they play back the way you want.
You can use the automation in the Channel Mixer, as well as Effects and Master Effects. If you 
are planning not to include any of these features in the exported audio file, you should turn 
them off while preparing the Tracks as well, to hear what you get.

3. If you want to include the automation, make sure that the Read button is activated in 
the VST Channel Mixer.

4. Pull down the File menu and select “Audio Tracks...” from the Export submenu.
The Export Audio dialog opens.
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• You can also open this dialog by clicking the “Export Audio” button in the VST Master 
Window.

5. Set the Mixdown mode (Between Locators, Selected Parts or Selection Range) by click-
ing the corresponding radio button.

6. Decide whether you want to include automation and/or effects, by using the “Include” 
checkboxes.
You can independently include the automation from the VST Channel Mixer, the Mixer Ef-
fects and the Master Effects. If you are exporting with Dithering activated (see below and 
page 446), you should make sure that “Include Master Effects” is activated!

7. If you want to automatically import the resulting audio file back into Cubase VST, acti-
vate the “Import to” checkboxes.
If you activate the “Pool” checkbox, the file will appear in the Pool. Activating the “Audio 
Track” checkbox as well, will place the file in a new Part on an Audio Track, starting at the Left 
Locator. For more info about the created Audio Track, see page 502.

❐ Import is not available if you export in 8 bit Resolution (see below).

8. If you want an audible verification during the mixdown process, activate the “Audition 
Audio” checkbox.
This will cause unmuted audio Tracks to rapidly play back while the mixdown file is created.

9. Select a file type.
You can choose between AIFF, Sound Designer II and WAVE. Which type to choose depends 
on which other programs you plan to use the file in. 

❐ An MP3 Encoder is available for purchase, adding MPEG Layer 3 files to the available 
Export file types. For more information about this, go to www.cubase.net.
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10.Select mono or stereo with the “Channels” radio buttons.
You have three choices here: 

• You can make a mono file, in which case the left and right channels are mixed (as when using 
the mono switch in the Master window). 

• You can select Stereo Interleaved, in which case a true stereo file is created. 
• Finally, you can select the Stereo Split option, in which case two mono files (one for each ste-

reo side) will be created.

11.Select a Resolution.
The choices are 8, 16, and 24 Bit. Cubase VST/32 is also able to export 32 Bit files. 

• 8 Bit audio files are of limited fidelity, but can be useful for multimedia applications such as 
QuickTime movies (see page 618), or situations when you want to keep the file size down. 

• 32 Bit files can be imported into some high-end audio editors such as Steinberg WaveLab 3.0. 
• If you plan to use the file in a “regular” version of VST (Cubase VST or Cubase VST Score), you 

have to select the 16 or 24 Bit option.

❐ When you export to a resolution of 16 Bit or lower, you should consider activating the 
Dither function in the Master Mixer (see page 446). Note that you must activate the “In-
clude Master Effects” checkbox for the Dithering to be included in the mixdown.

12.Select a sample rate.
You can choose between 22.05, 44.1 and 48 kHz. If you are using the Cubase VST/32 version, 
you can also select 96kHz. However, to be able to re-import and play 96kHz files in Cubase 
VST/32, your audio hardware and its drivers must support this sample rate.

❐ It is possible to import and/or audition the file no matter which sample rate is selected. 
Please note however, that if the selected sample rate is another than the one used by 
Cubase VST, the pitch and length of the audio will be incorrect when you play it.

13.Select a folder and a name for the audio file to be created.
If you have selected the “Stereo Split” option above, the two files will have the same name, 
but with the characters “(L)” and “(R)” added for the left and right channel file respectively 
(before the file extension). As an example, creating a split AIFF file with the name “Mixdown” 
would result in two files named “Mixdown(L).AIF” and “Mixdown(R).AIF”.

14.Click Save.
The audio file is created. If you have activated the “Audition” option, the resulting audio will 
be cued (played back rapidly) during the process. If you have activated the “Import to” op-
tions, the file will be imported into the Pool and, if you like, onto an audio Track. You can play 
it back to check the results immediately. Just remember to mute the original Tracks, and turn 
off any eq and/or effects for the audio channel(s) used by the imported Track, so that you re-
ally hear the true result (see below).
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About imported files and Audio Tracks

If you choose to automatically import the audio file into the Arrangement, using 
the “Import to Audio Track” checkbox, the segment(s) and Track will have the fol-
lowing properties:

• If an Audio Track is selected when you select Export Audio, the imported audio is 
placed in a Part on the selected Track.
The selected Audio Track must be a mono Track if the audio file is in mono, a stereo track if 
“Stereo Interleaved” is selected and an “Any” channel Track if “Stereo Split” is selected. Oth-
erwise, a new Track is created, as described below.

• If no Audio Track is selected, a new Track, named MixDown, is created.

❐ Remember to mute the original audio Tracks when auditioning an automatically im-
ported Mixdown file!
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Including your MIDI music in the mixdown

If you want to prepare a complete master audio file, you probably want to include 
some MIDI material in your Arrangement. Proceed as follows:

1. Set up all your MIDI Tracks, instruments and external sound equipment, so that your 
Arrangement plays back as intended.

2. Connect the output of your mixer, synthesizer or whatever sound source you use, to 
the VST audio inputs.
To avoid feedback, make sure not to include the VST audio output in the mix.

3. Select one or two Tracks for recording, and check the recording levels with the Input 
Meter function in the Master window, by playing back loud sections of the MIDI music.

4. Rewind to where the MIDI Parts start, and activate recording.
When you are done, stop recording as usual. You will now have audio Tracks that play back 
the sound of your MIDI equipment. You can now mute the corresponding MIDI Tracks.

5. If you need to overdub more MIDI material, repeat steps 3 and 4 (using new audio 
Tracks).

6. Finally, use the Export Audio function as described in this chapter, to create an audio 
file containing a complete mixdown of your Arrangement.
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Working with ReCycle files



- 505 - 

About ReCycle

Steinberg ReCycle is a program designed especially for working with sampled 
loops. By “slicing” a loop and making separate samples of each beat, ReCycle makes 
it possible to for example change the tempo of loops without affecting the pitch 
and to edit the loop as if it was built up of individual sounds.

Using ReCycle files in VST

To ReCycle a file for use in Cubase VST, proceed as follows:

1. Locate the file on disk and open it in ReCycle.
This can be a file you have recorded in Cubase, or a file of any other origin.

2. Set up the slices, bar length, time signature and sampler options as desired.
A typical application would be “slicing for tempo changes”, see the application examples in 
the ReCycle manual for details.

3. Select “Export to ReCycle! REX file”, from the ReCycle File menu.

4. Specify a location and name for the file and save it.

5. Switch over to Cubase VST.

6. Select an Audio Track where you want to import the file and set the Left Locator at the 
position where you want the file to appear.
There are special rules for importing into “Any” Tracks, see page 507.

7. Select “ReCycle file” from the “Import” submenu on the File menu.

• There are currently three ReCycle file formats supported by Cubase, Rex1 (*.rex), Rex2 
(*.rx2) and Recycle (*.rcy).

8. Locate the ReCycle export file you just saved, and select it.
You can audition the file before opening it by clicking on the Play button. 
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9. Click Open.
The following happens:

• A copy is made of the ReCycle file. This copy is converted to a AIFF file, which is added to the 
Pool. 

❐ The original ReCycle file should not be deleted or moved, because it will be called upon 
if you later want to re-import the corresponding AIFF file into the Arrangement from 
the Pool. Cubase “remembers” the location of the original file and will automatically 
try to open it when needed.

• A number of Segments are created for the file, each one corresponding to a slice in ReCycle.
• A Part which will play these Segments is automatically created on the active Track, starting at 

the Left Locator position.
Now you can play back the ReCycled file in any tempo, as if using a sampler. You can also edit 
it in detail, quantize, etc., for example from the Audio editor.

• If you need to re-import the file into the Arrangement, drag the file item from the Pool 
to the Arrangement, just as any other file. 
A new Part is then created.

❐ Please note that the new file will sound very strange if played back in its entirety. It 
should only be triggered from the Part which has been created in the Arrangement. 

About Tempo Changes and the last Segment(s)
It may happen that you import a ReCycle file into an Arrangement that has a higher 
tempo than the loop originally had. In this situation, the slices (Segments) will over-
lap, and the last segment will “stick out” past the end of the Part.

An audio event in Cubase should never play past the end of a Part (since you would 
then hear audio in the Arrangement, that you couldn’t “see”). Therefore, Cubase VST 
automatically shortens segments that would otherwise play past the end of the Part, 
so that they end exactly where the Part ends. This is done automatically when you 
import the ReCycle file, unless the Audio Preference item “Optimize Audio Parts’ 
Length in Arrangement” is ticked. In this case Cubase will shorten or extend the 
length of the Part to the end of the last Segment. Make sure this Preference item is 
not activated if you plan to repeat the created Part.

If you have used a very high stretch factor in ReCycle, or if the Cubase tempo is drasti-
cally different from the original loop tempo, not only the last, but a few of the last 
segments could be affected by the aforementioned problem and will be shortened.

If you later raise the tempo, the shortened segments will become too short, since 
they no longer play to the end of the Part. There are two ways to fix this:

• Manually adjust the length of the offending segments, in the Audio Editor.

• Delete the existing Part and re-import the ReCycle file, by dragging the file symbol 
from the Pool to the Arrange window.
In the new Part that appears the length of the last segment(s) will be adjusted to fit the cur-
rent tempo.
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If you get clicks during playback

While a sampler or sampling synthesizer is polyphonic, each track in Cubase VST is 
monophonic, that is, it can only play back one sound at a time. This is not ideal for 
playing many short overlapping sounds, like you do when playing ReCycled files.

This fact will normally not cause any problems with drum loops. However, with other 
types of material, bass loops etc., the monophonic character of a Cubase VST channel 
might lead to clicks in the transition between segments. There are two ways to rem-
edy this:

Using AutoXFade

As described in the chapter “Using Auto Crossfade”, the AutoXFade feature will 
cause Cubase VST to automatically create crossfades between consecutive audio 
segments during playback. In many cases this should remove any clicks when play-
ing back ReCycle files. Proceed as follows:

1. Open the Inspector for the Audio Track on which you have imported the ReCycle files.

2. At the bottom of the Inspector, you will find the “AutoXFade” setting. Set this to “On”.

3. Try playing back.
If you still hear clicks, you could try raising the “Samples” value below the “AutoXFade” set-
ting. This instructs the program to use longer crossfade times.

Importing into “Any” Tracks - Polyphonic playback

Another way of avoiding the problems with monophonic playback of ReCycle files is 
for Cubase VST to “simulate” the polyphonic behavior of a sampler by splitting up a 
ReCycle file, so that the “slices” play back on more than one channel.

Proceed as follows:

1. Examine your Arrangement and locate two or more consecutive audio channels that 
you can reserve for a ReCycle file.
How many channels you need for Polyphonic operation depends on the nature of the loop. 
The trick is to completely avoid overlap between segments, since it is in the overlap that 
clicks might occur. If you have no idea what to chose, don’t worry, the program will suggest 
a number for you, see below.

❐ Please note that you can minimize the number of channels needed by using as small 
stretch factors as possible in ReCycle and avoiding very short segments.

2. Create or select a Track and set it to Channel “Any”.

3. Set the Left Locator to the position where you want the Part to appear.

4. Import the ReCycle file from disk.
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5. In the dialog that appears, the program suggests a number of channels that ensures no 
overlap at all. If needed, you can change this.
If for example you want the file to use channels 1, 2 and 3, specify “1” as the start channel and 
“3” as the number of channels to use.

6. In the same dialog, specify the first channel that should be used for the file and click 
“Do It”.

7. Open the Part that appears, and examine it in the Audio Editor.
As you see, the slices now alternate between the specified channels.

The drawback of this procedure is that more than one audio channel is “used up” by 
a single file. However, if you run out of audio channels you can use the “Export Audio 
Tracks” feature to turn your “multi-channel” ReCycle Track into one file, that only re-
quires one audio channel, see below.
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Editing Tips and Tricks

• You can completely re-assemble your drum patterns by editing slices in the audio editor. 
You can for example create variations and fills as needed, by duplicating and moving events.

• To replace the sounds in the loop, while maintaining the timing integrity of the playing, you 
can use the “segment pop-up” feature to make the events play other segments than they 
originally did. Hold down [Command] and [Option], click on an event and select the desired 
segment from the pop-up menu that appears. You may want to name the relevant segments 
in the Pool before doing this, to easier find the desired segments on the pop-up menu.

• Once you have finished editing a ReCycle file (or several), you can mix it (them) down to one 
audio file, using the “Export Audio Tracks” feature described elsewhere in this book. This 
minimizes the audio channels required for the loops. If also simplifies some editing proce-
dures, since there are fewer events to handle when “cutting and pasting”. Doing this does 
not mean you can’t continue to perform detailed editing on the loop. You can always keep 
the original ReCycle Track muted, and re-do the “Export Audio Tracks” whenever it is needed.

• Exporting a “Polyphonic” ReCycle Track into a mono means it will only use up one audio 
channel. No clicks will ever appear in this file, since the mixdown will include any overlap-
ping audio as originally played on multiple channels.
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35
Making the Most of the Event/Segment Relationship
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What is an Event really?

An Audio Event is an item in Cubase VST that contains three pieces of information:

• A reference to a segment.
• A start point, relative to the Part the Event resides in.
• A Q-Point (see page 357).

Everything else that you see when you edit an Event in the Audio Editor, is really in 
the segment!

What is a Segment really?

A segment is an item that contains the following information:

• A reference to an audio file on your hard disk. By reference we mean that the segment 
doesn’t contain any audio in itself; it only “points” to a file on disk.

• A start and end inset, to determine which section of the file that the segment plays.
• A name.
• A volume curve (if you have created one).
• A pan curve (if you have created one).
• A set of Match Points (if you have created Match Points, either manually or using the Get M-

Points function).

Copying Audio Events

There are two principal ways of copying Audio Events in Cubase VST: “normal” 
copying and Ghost copying. These two methods are fundamentally different, 
which is important to understand.

Making “Normal” Copies of Audio Events

When you copy Events in any “normal” way, new segments are automatically cre-
ated. This means that if you edit the segment in a copied Event, the original segment 
is unaffected. 

When should I use “normal” copies?

There are a number of situations where this is exactly what you want. You may 
want to add a volume curve to one of the copied Events, but not to the others, or 
shorten one of the copied Events, to “make room” for another Event on the same 
audio channel, etc.
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Making Ghost Copies of Audio Events

A Ghost Event is any Audio Event that plays the same segment as another Event. 
This means that there are no “original” Events; all Events that play the same seg-
ment are considered Ghosts.

In the Audio Editor, Ghost Events are shown with dotted outlines.

When are Ghost Events created?

Ghost Events are created when you perform the following operations:

• When you ghost copy an Event in the Audio editor.
This is done by holding down [Command] and dragging the Event to a new position in the 
Part.

• When you drag a segment from the Pool into the Audio editor or the Arrange window, 
and that segment is already played by another Event.
As soon as two or more Events play the same segment, the Events are Ghost Events.

• When you make a Ghost Copy of an Audio Part.

• When you make regular copies of an audio Part, and the Audio Preference “Copy Part 
Creates New Audio Segments” is deactivated.

• In the Audio editor, when you hold down [Option] and [Command] and select a new 
segment for an Event, and the segment you select is already in use.

These are Ghost Events. They play the same segment.

This is a “normal” copy (uses a segment “of its own”).
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When should I use Ghost Events?

If you edit a segment, the changes you make are reflected in all Events that play the 
segment. Therefore, you may use Ghost Events if you want any editing you do to 
apply “every time that segment” is used. This includes:

• The start and end insets (when you edit them “in the Pool” - see below).
Allows you to for example fine-tune the length of a drum loop and use it repeatedly in your 
Arrangement.

• The volume and pan curves.
Lets you for example smooth out the volume in an “uneven” segment, or create auto-pan 
effects.

• The Match Points.

• The name of the segment.

The following editing is not copied to Ghost Events:

• Changing the position of the Q-Points.
These are part of the Events, not the segments.

• Changing the start and end insets “in the Audio editor”. 
This will instead automatically create a new segment. However, if you hold down [Command] 
while you are changing the insets, all Ghost Events will be affected and no new segment will 
be created.

Converting a Ghost Event to a “normal” Event

If you find that you want to edit one Event without affecting its Ghost Copies, you 
have to convert it to a “normal” Event first:

1. Open the Pool and select the segment that the Event plays.

2. Pull down the Do pop-up menu and select Duplicate Segment.
A new segment with the same name is created. If you want to, you may change the name of 
the new segment to avoid confusion.

3. Return to the Audio Editor and select the Event in question.

4. Hold down [Option] and [Command] and click on the Event.
A pop-up menu opens, containing all segments “belonging to” the same audio file.

5. Select the segment you created in the Pool.
Now, the Event is no longer a Ghost Event, and you can edit it without affecting any other 
Events.

About Audio Ghost Parts

You can create Ghost-copies of Audio Parts, by using the Pencil tool, the Repeat 
command or by [Command]-[Option]-dragging. The audio Ghost Parts behave just 
like MIDI Ghost Parts.
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36
Optimizing Audio Performance
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Introduction

This chapter contains several different sections:

• Information about the System dialog and Driver settings.
This is important information for all Cubase VST users.

• Some tips for optimizing audio performance.

• Hard disk maintenance tips.
You do back up regularly, don’t you?

Audio System Settings

Cubase allows you to set the number of audio channels you want to use to in the 
program. The maximum number of audio channels is 72 (128 if you are using the 
Cubase VST/32 version), but most systems will be restricted to a smaller number, 
due to limited processor power, RAM, etc. The settings are made in the Audio Sys-
tem Setup dialog (reached from the Options menu) and involves several parame-
ters:
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Audio Performance section

• Number of Channels.
Sets the number of audio channels you would like to have access to (4 - 72, or 4 - 128 in VST/32).

• Memory per Channel.
Sets the amount of internal memory assigned to each audio channel. This value multiplied 
by the Number of Channels has a direct relation to the amount of RAM assigned to the pro-
gram in the Finder. The higher the value the lesser the risk of playback problems. On the 
other hand, raising this will probably lower the number of channels you can use at the same 
time, since the total amount of RAM in the computer is always limited.

• Disk Block Buffer Size.
Governs the buffer size used in Cubase VST when reading and writing data from/to the hard 
disk. The larger value, the smoother and faster performance. 
However, each Buffer Size value has a corresponding minimum Memory per Channel setting. 
For example, if the Disk Block Buffer Size is 64 kB, the Memory per Channel cannot be lower 
than 192 kB.

As you can see, there is a quite involved relation between these three parameters. 
To ensure the best HD/audio performance, you would raise the Disk Block Buffer 
Size, but this automatically increases the Memory per Channel which in turn limits 
the possible Number of Channels. This means you will have to experiment with dif-
ferent settings to find the performance/memory/channel balance best suited for 
your system.

The Apply button

Clicking the Apply button applies the settings you have made. If you get a warning 
reading “Not enough memory for the Audio Engine”, you either have to decrease 
the number of audio channels or decrease the Memory per Channel figure.

Try these settings first!

• Generally, start with Disk Block Buffer Size set to 64 kB and Memory per Channel set to 
256 kB. 

• If you find that the audio and hard disk performance is poor (playback stutters, system 
momentarily slows down), try raising the Disk Block Buffer Size to 96 kB.
The Memory per Channel setting is automatically increased to 288 kB.

• If you need more channels, try lowering Disk Block Buffer Size to 48 kB.

• If you have plenty of free RAM, another option would be to quit the program, increase 
its memory assignment in the Finder and re-launch it.
Generally, the more RAM you make available for the program, the better the performance.

❐ All of the above assumes your hard disk is fast enough to handle the number of chan-
nels specified. 
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Audio I/O

ASIO Device

This pop-up menu contains the installed ASIO drivers. “Installed” in this case means 
that the drivers reside in the “ASIO Drivers” folder inside your Cubase VST folder. Use 
the following guidelines when selecting drivers:

• If you have installed additional audio hardware (that is, audio hardware other than the 
one built into the Macintosh), there should be a dedicated ASIO driver available for 
this. Select this.
It may be possible to use some audio hardware without a dedicated ASIO driver (using the 
ASIO Sound Manager driver instead), but we strongly recommend using an ASIO driver writ-
ten exclusively for the audio hardware. As always, make sure you get the latest driver ver-
sions from the hardware manufacturer.

• If you are using the Mac’s built-in audio hardware, you should select the “ASIO Sound 
Manager” driver.

ASIO Device Control Panel

Some of the ASIO drivers come with a special control panel, for making various set-
tings related to the audio hardware. For example, the control panel for the ASIO 
Sound Manager device allows you to adjust input gain, select input source, etc. 
(note that the availability of these features may depend on the MacOS version).

• To open the control panel for the selected ASIO driver (if available), click the Launch 
button.

Latency indication

The Latency is the delay between when audio is “sent” from the program and when 
you actually hear it. The latency in an audio system depends on the audio hardware 
and its drivers. As described in the Getting Started book, latency may be a problem 
if you monitor through Cubase VST, when you are playing VST Instruments “live” 
from a MIDI keyboard or when you mix your audio (in situations where high time 
precision is required). However, the recorded audio will not be affected, since VST 
takes the latency into account, and adjusts the timing of the recorded audio ac-
cordingly.

The Latency indication in the Audio System Setup dialog shows you the latency 
with your current ASIO driver and settings. Some audio hardware and ASIO drivers 
allow you to reduce the latency by adjusting the number and size of the audio buff-
ers in the ASIO Device Control Panel (see the hardware documentation for details).

❐ Audio playback and recording timing will not be affected by latency, since VST takes 
the latency into account, and adjusts the timing accordingly. Similarly, if you play back 
MIDI Parts routed to VST Instruments, the playback precision is sample accurate, re-
gardless of the latency.
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Sample Rate

This setting determines the audio quality of your recordings. The higher the value, 
the better the quality, but when you raise the value, each recording also uses up 
more disk space and computer processing power.

You should not change the Sample Rate setting if you already have files in the Pool 
(which you will have if you have made any audio recordings at all in this Song).

Audio Clock Source

If the card and its driver supports it, this pop-up allows you to select an external 
source to which the audio playback can synchronize its sample rate. For details, see 
the documentation that came with the card.

MIDI Sync Reference

This determines what clock source MIDI playback will use.

• “Audio Clock” is the preferred option when you are not using any external synchronization. If 
Audio Clock is selected, MIDI and audio playback will always be in perfect sync.

• If “Time Code” is selected, the MIDI playback will always be in time with any external time 
code coming in. However, there is a risk that MIDI playback will not be in perfect sync with 
the audio. This happens because the audio card is not aware of fluctuations in the incoming 
time code and therefore can not adjust to them.

MIDI to Audio Delay

If you experience that MIDI playback lags behind the audio, this could be because 
the MIDI response in your MIDI instrument is slightly slow. If this is the case, use this 
parameter to compensate.
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Monitoring

There are several options for how Cubase VST will handle monitoring (listening to 
the signal you are recording). These options are described in the Getting Started 
book.

ASIO Direct Monitoring

When the option ASIO Direct Monitoring is activated, monitoring is handled by the 
actual audio hardware, that is, the monitored signal does not pass through Cubase 
VST. Instead, the ASIO driver for the audio hardware is instructed to send the audio 
from the monitored input directly back to a specified output, thus providing moni-
toring with very low latency.

❐ If this feature isn’t supported by your audio hardware or its ASIO driver, the option will 
be greyed out in the Audio System Setup dialog.

• The monitored sound is sent to the output specified for the audio channel on the VST 
Channel Mixer’s Output pop-up menu.
Not all ASIO drivers may support this feature. Also, some ASIO drivers may not allow Direct 
Monitored audio and playback audio to be sent to the same Output, in which case you need 
to designate a separate output for monitoring.

• You can control the volume and pan of the monitored sound using the channel fader 
and pan control in the VST Channel Mixer.
Again, not all ASIO drivers may support this feature.

• ASIO Direct Monitoring follows the same rules as the internal VST monitoring.
That is, if Tape Type monitoring is selected, Direct Monitoring will be activated for Record En-
abled Tracks in Stop and Record modes. If Record Enable Type monitoring is selected, Direct 
Monitoring will be activated whenever a Track is Record Enabled in the Inspector.

• VST effects or EQ will not affect the Direct Monitored sound.

General

This section contains the following additional settings:

Enable Multi-Processing

This is described on page 521.

Record Mode pop-up menu

This pop-up menu is a mirror of the Record Mode pop-up menu in the Arrange win-
dow. The setting determines the resolution used for recording. The implications of 
recording with higher resolution than 16 bit are discussed in the chapter “Record-
ing in High Resolution and Using TrueTape™”.

Plug-in Delay Compensation

This option is described on page 441.
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Favour MIDI Timing

When this is activated, the MIDI processing gets somewhat higher priority than the 
audio processing, for optimum MIDI timing. As long as the “CPU Over” indicator in 
the Audio Performance window doesn’t light up, leave this option activated.

❐ If you are using OMS, you should always activate Favour MIDI Timing.

Save your System settings!

Some of the settings in the System Setup dialog are saved automatically in the Cu-
base VST preferences, while others are saved with the Song, according to the table 
below.

• To have the settings saved with your Song, activate the “Save with Song” checkbox.

Which settings are saved where is listed in the table below. To make sure that you 
always start out with the audio settings you know work well on your system, tailor 
your System settings once and for all, and save your Song as the Autoload Song.

Setting Saved in

Audio Performance Settings Song or Preferences

Monitoring Switch Song or Preferences

MIDI Sync Reference Song or Preferences

Audio I/O Settings Preferences

MIDI To Audio Delay Preferences

Enable Multi Processing Song or Preferences

Record Mode (Resolution) Song or Preferences

Favour MIDI Timing Song or Preferences



- 521 - 

Multi processing

The benefits of multi processing

With Cubase VST, it is possible to take advantage of Macintosh computers with 
multiple processors. This makes it possible to for example run several processor-
intensive effects and EQs, without affecting the speed of the user interface.

Preparing for multi processing

• Before you attempt to run Cubase VST in Multi Processing mode, you need to make 
sure that the Multi-processing Extensions are installed properly in the Extensions 
folder in your System folder.
Please refer to the documentation included with the computer or the MP card for details.

Running VST in Multi Processor Mode

1. Make sure no other application is running, and launch Cubase VST.

2. Pull down the Options dialog and select System... from the Audio Setup submenu.
The Audio System Setup dialog appears.

3. Make sure the Enable Multi-Processing checkbox is activated.

4. Close the Audio System Setup dialog.
The program will now take advantage of the multiple processors. You will note the result, es-
pecially if you activate a lot of effects, eqs, inputs and buses.

❐ If you want Multi-Processing to be enabled by default, make sure the “Save with Song” 
checkbox is activated in the Audio System Setup dialog and save the Song as the Auto-
load Song (see page 622).

The Enable Multi-
Processing checkbox.
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Methods of Optimizing Performance

There are several things you can do to improve the computer performance when 
running Cubase VST. The following is a brief list of things you may want to try:

• Don’t run other applications when you use Cubase VST, if you don’t explicitly need 
them.
You may want to check for and remove unnecessary “Startup Items” in the Macintosh Exten-
sions Manager.

• Use the Macintosh Extensions Manager to create a separate extension set for Cubase 
VST work.
This may not be absolutely required, but can be useful for two reasons: 
A. There may be extensions that cause conflicts and degrade performance (e.g. schedulers, 
screen savers and similar). 
B. Unnecessary extensions cause the MacOS to use more memory (RAM), that could be put to 
better use by Cubase VST.

• Assign as much RAM as possible to Cubase VST.
However, you should leave a little extra RAM available for the MacOS system when Cubase 
VST is running (2-5 MB is usually sufficient, depending on the system).

• Rebuild the desktop now and then.
See the Macintosh documentation for details.

• Check the integrity of your hard disk(s) regularly.
Even though nothing may appear to be wrong, there can be various small hard disk errors 
that affect performance. There are several hard disk analysis and repair tools available - just 
make sure you use a version compatible with your MacOS and file structure! See also page 
524.

❐ We recommend that you check the Steinberg Knowledge Base for the latest info on 
how to optimize your system. This can be reached from the Help menu in Cubase VST 
(provided that you have a working Internet connection).
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The Performance window, EQ and Effects

Even though you have been able to activate a number of audio channels in the Sys-
tem dialog without getting any warning, you may possibly run into performance 
problems when adding EQ or effects. This is due to the fact that the Apply function 
doesn’t “know” how much processing is activated. The EQ, effects modules and VST 
Instruments put a certain demand on the processor, which may cause the audio 
playback to drop out or stutter. Therefore:

1. Pull down the Panels menu and select VST Performance...
The VST Performance window appears.

2. Move the Performance window to a place on the screen, where you can see it all the 
time.

• The upper bar graph shows the CPU (processor) load.
If the red indicator lights, you need to decrease the number of EQ modules, active Effects 
and/or audio channels playing back simultaneously.

• The lower bar graph shows the Hard Disk transfer load.
If the red indicator lights, the hard disk is not supplying data fast enough to the computer. 
You might then try going into the System dialog, lower the number of channels and raise the 
Disk Block Buffer Size. If this doesn’t help, you need a faster hard disk.

❐ Please note that the red indicator for the Disk meter may light up briefly during posi-
tioning or when stopping playback. This is not an indication of any problem.
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Maintaining the Hard Disk

Defragment!

Always make sure your hard disk is defragmented. Fragmentation affects the per-
formance of any hard disk severely. See your computer manuals for details.

Delete Unused Files!

Cubase VST requires a lot of disk space and fast disks. If you don’t delete unused 
files, your hard disk will soon fill up.

When you use Purge Segments in the Pool, it will be evident which files are no 
longer used in a Song (the files not used will have no Segments at all). This gives 
you a way of finding out which files can be deleted. But please remember that an 
audio file can be used in more than one Song.

Back Up!

It can’t be said too often. Disk crashes are a well known phenomenon. Without a 
regular backup scheme you take the risk to lose valuable recordings!
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37
The Master Track
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What is the Master Track?

Cubase VST has a Master Track, a special “hidden” Track that contains all the tempo 
and time signature changes. There is one Master Track for each Arrangement. The 
Master Track does not have Parts, you always edit the entire length of the Song.

❐ For the tempo changes to have any affect on the Arrangement whatsoever, you must 
have the Master button on the Transport Bar activated! The Time Signatures in the 
Master Track, however, are always used.

There are three ways to change the Master Track:

• By editing in the Master Track Graphic editor (see page 527 in this chapter).
• By editing in the Master Track List editor (see page 546 in this chapter).
• By recording tempo changes (see page 534 in this chapter).

The Master button 
on the Transport Bar.
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Opening the Graphic Editor

You can open the graphic Master Track editor in four ways:

• By double clicking in the ruler in the Arrange window or in any editor.

• By selecting Graphical Mastertrack from the Edit menu.

• By using a key command (by default [Command]-[M]).

• By double clicking the Master button on the Transport Bar.
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The Window Sections

The central display in the Graphic editor is divided into seven sections. Some of 
these can be hidden using the group of buttons on the Function bar.

Here are the graphic editor’s areas, from top to bottom:

Time Ruler (turned on/off 
using the Time button).

Time Hitpoint Strip 
(turned on/off using the 
Hitpoint button).

Tempo display (always visible).

Meter Hitpoint Strip 
(turned on/off using the 
Hitpoint button).

Time Signature Strip 
(turned on/off using 
the Time Sig button).

Meter Ruler (always visible).

Info Line (turned 
on/off using the 
Info button).
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About the Tempo Display

The Tempo Display behaves very much like the Continuous Data Display in for exam-
ple Key Edit. For a basic introduction to Cubase VST's way of handling continuous 
data (tempo belongs to this type of data), see the chapters about the MIDI Editors.

The First Tempo/Time Signature Event

When you first open the Master Track editor, for a new song, it will only contain one 
tempo, displayed as a colored box continuing indefinitely to the right. 

❐ You can't move or delete the first Tempo or Time signature Event.

The Tempo Display and Scrolling

Since the Tempo Display can be scrolled and the window resized, you might not al-
ways see the entire tempo graph:

• If the display is “white”, this is because the tempo graph is below the window (scroll down).
• If the entire display is colored, this is because the top of the graph is above the window 

(scroll up).

About Time Signature Events

Time Signature Events are displayed as small “hangers” above the tempo graph, vis-
ible if the Time Sig button is activated on the Function bar (see illustration above). 
The Events themselves can be selected, moved, copied, etc. and the values for them 
are edited on the Info Line, as described on page 538.
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About Rulers and Positions 

The Master Track editor has two rulers, one above and one below the Tempo Dis-
play. The upper ruler shows meter (bars, beats etc.). The lower ruler – which can be 
turned on/off using the Time button, see page 528 in this chapter – shows time in 
one of a number of formats. To select a time format for this ruler, use the pop-up Op-
tions menu.

The formats are made up as follows:

For SMPTE/EBU and Frames, the number of frames per second is set in the Synchro-
nization dialog box, reached from the main Options menu. There are always 80 
subframes to a frame, regardless of the frame rate.

The amount of detail shown on the ruler depends on how far you have zoomed in.

SMPTE/EBU hours:minutes:seconds:frames:subframes

msec hours:minutes:seconds:thousands of seconds

Frames frames

16mm Film feet’frames

35mm Film feet’frames:sprockets (4 sprockets per frame)
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Switching between Meter and Time based Display

Normally, the meter ruler will be linear, that is, there will be equal distance between 
all bars on the screen. If there are tempo changes, the time ruler will be non-linear 
to match. If you watch the accelerando below you will see that the meter ruler is lin-
ear but the tick marks on the timing ruler get more and spread apart as the tempo 
increases.

There will be cases where you want the Meter ruler to be linear and the Time ruler 
to adapt to this, and there will be cases where you want the opposite (for example 
when working with film or video). For this purpose, the display can be switched, us-
ing one of the buttons on the Status Bar.

Meter Linear / Time Linear

After switching, you may have to change the horizontal magnification of the win-
dow to make the window show the range you are interested in.
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Moving around and setting Song Position

Since the Master Track is basically an editor like any other, moving around and set-
ting Song position is basically identical to using any editor. Here are two minor dif-
ferences:

• To Position the Song Pointer, simply click on either Position Ruler.

• The Goto menu has slightly fewer options than the other editors.

Position Boxes

The Mouse Pointer position is always shown on the Status bar, at the top as a time 
position and below as a meter position. These two position boxes are also used 
when moving and duplicating objects, as in all Cubase VST editors and in the Ar-
range window.

❐ Please note that these two boxes always show the position at the closest Snap value. 
Since the Snap value is used when positioning Events, these boxes will always indicate 
the position that an Event will actually appear on when you move it or draw it in. This 
also means that when you have zoomed in very far, you will probably want to set Snap 
to Off to be able to position accurately.

About Hitpoints

The Master Track editor also adds “Hitpoints” to Cubase VST. These are used to 
match time positions to meter positions, for example to make a certain musical cue 
fit a scene in a film or video.

Hitpoints come in two flavors, meter and time based. “Meter Hits” are shown on the 
upper Hitpoint strip and “Time Hits” are shown on the lower. You can hide all Hit-
points by using the Hitpoint button on the Status Bar, see page 528 in this chapter. 
Utilizing Hitpoints, tempo changes can be created which make the music fit any 
type of cue. More on working with Hitpoints in the next chapter.

Time Position

Meter Position Tempo
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About the Toolbox

The Master Track editor has a Toolbox, just like all Cubase VST's main windows:

Activate Master!

❐ For the Tempo and Time Signature changes to have any effect on playback, you must 
turn on the Master button on the Transport Bar.

The Speaker tool is not used in 
the Master Track editor.
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Recording Tempo Changes

Recording Tempo Changes in the Graphic Editor

To record tempo changes using the mouse, proceed as follows:

1. Select a Snap value (using the Snap pop-up on the Function bar) to decide for a spacing 
between the Events.
Do not use a higher value than needed, since this will make it harder to perform detailed ed-
iting on the recording afterwards. Often quarter notes will suffice, but experiment to find a 
value that suits you.

2. Activate playback from any position in the Song.

3. Position the mouse pointer over the tempo scale to the left of the tempo graph.
Watch the Tempo box on the Status bar, it will show the Tempo represented by the mouse 
position, see page 532 in this chapter.

4. Click the mouse button to insert one tempo Event, or drag up and down to create acce-
lerandi or ritardandi. 

5. When the mouse button is down you record tempo changes, when it is up you don't. 
Use this is as a way of punching in/out.
 The display does not get updated while the mouse button is down. 

6. When you are ready, stop playback.

❐ The recording you make overwrites any earlier recordings at the same positions (the 
Master Track editor always records in “Replace Mode”).
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Recording Tempo Changes from the Arrange Window

It is possible to record changes in tempo without entering the Master Track editor(s). 
There are two major uses for this:

• You get a better view over the actual position in the Song, since you can watch the Part dis-
play while you are changing the tempo.

• You can use this for setting out “markers” for tempo changes and then edit in the actual 
tempo values in the Master Track afterwards.

When the “Record Tempo/Mutes” item is on (checked) on the Options menu, and 
Cubase VST is put into Record mode, it records any tempo changes and puts them 
in on the Master Track.

❐ Make sure you don't overwrite (Replace) any regular recording when Cubase VST is put 
into Record mode. To make certain, select an empty Track.

Tempo Recording works just as regular recording, using the Locators, with punch 
in and out at any time and so on, but...

• The Master Track is always in Replace mode, that is, the recording always replaces the 
existing tempo Events. 

Once in Record mode, change the tempo value on the Transport bar. Each time you 
change it, the new setting is recorded. Recorded tempo changes appear in the Mas-
ter Track, where they can be edited as usual.

❐ For the recorded tempi to have any effect on playback or future recordings you must of 
course activate the Mastertrack (press [M] on the computer keyboard).

Remember that it is only tempo changes that are recorded, you may have to set an 
initial tempo directly in the Master Track. Also remember that this type of recording 
does not use the Snap value, and is therefore harder to edit than a recording made 
directly in the Graphic editor.
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Selecting

Tempo Events

Selecting in the tempo graph is done as everywhere else in Cubase VST:

• Clicking on one Event selects it.
• If you hold down [Shift], you can select more Events.
• If you press the mouse button somewhere in a free (white) area and drag, a rectangle ap-

pears. This rectangle should stretch over the beginning of all the Events you wish to select.

With a rectangle like this...

... you select these two Events, since they both begin within the range.

• You can click on one Event and then use the [←] and [→] keys to step through them. Hold 
down [Shift] to select as well.

• You can use Select All ([Command]-[A]) to select all Events, not just the tempo ones.
• To deselect, simply click on some free (white) area in the display.

Time Signature Events and Hitpoints

Selecting Time Signature Events (and “Hitpoints”, see the next chapter) is done in 
exactly the same way as with Tempo Events, see above.
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Selecting Events of Different Types at the Same Time

The Master Track editor displays data of several different types: Tempo Events, 
Time Signature Events and Hitpoint Events. To select more than one type, first 
make your selection in one area (for example in the Tempo Display) using any of 
the methods above then hold down [Shift] and continue selecting in the next area 
(for example among the Time Signatures), again using any method.

To select for example some Tempi and a Time Signature, first select the Tempi, then hold down 
[Shift]...

...and click on the Time Signature Event.

The only exception to this is Select All, which (as stated above) selects all Events, re-
gardless of type.
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Editing on the Info Line

When you select one and only one Event its settings appear on the Info Line. 

• All types of Events have a Time and a Meter position. You can edit either to move the Event.
• The Time Position is always edited in time code (SMPTE) format; as hours:minutes:sec-

onds:frames:subframes.
• Tempo Events can also be edited on the Info Line. If you have the display switched to the 

Time based mode (see page 531), the curve will get “compacted” or “expanded” as you 
change the tempo.

• Time Signature Events have a numerator and a denominator which can be changed individ-
ually on the Info Line to produce any time signature from 1/2 to 64/64.

• Hitpoints' names (as shown in the value column) are described on page 554.

❐ Moving Time Signatures using the Info Line can be a bit confusing at first. Here's why: 
If you move a Time Signature so that it winds up on the same position as an existing 
Time Signature, that Event will be deleted. If this is not what you want, either double 
click on the position value on the Info Line and type in the desired position or move the 
Event using the mouse, see page 541.

❐ You can not move the first Time Signature Event.
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Redrawing the Tempo Curve

If you select the Pencil from the Toolbox and drag over an existing tempo curve, you 
will change the values of the tempo Events you pass over. A box on the status bar, 
just to the left of the Quant value, will show you exactly which tempo the current 
mouse position represents, see page 532 in this chapter.

To change the value of one Event for example, you can position the Pencil anywhere 
“over it”, move up and down until you see the right tempo, and then simply click to 
set the Event to that tempo.

Clicking in the graph changes the tempo of the Event to the position of the pointer.

To change the tempo of several Events at the same time, you simply drag over 
them with the mouse button down. If you drag faster than the program can redraw 
the screen, don't worry, your movement is tracked anyway.

Please note that this only changes the values of existing Events, it does not input 
new ones. To do this, you must hold down [Option], see below.

If you have the display switched to the Time based mode (see page 531), the curve 
will get “compacted” or “expanded” as you change the tempi.
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Drawing new Events

Tempo Events

Drawing one Event

1. Set the Snap value.
You can only input Events at the closest Snap position.

2. Select the Pencil.

3. Hold down [Option], position the pointer (watch the tempo indicator on the Status 
Bar), and click once.

Drawing a Curve

1. Set the Snap value.
Don’t draw Tempo Events with a tighter spacing than you need, it’ll “eat up” memory and 
make the screen redraw slowly.

2. Select the Pencil.

3. Hold down [Option], position the pointer (watch the tempo indicator on the Status 
Bar), and drag.
If you drag faster than the program can redraw the screen, don't worry, your movement is 
tracked anyway and the values are smoothed at the end of the draw.

If you have the display switched to the Time based mode (see page 531), the curve 
will get “compacted” or “expanded” as you input new tempi.

Time Signature Events

To draw in Time Signature Events, simply select the Pencil and click once in the 
Time Signature strip. You can also drag to input several Time Signature Events at 
the same time. To input a Time Signature change at every bar for example, set Snap 
to “1” and drag across the time Signature Strip. Then select each one and set its 
value using the Info Line.
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Moving Events Using the Mouse

If you have one or more Events selected (even of different types) you can move 
them using the mouse, just as with any object in Cubase VST (select the arrow 
pointer from the Toolbox). Only horizontal movement matters.

If you are only moving one tempo Event, its position is indicated by a vertical line. If 
the selection contains several tempo Events, a rectangle encompassing the area 
from the start of the first selected Event to the start of the last selected Event guides 
you. The movement snaps to the closest Snap value.

❐ A block of tempo data that you move, always replaces any existing tempo data on the 
position you move it to. You can not move the first Tempo and Time Signature Events.

Duplicating Events

If you hold down [Option] and move Events, you are duplicating them. Everything 
else is as when moving.

❐ Time Signature events can only be positioned at the beginning of a bar.

Adding a Tempo Change at the Song Position

To insert a tempo change at the Song Position, proceed as follows.

1. Set the Song Position exactly where you want the new tempo event.

2. Select “Split tempo at Songpos” from the pop-up Do menu.
A new tempo event is added, but since it has the same value as the previous, there is no 
graphical difference.

3. Select the new event and change its value.

Cut, Copy and Paste

The Master Track editor supports full Cut, Copy and Paste of all types of Event. Cut 
and Paste works just like in any other part of Cubase VST.

❐ If, as a result of the Paste, one Tempo or Time Signature Event will wind up on the same 
position as the other, the previous Event will get replaced. A block of tempo data that 
is Pasted in always replaces any tempo data at those positions. 
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Deleting Events

• To delete Events using the mouse, select the Eraser and click or drag over the Events.

• To delete using the computer keyboard, first select the Events you want to delete, then 
press [Backspace].

• You can also use the “Delete” item on the Edit menu to clear the selected Events.

❐ When you delete a Tempo or Time Signature Event, you actually remove a change in 
Tempo/Time Signature. Since you remove the change, the previous Tempo or Time 
Signature will remain, until the next Event. 
You can not delete the first Tempo or Time Signature Event.

Repeating Events

The Repeat function on the pop-up Do menu can be used to block-duplicate a num-
ber of Events one or more times. It operates on all Events, Tempo changes, Time Sig-
nature changes and Hitpoints at the same time.

1. Set up the Left and Right Locator (on the Transport bar) to encompass the section you 
want to repeat.

2. Set the Song Position to where you want the first block of Events to appear (you can 
click on the Time or Meter Rulers to do this).

3. Select Repeat from the pop-up Do menu.

4. In the dialog box that appears, set the number of times you want the block repeated.

5. Click OK.
The copies will now appear. They are lined up “edge to edge”, starting at the Song Position.

Creating Accelerandi and Ritardandi

The Line tool in the Toolbox (see page 533) can be used to create continuous 
tempo changes, accelerandi and ritardandi (de-accelerandi). The Line tool is de-
scribed in detail in the chapters describing the MIDI editors.

• To fit existing Events under the line (to create a ramp), position the mouse, press the 
mouse button and drag to create a line. Release the mouse.

• To create new Events, hold down [Option] before pressing the mouse button. New 
Events that fit “under the line” are created, spaced according to the Snap value.

Please note that if you have the display switched to Time Base (see page 531) the 
ramp will appear “curved” since the meter scale is compacted/expanded. If this is 
confusing, switch over to meter base.
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Reducing the number of Tempo Events

As a result of a tempo recording you may have an overly dense tempo curve, which 
might make the screen redraw sluggishly and the tempo curve hard to edit.

Reduce, found on the pop-up Do menu thins the data at its densest points, making 
the spacing more even. Applying it repeatedly will make the data consecutively 
“thinner”. 

Reduce only works on the selected Events. Select a section of the tempo curve and 
use the Reduce function.

Smoothing Tempo Event values

This function, found on the Do pop-up menu, evens out a tempo curve with “tran-
sients” (jumps), without inserting or deleting Events. Instead, existing Tempo Events 
are averaged to make the curve smoother.

Again, this function affects the selected Events only.

…and after.Before Smoothing....
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Numerical processing of Tempo Events

The Process Tempo dialog, located on the pop-up Do menu, is the equivalent of a 
fit time calculator. It is used to numerically change a set of tempi by a specific 
amount or to fit a certain cue. Since this function uses numbers, it might feel com-
plicated when you first try it. We will try to guide you through it. Here's the main 
procedure:

• The Process Tempo dialog adjusts existing tempi so that a region of bars (for example eight 
bars) will fit a certain time span (for example “6 seconds and ten frames”). 

• Since the function does not create any tempi of its own, you have to put them in before you 
start. If you want a smooth tempo change, create a ritardando or accelerando. If you want 
more direct changes, only input one or a few Events. Also note that the adjustment is made 
overall for all the tempi in the range, which means they keep their relative tempo differences. 
In other words, a steep ritardando will still be a steep ritardando after the processing.

• The adjustments themselves are made in a dialog where you can change only two things: ei-
ther you simply set an overall scale factor (for example 70% of the original tempo) or you set 
an end time for the range, so the number of bars that you selected will now end at precisely 
that position.
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Here are the details: 

1. To use this function, select one or more tempi that make up a range of bars, but do not 
include the last tempo in the Song! 
(If the last tempo is selected, Process Tempo will be greyed out on the menu). All the tempi 
within the selected range will get processed, whether they are all selected or not.

This selection will Process all Tempi between bar 19 and 21.

2. Select Process Tempo from the pop-up Do menu.
A dialog box appears.

3. The Start and End Meter values in the “Selection Range” section are only display val-
ues. They show you the range of the selection you made.

4. The Start Time and Length fields in the same section are also just display values. Start 
Time shows you the Time position of the beginning of the selection. End Time shows 
you the time position of the end of the selection. This last value will change when you...

5. ...set the amount of change either by adjusting Length or Tempo Scaling in the “Set-
tings” section of the dialog. In either case the other value and the Length value will get 
updated to show you how the change will affect the bars the selection encompasses.

6. When you are done with all the settings, click Do.
The changes take effect immediately. You can also click Undo to revert to what you had be-
fore.

7. When you are ready, click Exit.

A more intuitive way of fitting tempi to time based cues is by using Hitpoints, see 
page 561.
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The Master Track List Editor

Cubase VST also features a list editor for Tempi, Time Signatures and Hitpoints. You 
can use this instead of the Graphic editor, or as a complement.

The List window is very straightforward to use. If you are familiar with the Graphic 
editor and Cubase VST’s List Edit for MIDI data, using this editor will be easy.

Opening the List Editor

You open the list editor by selecting List Mastertrack from the Edit menu or by us-
ing a key command (by default [Shift]+-[M]).

You can have the List and the Graphic editors open at the same time, and they will 
always be “in sync”, just as when you have two MIDI editors open at the same time.

Selecting a Time Format and Hiding Event Types

Using the upper part of the pop-up Options menu at the top of the window, you 
can select a format for the Time Positions of the Events (as described on page 530 
in this chapter).

Using the lower part of the same menu, you can hide/show any of the four possible 
Event types.
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Creating Events

If you want to create a new Event, proceed as follows:

1. Select an Event type from the Tempo pop-up menu.

2. Set the Song Position on the Transport Bar to where you want your new Event.

3. Click the Insert button.

❐ If an Event of the same type already exists on that position, it will get overwritten.

Moving Events

This is done by adjusting the position values in the list, as on the Info Line in the 
Graphic editor (see page 538). You can move an Event by either giving it a new 
Meter Position or a new Time Position (in Time Code format (SMPTE/EBU) only).

❐ You can not move the first Tempo and Time Signature Event.

Deleting Events

1. Select the Event(s) you want to delete.
You can use [Shift] to select several Events at the same time.

2. Press [Backspace].

❐ You can not delete the first Tempo/Time Signature Event.

Cut, Copy and Paste

Events that you have selected can be Cut, Copied or Pasted. When you Paste they 
will get inserted as a block, starting at the Song Position.
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Moving Master Track data between Arrangements

As you know, you can have several Arrangements open at the same time. Each Ar-
rangement has its own Master Track, for which the Master Track editor is an editor. 
To move Tempo Events, Time Signatures and Hitpoints between Arrangements, you 
can use two techniques: Cut, Copy and Paste or Import/Export.

Using Cut, Copy and Paste

To Cut, Copy and Paste between Arrangements, proceed as follows.

1. Select the Events you want to move, in the Graphic editor or in the List (it doesn't mat-
ter which). For details on selecting, see page 536.

2. Select Cut or Copy.

3. Select another Arrangement
This can be either an open one, one that you create using New on the File menu or one that 
you open from disk (as an Arrangement file).

4. In the new Arrangement, open the Master Track editor.

5. Set the Song Position to where you want to insert the block of data, and select Paste 
from the Edit menu.

❐ If, as a result of the Paste, one Event will wind up on the same position as an existing, 
the existing Event will get replaced. A block of tempo data that is Pasted in always re-
places any tempo data at those positions. 

Using Import and Export

If you want to move an entire Master Track between Arrangements, you use Import 
and Export on the pop-up Do menu in the Master Track editor.

• Export presents you with an ordinary file selector where you can define a name and location 
for your Master Track file.

• Import loads a Master Track from disk which simply replaces the current Master Track.
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Hitpoints
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About this Chapter

This section describes how Hitpoints are used and how they can be applied to dif-
ferent situations, such as Fit Tempo operations and sync to existing music on tape. 
It assumes you are already familiar with the basic use of the graphic Master Track 
editor.

The following text will first describe how Hitpoints are handled, and then applies 
this to real life situations.

What can I do with Hitpoints?

Hitpoints are basically used for matching time positions to meter positions, by in-
serting – and changing the values of – tempo changes. This can be used in a num-
ber of situations:

• When scoring for film and video, matching music to visual cues.
• For syncing Cubase VST to live music on tape.
• For restoring lost sync tracks.
• When working with material that contains both music (tempo based Events) and for exam-

ple sound effects (time based Events).
• Creating tempo maps for music recorded without a metronome, and fit the music to the “bar 

lines” in Cubase VST.

What are Hitpoints?

Hitpoints are actually only positional references, markers of important positions that 
appear in the Graphic Master Track editor (and also to some extent in the MIDI edi-
tors, see page 556). They are used to define the relationship between time and 
meter in order to “match tempo” (see below) or to create tempo maps that fit cer-
tain cues.
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There are two types of Hitpoints, Meter Hits and Time Hits. Meter Hits are found on a 
strip above the Tempo Display and Time Hits are found on a strip below (see page 
532). If these Strips are not visible, there is a Hitpoint button on the Status bar that 
reveals them.

The Hitpoint button.

Meter Hits always appear on meter positions (bars, beats etc.) and Time Hits are al-
ways on time positions (for example displayed as time code).

The idea is that you set out Time Hits to mark out important visual keys in film, or for 
example quarter notes in freely recorded music. You then use various tools to find a 
relation between the Time Hit’s positions (defined in time) and important musical 
positions (defined in bars and beats). This relation is created in one of two ways: by 
linking Time and Meter Hits, or by using the Tempo Match/Tempo Scan function.

Hitpoint Strips hidden.

Hitpoint Strips shown.

Time Hitpoint Strip 
(turned on/off using the 
Hitpoint button).

Meter Hitpoint Strip 
(turned on/off using 
the Hitpoint button).

Time Hitpoint.

Meter Hitpoint.
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Setting Out Hitpoints

Using the Mouse

The obvious way of setting out Hitpoints is using the Pencil in the Toolbox. This 
works just as with Time Signature changes (see page 540), just select the Pencil 
from the Toolbox and click or drag in a Hitpoint Strip (see previous chapter). The 
Snap values restricts your input as usual.

❐ Please note that when setting out Meter Hits, you may want to turn off Snap com-
pletely.

If you hold down [Option] while dragging, you get two linked Hitpoints, but more 
about that on page 559.

Via MIDI

You can use MIDI to input Time Hits, whether Cubase VST is playing or not. 

1. Activate the MIDI In button on the Status Bar.

The MIDI In button.

2. If so desired (see below) activate playback.

3. “Send” in some MIDI Notes, for example by tapping a MIDI keyboard.
When the MIDI In button is activated, MIDI notes coming in while the Master Track editor is 
open will be converted to Time Hits.

4. When you are done, turn off the MIDI In button.

❐ For this function to work, you don’t have to be in play or record mode. This means you 
can add hitpoints even when syncing to time code running very slow or even at still 
frame (using VITC time code converted to MIDI Time Code, for example). This will allow 
you to input Hits “manually” with very high precision.

Using Fill

To create evenly spaced Meter Hits, there is a special item on the Do pop-up menu, 
called “Fill meter hits”. This will fill the Meter Hit strip with Hitpoints, between the 
Left and Right Locator, spaced according to the Snap value.
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Mirror

This function, found on the Do pop-up menu, will mirror the selected Hitpoints 
onto the “other side”. A Time Hit will get a Meter Hit at the corresponding position, 
and vice versa.

Selecting two Hitpoints and then Mirror...

...creates two new Hitpoints.
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Editing Hitpoints

Moving and Naming using the Info Line

Just as with Tempo Events and Time Signatures, Hitpoints can be edited one by 
one on the Info Line. Apart from moving them this way you can also give each Hit-
point a name. Just double click on the default name at the far right end of the Info 
line and type in a new one.

The right end of the Info line shows the type of Hitpoint and its name.

Moving, Duplicating, Deleting etc.

Just as with Time Signatures and Tempo Events (and many other objects in Cubase 
VST) you can use the tools in the Toolbox and the computer keyboard to select 
move, duplicate, Cut, Copy, Paste and delete Hitpoints. This is all described in detail 
in the previous section.

Also, the Repeat function described on page 542 of course applies to Hitpoints too.

Nudging

The Nudge tools in the Toolbox can be used to move one Hitpoint one Snap value 
to the left or right, respectively.

❐ If – as a result of a nudge – a Hitpoint winds up on the same position as another one, 
you will only see one of them. You can always use the Master Track List editor to check 
for “double” Hitpoints.

Converting MIDI Notes to Hitpoints

If you have Copied or Cut notes or Control Change messages (for example sustain 
pedal) from a MIDI editor, and Paste them in the Master Track, they will appear as 
Time Hitpoints, starting at the Song Position.

Keep Linked and Keep Selected

These two functions on the Do pop-up menu can be used to conditionally delete 
Hitpoints.

• “Keep Linked” deletes all Hitpoints that are not linked (see below). 
• “Keep Selected” deletes all Hitpoints that are not selected.
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Quantizing

Meter Hits can be Quantized. This is probably most useful together with the Mirror 
& Link function as described on page 560. Combining these two functions allows 
you to for example easily insert small tempo changes to make some Hits perfect af-
ter using Match to find an adequate tempo.

1. Set a Quantize value using the Quant pop-up menu.

2. Select the Meter Hits you want to Quantize.
If you want to Quantize them all you use Select All, since no other Events than Meter Hits are 
affected by this operation).

3. Select Quantize Meter Hits from the Do pop-up menu.
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Hitpoints in the MIDI Editors

MIDI editors that have a regular meter ruler can also display Meter Hitpoints. View-
ing Meter Hits in the MIDI editors has the advantage that it allows you to relate the 
positions of the Hits to the positions of MIDI notes and other musical data.

Viewing Hitpoints in the MIDI Editors

The “H” button on the Status Bar in the MIDI editors allow you turn the Meter Hit-
point strip on and off.

The Meter Hits Strip button.

This strip is just another view to the same Hitpoints that can be found in the Master 
Track editor. Any editing you perform in either window is immediately reflected in 
the other.

Adding and Editing Hitpoints in the MIDI Editors

The following editing can be performed on meter Hitpoints in the MIDI Editors (for 
exact details of the procedures, see the previous pages).

• Drawing new Hitpoints with the Pen.
• Deleting.
• Renaming.
• Moving and Duplicating.

Converting Notes to Meter Hitpoints

As described on the following pages, a common situation for tempo matching is 
that you already have a number of recorded MIDI notes, that form a rhythmic pat-
tern that you want to use as basis for a tempo match. It is then very convenient to 
convert these notes to Meter Hitpoints, for further processing in the Master Track 
editor. Proceed as follows:

1. In the MIDI Editor, select the notes you want to convert to Meter Hitpoints.

2. Select “Selected to Hitpoints” from the Do pop-up menu.
Corresponding events appear on the Meter Hitpoint strip.

3. Switch to the Master Track Editor and perform any of the operations described on 
pages page 561 and onwards, in this chapter.
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Playing back Hitpoints via MIDI

You can get audible feedback on the position of a Hitpoint. While this is probably 
most useful for Time Hits, it can be used on Meter Hits too.

To set up MIDI playback of Hitpoints, select “Edit Hitpoint Note” from the Do pop-
up menu in the Graphic Mastertrack editor. If you are familiar with the Metronome 
dialog, this one will be self explanatory.

The Meter and Time Hitpoints can be set to play one key each with a certain velocity. 
Both share a MIDI Channel and Output setting, (which can be defined as an Instru-
ment).
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Linking Hitpoints

Linking Hitpoints is a way of telling the Master Track editor which Meter and Time 
Hits belong together. The program can then use this information to change tempo 
(and insert tempo changes if needed) to make certain meter and time positions line 
up. The practical uses of this are described on page 565 and page 567.

Linked Hitpoints

Show Hitpoint Links

To make the links between Hitpoints visible, you must make sure that Show Hitpoint 
Links on the Option pop-up menu is ticked. If it isn't, select it.
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Manual Linking

To manually Link two Hitpoints, proceed as follows:

1. Select the Arrow pointer.

2. Position the mouse inside a Hitpoint.

3. Press the mouse button and drag down or up depending on where you started (from 
Meter to Time or vice versa).
A line will follow the pointer.

f

4. Drag until the mouse pointer is positioned inside a Hitpoint on the “other side”.
The Hitpoint “lights up” to show you when you have the pointer inside it.

5. Release the mouse.

When Drawing

If you hold down [Option] while drawing a Hitpoint you automatically get a linked 
Hitpoint right above/below it.

Breaking Links

If you want to break a Link between two Hitpoints, select the scissors from the Tool-
box and use it to click on or drag over the lines. Do not click on the Hitpoints them-
selves.

Also, if you delete a Hitpoint, its link to any other Hitpoint will vanish.

Link Hitpoints One to One

This item on the Do pop-up menu, automatically links the first Meter Hit with the 
first Time Hit, the second Meter Hit with the second Time Hit, etc.

This is most useful when you have tapped in the Time Hits and used “Fill Meter Hits” 
to create Meter Hits. This will be the situation, for example when syncing to existing 
music on tape or when restoring a lost sync track (see page 567).
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Mirror & Link

This function on the Do pop-up menu, takes all the selected Hitpoints and copies 
them “to the other side” (Hits to Meter and vice versa) and also links each pair.

This function is very useful when you have certain visual cues indicated as Hitpoints 
and wish to find corresponding meter positions to fit them to. By using Mirror and 
Link, moving or quantizing the resultant Meter Hits and then using Straighten up, 
the tempo is adapted in a few simple operations. For more details, see page 565.
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Working with Tempo Matching

The Tempo Matching feature of the Master Track editor is best suited for finding 
suitable tempi for shorter spots or a smaller section of a larger piece.

Show Hitpoint Match

When this option is activated on the Option pop-up menu, lines will extend from 
the Time Hits up over the Tempo Graph and onto the Meter Hit strip. When these 
lines are dotted, the Time Hits currently do not match any certain meter positions, 
when they are solid, they do.

In this figure, the Time Hit in the middle doesn’t match, but the other two do.

About Matching

So how do you tell the program what “matching” means, in your particular case? 
There are two settings for this, the Snap value and the Tolerance pop-up (in %) 
beside it.

If you for example set Snap to 4 and Tolerance to 12%, this means that all Time Hits 
that are positioned within 12% from a quarter note are considered matching and 
will be shown in solid black.
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Finding Matches

Let's say you have a short video spot for which you want to find one tempo that fits 
as many visual cues as possible. You have a video tape recorder with time code that 
you can feed to Cubase VST to achieve synchronization. Proceed as follows:

1. Activate the Master Track by clicking on the Master button on the Transport bar.

2. Use the Synchronization dialog to set things up so that Cubase VST starts exactly 
where the music should start in the spot.

3. Set up a few Time Hits to match the important visual cues.

4. Use the Hitpoint MIDI playback function (see page 557) to verify that the Hits actually 
happen when they should.

5. Decide for a Snap setting and a Tolerance.
Raising the Tolerance will give you a larger number of Matches, but they will be of lower pre-
cision. However, you might gain from increasing the Tolerance initially to find as many 
matches as possible. You can later link the Time Hits to absolute Meter positions and then use 
Straighten Up to automatically create a perfect fit. See page 564.

6. The method works best if you don't have any tempo changes at all during the section 
which you try to fit, so preferably delete any tempo changes in the section.

7. Set the tempo to the lowest you could possibly be satisfied with.

8. Raise the tempo gradually, by using the Pencil directly in the graph. Zoom in verti-
cally if you need higher precision. You can also use the Info Line.

9. Watch the Tempo Match lines as you change the tempo.
Whenever one of them turns solid, you have found a match. Change the tempo up and down 
until as many of the Hits match as possible. Also note where they match. For example, if you 
have Snap set to “4”, a match on the second quarter in a bar may not be as “useful” to you as 
a match on the down- or up-beat.

10.Experiment with different Snap and Tolerance settings.

11.Play back the Song and monitor the MIDI playback of the Hits and how they relate to 
the metronome to get a feel for how the music should be written to fit.
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Using Auto Tempo Scan

If adjusting the tempo as in the Process above feels like too much work, the Master 
Track editor can do it for you.

1. Set things up just as described above and set the tempo to the lowest you could possi-
bly be satisfied with.
The Master Track editor always raises the tempo when trying to find matches.

2. Select the Tempo Event you want to vary to find the match.
Auto-scan can only vary one Tempo Event at a time.

3. Also select (hold down [Shift]) the Time Hits that you want to find a Match for.
The function will only check the selected Time Hits for a match, no other Hits.

To use Tempo Scan, exactly one Tempo Event and at least one Time Hit must be selected.

4. Select Auto Tempo Scan from the Do pop-up menu.

The program now raises the tempo gradually and looks for matches. If it finds a 
match for all selected Hitpoints, it stops. You will have to select Auto Tempo Scan 
repeatedly to step through all the possibilities.

If no match can be found for all selected Hits, the program will show you the last of 
the best matches, that could be found. If you for example have three Hitpoints se-
lected and the program can only find a match for two of them, it will show this.

❐ The more Hitpoints you have, the longer the scan will take. Please be patient...
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Proceeding from here

If you have found a tempo that you would like to use, but not all Hits match, or you 
think you have raised the Tolerance too far, you can automatically insert tempo 
changes to create a perfect match:

1. Use Tempo Match (with or without Auto Tempo Scan) to find a tempo that gives an ad-
equate match, as described above.

2. Select Show Hitpoint Links from the Option pop-up menu. The Tempo Match lines dis-
appear.

3. Select all the Time Hits involved.

4. Select Mirror & Link from the Do pop-up menu.

5. Set Quant to the appropriate value. If your match is for example to downbeats, set it to 
“1”.

6. Use Quantize Meter Hits to move the Meter Hits exactly to the downbeats.

7. Select Straighten Up from the Do pop-up menu.
A dialog box will ask you if you are prepared to insert Tempo changes. Click OK. You will now 
find that the tempo varies (probably just slightly) between the Hits.
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Working with Straighten Up

Straighten Up is a function, and as all others in the Master Track editor it is located on 
the Do pop-up menu. Straighten up adjusts and inserts tempi to make Linked Time 
and Meter Hits match, so that musical positions (Meter Hits) happen at specific time 
cues (Time Hits).

Switching to “Straighten Up Mode” (Show Hitpoint Links)

To display the Links between Hitpoints (instead of the Tempo Match lines) activate 
Show Hitpoint Links on the Option pop-up menu.

How Straighten Up works

When you have input and adjusted your Hitpoints and select Straighten Up, all Hit-
points are examined, one pair at a time, starting from the beginning of the song. 

To make the two Hitpoints match in time and meter, Tempo Events just before the 
pair are adjusted. Visually, this turns any diagonal link-line into a solid vertical one. 

If there aren’t enough tempo changes for Straighten Up to make a pair match, it 
will ask for permission to insert additional tempo Events.

In some cases a perfect match can not be found (for “mathematical” reasons). In this 
case, the line remains dotted, but it may be straight on screen anyway. This slight 
mismatch (which is always in the millisecond range) probably won't be noted.

If you have cross-linked Hitpoints, the program will be unable to straighten up and 
will inform you via a dialog box.

Working with visual cues

If you are working with music for film or video, for example with Cubase VST synced 
to time code from a video, Straighten Up is an invaluable tool for making cues 
match the picture. Here's a general outline of how to work with Hitpoints and 
Straighten Up:

1. Set up synchronization to the video.
See the Synchronization chapter.

2. Activate the Master Track (press Master on the Transport Bar) and open the Master 
Track editor. Set an approximate initial tempo for the music you have in mind.

3. In the Synchronization dialog box, find a starting point, for example approximately 
two bars before the music should actually start.

4. In the same dialog, to make the Time Ruler in Cubase VST display the actual time code 
on the tape, set the Time Display to the same value as the Song Start. Also set Bar Dis-
play to for example -2, so that position 1.1.0 in the Song is where the music should ac-
tually start.

5. Draw in, or use MIDI to insert a Time Hit where the music will start.
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6. Draw a Meter Hit on Bar 1, and link it to the Time Hit.

7. Now select Straighten Up, and the tempo will get adjusted so that these two points line 
up.
If the tempo was changed too much, you might have to repeat the procedure, set a new 
Song Start and Time Display in the Sync dialog, and move the Time Hit accordingly, then 
Straighten Up again.

8. When the beginning of the Song is adjusted to taste, you can begin inserting Time Hits 
for important visual cues.
We suggest you name them for future reference.

9. The next step is to create corresponding Meter Hits. This can be done manually (draw 
and link) or using Mirror and Link.

10.Move the Meter Hits around to fit the music and use Straighten Up to examine what 
kind of tempo changes were needed.
Please note that Straighten up only inserts one tempo change for each linked pair. If you 
want a gradual tempo change between two pairs, draw in an accelerando/ritardando, and 
Straighten Up will scale the entire section to fit.

11.Keep adjusting the Hitpoints, insert new tempo changes (accelerandi or ritardandi for 
example) where needed, and use Straighten Up to restore the Time/Meter relations.

Don't worry about making last minute changes. If you for example receive a new 
copy of the video where a few frames have been cut out, just move your Time Hits 
accordingly and straighten up again. Changes you make in the beginning of the 
Song won't affect tempi at later positions, since each matched pair of links creates a 
new fixed “reference” between time and meter.

During the course of this procedure, you can of course switch back to the Arrange 
window and record and edit music to fit the cues.
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Synchronizing to existing music and recovering lost Sync Tracks

It is not uncommon to have to synchronize MIDI sequencing to existing music. To 
do this, you need the Master Track editor and a tape with the music on one track 
and time code on another.

Anyone who has been in the unfortunate situation of losing a time code track, for 
example by accidentally erasing it, knows how time consuming it can be to restore 
it.

The procedure below lets you do both these things very easily:

1. Start by striping the tape with fresh time code, if necessary. This code should start a 
few bars before the music and extend well after it.

2. Activate the Master Track by clicking on the Master button on the Transport bar.

3. Set up synchronization to this time code, and verify it works as expected.
See the Synchronization chapter for details.

4. Try to set an approximate initial tempo.
You can for example turn off sync, and guess at a tempo. Start the sequencer in time with the 
metronome turned on, and adjust roughly.

5. In the Synchronization dialog, set a Songstart position approximately (for example) 
two bars before the music starts. Turn on sync again.

6. In the same dialog, to make the Time Ruler in Cubase VST display the actual time code 
on the tape, set the Time Display to the same value as the Songstart. Also set Bar Dis-
play to for example -2 (if the music starts two bars after the Songstart), so that position 
1.1.0 in the Song is where the music will actually start.

7. Use MIDI to insert a Time Hit where the music starts. Verify its position by making it 
play back for example a drum sound via MIDI.

8. Draw a Meter Hit on Bar 1, and link it to the corresponding Time Hit.

9. Now select Straighten Up, and the tempo will get adjusted so that these two points line 
up.
If the tempo was changed too much, you might have to repeat the procedure. Note down 
the position of your Time Hit. Select a new Songstart and Time Display in the Sync dialog, 
and move the Time Hit accordingly. Then Straighten Up again.

10.When the beginning of the Song is adjusted to taste, you can begin inserting Time Hits.
We suggest you use MIDI to input them, and start out with one or two Hits per Bar. Of course, 
the tighter you place the Hits, the tighter your sync will become, but editing will also be 
more difficult and each Straighten Up will take more time to perform.

11.Use Fill to input Meter Hits at the same spacing as the Time Hits (set Snap to for exam-
ple whole notes or half notes). 
Make sure the first Time Hit and the first Meter Hit indicate the same position in the song; for 
example, the first Time Hit should be where the downbeat of bar 1 is on the tape and the first 
Meter Hit should be on position 1.1.0 in Cubase VST.

12.Select Link One By One from the Do pop-up menu.
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13.Select Straighten Up from the Do pop-up menu.
Straightening Up might take some time.

14.Play back the Song in sync with the tape.

15.If you don't like what you got, move the Time Hits around and try Straightening Up 
again.

Remember, Straighten Up only scales the tempo changes between two Hitpoints. If 
you need a gradual tempo change between two Hits, use the Line tool to create an 
accelerando or ritardando that can be scaled to fit.
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Tempo Mapping “freely recorded” Music using Time Locked 
Tracks

The Master Track editor interacts with Cubase VST’s Time Locked Tracks in a special 
and very useful way. If you change the tempo in the Master Track editor, notes on 
Time Locked Track will get moved, bar-wise, so as to make them still appear on the 
same time positions. You can use this to your advantage:

• To “reposition” Events in music recorded without a metronome, so that they fit the 
meter positions in Cubase VST.

• To match music to for example sound effects or other audio Events that occur on fixed 
time positions, rather than meter positions.

Observe this when working with Time Locked Tracks

Time Locked Tracks are described in general in their own chapter in this book. 
Please just observe the following points:

• The time it will take to recalculate Time Locked Tracks depends on the number of tempo 
changes in your Arrange window. When you work with the Master Track editor it is common 
to have very large amounts of Tempo Events. This will lead to noticeable recalculation times 
(sometimes very long) in two cases: when you adjust the Tempo curve and when you use 
Straighten Up.

• Try to avoid to edit a Part on a Time Locked Track in a MIDI editor, at the same time as you are 
changing the tempo in the Master Track editor. The reason is that if a tempo change hap-
pens to move an Event so that it winds up on a position before the beginning of its Part, this 
Event will be lost!

Working with Time based Events

If you already have Events on Time Locked Tracks which indicate important posi-
tions (Hits) in the music, you can use these as a basis for your tempo changes:

1. Time Lock the Tracks that have Events which happen on “fixed” Time Positions.

2. Open a MIDI editor and select the Events you want to use as Hitpoints in the Master 
Track editor. Note down the position of the first of the selected Events.

3. Open the Master Track editor and set the Song Position to the position of the first 
Event you copied.

4. Select Paste. The Events are now Pasted in as Time Hits and can be used as a basis for 
Tempo Matching or Straighten Up, as described in the previous section.
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Repositioning “freely recorded” Music

Many musicians find it constraining to record in time with a metronome. With the 
Master Track editor you can record in “free time” and later adapt the recording to 
Cubase VST’s meter positions:

1. Turn off the Metronome and perform a recording.
If you plan to preserve the feeling in the recording, make sure you get a take that contains all 
the tempi just as you want them.

2. For safety, make a copy of the Track and Mute it.

3. Open the recording for editing, for example in Key Edit. Select all Events and drag 
them so that the first Event winds up on position 1.1.0. 
This assumes the Part begins on 1.1.0. If it doesn’t you can either move the Part or use the 
Pencil in the Arrange window to adjust the beginning of it.

4. Select a number of Events on easily defined meter positions.
For example if the piece contains a relatively simple bass line (mainly happening on quarter 
notes and eighth notes), select the notes in this bass line. If it is a more complex piece you 
might have to work a bit on the selection, or maybe only do a bit at a time. Try to not select 
notes that are more tightly spaced than quarter notes. (It probably isn’t necessary and link-
ing them will take more time.)

5. If selecting notes in the actual recording doesn’t work for you, you might try recording 
a special Track with a drum sound, where you simply tap the beat while listening to the 
recording. Then you can use this Track for reference instead of the notes in the actual 
recording.

6. When you have the selection right, copy the Events (using Copy on the Edit menu). 
Close the editor.

7. Open the Master Track editor. Position the Song Position on 1.1.0. 
Pasting always happens at the Song Position!

8. Paste.
All the notes will now appear as Time Hits.

9. Use the Pencil to draw in Meter Hits on the musical positions that the Time Hits refer to. 

❐ Since the tempo is completely wrong at this point, the Meter ruler and the Time ruler 
will not match up at all. This might lead to some confusion at first. What you are sup-
posed to do is to tell the program what meter positions the Pasted Time Hits refer to. If 
the bass for example played on straight quarter notes only, draw in one Meter Hit on 
each quarter note.

10.When you are done and have one Meter Hit for each Time Hit, use Link One By One on 
the Do Pop-up menu to link all the Hitpoints together.

11.Select Straighten Up, and when the dialog box appears, verify that it is OK to insert 
new Tempo Events.

12.Play back the Track and examine it in Key or Score Edit to check that everything actu-
ally has wound up as you intended.
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When examining the recording in one of the editors, you will note that the Events 
have been moved to the correct musical (meter) positions. This allows you to use 
Cubase VST’s different tools (such as quantizing) in a predictable way and to format 
the recording for printout in Score Edit. But, since a number of tempo changes have 
been created, the piece still plays back as it originally did.

If you are happy with the piece as it is now, you should possibly turn off Time Lock 
for the Track before you proceed with further editing (maybe you should make a 
copy first?).

If you want to hear how the piece plays back at a fixed tempo, simply turn off the 
Master Track. And if you like, you can continue to use the Master Track editor to edit 
the tempo further.
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39
Matching Audio and Tempo
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Introduction

This chapter describes Cubase VST’s features for matching the tempo of the audio 
to the MIDI playback tempo and vice versa. These features are based on the Match 
Points described on page 367 in the Audio Editor chapter. 

Having a reasonably good knowledge of the Mastertrack Graphic Editor will sim-
plify working with Audio/Tempo matching. If you want to check up on details, see 
the Mastertrack and Hitpoints chapters.

Opening the Audio/Tempo Match Editor

This part is the same, whether you want to match the audio tempo to MIDI or vice 
versa:

1. Select the Audio Event in the Audio Editor.
At this point, you may have created Match Points already (see the Audio Editor chapter), or 
you may do it in the Match Audio/Tempo editor as described on the following pages.

2. Select the Event, pull down the Do pop-up menu and select Match Audio with Tempo...
The editor window opens.

This window is very much like the Mastertrack Graphic Editor, but with four extra 
features:

• A waveform display directly below the graphic tempo display.
• Match Points are shown in the Time Hitpoint area.
• An additional fader in the lower left corner.
• An additional Audio pop-up menu.
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Adding and Editing Match Points in the Editor

Match points, or M-Points, are “markers” within an Audio Event, used to indicate 
significant positions in your Audio file - often all “beats” in the recording. In this ed-
itor, the Match Points are shown as small arrows in the area below the waveform, 
where Time Hitpoints usually are shown. 

Creating Match Points

There is no actual “add M-Points” function in the Match Audio/Tempo editor. To 
create Match Points, you have the following options:

• Use the Get M-Points function.
• Duplicate other M-Points and move the duplicates to desired positions.
• Convert Time Hitpoints to M-Points.

The Get M-Points function

1. Select the Get M-Points command on the Audio pop-up menu.
A dialog box opens. The parameters are explained in the table below.

• If you don’t want to experiment with different settings, click the Default button.

2. When you have made the desired settings, click on Process.
The program scans the audio and inserts Match Points.

Sensitivity The higher value, the more “sensitive” the detection algorithm, and the more 
Match Points will be created.

Attack Try experimenting with this parameter when you are working with “non-
percussive” recordings.

Max. Number of 
Events per Sec.

The maximum allowed number of Match Points per second of audio.

Match Points
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Manual Adding and Editing of M-Points

As already mentioned, there is no actual “add M-Points” function in the Match 
Audio/Tempo editor, and you cannot draw in M-Points like you can in the Audio 
editor. Instead you can do the following:

Duplicating an existing Match Point

1. Click on a Match Point to select it.

2. Set Snap to a suitable value.
Since you will most likely want to be able to place the Match Point anywhere in the wave-
form, “Off” might be a good choice for Snap.

3. Hold down [Option] on the computer keyboard and press the mouse button.
A dotted outline is shown around the Match Point.

4. Drag the outline to where you want the new Match Point and release the mouse button.
A duplicate of the Match Point is created and placed where you indicated. You may move it 
later.

Adding a Time Hitpoint and converting it

1. Set Snap to a suitable value.
Since you will most likely want to be able to place the Match Point anywhere in the wave-
form, “Off” might be a good choice for Snap.

2. Select the Pencil tool and click in the Time Hitpoint area.
A new Time Hitpoint is created (see the Hitpoints chapter in this document).

3. Select the Hitpoint with the Arrow tool.

4. Pull down the Audio pop-up menu and select Hitpoint to M-Point.
The selected Time Hitpoint is converted to a Match Point, which you later can move to an-
other position if you like.

Moving Match Points

Match Points can be moved by clicking on them and dragging to the left or right. 
Remember that the Snap value affects to which positions you can move the Match 
Point (in most cases it will be best to turn Snap off when you move Match Points).

If you want to move a Match Point to a certain position in the audio, you can use 
the following method for better accuracy:

1. Press the mouse button with the pointer positioned on the Match Point.

2. Move the pointer to the position in the waveform where you want the Match Point to 
appear.
Since you can “aim” directly in the waveform display, it is easier to find the correct position 
than when you drag the Match Point in the strip below the waveform display.

3. Release the mouse button.
The Match Point is moved to the selected position. This function can also be used with Hit-
points.
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Deleting Match Points

There are two principal ways to delete Match Points:

• Click on the Match Point with the Eraser tool.

or

• Select the Match Point(s) and press [Backspace] on the computer keyboard.

Existing Match Points are automatically deleted when you create a new set with the 
Get M-Points function.

Cut, Copy and Paste

You can use these features on Match Points, as you can on other items in Cubase 
VST. When you Paste, Match Points are Pasted in beginning at the Song Position.
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Making the Playback Tempo follow the Audio

There are two ways to do this:

• Use Hitpoint Match mode to find the closest tempo match, and insert one tempo 
change at the beginning of the Event.
This may be sufficient if you’re working with rather short Events and audio with a fairly 
steady tempo. The method is described below, under the heading Fixed Tempo Match.

• Use Hitpoint Link mode and Straighten Up to make a tempo map.
This means that tempo changes are inserted at several places in your Event. This method 
works with long Events and audio with fluctuating tempo. It is described on the following 
pages under the heading Creating a Tempo Map.

Fixed Tempo Match

For this to work, the audio should have a fairly steady beat, and the Match Points 
should be evenly distributed, for example on the quarter notes. However, it is suffi-
cient if Match Points are inserted in the first two or three bars of the Event (i.e. they 
can be seen in the editor window at the same time).

1. Activate Master on the Transport Bar.

2. At the beginning of the Audio Event, insert a tempo change with a value roughly the 
same as the tempo of the recording.

3. Set Snap to the note value that separates the Match Points.
In our example, this would be 4 (quarter notes).

4. Pull down the Option pop-up menu and select Show Hitpoint Match.
This will display vertical lines rising from the Match Points.

If the position of the Match Points 
coincide with the Snap value, the 
lines will be fully drawn.
If the Match Points are “off” the Snap 
value, the lines will be dotted. 
See the chapter “Hitpoints”.
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5. Set the Tolerance pop-up to a fairly high percentage.
The higher the Tolerance percentage, the more “off” the Match Points are allowed to be and 
still be considered Matching.

Now, the object is to find a tempo where as many as possible of the M-Points are 
matching (shown with fully drawn vertical lines). This is done either by changing 
the tempo in the graphic tempo display (as described in the “Hitpoints” chapter), or 
by using the slider to the left to visually stretch the waveform in the window, and 
then letting the program automatically calculate the tempo. The steps below de-
scribe the latter alternative:

6. Select a Stretch percentage range from the pop-up below the slider.
This determines the maximum stretch range with the slider. If you for example select 4.2%, 
you may visually stretch the waveform ± 4.2%, with zero stretch in the slider’s middle position.

7. Move the slider and try to find the position where as many as possible of the vertical 
lines are fully drawn (matching).
To reset the slider to middle position (zero stretch), hold down [Command] and click any-
where on the slider.

❐ As you move the slider, you will note that the waveform image is stretched (slider above 
middle position) or contracted (slider below middle position). This is only a visual help 
for you, to make it easier to find a match, and does not affect the actual Audio Event!

8. When you have found the best possible match, pull down the Audio pop-up menu and 
select Slider to Tempo.
The program will calculate a tempo based on the slider setting. 
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• If there already is a Tempo Event at the beginning of the Audio Event, this Tempo Event sim-
ply gets the calculated Tempo value.

• If there is no Tempo Event at the beginning of the Audio Event, one is created, and gets the 
calculated Tempo value.

• If there are several Tempo Events within the duration of the Audio Event, (e.g. a ritardando), 
these are all affected relatively - the tempo is “scaled” according to the calculated value.

9. When you’re done, press [Return] to close the editor.

When you play back the Song, the tempo will match the tempo of the audio.

Creating a Tempo Map

For this to work, Match Points should be inserted throughout the whole Event, and 
preferably evenly distributed, for example on every quarter note. It is possible to cre-
ate a tempo map for an Audio Event with a lot of “syncopated” Match Points, but 
this will require you to insert and move Meter Hitpoints by hand (see step 6 below).

1. Activate Master on the Transport Bar.

2. At the beginning of the Audio Event, insert a tempo change with a value roughly the 
same as the tempo of the recording.
This will make it easier for you to see if the links are correct (see step 8 below).

3. Set Snap to the note value that separates the Match Points.
In our example, this would be 4 (quarter note).

4. Set the Left and Right Locators so that they encompass the Event.

5. Select Fill Meter Hitpoints from the Do pop-up menu.
Meter Hitpoints are inserted in the area above the tempo curve.

6. If your Audio Event contains Match points that are not positioned on quarter notes (or 
whatever Snap value you have chosen), you need to insert Meter Hitpoints on the cor-
responding places as well. Also, if for some quarter notes in your Audio Event, there 
are no Match Points (for example in long breaks, pauses, etc.), you have to delete the 
Meter Hitpoints on the corresponding positions.
This is because you will later perform a “link one by one”, where each Match Point is linked to 
exactly one Meter Hitpoint. If there is a Hitpoint or a Match Point “missing”, the wrong Match 
Points will be linked to the wrong Hitpoints.

❐ It is perfectly possible not to use the “Link Hitpoints One to One” function, and instead 
link the Hitpoints to the Matchpoints “by hand” as described in the Hitpoints chapter 
in this document. If you choose to do this, the number of Hitpoints does not have to be 
the same as the number of Match Points.

7. Pull down the Option pop-up menu and select Show Hitpoint Links.
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8. Pull down the Do pop-up menu and select Link One to One.
Now, the program attempts to link each of the Meter Hitpoints to a Match Point, starting 
from the first one. 

If everything is OK, you should get a number of roughly vertical lines (if you made a 
good estimation of the audio tempo in step 2 above). If the angle of the lines 
changes abruptly from one line to the next, this indicates that there are dramatic 
tempo changes in the audio. If you know that there are no such tempo changes in 
the audio, the links are not correct and you need to insert or delete Meter Hitpoints. 
Repeat steps 6 to 8 until the links seem OK.

9. Pull down the Do pop-up menu and select Straighten Up.
The program creates a tempo map, i.e. inserts tempo changes into the Master Track, to make 
the playback tempo continuously change to fit the audio tempo.
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Making the Audio Follow the Tempo

This means changing the length of the audio file, to make it fit the playback tempo. 
One reason to do this (instead of matching the tempo to the audio) might be that 
your Song contains other audio files that already match the tempo, or that you sim-
ply are perfectly satisfied with the playback tempo you have.

There are two ways to match the audio to the tempo:

• Use Hitpoint Match mode to find the closest time stretch match, and tell the program 
to time stretch the whole Event by one fixed stretch factor.
This may be sufficient if you are working with rather short Events and audio with a fairly 
steady tempo. The method is described below, under the heading Fixed Time Stretch.

• Use Hitpoint Link mode and tell the program to quantize the audio Event.
This means that the Match Points in the audio are quantized (moved to coincide with the 
Meter Hitpoints) and the audio material between the Match Points are stretched/contracted 
accordingly. This method works with long Events and audio with fluctuating tempo. It is de-
scribed on the following pages under the heading Quantizing Audio.
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Fixed Time Stretch

For this to work, the audio should have a fairly steady beat, and the Match Points 
should be evenly distributed, for example on the quarter notes. However, it is suffi-
cient if Match Points are inserted in the first two or three bars of the Event (i.e. they 
can be seen in the editor window at the same time).

1. Activate Master on the Transport Bar.

2. Set Snap to the note value that separates the Match Points.
In our example, this would be 4 (quarter note).

3. Pull down the Options pop-up menu and select Show Hitpoints Match.
This will display vertical lines rising from the Match Points. If the position of the Match Points 
coincide with the Snap value, the lines will be fully drawn; if the Match Points are “off” the 
Snap value, the lines will be dotted (see the chapter “Hitpoints”).

4. Set the Tolerance pop-up to a fairly high percentage.
The higher the Tolerance percentage, the more “off” the Match Points are allowed to be and 
still be considered Matching.

Now, the object is to find a stretch factor for the audio where as many as possible of 
the M-Points are matching (shown with fully drawn vertical lines). This is done by 
visually stretching the waveform in the window, using the slider to the left.

5. Select a Stretch percentage range from the pop-up below the slider.
This determines the maximum stretch range with the slider. If you for example select 4.2%, 
you may visually stretch the waveform ± 4.2%, with zero stretch in the slider’s middle posi-
tion.

6. Move the slider and try to find the position where as many as possible of the vertical 
lines are fully drawn (matching).
To reset the slider to middle position (zero stretch), hold down [Command] and click any-
where on the slider.

❐ As you move the slider, you will note that the waveform image is stretched (slider 
above middle position) or contracted (slider below middle position). This is only a vi-
sual help for you, to make it easier to find a match, and does not affect the actual Audio 
Event at this stage.

7. When you have found the best possible match, pull down the Audio pop-up menu and 
select Slider to Time Stretch.
This instructs the program to process the Audio Event using the Stretch factor set with the 
slider.

8. When this is done, your Audio Event will play a new segment, time stretched to fit the 
playback tempo. 
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Quantizing Audio

❐ This text describes advanced audio quantizing of any type, Groove, Iterative etc. If all 
you want is quantizing to a certain note value, see page 372.

For this to work, Match Points should be inserted through the whole Event, and pref-
erably evenly distributed, for example on every quarter note. It is possible to create a 
tempo map for an Audio Event with a lot of “syncopated” Match Points, but this will 
require you to insert and move Meter Hitpoints by hand (see step 5 below).

❐ Do not put Match Points too close! This might give rise to large stretch factors when 
quantizing, which in turn may produce a result that is not musically desirable.

1. Activate Master on the Transport Bar.

2. Set Snap to the note value that separates the Match Points.
In our example, this would be 4 (quarter note).

3. Set the Left and Right Locators so that they encompass the Event.

4. Select Fill Meter Hitpoints from the Do pop-up menu.
Meter Hitpoints are inserted above the tempo curve, spaced according to the Snap setting.

5. If your Audio Event contains Match points that are not positioned on quarter notes, 
you need to insert Meter Hitpoints on the corresponding places as well.
Also, if for some quarter notes in your Audio Event, there are no Match Points (for ex-
ample in long breaks, pauses, etc.), you have to delete the Meter Hitpoints on the cor-
responding positions.
This is because you will later perform a “link one by one”, where each Match Point is linked to 
exactly one Meter Hitpoint. If there is a Hitpoint or a Match Point “missing”, the wrong Match 
Points will be linked to the wrong Hitpoints.

❐ It is perfectly possible not to use the “Link One by One” function, and instead link the 
Hitpoints to the Matchpoints “by hand” as described in the Hitpoints chapter. If you 
choose to do this, the number of Hitpoints does not have to be the same as the number 
of Match Points.

6. Pull down the Option pop-up menu and select Show Hitpoint Links.

7. Pull down the Do pop-up menu and select Link One by One.
Now, the program attempts to link each of the Meter Hitpoints to a Match Point, starting from 
the first one. If everything is OK, you should get a number of roughly vertical lines (if you made 
a good estimation of the audio tempo in step 2 above). If the angle of the lines changes 
abruptly from one line to the next, this indicates that there are dramatic tempo changes in the 
audio. If there are no such changes in the audio, the links are not correct and you need to in-
sert or delete Meter Hitpoints. Repeat steps 5 to 7 until the links seem OK.

8. Pull down the Audio pop-up menu and select Quantize Audio.
This instructs the program to move each M-Point in the Audio Event to the position of the 
corresponding Meter Hitpoint, and timestretch the material in between.

9. When this is done, your Audio Event will play a new segment, processed to fit the play-
back tempo. 
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If your Audio Event is partly right in Timing

If some parts of the Audio are in timing but some are not, a special situation arises. 
For example, let’s look at a drum loop where one beat is “off” but the rest is correct. 
When you now use Quantize Audio to put the faulty section right again, you must 
be careful to not also accidentally move parts of the correctly timed audio:

The essence of this is:

❐ Always put one Match Point before and one after the sections you want to quantize, at 
the nearest beats (or other musical “events”) that are in timing, and “straight-line” link 
both these Match Points to meter hitpoints!

Here, the beat in the middle is played too early (note that the link line is dotted). If you Quantize 
Audio with these three links, the faulty beat will be moved to a correct position.

But, Cubase VST will also stretch the audio to the left of the faulty beat (to fill up the gap when the 
beat is moved to the right). In our example, this will mean that this correctly timed beat is moved to 
the right, and will be out of timing!

In this example, the correct beat closest to the left of the faulty one is linked instead.

When you Quantize Audio, this section will be stretched. But since there are no actual beats 
within the section, this will not affect the rhythmic “feel” of the audio.
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It may seem that an easy way to avoid the problem above would be to simply draw 
two Match Points immediately before and after the faulty beat, and very close to it, 
so that no important, correctly timed audio was affected. This is not a good idea! 
Putting Match Points too close might give rise to very large stretch factors when 
quantizing, which in turn may produce a result that is not audibly desirable.

Creating a Groove template

With this feature, an audio file is used as a source for a new groove template. The 
template is added to the Groove list on the Quantizing Type submenu, and can be 
used with any MIDI material.

1. Pull down the Do pop-up menu and select Get M-Points.
The Get Match Points dialog appears (see page 574).

2. Experiment with the settings in the Get Match Points dialog until you get a sufficient 
amount of Match Points in your Audio Event.
If possible, try to get Match Points on the sixteenth notes.

❐ The Get M-Points function removes all existing Match Points in the Event, before it cre-
ates new ones.

3. If you want to adjust the velocity values of the individual Match Points, you have to 
exit to the Audio editor.
You change velocity values by holding down [Shift] and dragging the black squares on the 
Match Points up or down. When you drag, the current velocity value is displayed numerically 
beside the Match Point.

4. In the Match Audio/Tempo editor, pull down the Audio pop-up menu and select M-
Points to Groove.
Cubase VST creates a Groove Template with the name of the audio file, and Stores this as a 
file in your Groove folder, which means it is also directly available from the Functions menu. 
For information on how to use the Groove, see the chapter “More about Quantizing and 
Grooves”.
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Using Snip at M-points 

This function (found on the Do pop-up menu in the Audio editor) allows you to take 
a rhythmic piece of audio (for example a drum loop) and make it play back faster, 
without raising the pitch or performing any actual time correction. The trick is to split 
the Audio Event at each single “beat”. The new Events that are created by the opera-
tion, will each start playback at a specific meter position in the Song, so if you raise 
the playback tempo, the tempo of the audio will seem to follow! Proceed like this:

1. Select the Event in the Audio editor.

2. Create Match Points and see to it that they are positioned on each single rhythmic 
“building block” (e.g. drum beats) in the Audio Event.
You may use the Get M-Points function, and/or add M-Points manually.

3. Pull down the Do pop-up menu and select Snip at M-Points.
The Event is split at each Match Point.

4. Select all the Events, pull down the Do pop-up menu and select Group.
We recommend you to do this, since if you don’t, you will find it hard to move or copy the en-
tire piece of audio without losing the timing.

5. Try activating playback and raising the tempo.
Even though this will make each Event start playing before the previous has ended, it will not 
cause the two sounds to mix. This is simply because only one Event at a time can play on the 
same audio channel!

Raising the tempo. Note how the Events are moved together to overlap each other.
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Why not lower the Tempo as well?

Of course you can lower the tempo with this function. The individual Events will 
start at the correct positions, giving the impression of a lower tempo in the audio. 
But since the length of the Events doesn’t change when you lower the Tempo, 
there will be “empty space” between the Events, which in most cases will sound 
strange (see the figure below). Therefore, we cannot recommend lowering the 
tempo other than as a special effect.

The effect of dramatically lowering the tempo.
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Time Locked Tracks
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What are Time Locked Tracks?

Events on Time Locked Tracks are fixed in time. This means that even if you change 
the tempo, the Events will stay at the same position, time-wise. For example, an 
Event that played back ten seconds in from the beginning of the Song will still play 
back ten seconds in from the beginning, even if the tempo is doubled.

Time locked Tracks can be used for example when you work with audio locked to 
film or video and mix sound effects with music in one Arrange window. Time 
Locked Tracks can also be used to create music with multiple tempi.

Time Locking a Track

1. As a first step, we recommend you to duplicate the entire Track.
This allows you to go back to the original meter based positions later.

2. Click in the “T” column of the Track.
A lock symbol appears, indicating that the Track is Time Locked.

3. Click on the Master Button on the Transport Bar, to make the settings in the Master 
Track govern the tempo.

❐ The Master Track must be activated for the Time Locking to have any effect on your re-
cordings. For information about the Master Track, see the chapter “The Master Track”.

Changing the Tempo

• If you change the tempo by editing the Master Track, the positions of Events on time locked 
Tracks are recalculated, so that they stay on the same time position. When you examine 
these Tracks in for example Key Edit, the Events will appear to have moved, meter-wise.

• When you change the tempo, the Parts are also lengthened and shortened bar-wise, as 
needed to accommodate the Events. The Events' positions are also recalculated when you 
move the Part.

• If you have a lot of Tempo changes and a lot of Events in the Time locked Tracks, moving 
parts, inserting new tempi or changing existing ones may lead to noticeable recalculation 
times.
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Turning Time Lock On and Off

A Track can at any time be switched in and out of Time lock mode. But when you 
switch a Track out of time locked mode the Events will of course stay at their cur-
rent time position. This means that if you have made any tempo changes since you 
Time Locked the Tracks, the Events on those Tracks will not be at “sensible” meter 
positions when you turn off Time Lock.

Editing Time Locked Tracks

When editing Time Locked Tracks, please observe the following:

• When moving Parts on Time Locked Tracks, set the Snap value to Off.
This is since Time Locked Tracks are not related to Meter Position the way usual Tracks and 
the Snap value are.

• Remember that you can click the Mouse box to make the Mouse position and the Bar 
Display switch to show time code values instead of bars and beats. 
The same applies in the MIDI editors. 

• The Song Position can be always used as a converter between bar and time positions at 
the current tempo. 
If you for example know the time and need the bar position, input the bar beat and tick in the 
Song Position box and read back the time value in the Time Position box (and vice versa).

Creating Multiple Tempi

When scoring for film and video it is not unusual to need a piece fading over into 
the next which is played in another tempo. Here are the necessary steps, in brief.

1. Finish the first piece, the one that the Song begins with.

2. Time lock the existing Tracks.

3. Insert a tempo change where the new piece begins, even if this is before the end of the 
last.
The previous piece will then not be affected by the new tempo.

4. Create new Tracks for the second piece and record it.

Things To Note

• When you time lock a Track with Ghost Parts, they are automatically converted into 
real Parts.

• Group Tracks and Tape Tracks can not be Time Locked.
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Synchronization
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Introduction

Synchronizing is when you make two pieces of equipment agree on time or tempo. 
You can establish synchronization between Cubase VST and a number of other types 
of devices, including tape recorders and video decks, but also other MIDI devices that 
“play back”, such as other sequencers, drum machines, “workstation sequencers” etc.

The two types of Sync Signals

Basically there are two types of synchronization signals:

Sync To Time Code (SMPTE, EBU, MTC, VITC)

Time Code appears in a number of guises. No matter which “format” it has, it always 
supplies a “clock on the wall” type of synchronization, that is a synchronization re-
lated to hours, minutes, seconds and two smaller units called “frames” and “sub-
frames”.

Sync To MIDI Clock

MIDI Clock is a tempo based type of synchronization signal, that is, it is related to 
the number of “beats per minute”.

Cubase VST has full support for both Time Code and MIDI Clock.

Cubase VST – Master Or Slave?

When you set up a synchronization system you must decide which unit is the mas-
ter. All other devices are then slaved to this unit, which means they will adjust their 
playback speed to the master’s.

Cubase VST as a Slave

When a synchronization signal is coming in to Cubase VST, from another device 
(such as a tape recorder, a disk based recording system, a drum machine, another 
sequencer etc.), this device is the master and Cubase VST is the slave. Cubase VST 
will adjust its playback to the other device.

Cubase VST as a Master

When you set up Cubase VST to transmit synchronization signals to other devices, 
Cubase VST is the master and the other devices are the slaves; they will adjust their 
playback to Cubase VST.

Cubase VST – Both Master and Slave

Cubase VST is a very capable synchronizing device. It can operate as both a master 
and a slave at the same time. For example, Cubase VST might be slaved to a tape re-
corder transmitting time code, while at the same time transmitting MIDI Clock to a 
drum machine, acting as a master for that.
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Synchronization and audio playback - Introduction

Synchronizing digital audio material with the “real world” raises many issues which 
are not immediately apparent when using MIDI only systems. This is a big subject, 
and we will only be able to touch upon it here.

Avoid MIDI Clock!

With Cubase VST, you should sync the program to time code (SMPTE or MIDI Time 
Code), not MIDI Clock. MIDI Clock is a tempo dependent synchronization with low 
resolution, not really suitable for professional audio applications.

If your Audio Hardware supports the ASIO Positioning 
Protocol

Background Information

About the ASIO Positioning Protocol

The ASIO Positioning Protocol is a technology that ensures that audio in Cubase 
VST is in sample accurate sync with external devices. It is part of the ASIO 2.0 fea-
ture specification. Implementation of the ASIO 2.0 protocol can be found in various 
audio software and hardware. However, this text mainly describes its implementa-
tion in Cubase VST.

In order to take advantage of the ASIO Positioning Protocol, your audio hardware 
must be suitably equipped and the functionality must be included in the ASIO driver 
for the hardware.

❐ If in doubt, consult the documentation for the hardware and its ASIO driver.

About Sample Accurate Positioning

When transferring audio digitally between devices, it is important that synchroni-
zation is established on two levels:

• Level 1 : Sample Rate (word clock sync)
If this type of sync isn’t established, you may run into problems with for example clicks and 
pops or distortion.

• Level 2 : Sample Position (time code sync)
If the two devices do not agree on time positions, inaccuracies in positioning of the material 
will occur.

When performing audio transfers between devices, you need both types of sync 
(word clock and time code). Furthermore, the two need to be completely correlated. 
If not, the audio will not be recorded at the exact intended (sample accurate) posi-
tion, which can cause various types of problems.

A typical situation is when transferring material from a digital multi-track tape re-
corder to Cubase VST (for editing) and then back again. If you do not have sample 
accurate synchronization set up, you can not be sure that the material will appear 
in its exact original position, when transferred back to the tape recorder.
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About Continuous Resynchronization (Resolving)

An expansion of the situation above is when an entire digital audio system is locked 
to an external clock (as in video post-production, for example). If that external clock 
fluctuates in speed (for example, if it is generated by an analog video deck), the en-
tire system must follow those fluctuations to a sample accurate level.

While this can be achieved with a combination of various hardware (audio inter-
faces and synchronizers), the ASIO Positioning Protocol makes it possible to use 
one hardware system for everything, which facilitates set-up and provides a higher 
degree of accuracy.

About time code in this context

Normally, the term time code refers to SMPTE/EBU (audio format time code), MTC 
(MIDI format time code) and VITC (Video format time code). However, for sample ac-
curate synchronization with ASIO 2.0, the concept must be interpreted slightly dif-
ferently. Time code for ASIO 2.0 may be supplied in one of the following formats:

• ADAT sync (Alesis).
• LTC (often referred to as SMPTE).
• VITC.

Future high precision time code formats may also be supported. However, MTC 
(MIDI Time Code) is not recommended for sample accurate synchronization, since 
the resolution is too coarse.

Example Setup 1 - Sample Absolute Positioning

This section provides an example of a system for doing sample accurate transfers, in 
this case transferring audio tracks from an Alesis ADAT to Cubase VST. Here the ADAT 
will be the sync master (though it doesn’t necessarily have to be). It provides both the 
digital audio (with an inherent word clock) and positional information (time code) via 
its ADAT sync protocol. The master clock is generated by the ADAT itself.

Hardware and Software Requirements

• Your computer audio hardware (in our example this would be an ADAT card in your com-
puter) must support all the functionality required for the ASIO Positioning Protocol. That is, it 
must be able to read the digital audio and the corresponding positional information from 
the external device.

• There must be an ASIO 2.0 driver for the audio hardware.

When you have set up sync to time code via ASIO Positioning Protocol as described 
on page 602, the external device will act as a master for your system. Audio that 
you transfer between the two devices will be sample accurately synchronized.
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Example Setup 2 - Continuous Resynchronization (Resolving)

In this case, the idea is that the external device is in its turn synchronized to yet an-
other device. An example would be a Lexicon Studio system synchronized via LTC to 
a video tape recorder. In this case, the incoming time code will vary with the speed 
of the video tape recorder. The Lexicon Studio will make sure the audio word clock is 
adapted to fluctuations in the LTC sync signal and will supply all this information to 
Cubase VST via its ASIO 2.0 driver. 

Now, any fluctuation in speed of the incoming LTC will be accurately transferred to 
both the time code and word clock sync in Cubase VST. In other words, all devices 
are in complete, sample accurate sync with the master, a phenomenon referred to 
as continuous resynchronization or resolving.

Additional Hardware and Software Requirements

This setup has the same requirements as the example above, plus the following:

• The audio hardware (in our example the Lexicon Studio system) must have a time code 
reader/writer on-board.

• The time code coming from the device must be completely hardware locked to the audio 
clock in the device.

❐ The ASIO Positioning Protocol exploits the inherent advantage of having an audio card 
that has a built in Timecode reader. With such a card and the ASIO Positioning Proto-
col, you can achieve sample accurate synchronization between the audio source and 
Cubase VST.
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If your Audio Hardware doesn’t support the ASIO Positioning 
Protocol

If you can – Use Cubase VST as a Master

To avoid drift between audio and MIDI we recommend you to not synchronize 
Cubase VST externally at all when using audio, if possible. However, you might very 
well use Cubase VST as a “master” for other systems. Using MIDI Time Code or MIDI 
Clock generated by Cubase VST (for transmission to other devices) will ensure sync 
with the audio.

Audio and External Synchronization

How Timing is handled in a non-synced system

Let’s first look at the situation where Cubase VST is not synchronized to any exter-
nal source.

Any digital playback system has an internal clock that ultimately affects the play-
back speed and stability, and Macintosh audio hardware is no exception. This clock 
is extremely stable.

Normally, you will have the MIDI Sync Reference setting in the Audio System Setup 
dialog set to “Audio Clock”. This means that when Cubase VST plays back, the MIDI 
part of the program is internally synchronized to the digital audio to ensure synchro-
nization between digital audio and MIDI.

Synchronizing Cubase VST’s playback

Let’s assume now that we use external synchronization, with Cubase VST, for exam-
ple, we might synchronize playback to a tape recorder, using time code.

Time code coming from an analog tape recorder will always vary slightly in speed. 
Different time code generators and different tape recorders will also supply time 
code with slight differences in speed. In addition, the shuttling of tape mechanisms 
due to overdubs and re-recordings can cause the physical tape to wear and stretch, 
which affects the speed of the time code.

If you now set the MIDI Sync Reference setting in the Audio System dialog to Time 
Code, and Cubase VST receives time code, it will vary its overall playback speed (the 
“song position speed”) to compensate for such fluctuations in the speed of the 
time code, that’s the whole purpose of synchronization.
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What happens with the Digital Audio?

The fact that Cubase VST’s playback is synchronized to the time code does not affect 
the playback of the digital audio. It still relies on the perfectly stable, built-in clock in 
the audio hardware.

As you may understand by now, problems will appear when the perfectly stable 
digital audio gets related to the slightly varying speed of a system synchronized to 
time code.

The playback timing of each segment will not be in total accordance with the tape 
or the MIDI playback, since the playback speed of the audio is determined by the 
digital audio hardware’s built-in clock.

So, what can I do about it?

There are generally two methods that solve the problem, and a few others that 
minimize the problem to an acceptable level without actually solving it.

Resolving

The first – and best – solution is to use one external clock for all components in the 
system. One master clock is used to derive whatever type of clock signal each com-
ponent in the system needs. For example, something called a house clock can be 
used to generate sample rate clocks for the digital audio hardware and time code 
for Cubase VST. This ensures all components in the system use the same reference 
source for their timing.

Synchronizing digital audio to external clocks running at sample rate is often called 
“resolving” or “synchronizing to word clock”. 

However, this option is not available with the internal Macintosh audio hardware. It 
might be possible to do on more advanced audio hardware, but even then it re-
quires additional, fairly expensive synchronizing hardware.

Continuous Resynchronization

Some systems use digital signal processing techniques to simulate variations in 
playback speed. In a typical such situation you feed the digital audio hardware time 
code (or MIDI Time Code) and it uses this to calculate in what way it should adjust 
the playback speed to stay in sync with the time code (and hence with Cubase VST). 
This method is often called “continuous resync”.

Cubase VST Solutions

The third solution is offered by Cubase VST, and comprises a set of tools and strate-
gies to minimize the problems without the need of additional hardware, and with-
out compromising audio quality. These solutions are described in the following 
paragraphs:
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Choose your Audio Timing Reference

In the System dialog there are two settings that are related to sync (see page 518):

• The MIDI Sync Reference allows you to decide whether Cubase VST’s playback (and hence 
the MIDI) should slave to the external time code or to the audio hardware.

• The Audio Clock Source setting is for those with advanced audio hardware that supports re-
solving via external word clock signals. It allows you to clock the audio card from an external 
source.

Always use the Same Sync Source!

Throughout a project, use the same synchronization source for all audio recording 
and editing. If you plan to sync Cubase VST to for example a tape recorder, make 
sure you are synchronized to that tape recorder at all times!

Use Generate SMPTE

The Generate SMPTE command on the Options menu allows Cubase VST to create 
a synthesized audio file containing ”perfect” SMPTE time code.

Once you have created the audio files that simulates a time code recording, you 
can stripe the tape you intend to synchronize your work to, with this code. The idea 
is that since this time code is generated at exactly the same speed as your digital 
audio hardware uses, it will make the MIDI playback play back in “perfect” sync with 
the digital audio.

We highly recommend using this feature to generate the time code before com-
mencing any synchronized work with Cubase VST.

The code is generated ”off-line” and is created very quickly. When finished, you can 
simply throw the file away or perhaps store it on a stable medium – such as DAT tape 
– for later use.
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The Synchronization Dialog Box

This dialog box is used for setting up everything that has to do with Cubase VST’s 
synchronization to other units. You reach it from the Options menu, or by double 
clicking the Sync button on the Transport Bar.

Once you have the settings in the dialog box right, you activate sync as such by 
clicking on the Sync button on the Transport bar or by pressing [X] on the com-
puter keyboard. When the Sync button is activated, Cubase VST will automatically 
start when it receives a proper synchronization signal. 

If you use OMS, see the separate OMS documentation for information on how to 
synchronize.
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Internal Sync - No External Synchronization used

When no external synchronization source is used at all, it actually doesn’t matter 
what settings you have made in the Synchronization dialog box, as long as the 
Sync button on the Transport Bar is deactivated.

Sync deactivated on the Transport Bar.

However, there are situations where you might want to make sure that Cubase VST 
is definitely not synchronized to any source, even if you (accidentally) activate Sync 
on the Transport Bar. Proceed as follows:

1. In the Synchronization dialog box (reached from the Options menu), set Timecode 
Base to Intern.

2. Set Tempo Base to Intern.

3. Close the Synchronization dialog.

Sync to time code deactivated

Sync to MIDI Clock deactivated
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Synchronizing Cubase VST to MIDI Time Code (MTC) or Time 
Code via ASIO Positioning Protocol

You might have a device which transmits time code in a MIDI cable – MIDI Time 
Code (MTC). There are several types of devices that do just this:

• MIDI interfaces with built-in synchronization capabilities.
• Time Code (SMPTE) to MIDI Time Code converters.
• VITC (Vertical Interval Time Code, used in video editing systems) to MTC converters.
• MIDI devices (like other sequencers or disk based recording systems) which generate MIDI 

Time Code.

In this type of setup, synchronization happens as follows:

• Cubase VST is synchronized to the time code. In other words, the device transmitting the 
time code (for example the video deck or hard disk recording system) is the master and Cu-
base VST is the slave).

• The time code synchronization signals do not control Cubase VST’s tempo directly. Instead, 
the time code replaces Cubase VST’s internal “clock on the wall” type of clock, as displayed in 
the Time Position box on the Transport Bar. Cubase VST still follows the tempo set either on 
the Transport Bar or in the Master Track. However, if the time code coming in slows down or 
speeds up, this will affect Cubase VST’s internal clock and thereby the tempo (since the “min-
utes” in the “beats per minute” setting now varies).
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Setting Up for Synchronization

1. In the Synchronization dialog, set Timecode Base to “MIDI Timecode” or “ASIO 2.0” (if 
your hardware is ASIO Positioning Protocol compatible).

2. If you are not using ASIO Positioning Protocol, pull down the From Input pop-up menu 
and select the input to which the time code is coming in.
Cubase VST is now expecting a time code synchronization signal from the specified port.

3. Set Tempo base to Intern.
This tells Cubase VST to not expect MIDI Clock signals.

4. Use the pop-up in the dialog box to tell Cubase VST what Frame Rate to expect from 
the incoming code (see page 604 in this chapter).

5. Use the Song Start value to set which frame on the external device that should corre-
spond to the beginning of the Song (position 1.1.1.0 in Cubase VST).

6. Close the Synchronization dialog.
This is actually not necessary, but probably preferable.

7. On the Transport Bar, activate Sync by clicking on the button with the same name, or 
by pressing [X].
Cubase VST is now expecting MIDI Time Code to come in via the specified port.

Sync activated on the Transport Bar.

8. If you want the tempo to follow the Master Track, activate Master on the Transport Bar.

Sync to time code activated

Sync to MIDI Clock 
deactivated

The MIDI Input for the time code

The frame rate

Set this to the time code position 
where you want the Song to start 
from the beginning.
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9. Start the tape (or video, or...) that contains the time code. Cubase VST starts playing 
when it receives MIDI Time Code with a position “higher” than, or equal to, the Song 
Start frame.

You can wind the device that sends the MTC to any position and start from there. 

❐ When the device with the time code is stopped, you can use the Cubase VST transport 
controls as you normally do, when it is not synchronized. 

If you synchronize Cubase VST to Time Code you should also look into the Time Dis-
play Offset described on page 609 and Sync Options described on page 612.

Synchronizing Cubase VST to MIDI Machine Control (MMC)

This is described in the document “Controlling Tape Recorders”.
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About Frame Rates

The Frame Rate is the number of frames per second in a film or on a video tape. Just 
as there is always sixty seconds to a minute, there is always a certain number of 
frames to each second. However, the frame rate used varies with the type of media 
(film or video), which country the video tape has been produced in, and other cir-
cumstances.

When synchronizing Cubase VST to time code, you must make sure that the Frame 
Rate setting in Cubase VST matches the actual frame rate of the time code.

In Cubase VST there are six frame rates to choose from:

24 fps The traditional frame rate of 35mm film.

25 fps The frame rate used for all video and audio in Europe (EBU).

30 fps Straight 30 frames per second. This is often used in the United States for audio only 
work.

30 dfps Very rarely used.

29.97 fps Straight 29.97 frames per second.

29.97 dfps “Drop frame” code running at 29.97 frames per second, most often used in the 
United States for work with color video.
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Synchronizing Cubase VST to another MIDI Device via MIDI 
Clock

❐ This method should only be used for MIDI-only material.

If you want Cubase VST to follow the tempo of another MIDI device (such as another 
sequencer, a drum machine or similar), you need to use MIDI Clock signals. In this 
situation, synchronization happens as follows:

• Cubase VST’s tempo is synchronized to the other device’s. In other words, the other device is 
the master and Cubase VST is the slave.

• Cubase VST’s Master Track and the tempo setting on the Transport Bar have no effect on 
playback. Instead, Cubase VST plays in the same tempo as the other device.

Proceed as follows:

1. In the Synchronization dialog box (reached from the Options menu), set Timecode 
Base to Intern.
This tells the program that you are not synchronizing to time code.

2. Set Tempo Base to MIDI Clock.
This prepares the program for synchronizing to MIDI Clock.

3. From the menu just below Tempo Base, select the MIDI input to which you have con-
nected the device transmitting the MIDI clock signal.

4. Close the Synchronization dialog.
This is actually not necessary, but probably preferable.

5. On the Transport Bar, activate Sync by clicking on the button with the same name, or 
by pressing [X].

Sync activated on the Transport Bar.

6. Set up the other device to transmit MIDI clocks, and Start it. 
Cubase VST will automatically start and play in the same tempo as the other device.

Sync to time code deactivated

Sync to MIDI Clock activated

The MIDI Input for the MIDI Clock
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This type of synchronization is tempo based, that is the external device controls Cu-
base VST’s tempo. This means that the Master Track and the tempo setting on the 
Transport Bar have no effect on playback.

❐ You do not need to activate play in Cubase VST, it will automatically begin playback 
when it senses the incoming MIDI Clock. However, when the other device is stopped, 
you can use the Cubase VST transport controls as you normally do, when it is not syn-
chronized to any device. 

If the other device sends messages called Song Position Pointers, Cubase VST will 
follow when you wind and rewind, and will always start from the same position as 
the other device. If it doesn’t send Song Position Pointers, you must manually locate 
Cubase VST and the other device to exactly the same position (for example the be-
ginning of the Song!) before you Start.
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Synchronizing other Equipment to Cubase VST

You may have other MIDI devices which you may want to synchronize Cubase VST 
to. There are two types of synchronization that Cubase VST can transmit: MIDI Clock 
and MIDI Time Code.

Transmitting MIDI Clock

• If you transmit MIDI Clock to a device supporting this type of synchronization signal, the 
other device will follow Cubase VST’s tempo. That is, Cubase VST is the master and the other 
device is the slave.

• The tempo setting in the other device is of no relevance. Instead it plays at the same tempo 
as Cubase VST.

• If the device also reacts to Song Position Pointers (which Cubase VST transmits) it will follow 
when you wind, rewind and locate using the Cubase VST Transport Bar.

Transmitting MIDI Time Code

• If you transmit MIDI Time Code to a device supporting this type of synchronization signal, 
the device will synchronize time-wise to Cubase VST (the time displays on Cubase VST’s 
Transport Bar and on the other device will agree). 

• In this situation, Cubase VST is the master and the other device is the slave.
• If you wind and locate Cubase VST and then activate playback, the other device will follow 

from the same position (if it has this capability and is set up for it!).

Setting Up

1. Connect a MIDI Out from Cubase VST to the device that you plan to synchronize.

2. Open the Synchronization dialog box.

3. Use the Sync Out menus to decide what type of synchronization to send and to which 
MIDI Output(s). 
You can actually output both types, but it is unlikely that you want to. Instead set one of the 
menus to Off, and the other to the Output to which you connected the external device.

4. Set the other device in “external synchronization” mode (or some other mode with a 
similar name) and activate Play on it if necessary.

5. Activate Play in Cubase VST, and the other device will follow.

If you activate one or more 
Outputs on a menu...

...it will show ”On”.
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Transmitting Synchronization Signals while Cubase VST is 
synchronized to an External Source

• Cubase VST can be synchronized to an external source at the same time as it transmits syn-
chronization signals to another device.This means that Cubase VST is acting as a slave to one 
device at the same time as being the master for another. A common application for this 
would be to for example synchronize Cubase VST to tape while transmitting MIDI clock to for 
example a drum machine.

• You could possibly also synchronize Cubase VST to time code and at the same time transmit 
the same code in MIDI Time Code format to another device unable to read time code directly 
off tape.

There’s one very important fact to note:

❐ If several devices in your MIDI system should run at the same tempo, they should all be 
synchronized using MIDI clock. Only one of them should be synchronized to time code 
(if necessary), and this will be the master in the system. All other devices should be syn-
chronized via MIDI clock to this master.
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Song Start

This is the position on the time code tape that will make Cubase VST start the song 
from the beginning. If you for example set this to 0:5:0:0:0 (five minutes) Cubase 
VST will start from the beginning of the Song when it receives a time code message 
with this value. 

In other words, if Cubase VST receives a time code message of “seven minutes” with 
the Song Start value suggested above, it will jump to a position two minutes in 
from the beginning of the Song.

This way sequenced material can be matched to film or video, and you can adjust 
the relative starting points between e.g. material recorded on an audio tape and Cu-
base VST.

The Song Start value is in the following format: 

hours:minutes:seconds:frames:subframes (80 bits).

Time Display Offset

The Time Position display on the Transport bar usually starts at “zero”, even if the in-
coming time code is something else. But if you want Song Position 1.1.1.0 to corre-
spond to some certain Time position on the Transport bar, set this value with Time 
Display.

If you for instance want the Transport bar to show the actual incoming time code 
values during external synchronization, the “Song Start” and “Time Display” should 
be set to the same value. 

The Song Start time 
code position.

This value will be used for the time 
position of the beginning of the song.
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Bar Display

By the same token as with Time Display Offset you can here set the number of the 
first Bar in the Song. This allows you to record before position 1.1.1.0, which is other-
wise impossible.

MROS Resolution

This allows you to set the MIDI playback resolution of the program. 

Cubase VST normally gives MIDI playback first priority. This means that whatever the 
workload of the computer, MIDI data is sent out when – and as – it should. However, 
when a lot of MIDI data is handled and an unusual amount of real-time processing is 
going on, the program might not feel as smooth to use as it normally does.

If you for example feel the graphics aren't updated as quickly as you like, you could 
try lowering the resolution to 384 (or less) ticks per quarter note.

On the other hand, if you need extremely high playback resolution, you should use 
the highest possible playback setting, 1920 ticks per quarter note (often called 
pulses per quarter note and hence abbreviated PPQN).

No matter what this setting is, audio is always recorded and played back at 15360 
PPQN. Editing conforms to the display resolution, set in the Preferences-General-
General dialog.

For example, setting the Bar Display 
to “-1” makes the Song start at “0.1.1” 
instead of the normal “1.1.1”.



- 611 - 

Write Timecode

This function can only be used if you are using a time code device, which can be in-
structed by Cubase VST to start writing timecode.

Writing Time Code is sometimes called “striping the tape”. It is a procedure where 
you record time code on for example a track on a tape recorder. The recorded time 
can later be used as a Master for synchronizing Cubase VST and other devices.

1. Hook things up so that the device producing the time code is connected to a track on 
the tape recorder (if that is what you are using for recording the time code).

2. Select a Frame Rate, using the pop-up (as described on page 604 in this chapter).

3. Decide the position you want to start writing code at by adjusting the digits in the 
Write Timecode box.

4. Activate recording on the tape recorder.

5. Click on Start.

6. When you are done, click Stop.
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Sync Options

Lock Time

Using this field you can set how many frames of “correct” time code Cubase VST 
should receive before attempting “lock” (synchronize) to incoming time code. If 
you have a tape recorder with a very short start-up time, you could try lowering this 
number to make lock-up even faster than it already is. If you have Chase Events 
turned on, and many Events to chase, you could try raising this number.

Dropout Time

On a tape with time code (SMPTE) dropouts may occur. If a drop-out is very long, Cu-
base VST may (temporarily) stop. In the Dropout Time field you can set how long a 
drop-out (in frames) should be tolerated until Cubase VST decides that the tape isn't 
good enough to synchronize to. If you have a very stable time code source, you may 
lower this number to make Cubase VST stop more swiftly after the tape recorder has 
been stopped.

Detect Frame Change

If this option is ticked, Cubase VST will automatically detect frame rate changes in 
incoming time code and reset the Frame rate setting to the new value.

The “normal” setting for this parameter is “Off”.
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42
Quicktime Movie capabilities
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Basic Movie Playback

The basic procedures for setting up, selecting and playing back movies are de-
scribed in the Movies chapter in the Getting Started manual:

• Adding movies to the Song is done in the Movie Setup dialog.
This is accessed from the Movie Setup submenu on the Options menu.

• Opening movies for viewing can be done in the Movie Setup dialog or from the Movies 
submenu on the Windows menu.
This opens the movie in a separate window, with controls for viewing and offset controls.

The Movies submenu.

• Removing movies from the Song is done in the Movie Setup dialog.

Movie features
Apart from opening a QuickTime movie and playing it in sync with audio and MIDI 
playback, you can do the following things:

• You can export an audio track from a QuickTime movie, and import it into a Track in 
Cubase VST.
This allows you to edit the audio data there, cut out unwanted parts, add music, etc.

• You can export audio that you have prepared in Cubase VST and import it into a Quick-
Time movie, replacing the existing audio track.

• You can add sound to a silent QuickTime movie.

These features allow you to use Cubase VST as an audio and music editing tool for 
your QuickTime movies.

The features are based on a utility called MovieTracks, that allows you to import and 
export audio data to and from QuickTime movies. We will first explain how this util-
ity works, and then outline an example of its practical use.

❐ For this feature to be available, the file MovieTracks must be in the Cubase VST folder. 
The file is automatically placed there during installation; just make sure you don’t 
move or delete it.
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Opening a movie in the MovieTracks window

1. Pull down the Options menu and select “MovieTracks…” from the “Movie Setup” sub-
menu.
The following window appears.

2. Pull down the “MovieTrack Functions” pop-up and select Open Movie.

3. Locate and open the movie.
It appears in the left part of the window, from where you can play it back, like in any Quick-
Time window.

This menu is used for selecting a track in an open movie.

This menu contains a number of functions.

This area displays the movie.
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The Controls in the MovieTracks windows

Movie panel

On the left side of the window, a regular QuickTime panel allows you to play the 
movie.

Tracks pop-up

This is used to select one of the Tracks in the movie (the video track, the audio track, 
etc.). Whatever changes you make with switches and sliders will only affect the track 
selected here.

Active checkbox

This is used to turn on/off the selected track. When a track is deactivated, it will not 
play. When you save the movie you also have the option of excluding deactivated 
tracks, see below.

Sliders

These allow you to make adjustments to the track selected with the top (Tracks) 
pop-up. Any changes you make will only affect this track. For large changes, drag 
the handle with the value. For smaller changes, click the “+” or “–” buttons.

MovieTrack Functions pop-up

This menu contains the following options:

• Open Movie
This presents you with a regular QuickTime Open dialog, that allows you to open any Quick-
Time movie file you have on your disks.

• Save Movie
This allows you to save the movie, including the changes you have made in MovieTracks. See 
page 619 for details.

• Import Audio
This allows you to add an audio track to your movie. This can either be a separate audio file or 
you can extract the audio from another movie. See page 618 for details.

• Export Audio
This allows you to export an audio track in a movie into a separate audio file. See page 617 
for details.

• Remove Track
This removes the selected track from the movie, altogether.

Name Description

Offset This allows you to make a track start later than the others. This is useful to for exam-
ple make adjustments to a narration or music track that doesn’t play “in sync” with 
the video.

Volume This only applies to audio tracks, and allows you to adjust its playback level.

Balance/Pan This only applies to audio tracks and allows you to adjust the stereo balance of an 
audio track (left/right).
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Extracting Audio Data from Movies (Export Audio)

MovieTracks allows you to export any audio track in a QuickTime movie and convert 
it into a regular audio file that can be imported into Cubase VST.

The file is saved in AIFF format (the standard audio file format on the Macintosh). 
Options in the dialog allow you to control the sample rate and bit resolution of the 
file. The main reason to change any of these values is if you want to use the files in 
a program that requires certain sample rates and resolutions (Cubase VST does, see 
below).

Proceed as follows:

1. Make sure the Tracks menu indicates that the correct audio track is selected.
If not, select the desired track from the top pop-up.

2. Pull down the “MovieTrack Functions” pop-up and select Export Audio.

3. Specify a location and name for the file and fill out the options as follows:

4. Click Save.
The new file is created on your hard disk.

Option Description

Export in original format This saves the file in AIFF format, without changing the sample rate or 
bit resolution.

Export and Convert to... This saves the file and adapts its sample rate and resolution to the stan-
dard values for Cubase VST. Use this option if you want to import the 
files into Cubase VST.

Export as: This allows you to select from a number of sample rates and from the 
two possible bit resolutions, using pop-ups.

An audio track selected.
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Adding Audio to Movies (Import Audio)

If you have prepared an audio file in Cubase VST or other program you can import it 
into an existing movie.

• The file must be in AIFF format (the standard audio file format on the Macintosh).

• Any sample rate is allowed.
If you like, MovieTracks can convert the sample rate when importing it. See next page.

• The file can be in 8 or 16 bit format.

• The file will appear as a new track which gets added to the existing audio tracks in the 
movie file.

Proceed as follows:

1. Pull down the “MovieTrack Functions” pop-up and select Import Audio.

2. Fill out the options, as follows:

3. Locate the file and click Open.
The file gets added to the movie as a new track. 

If required, you can now select the track and make adjustments to its volume, ste-
reo balance and starting point, as described on page 616.

Option Description

Import in original format This adds the file as a new track, without changing the sample rate or bit 
resolution.

Import and Convert to... This adds the file as a new track and adapts the sample rate and bit res-
olution to the existing audio track(s) in the movie.

Import as: This allows you to select from a number of sample rates and from the 
two possible bit resolutions, using pop-ups.
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Saving a Movie

When you save a movie, the following information is included:

• Any track you have imported since you opened it. 
You can decide not to save deactivated tracks, see below.

• Any setting changes you have made to the tracks (offset, volume etc.)

Saving

1. Pull down the “MovieTrack Functions” pop-up and select Save Movie.

2. Find a location for the file, enter a name and fill out the options as follows:

3. Click Save.
The new file is created on your hard disk.

Option Description

Save as self contained.../
Save normally...

A self contained movie contains all the information needed for playing it 
back, in one file. A file with dependencies, on the other hand, might be 
“assembled” from other files. Normally, you would choose “self con-
tained”. For more information about this, see the Apple QuickTime doc-
umentation.

Make PC compatible 
movie.

If this movie will ever be played back on a QuickTime equipped PC com-
puter, make sure this check box is activated when you save.

Disable playback 
optimizations:

When this is activated, editing the movie will be faster, but playback may 
be “jumpier”. If this is the final edit of the movie, make sure this option is 
deactivated.

Only save active Tracks: When this is checked, only the tracks that are activated in the MovieT-
racks window, will be saved.
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Editing the audio for a movie - An example

To get an idea of how the various options in Cubase VST can be used to edit and 
add audio to a movie, please read the following example:

Let’s say you have recorded a movie with a video camera and transferred it to your 
Macintosh computer. This contains some dialogue recorded together with the pic-
tures. You want to make some small adjustments to the existing audio (remove 
some parts, replace some bits, add some effects etc) and add some music. Proceed 
as follows:

1. Open the movie in MovieTracks, and export the audio track, using the option that con-
verts the sample rate to Cubase VST’s preferred rate.

2. Import the newly created audio file into a Track in Cubase VST.

3. Set up a movie playback window that plays back the video in sync with the Song.

4. Make the edits to the audio track (possibly adding new recordings), until the existing 
audio is playing back as you want it.

5. Create the music tracks.

6. Set up a final mix for all the audio (both the dialog and the music).

7. Use the Export Audio Tracks command in Cubase VST to convert the entire Arrange-
ment to a single audio file.
Make settings for the audio file according to the specifications on page 618. The Export Au-
dio Tracks feature is described on page 499.

8. Use the MovieTracks window to remove the existing audio track from the movie and 
replace it with the file you just created (by importing the new file).

9. Make any adjustments you find necessary.

10.Save the movie in self contained format.
It will now play back with new audio, complete with music and edited dialog.
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43
Customizing Cubase VST
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Why Customize?

When you use Cubase VST the first time, all settings in the program have “factory 
values”. Depending on your working style, what we have chosen might suit you 
perfectly or not at all. By customizing Cubase VST, you are able to make it “your pro-
gram” and you will streamline your work considerably.

Creating a Custom Startup Song
Creating a custom Startup Song actually only involves two steps:

1. Setting up the program exactly as you want it to be each time you start up.

2. Saving those settings as an Autoload song (hereafter referred to as the “startup 
song”).

Before customizing...
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... and after.

Examples of things to customize

Below follows a brief list of candidates for customizing. At this point you might not 
understand what all the functions below are for and what they do. Either look them 
up in the rest of this manual or leave them out for now.

Preferences

This is the most natural place to start. The various Preferences dialogs on the Edit 
menu contain many very useful functions that allow you to make Cubase VST look 
and behave as you want it to.

Key Commands, MIDI Remote and Toolbar

If you prefer to invoke commands from the computer keyboard or via MIDI, please 
be aware that a huge number of commands can be set up for key or remote MIDI 
control. You can connect any key and practically any MIDI message to any function. 
See page 628.

If you’d rather use your mouse, you can set up your own Toolbar, as described on 
page 632. This let’s you use graphical “buttons” for all the same functions that can 
be accessed from the computer keyboard and via MIDI.
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Window Settings and Sets

You can move and change the size of the windows, open various types of windows, 
move dividers and set the magnification, to tailor the windows to your needs. Sav-
ing this in the startup song will make the program appear as you want it.

In addition to this you can create Window Sets (see page 646) that allow you to 
quickly switch between various window configurations.

Tracks

You can create and name Tracks, set them to different Track classes, etc. For example 
if you know you always want a Drum Track that plays on MIDI Channel 10, simply cre-
ate it!

A more advanced option is to prepare empty Folder Tracks, for example for various 
sections in your orchestra.

You can also rearrange, hide and resize Track columns as you like.

Parts

You can even have Parts in your startup song. These could for example contain li-
braries of often used drum patterns or riffs. Or, they could contain system Exclusive 
dumps of settings that load your instruments with certain sounds. Put the Parts on 
muted Tracks and drag them onto other Tracks when you need them.

Transport Bar settings

You might for example prefer to record in Replace Mode, or you might always want 
Automatic Quantizing of your recordings. If you do, simply set this up on the Trans-
port Bar.

Editor settings and Drum Map

If you prefer certain settings in the editors, for loops, quantizing etc., set them up 
and save them with the startup song.

A perfect candidate for customizing is the Drum Map. This includes which Drum 
Maps to use and how they should be set up.

MIDI Track Mixer

As described on page 306, you can modify the MIDI Track Mixer to include various 
“custom control panels”. Preparing such maps and including them in the startup 
song allows you to access many important control functions in your MIDI instru-
ments from the MIDI Track Mixer.

Mixer Maps

You can have up to eight Mixer maps loaded in a song. You might for example have 
different “editors” for various MIDI instruments in your rig.
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Audio Settings

There are a number of things you can prepare that are related to Audio:

• System settings as described on page 515. This is mainly done to optimize the number of au-
dio channels, EQs and effects.

• Initial mix settings, channel naming, effect settings etc., as found in the VST Channel Mixers 
and in the various effects windows. This allows you to start with a basic tracking setup every 
time you begin on a new song.

• Audio buses, sends etc. This is mainly for those using audio hardware with multiple outputs. 
Preparing this assures all outputs are used for their right purposes for every new project.

• The Pool window allows you to determine how you want the files and segments listed.

Grooves and other Quantize settings

If you have created a few favorite Grooves or made settings for Iterative Quantize, 
make these part of your startup Song.

Metronome, MIDI Setup and MIDI Filter

Do you want a click at all? Do you want it via the computer speaker or via MIDI? 
How long do you want the count-in to be? All this is set in the “Metronome” dialog, 
reached from the Options menu. The “MIDI System Setup” dialog, reached from the 
MIDI Setup submenu on the Options menu, contains information about your MIDI 
Interface (among many other things). Since you don’t want to have to set this every 
time you launch Cubase VST you should save this setting in the startup Song.

If you have equipment that generates MIDI data that you don’t want to record, use 
the “MIDI Filter” dialog, reached from the MIDI Setup submenu on the Options menu.

Sync

Most often you will synchronize to the same external equipment – for example the 
tape recorder in your studio. By setting up the Synchronization dialog as you want 
it, activate Sync on the Transport Bar and save this with the startup Song, Cubase 
VST will automatically synchronize as soon as you hit play on the tape recorder.
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Saving the Autoload Song

Once you have set up the Song, perform the following steps.

1. Pull down the File menu and select “Save As...”.

2. Select “Song” from the file format pop-up menu.

3. Make sure you save in the same folder as where you have your Cubase VST program.

4. Type in the name “Autoload” (make sure you type the name exactly like that, but with-
out the quotes of course!).

5. Click Save.
Now the next time you launch the program, the Song you just saved will automatically be 
loaded.

Opening the Last Song on Startup

Normally, the Autoload Song is automatically loaded when you launch Cubase VST. 
However, if you activate the option “Open Last Song on Startup” in the Preferences-
General-General dialog, the last Song you had open in your previous Cubase VST 
session will be opened instead!

Starting from other Song documents –Templates

There are only two things special about the Autoload Song, compared to other 
Songs:

• It loads automatically on startup if found in the same folder as the program.
• It loads automatically if you select the “New Song” item on the File menu.

You can in fact use any Song document for customizing on startup. This is conve-
nient if you do different types of work and want different “templates” for each.

1. Set up the Song as you want it.

2. Save it under any name in any folder on your hard disk.
You might for example save a number of “template” documents on the Desktop.

3. When you want to use a “template” song, simply double click on the document icon.
Cubase VST launches and the Song is loaded automatically.
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44
Keyboard Commands, MIDI Remote Control and the

Toolbar
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Defining and Using Key Commands

Introduction

Most of the main menus in VST have Key Command shortcuts for certain items on 
the menus. In addition, there are numerous other VST functions that can be per-
formed via Key Commands. These are all factory default settings. You can, however, 
customize all existing Key Commands to your liking, and also add commands for 
menu items and functions currently not assigned any. All this is done in the Prefer-
ences–Key Commands dialog. 

How are the Settings Saved?

If you edit or add any Key Command Settings, these are stored separately in the 
“Cubase Preferences” system folder - not as part of the Song. See below for details 
on how to Save complete Key Command settings.

❐ Remember that no Key Commands are fixed, including defaults. If you should happen 
to use Cubase on a different computer, Key Commands you are accustomed to may 
perform completely different commands.
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Adding or Modifying a Key Command

In the Preferences–Key Commands dialog you will find all main menu items and a 
large number of other functions, all arranged on different “pages” depending on 
which menu/window they belong to. You can also see which Key Commands are 
currently assigned by default. A complete list of the default settings can be found 
at the end of this chapter. To add a Key Command, proceed as follows:

1. Pull down the Edit menu and select Preferences–Key Commands.
The Key Commands dialog appears.

2. Use the pop-up at the top of the window to select the preferred page.

This function has no key 
command assigned.

This function has a key com-
mand assigned already.
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3. Click in the “Key” column for the item or function to which you wish to assign a Key 
Command, or alternatively, select the item and click the “Set Key” button.
A window appears prompting you to press a Key. You can choose between any single key or 
a combination of one or several Modifier keys (Command, Option, Ctrl, Shift) plus any key. 

❐ If the Key Command you enter is already assigned, you will get a prompt asking if you 
want to replace the currently assigned command or cancel the operation.

4. Click OK.

Removing a Key Command

To remove a Key Command, proceed as follows:

1. Repeat step one above and Select the Key Command you wish to remove.

2. Click in the “Key” column for the item or function to which you wish to remove.
Alternatively, select the item and click the “Set Key” button.

3. In the dialog that appears, click “Remove”.

4. Click OK to close the Key Commands dialog.

Saving complete Key Command Settings

As mentioned previously, any changes made to the Key Commands are automati-
cally stored in the Cubase Preferences System folder. It is, however, also possible to 
store Key Commands settings separately. In this way, you can store any number of 
different complete Key Commands settings for future recall. Proceed as follows:

1. Edit the Key Commands to your liking.

2. Click OK to exit the Key Commands dialog.

3. Select “Save As...” from the File menu.
The “Save File As” dialog appears.

4. Pull down the file format pop-up menu and select “Keyboard Layout”.

5. Navigate to the desired folder, and enter a name for the Keyboard Layout.

6. Click Save.
A separate Keyboard Layout file is created at the chosen location.
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Recalling saved Key Command settings

To recall a saved Key Command list, proceed as follows:

❐ Note that this operation will replace the existing Key Commands! If you want to be able 
to revert to these settings again, make sure to save them first!

1. Select Open from the File menu.

2. Select the Keyboard Layout file you wish to open.

3. Click “Open”.
The opened Keyboard Layout replaces the current Key Command setup.

About the “Standard” Key Commands

When you install Cubase VST, a file called “Cubase Standard Keys” is included, and 
placed in the “Library Files” folder within the program folder. This contains the de-
fault key commands, i.e. the key command setup you get when you launch Cubase 
VST for the first time.

If you have experimented with different key command setups, and wish to return 
to the default settings, you only need to open this file (by selecting it on the “Open 
from Library” submenu on the File menu).
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The Toolbar

The Toolbar is a bar of icons representing shortcuts to common VST functions and 
commands. The Toolbar has a default set of icons. These may be removed from the 
bar, but their functions cannot be changed. For example, the Record Button icon 
can only be assigned that specific function. If you want to add icons to the Toolbar 
there is a list of “generic” icons, which can be assigned any (non-default) com-
mand/function.

❐ The Toolbar settings are saved in the Cubase Preferences, and included when you save 
or open Keyboard Layout files (see page 630).

Using the Toolbar

1. To display the Toolbar, select “Show Toolbar” on the Windows menu.
The Toolbar appears. You can move it to the desired position by clicking on the handle to the 
left and dragging.

2. Click on the icon for the function you wish to perform.
To help you find the right icon, the corresponding function is displayed beneath the icon you 
point at.

3. If you want to hide the Toolbar again, select “Hide Toolbar” from the Windows menu, 
or click in the close box of the Toolbar window.
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Hiding and Showing default Icons

When you first open the Toolbar, a number of icons will be shown. As described 
above, these are the “default” icons, each of which is exclusively associated to one 
specific function. If you wish, you can remove any of these icons from the Toolbar:

1. Pull down the Edit menu and select Preferences–Key Commands.
The Key Commands dialog appears.

2. Use the pop-up menu and the scroll bar to locate the function whose icon you want to 
remove.
The icons currently on the Toolbar are shown in the “Icon” column to the right.

3. Click on the icon to remove it from the Toolbar.

4. Click OK to close the dialog.

• To show the icon again, click in the “Icon” column for its function.
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Adding generic Icons

For the majority of functions, there are no exclusive icons. Instead you can choose 
generic icons for these, and add them to the toolbar:

1. Open the Preferences–Key Commands dialog.

2. Use the pop-up menu and the scroll bar to locate the function for which you want to 
add an icon.

3. Point at the “Icon” column for the function, and press the mouse button.
The custom list of icons appears. As you can see, some of the icons suggest specific func-
tions, some contain text and others are just symbols. In any case, they can all be used for any 
non-default function.

4. Select an icon.

5. Click OK to close the dialog.
The selected icon is added to the Toolbar.
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Removing generic icons

To remove an existing generic icon from the Toolbar, proceed as follows:

1. Open the Preferences–Key Commands dialog.

2. Use the pop-up menu and the scroll bar to locate the function whose icon you wish to 
remove.

3. Pull down the Icon list for the function and select “Off”.

4. Click OK to close the dialog.
The icon is removed from the Toolbar.

Rearranging icons on the Toolbar

You can quickly customize the Toolbar without having to open the Preferences di-
alog. This is done using modifier keys:

• To move an icon in the Toolbar, hold down [Command] and drag it to a new position.

• To remove an icon from the Toolbar, hold down [Option] and click on it.

• To open the Preferences-Key Commands dialog, double click in the area below the 
icons in the Toolbar.
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MIDI Remote Control

❐ Remote Control of the VST Mixers is set up separately, as described in the chapter “Re-
mote Controlling VST Objects”.

Just as you can use Key Commands or the Toolbar to perform specific commands 
and functions, you can also use MIDI messages to trigger commands. For example, 
this allows you to control the transport without taking your hands off your MIDI in-
struments. 

❐ The MIDI Remote Control settings are saved in the Cubase Preferences, and included 
when you save or open Keyboard Layout files (see page 630).

You set up and activate MIDI Remote Control in the Key Commands dialog. Proceed 
as follows:

1. Open the Preferences–Key Commands dialog.

2. Use the pop-up menu and the scroll bar to locate the function which you want to con-
trol via MIDI.

3. Point in the “Ev Type” column for the function and press the mouse button.

4. On the pop-up menu that appears, choose which type of Event should be used to con-
trol the selected function:

5. Use the “Event” column to specify exactly which note, Controller or Program Change 
Number should be used to control the function.
Scroll the value up or down, or double click and type in a value numerically.

❐ If you use a Controller as a remote, the function will be activated whenever a value 
above 0 is received. This means that if you for example use a foot switch you'll activate 
the function each time you press the pedal. If you use a modulation wheel or slider, you 
will activate the function as soon as you move it.

Option Description

None Selecting this is the same as turning off MIDI Remote Control for the function.

Note This allows a certain MIDI key to activate the function.

Controller This makes a certain MIDI Controller message activate the function. The Event 
field is used to specify which Controller (see below).

Prog. Change This makes a certain Program Change number activate the function. The Event 
field is used to specify which Program Change number should be used (see be-
low).
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6. Repeat steps 2 to 5 for any other functions you wish to Remote Control.

❐ Make sure that a certain MIDI Event is not used for more than one function. If the same 
Event is used for several functions, only one of these functions (the first in the list) will 
be affected.

7. If you like, activate the “Remote Key” checkbox and use the value field to the right to 
specify a key.

This function is handy if you have specified that some keys should be used for Remote Con-
trol, but still want to be able to use these keys for playing and recording:

• If the “Remote key” function is activated, you have to hold down the specified Remote 
key for the keys to work as Remote Controls.
For example, if you have set up the key C3 to control Click On/Off, and specified the key A6 as 
“Remote Key”, you have to hold down A6 and press C3 to turn Click on or off.

• If the “Remote key” function is not activated, pressing a key assigned as Remote Con-
trol will always activate the corresponding function (which makes it impossible to use 
this key for playing).
In our example, this means that pressing C3 would always turn Click on or off.

8. Finally, activate the “Remote Active” check box.
This is a global on/off switch for the whole Remote Control feature. You can also use a key 
command for this (by default [Y]).
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The Default Key Commands

As mentioned before there are numerous default Key Commands. Below is a list of 
all the default settings.

❐ You can always revert to the factory default key settings by opening the “Cubase Stan-
dard Keys” file (as described on page 631).

File Menu

Edit Menu

Key Command Function

[Command]-[N] New Arrangement

[Command]-[O] Open 

[Command]-[S] Save 

[Command]-[W] Close (Arrangement or Editor)

[Command]-[Q] Quit

Key Command Function

[Command]-[Z] Undo

[Command]-[X] Cut

[Command]-[C] Copy

[Command]-[V] Paste

[Command]-[A] Select All Parts/Events

[Command]-[I] Get Info

[Command]-[E] Open Key Edit or default Editor (depending on Track Class)

[Command]-[G] Open List Edit window

[Command]-[D] Open Drum Editor

[Command]-[R] Open Score Editor

[Command]-[M] Open Graphical Master Track window

[Shift]-[Command]-[M] Open List Master Track window

[Command]-[B] Open Notepad window
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Structure Menu

Functions Menu

Panels Menu

Options Menu

Key Command Function

[Command]-[T] Create Track

[Command]-[P] Create Part

[Command]-[K] Repeat Parts

[Command]-[J] Show Groups

[Command]-[U] Build Group

Key Command Function

[Q] Quantize

[U] Undo Quantize

[Command]-[L] Open Logical Editor

[Command]-[H] Transpose/Velocity

[Option]-[T] Fixed Length

Key Command Function

[Command]-Num [*] Open VST Channel Mixer

[Command]-Num [+] Open VST Master Mixer

[Command]-Num [=] Open VST Send Effects

[Command]-Num [/] Open VST Master Effects

[Command]-[F] Open Audio Pool

Key Command Function

[F] Follow Song

[Command]-[Y] Ears Only
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Score Menu

Windows Menu

Arrange/Editors

Key Command Function

[Option]-[Y] Grace Note

[Option]-[1 - 8] Move to voice 1 - 8 

[Option]-[X] Flip

[Option]-[G] Group

[Option]-[B] Hide

[+] Next Dynamic/Text Size/String

[–] Prev Dynamic/Text Size/String

Key Command Function

[F12] Show/Hide Transport Bar

Key Command Function

[Option]-[L] Set left Loop

[Option]-[R] Set right Loop

[Option]-[C] Controller Display On/Off

[Option]-[I] Note Info on/off

[Option]-[M] Mute selected Track

[Option]-[O] Loop On/Off

[Option]-[N] Name Track/Drum

[Option]-[J] Name Instrument

[Option]-[W] IPS On/Off

[Option]-[A] Show Events On/Off

[Option]-[S] Drum Solo On/Off

[A] Editor Solo On/Off

[X] Sync On/Off

[C] Click On/Off

[S] Solo On/Off

[L] Edit left Locator

[R] Edit Right Locator

[P] Edit Position

[I] Punch In On/Off

[O] Punch Out On/Off

[M] Master On /Off
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[V Cycle Rec: Delete Last

[B] Cycle Rec: Delete Subtrack

[N] Cycle Rec: Quantize last

[K] Cycle Rec: Key Erase

[1] Quantize to whole note

[2] Quantize to half note

[3] Quantize to quarter note

[4] Quantize to eighth note

[5] Quantize to 16th note

[6] Quantize to 32nd note

[7] Quantize to 64th note

[8] Quantize to 128th note

[T] Quantize to Triplet On/Off

[.] Quantize to Dotted On/Off

[Shift]-[H] Zoom in vertical

[Shift]-[G] Zoom out vertical

[H] Zoom in horizontal

[G] Zoom out horizontal

[Y] Remote On/Off

[Z] Auto Quantize On/Off

[Pg up] Page Up

[Pg down] Page Down
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Transport and Locators

Key Command Function

[numlock] Rew

Num[=] Forward

Num[0] Stop

[Space] Alternate Stop Key

Num[Enter] Start

Num[*] Rec

Num[–] Tempo down

Num[+] Tempo up

Num [/] Cycle On/Off

[Option]-[Home] Songpos to Selected Event

[Home] Editors: Position to Left of Window

[Option]-[P] Locator to selected Part(s)

Num [1] Position to left Locator

[Shift]-Num[1] Left Locator to Position

Num[2] Position to right Locator

[Shift]-Num[2] Right Locator to Position

Num[3] to Num[9] Recall Loc 1 - 7

[Shift]-Num[3] to Num[9] Store Loc 1 - 7

[Shift]-[1] to [0] Recall Mutes 1 - 10

[Shift]+[Option]-[1] to [0] Program Mutes 1 - 10

[Command]-[1] to [0] Recall Locators 1 - 10

[Command]+[Option]-[1] to [0] Program Locators 1 - 10
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45
Track Views and Window Sets
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Track Views

When you are working in the Arrange window, you will often want to use different 
Track Column layouts for different situations. You may for example want a minimum 
number of Track columns to be shown when editing in the Part Display, and more 
columns to be shown when you are making Play parameter settings. To be able to 
quickly switch between such Track Column configurations, you can use the Track 
View feature.

Storing Track Views

1. Configure the Track Columns as you want them.

2. Hold down [Option] and click in the Track Column heading area.
A pop-up menu appears.

The Track View pop-up menu.

3. Select “Store View...” from the pop-up menu.
A name dialog appears.

4. Enter a name for the Track View and click OK.

❐ Track Views are stored in the Cubase Preferences. This means that any Track Views you 
create will automatically be available in all Songs.

Recalling Track Views

1. Hold down [Option] and click in the Track Column heading area.
The Track View pop-up menu appears. Any Track Views you have stored are listed at the bot-
tom of the pop-up menu.

2. Select the Track View you want to recall.
The Track Columns are reconfigured according to the stored settings.
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Renaming and Deleting Track Views

1. Hold down [Option] and click in the Track Column heading area.
The Track View pop-up menu appears.

2. Select “Edit...” from the pop-up menu.
A dialog appears, with the existing Track Views listed.

3. To rename a Track View, double click on it in the list and type in a new name.

4. To delete a Track View, select it and click “Remove”.

5. Click “Exit” to close the dialog.
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About Window Sets

Window Sets allow you to tailor the layout of your screen, including not only win-
dow appearance but also window related settings. By creating, saving and recalling 
Window Sets, you can switch between various “work layouts”. Basically, you set the 
screen up as you want it and then take a “snapshot” of it and store this under a spe-
cific name.

What is included in a Window Set?

A Window Set stores basic information about each window on the screen, includ-
ing the following:

• Size.
• Location.
• Location of any associated Toolboxes and Palettes.
• Magnification factor.

It does not include:

• Positions of scroll bars.
• Color schemes.

Below follows a list of the windows that can be included in a Window Set. For some 
of them additional information about settings that can be included, is specified:

Arrange window restriction

One restriction applies to Arrange windows. A Window Set can only restore settings 
for one Arrangement, the one currently active (on top).

Where are Window Sets stored?

Window Sets are stored as parts of your Preferences. That is, all Songs share one set 
of Window Sets.

Window type Additional settings stored

Arrangement Track View layout, Inspector hidden/shown, Status Bar settings etc.

Key, List, Drum, Score, Audio 
and Controller Edit

Snap and Quantize values. Controller display hidden/shown (where 
it applies). “Lanes” in Controller Editor.

Master Track windows None

All Mixers None

Pool None

Notepad None
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Creating a Window Set

1. Set up the window or windows as you want them.
This may include activating, resizing and positioning windows, as well as making settings 
(see the application examples later in this chapter).

2. Select “New Window Set...” from the Window Sets submenu on the Windows menu.
A dialog appears.

3. In the dialog that appears, type in a name and fill out the options as desired:

Option Description

All Windows This stores the “state” (open/closed, position etc.) of all win-
dows, including settings for each one as listed in the table on 
page 646.

Top Window Only This stores the state of the currently active window only.

Include Settings If this option is activated, the settings (if any, see page 646) for 
the currently active window are included.

All Windows Excluding Settings This stores the “state” of all windows, without including any 
settings.
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Recalling a Window Set

From the Windows Menu

All the Window Sets you have created are available for direct selection from the 
Window Sets submenu on the Windows menu. Selecting one recalls it.

From the Computer keyboard or via MIDI

In the Preferences–Key Commands–Windows Menu dialog you can set up key 
shortcuts and MIDI commands that recall any of the first fifteen Window Sets on 
the menu. See page 628.
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Renaming and Removing Window Sets

The Edit item on the Window Sets submenu (on the Windows menu) brings up a 
dialog that lists all Window Sets.

Note that the items on the list give you a hint about which options were selected when each 
Window Set was created.

• To rename a Set, double click on it, type in the new name and Press [Return].

• To delete a Set, select it in the list and click the Remove button.

• When you are done, click Exit.
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Application Examples

The Complete Work Set

To create a complete “image” of your working space, set up all windows listed on 
page 646, including settings and appearance, and save this as a Window Set with 
the option “All Windows Including Settings” activated.

If you like, set up different Sets in the same way, each one with different combina-
tions of open windows. For example, create one with the Arrange window “on top”, 
but with the Inspector closed, one with the Arrange window on top but the Inspec-
tor open, yet one with a certain editor active etc.

Switching Between Windows

To create Sets that are only used to switch between various windows, proceed as 
follows:

1. Make the first window active.
This could for example be the Arrange window.

2. Store a Window Set with the option “Top Window Only” activated and “Include set-
tings” turned off.

3. Make another window active (for example Key Edit) and store a new Window Set with 
the same settings.

4. Proceed like this for all windows.
Now when you select these Window Sets, the window specified in this Set is opened if it is 
closed and made active (put “on top”) if it isn’t.

This type of Window Set is an ideal candidate for key commands. By setting up 
shortcuts for each Window Set, you can switch between, re-size and position win-
dows very conveniently.

Tailoring a window

By saving several Window Sets, all for the same window (Top Window Only acti-
vated and with the “Save Settings” option active), you can switch between several 
appearances for the same window. An example candidate for this is the Controller 
Editor, where you can use Window Sets for determining what type of information is 
displayed. Each Window Set can have a different selection of data types visible.

File Handling of Window Sets

You can save all the Window Sets currently on the menu, as a file. Exactly how to 
save and open files is described in the Getting Started book.

❐ When you open a Window Set file, the Window Sets in the file replace all Sets currently 
available in the program.
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A
Accelerandi 542
Active Part

Audio editor 348
Editors In General 164
MIDI Editors 164
Score Edit 233

Aftertouch
Deleting 188
Editing 185, 248
Filtering 285
In List Edit 217
In Logical Edit 274
Selecting Events In Editors 187

Analytic Quantize 155
Any

Audio Channel 31, 47
MIDI Channel 39

Apogee UV22 446
Arrow Tool

Editors 168, 179, 187
List Edit 225
Master Track 541

ASIO 2.0 602
ASIO Device 517
ASIO Direct Monitor 519
ASIO Positioning Protocol

About 593
Activating 602

Audio Channel
About 30
Any 31, 47
Assigning to Bus 492
Copying Settings 449
Maximum nr of 516
Routing to a Group 453
vs Track 30

Audio Clock Source 15, 518
Audio Editor

Color Palette 347
Display Formats 346
Dragging Audio into 349
Info Line 352
Opening 337
Recording In 348
Single Channel Track 338
Stereo Track 339
Time/Meter Scale 346

Audio Events
About 35, 337, 511
Copying 511
Crossfading 382
Deleting 366
Duplicating 360
Exporting into Files 389
Ghost Copying 511
Grouped 377
Moving 359
Muting 364
Overlapping 341
Selecting Segment for 389
Splitting 365

Audio Files
About 33
Audio Pool 311
Creating in Wave Editor 409
Deleting 319
Deleting Unused 319
Deleting Unused Portions of 326
Duplicating 318
Exporting 330
Importing 328, 350, 497
Locating Missing 321
Locating on Hard Disk 318
Mixing Down 499
Naming 318
Replacing 320

Audio Functions 392
Audio Mute Button 298
Audio Pool

Contents 313
Loading 335
Opening 311
Saving 335
Time Formats in 316

Audio Tracks
In List Edit 216
Setting Channel for 30

Audio/Tempo Match Editor 573
Audiomix Part 467
Auditioning

Audio Editor 351
Audio Pool 323
Wave Editor 406

Auto Quantize (Score) 236
Auto Tempo Scan 563
AutoGate 426
AutoLevel 428
AutoXFade 41, 507
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B
Banish Silence 379
Bank Select 120
Bar Display Offset 610
Bar Range 282
Buses

About 487
Activating 490
Naming 491
Routing Channels to 414
Routing to Outputs 491

C
Change Volume with Slider 97
Channel, see MIDI/Audio Channel
Chase 123
Chn

Drum Map 212
Drum Tracks 201

Clean Lengths 237
Clef 235
Color

In "Any" Track Inspector 48
In Audio Editor 347
In MIDI Editors 165

Comment (Score Edit) 243
Compress (VST Dynamics) 429
Compression 99
Conditions 273
Controller Display

Drum Edit 185
Key Edit 185
List Edit 226

Controller Editor
About 246
Displaying Events 251
Editing 255
Scale Slider 260

Controllers
Deleting 188
Editing 185, 248
Filtering 285, 286
In List Edit 217
In Logical Edit 274
Mapping 288
Selecting Events In Editors 187
Transforming 217

Convert SDII to AIFF 329
Converting

Drum Tracks To MIDI Tracks 213
Hitpoints to Matchpoints 575
MIDI Notes to Hitpoints 554
MIDI Tracks To Drum Tracks 213

Copy
Audio Events 363
Logical Edit 276
Master Track 541, 547
Master Track Data Between 

Arrangements 548
MIDI Events 183
Parts 60
VST Channel settings 449

Copy Locator Range 77
Copyright (Score Edit) 243
Create

Accelerandi/Ritardandi 542
Events 177, 221
Events, Disabling 180
Hitpoints 552
Master Track Events 547
Parts 57
Tempo Events 540
Time Signature Events 540

Crossfade
Automatic 41
Manual 381

Cubase VST/32 27
Customizing

About 622
Saving 626
Settings 623
Using Templates 626

Cut
Audio Events 363
Master Track 541, 547
MIDI Events 183
Parts 60

Cut At Locators 75
Cycle

Recording Audio in 385
Restricting Editing to 169

D
DC Offset 399
Default Drum Map 200
Default Song 626
Defragmenting Hard Disk 524
Delay

Drum Sounds 211
MIDI Inspector 98
Play Parameters 117
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Delete
All Events 171
Audio Events 366
Hitpoints 542
Logical Edit 276
Master Track Events 547
Parts 64
Segments 325
Tempo Events 542
Time Signature Events 542

Delete Note 170
Delete Unused Files 319
Detect Frame Change 612
Digital In/Out 15
Digital Mixer 18
Disk Block Buffer Size 516
Display Filters 227
Display Quantize 236
Dither 446
Do Pop-up Menu

Master Track 542
MIDI Editors 170
Score Edit 232

Double Click Opens 158
Drawing

Hitpoints 552
Tempo Events 540

Dropout Time 612
Drum Map

About 200
Editing 205
Editing via MIDI 208
I-note 201
Len Value 210
Loading 203
MIDI Channel 201
O-note 201
Q Value 209
Removing unused 208
Saving 208
Selecting 204
Velocity Values 210

Drum Parts
About 199
Editing 209

Drum Stick Tool 209
Drum Tracks

About 199
Converting to MIDI Tracks 213
In List Edit 217

Duplicate
Audio Events 360
Master Track Events 541
MIDI Events 171
Parts 63
Segments 324

Dynamic Events
About 387
Displaying 345, 387

Dynamic Functions 106
Dynamics, see VST Dynamics

E
Easy (Logical Edit) 269
Edit Solo 162
Editing

Audio Editor 352
In List Edit 222
MIDI Parts In Drum Edit 212
Wave Editor 408

Editing via MIDI 183
Editors

Closing, Cancelling Changes 161
Closing, Keeping Changes 161
Differences 157
Opening 158
Opening Several 159
Playback Parameters 165

Effects
About 431
Editing 442
Loading 444
Making Settings 436
Naming 443
Organizing in Folders 444
Routing MIDI to 441
Routing Outputs to Buses 493
Saving 444
Sends 434

Enharmonic Shift 241
EQ

About 421
Bypassing 423
Making Settings 421
Presets 423

Erase Muted 364
Erase Unused 326
Eraser Tool

Arrange Window 64
Audio Editor 366
Editors 184

Event Display 225
Event Type (Logical Edit) 272
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Events
Audio 35
Creating 177, 221
Deleting 184
Disabling Creation 180
Hiding 227
Monitoring In Editors 168
Moving 225
Score 220
Selecting 168
Special 220
Stop 220
Text 220

Expert (Logical Edit) 269, 282
Explode By Channel

With Audio Tracks 79
With Drum Tracks 79
With MIDI Tracks 78

Export Audio 499
Exporting Files and Segments 330
Exporting Master Tracks 548
Exporting Segments 389
Extended Inspector 100
External Wave Editor 411
Extract (Logical Edit) 276

F
Fade Dialog 399
Fade In 384, 393
Fade Out 384, 393
Fading In/Out Audio Events 381
Favour MIDI Timing 520
F-button 227
Fill 171
Fill Meter Hits 552
Film 530
Filtering

By Event Type 285
By MIDI Channel 286
Logical Edit 272, 276
Thruput 287

Filtering Controllers 286
Filters

About 285
In List Edit 227
In Logical Edit 270

Fit Event To Loop Range 375
Fixed Note 170
Flat Beams 237
Flip Stems 241
Folder Tracks

About 129
In MIDI Track Mixer 133
Moving Tracks into 130
Muting and Soloing 132

Follow Song 162

Fragmentation 524
Frame Rate 604
Frames 530
Freeze Play Parameters 165
Functions (Logical Edit) 270

G
Generate SMPTE 598
Get M-Points 574
Ghost Audio Events

About 511
Converting 513
Creating 361, 512
Selecting Segment for 389
vs "Normal" Audio Events 513

Ghost Parts
About 73
Audio 513
Creating 73
Creating Using Repeat 74

Glue Tube Tool
Arrangement 68
Score Edit 241

GM
About 309
Patchnames 92

Goto Pop-up Menu 167
Groove Control 147
Groove Quantize 371
Groove Tool 155
Grooves

Applying 148
Creating 151
Creating from Audio 585
Editing 149
Managing Files 153

Group Parts
About 143
Arranging 142
Arranging During Playback 144
Unpacking 144

Grouped Audio Events 377
Groups

About 135
Adding Parts To 137
Creating 136
Creating Group Tracks 141
Replacing All Parts In 138
The Group List 139
Using (basic steps) 136

Groups (Audio) 453
Grv Tool 155
GS

About 309
In MIDI Track Mixer 297
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H
Hand Tool (Wave Editor) 409
Hard disk maintenance 524
Hiding Events (List Edit) 227
Hitpoints

About 532, 550
Audio/Tempo Matching 577
Breaking Links 559
Converting MIDI Notes to 171, 554
Converting to Match Points 575
Creating 552
Deleting 542, 554
Duplicating 554
Editing 554
Linking 558
Meter 551
MIDI Input 552
MIDI Output 557
Moving 554
Naming 554
Quantizing 555
Showing Links 565
Time 551

I
Import Audio 328, 497
Importing Master Tracks 548
In Button 490
Inactive Part 164
Info 174
Info Line 528

Editing On 173
In Audio Editor 352
In Master Track Editor 538
In MIDI Editors 173

Init (Logical Edit) 270
Input Meter 490
Inputs (Audio)

Activating 20, 488
Digital 15
Multiple 14
Naming 488
Selecting for Recording 21, 489

Insert
Logical Edit 281
MIDI Editors 178

Insert At Locators 76
Insert at Record Position 332
Insert Button 178, 194
Insert Effects

About 431, 437
Routing Channels Through 438

Inspector 141
Extending 100
Parameters In 97
Program Change 115

Instruments
About 85
Extended Name 86
Patchname Source 91
Redirecting 89
Selecting 89
Setting Up 85

Invert (Phase) 393

J
Joining Parts 68

K
Keep Linked 554
Keep Note 170
Keep Selected 554
Key Commands

About 628
Adding 629
Default 631
Default List 638
Modifying 629
Recalling Saved 631
Removing 630
Saving 630

Key Signature 235
Keyboard Layout 630, 631

L
Lanes

About 338
Displaying 344
Single Channel Tracks 338
Stereo Track 339

Latency 517
Launch External Wave Editor 411
Length

Drum Notes 210
Logical Edit 282
MIDI Inspector 99

Limit 430
Line Tool

Editors 187
Master Track 542

Link
About 558
Breaking 559
Showing 558

Link Editors 160
Link Hitpoints

One to One 559
Load Pool 335
Lock Symbol 589
Lock Time 612
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Log Tool 265
Logical Edit

About 264
Conditions 273
Easy/Expert mode 269, 282
Filtering 272, 276
Functions 270, 281
Init 270
Opening 264
Preset List Window 266
Presets 265
Processing 270, 277

Loop
MIDI Editors 163
Restricting Editing to 169
Wave Editor 406

M
Magnification

Audio Editor 346
Audio Pool 315
Wave Editor 405

Mapping MIDI data 289
Mask

About 228
Event Type 228
Event Type and Value 228
Removing 229

Master Button 526, 533
Master Effects

About 431
Selecting 439
Sets 451
Solo buttons 440

Master Track
About 526
Copying Data Between Arrangements 548
Graphic Editor 527
Importing and Exporting 548
List Editor 546
Matching Audio and Tempo 573

Match Pitch to Scale 72
Match Points, see M-Points
Match Quantize

Audio Part with MIDI Part 374
MIDI Part with Audio Part 373
MIDI Part with Chord Part 72
MIDI Part with MIDI Part 70

Matching
Audio to Playback Tempo 581
Playback to Audio Tempo 577, 579

Memory per Channel 516
Merge Audio Segments 82
Merge Overlapping Parts 83
Merge Parts 59

Merge Tracks
With Audio Tracks 81
With MIDI and Drum Tracks 80

Meter Based Display 531
Meter Characteristics 462
Meter Hit Strip 528, 551
Meter Hits 532
Meter Ruler 528, 530
MIDI Channel

Any 39
Drum Tracks 201, 206
Filtering 286
In Events 37
Info Line 174
Logical Edit 275, 279
Multi Record Split 51
Setting for Tracks 38

MIDI Clock
Sync to 605
Transmitting 607

MIDI Colors 166
MIDI Connector Button 183
MIDI In Button 190, 552
MIDI Input 36, 183
MIDI Input Transformer 289
MIDI Mute Button 419
MIDI Output

About 36
Multi-port Interfaces 36
Standard Interfaces 36

MIDI Sync Reference 518
MIDI Thru Filters 287
MIDI Time Code 601
MIDI to Audio Delay 518
MIDI Track Mixer

About 293
Automating 299
Controls 294
Customizing 306
Editing automated data 303
Extended Channel Strip 295

MIDI Tracks
Converting to Drum Tracks 213
Merging 80

MIDI Volume 121
Mirror 553
Mirror & Link 560
Mixer (audio), see VST Channel Mixer
Mixer Tracks

In Controller Editor 247
In List Edit 219
In Logical Edit 264

Mixer Views 459
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Mixing Audio
Automated 463
Editing Automated 303, 468
EQ 421
Pan 420
Using Remote Control Devices 472
Volume 419

Mixing Down to File 499
Mono 31
Movies

Exporting Audio from 617
Importing Audio into 618

MovieTracks 615
Moving

Audio Events 359
Hitpoints 554
Master Track Data 548
Notes 179
Tempi 541
Time Signatures 541

MP3 497, 500
M-Points

About 367
Creating Automatically 368, 574
Creating Manually 368, 575
Deleting 369
Displaying 367
Editing 369
In Match Audio/Tempo Editor 573
Moving 575

M-Points to Groove 585
MROS Resolution 610
MTC 601
Multi Channel Recording 46
Multi Outs 100
Multi Track Recording

About 49
Activating 49
Channel Split Mode 51
Input Split Mode 52
Layering Sounds With 53
Merge Mode 50

Mute
Audio Events 364
Drum Sounds 212
Editing Recorded 127, 220
Notes 182
Parts 69
Pre-programming 125
Recording 125

Mute Buttons
MIDI Track Mixer 294
VST Channel Mixer 419

Mute Tool
Arrangement 69
Audio Editor 364
MIDI Editors 182

Muted Tracks
In Score Edit 239
With Cut At Locators 75
With Groups 143
With Insert At Locators 76

N
Naming

Hitpoints 554
Parts 72

No Beams 237
No Overlap 237
Normalize 394
Note Filter 112
Note Limit 110
Note On Quantize 155
Note Tool 240
Notes

Creating 177
Creating in Drum Edit 209
Deleting 170
Filtering 285
In List Edit 217
In Logical Edit 274
Length 75
MIDI Channel 178
Moving 179
Resizing 180
Velocity Modifiers 178

Nudge tool
Audio Editor 360
Master Track 554
MIDI Editors 179

Number of Channels 516

O
Omni VST Instruments 94
OMS Patchnames 94
Open Last Song on Startup 626
Optimize Arrangement 83
Output (MIDI) 36
Outputs (Audio)

About 487
Digital 15
Multiple 14
Routing Buses to 491
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P
Paint Brush Tool 177, 211
Pan

Audio Editor 387
MIDI Inspector 97
VST Channel Mixer 420

Parts
Active and Inactive 164
Creating 57
Cutting, Copying and Pasting 60
Deleting 64
Joining 68
Match Quantizing 70
Merging 59
MIDI Volume 97
Muting 69
Naming 72
Note Length 99
Overlapping 58
Recording 56
Repeating 63, 74
Resizing 61
Selecting Overlapped 58
Splitting 65
Transpose 98
Velocity 98

Paste
Audio Events 363
Master Track 541, 547
MIDI Events 183
Parts 60

Patch Name Script 92
Patchname Popup menu 91
Patchname Source 91
Pencil Tool

Arrangement 61, 73
Audio Editor 350, 368, 388
Editors 177, 180, 187
Groups 143
List Edit 225, 226
Master Track 539, 540, 552

Pitch Bend
Deleting 188
Editing 185, 248
Filtering 285
In List Edit 217
In Logical Edit 274
Selecting Events In Editors 187

Pitch Shift 395
Play in Background 485
Play Parameters

About 96
Delaying 117
Freezing 96

Plug-in Delay Compensation 441

Poly Pressure
Editing 188
Filtering 285
In List Edit 217
In Logical Edit 274

Pool, see Audio Pool
Position Box 532
Prepare Archive 333
Prepare Master 333
Presets (Logical Edit) 265
Printing

List Edit 230
Scores 244

Process Tempo 544
Processing

Audio 392
Logical Edit 270, 277, 281

Program Change
About 114
Detecting 118
Entering In Editors 118
Entering In Inspector 115
Filtering 285
In List Edit 217
In Logical Edit 274
Numbering 114
Recording 118
Resetting for Parts 116
Timing 117

Purge Segments 325

Q
Q Tool, see Match Quantize
Q-Points

About 357
Displaying 357
Grouped Events 378
Setting Automatically 358
Setting Manually 358

Quantize
Audio (by Time Stretching) 372, 583
Audio Events 370
Drum Edit 211
Drum Tracks 209
Editors 175
Hitpoints 555
Logical Edit 270, 276
Match 70

Quicktime
Exporting Audio from 617
Importing Audio into 618

Quieten 393
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R
R Column, see Multi Track Recording
Randomize 104
Read Button

MIDI Track Mixer 300
VST Channel Mixer 466

Rechannelizing 38
Record Info (Audio Inspector) 48
Record Mode 26
Record Tempo/Mutes 535
Recording

In Audio Editor 348
In Free Time 570
MIDI and Audio at the Same Time 53
Multi Track 49
Resolution 26

ReCycle Files 505
Redirect 89
Reduce Tempo Events 543
Regions 325
Remote Control

Of Program Functions 636
Of VST Mixer 472

Remove DC Offset 399
Repeat

Audio Editors 362
Editors 171
Master Track Events 542
Parts 63, 74

Reset Switch 462
Resolution 26
Resolving 597
Rest Tool 240
Reverse 171, 393
ReWire

About 481
Activating 483
Channels 485
Play in Background 485

Ritardandi 542
Roland GS 309
Ruler 528, 530

S
S/PDIF 15
Sample Accurate Synchronization 593
Sample Rate 518
Save Pool 335
Scissors Tool

Arrangement 65
Audio Editor 365
Master Track 559
Score Edit 241

Score
Displaying 234
Edit Mode 232
Page Mode 232
Printing 244

Score Edit
Editing Several Tracks 238
Joining Notes 241
Moving Notes 239
Splitting Notes 241
Transposing Notes 239

Score menu 232
Scrub

Audio Events 351
Wave Editor 406

Segments
About 34, 511
Auditioning 323
Changing Start and End Insets 324, 354
Creating in Audio Pool 319
Creating in Wave Editor 408
Deleting 325
Deleting Unused 325
Dragging into Other Windows 330
Duplicating 324
Editing in Wave Editor 408
Exporting 330
In the Audio Pool 312, 317
Renaming 323
Start and End Insets 353

Selected to Hitpoints 171
Selecting

Audio File in Pool 319
Events 168
Events in Master Track Edit 537
Logical Edit 276
Overlap 58
Segment in Pool 324
Wave Editor 407

Selection To Segment 408
Send Effects

About 431
Routing Channels to 434
Selecting 432

Sets (Master Effects) 451
Setup Instruments 85
Show Hitpoint Links 558
Show Hitpoint Match 561
Shuffle 237
Silence 393
Slider to Tempo 578
Slider to Time Stretch 582
Smooth 543
SMPTE see Time Code
SMPTE/EBU 530
Snap 175
Snap to Zero 342, 356
Snip at M-points 586
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Snip Loop 365
SoftClip 430
Solo

Drum Edit 212
Edit Solo 162
Folder Tracks 132
MIDI Track Mixer 294
Recording 125
VST Channel Mixer 419

Song Start Offset 609
SongPos to Selected Event 167
Speaker Icon

Audio Editor 352, 358
MIDI Editors 168

Speaker Tool 168
Arrangement 69
Audio Editor 351
Wave Editor 406

Split
Audio Events 365
Parts 65

Split (Piano) Staff 235
Split At Locators 77
Split Stereo Files 329
Staff

Active 238
Multiple 238

Staff Mode 235
Staff Settings 234
Start and End Insets

About 353
Changing in Audio Editor 354
Changing in Audio Pool 324

Startup Song 626
Step Button 190
Step Input

About 190
Entering Notes 191
Entering Rests 191
Insert 194
Note Length and Spacing 190

Stereo
About (Audio) 31
Inspector 44
VST Channel Mixer 46

Stereo Audio Files 33
Stop Events 220
Stop Follow Song after Scrolling 162
Straighten Up 565, 580
Stretch tool 61
Sync

MIDI Clock 605
MIDI Time Code 601
Recovering Lost Sync Tracks 567
To Existing Music 567
With Audio 593

Sync Button 599

Sync Options 612
Syncopation 237
System Exclusive

Editing 218
Filtering 285
In List Edit 217

T
Templates 626
Tempo

And the Info Line 538
Auto Scan 563
Creating Accelerandi and Ritardandi 542
Creating Events 547
Deleting Events 542, 547
Display 529
Drawing 539, 540
Events 536
Finding Matches 562
Mapping to Audio 579
Mapping using Time Locked Tracks 569
Matching 561
Matching Fixed to Audio 577
Moving Events 541, 547
Multiple in one Arrangement 590
Processing 544
Recording In Real Time 534
Reducing Events 543
Selecting 536
Smoothing 543
Straighten Up 565
Time Locked Tracks 589
Using Master Track 533

Tempo Display 528
Text (Score Edit) 242
Text Events 220
Time Based Display 531
Time Based Events 569
Time Code

Formats 530
Frame Rate 604
Generating 598

Time Display Offset 609
Time Format 546
Time Hit Strip 528, 551
Time Hits 532
Time Locked Tracks

About 589
Editing 590
Mapping Tempi 569

Time Position, Switching to 224
Time Ruler 528, 530
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Time Signature
About 529
Creating Events 547
Deleting Events 542, 547
Drawing 540
Editing 538
Moving Events 541, 547
Score 234
Selecting 536

Time Signature Strip 528
Time Stretch 61, 397, 582
Title (Score Edit) 243
To Pop-up Menu 169
Toolbar

Adding generic Icons 634
Displaying Default Icons 633
Removing generic icons 635
Using 632

Tools work on all selected Events 179
Track Class

Converting Between MIDI And 
Drum Tracks 213

Track Mix Part 301
Track Views 644
Tracks

Active 348
Audio 30
Drum Tracks 199
Group 141
Storing and Recalling Views 644

Transforming MIDI data 289
Transpose 141

Editing Transposed Notes 165
MIDI Inspector 98

Trim Events to Part 75
TrueTape 28

U
Undo

Audio Quantize 371
Editing 161

Ungroup Audio Events 377
Unmask 229
Use Waveforms 322
UV22 Dithering 446

V
Velocity

Editing 186
Editing via MIDI 183
For Created Notes 178
MIDI Inspector 98
MIDI Track Mixer 294
Modifiers (Drum Tracks) 210

Velocity Filter 108
Velocity Limit 107
Velocity Optimize 109
View pop-up menu (Audio Editor) 344
View pop-up menu (Mixer) 459
VITC 601
Volume

Audio Editor 387
Controller Editor 260
In Controller Editor 122
MIDI Inspector 97, 121
VST Channel Mixer 419

VST 2.0 Plug-ins 441
VST Channel Mixer

Automation 463
Editing automated data 249
Loading Settings 452
Master “On” button 416
Recording 465
Resetting 462
Saving Settings 450
Views 459

VST Channel Settings window 421
VST Dynamics

Activating 425
Bypass 425
Opening 424
Parameters 426

VST Instruments
Activating 476
Automating 479
Channels 477
Patchnames 94

VST Master Mixer
Controls 440
Showing in Channel Mixer 416

VST Performance Window 523
VST Remote Control 472
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W
Wave Editor

About 401
Cut, Copy and Paste 410
External 411
Loop button 406
Opening 402
Playing Back 406
Selecting In 407
Setting Magnification 405

Wave Images 322
Window Sets

About 646
Creating 647
Recalling 648
Renaming and Removing 649

Word Clock 12
Write Button

MIDI Track Mixer 299
VST Channel Mixer 465

Write Timecode 611

X
XG

About 309
In MIDI Track Mixer 296
Patchnames 92

Y
Yamaha XG 309

Z
Zero Crossings 342
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